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TEKTRONIX SOFTWARE LICENSE AGREEMENT

THE PROGRAM, OR PROGRAMS, ENCODED OR INCORPORATED WITHIN EQUIPMENT OR
ACCOMPANYING THIS AGREEMENT, IS FURNISHED SUBJECT TO THE TERMS AND CONDITIONS OF
THIS AGREEMENT. RETENTION OF THE PROGRAM FOR MORE THAN THIRTY DAYS OR USE OF THE
PROGRAM IN ANY MANNER WILL BE CONSIDERED ACCEPTANCE OF THE AGREEMENT TERMS.
IF THESE TERMS ARE NOT ACCEPTABLE, THE UNUSED PROGRAM AND ANY ACCOMPANYING
DOCUMENTATION SHOULD BE RETURNED PROMPTLY TO TEKTRONIX FOR A FULL REFUND OF
THE LICENSE FEE PAID. (FOR INFORMATION REGARDING THE RETURN OF PROGRAMS ENCODED
OR INCORPORATED WITHIN EQUIPMENT, CONTACT THE NEAREST TEKTRONIX SALES OFFICE.)

DEFINITIONS.

"Tektronix" means Tektronix, Inc., an Oregon corporation, or local Tektronix’ legal entity that is supplying the
equipment,

"Program" means the Tektronix software product (executable program and/or data) enclosed with this Agreement
or included within the equipment with which this Agreement is packed.

"Customer" means the person or organization in whose name the Program was ordered.
LICENSE.

Customer may:

1. Use the Program on a single machine at any one time;

2. Copy the Program for archival or backup purposes, provided that no more than one (1) such copy is permitted
to exist at any one time;

Each copy of the Program made by Customer must include a reproduction of any copyright notice or restrictive
rights legend appearing in or on the copy of the Program as received from Tektronix;

Customer may not:
1. Use the Program on more than one machine at any one time;

2. Transfer the Program to any person or organization outside of Customer or the corporation of which Customer
is a part without the prior written consent of Tektronix, except in connection with the transfer of the equipment
within which the programs are encoded or incorporated;

3. Export or reexport, directly or indirectly, the program, any associated documentation, or the direct product
thereof, to any country to which such export or reexport is restricted by law or regulation of the United States
or any foreign government having jurisdiction without the prior authorization, if required, of the Office of
Export Administration, Department of Commerce, Washington, D.C. and the corresponding agency of such
foreign government;

4. Modify the Program, create derivative works, or merge the Program with another program;

5. Reverse compile or disassemble the Program for any purpose, beyond the extent that such activity is expressly
permitted by applicable open source licenses or applicable law notwithstanding this limitation, or

6. Copy the documentation accompanying the Program.



For Programs designed to reside on a single-machine and support one or more additional machines, either locally
or remotely, without permitting the Program to be transferred to an additional machine for local execution, the
additional machines shall be considered within the definition of "single machine." For programs permitting the
Program to be transferred to an additional machine for local execution, a separate license shall be required for each
such machine with which the Program may be used.

Title to the Program and all copies thereof, but not the media on which the Program or copies may reside, shall be
and remain with Tektronix or others for whom Tektronix has obtained a respective licensing right.

Customer shall pay when due all property taxes that may now or hereafter be imposed, levied or assessed with
respect to the possession or use of the Program or this license and shall file all reports required in connection with
such taxes.

If the Program or any related documentation is acquired by or for an agency of the U.S. Government, the
Program and documentation shall be considered “commercial computer software” or “commercial computer
software documentation” respectively, as those terms are used in 48 CFR §12.212, 48 CFR §227.7202, or 48
CFR §252.227-7014, and are licensed with only those rights as are granted to all other licensees as set forth
in this Agreement.

THE PROGRAM MAY NOT BE USED, COPIED, MODIFIED, MERGED, OR TRANSFERRED TO
ANOTHER EXCEPT AS EXPRESSLY PERMITTED BY THESE TERMS AND CONDITIONS. UPON
TRANSFER OF ANY COPY, MODIFICATION, OR MERGED PORTION OF THE PROGRAM, THE
LICENSE GRANTED HEREIN IS AUTOMATICALLY TERMINATED WITH RESPECT TO THE PARTY
THAT TRANSFERS THE PROGRAM.

TERM.

The license granted herein is effective upon acceptance by Customer, and shall remain in effect until terminated as
provided herein. The license may be terminated by Customer at any time upon written notice to Tektronix. The
license may be terminated by Tektronix or any third party from whom Tektronix may have obtained a respective
licensing right if Customer fails to comply with any term or condition and such failure is not remedied within thirty
(30) days after notice hereof from Tektronix or such third party. Upon termination by either party, Customer shall
return to Tektronix or destroy, the Program and all associated documentation, together with all copies in any form.

LIMITED WARRANTY.

The Program is provided "as is" without warranty of any kind, either express or implied. Tektronix does not
warrant that the functions contained in the Program will meet Customer's requirements or that the operation
of the Program will be uninterrupted or error-free.

TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE.

LIMITATION OF LIABILITY, IN NO EVENT SHALL TEKTRONIX OR OTHERS FROM WHOM
TEKTRONIX HAS OBTAINED A LICENSING RIGHT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR CONNECTED WITH
CUSTOMER'S POSSESSION OR USE OF THE PROGRAM, EVEN IF TEKTRONIX OR SUCH OTHERS
HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

THIRD-PARTY DISCLAIMER.

Except as expressly agreed otherwise, third parties from whom Tektronix may have obtained a licensing right do
not warrant the program, do not assume any liability with respect to its use, and do not undertake to furnish any
support or information relating thereto.



GENERAL.

This Agreement contains the entire agreement between the parties with respect to the use, reproduction, and
transfer of the Program. Neither this Agreement nor the license granted herein is assignable or transferable by
Customer without the prior written consent of Tektronix.

This Agreement and the license granted herein shall be governed by the laws of the state of Oregon.

All questions regarding this Agreement or the license granted herein should be directed to the nearest Tektronix
Sales Office.
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Important safety information

This manual contains information and warnings that must be followed by the user
for safe operation and to keep the product in a safe condition.

To safely perform service on this product, additional information is provided at
the end of this section. (See page xiii, Service safety summary.)

General safety summary

Use the product only as specified. Review the following safety precautions to
avoid injury and prevent damage to this product or any products connected to it.
Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow
generally accepted safety procedures in addition to the safety precautions specified
in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove
the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is
operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where
hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system.
Read the safety sections of the other component manuals for warnings and
cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the
responsibility of the assembler of the system.
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Important safety information

To avoid fire or personal  Use proper power cord. Use only the power cord specified for this product and
injury certified for the country of use. Do not use the provided power cord for other
products.

Ground the product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded. Do not
disable the power cord grounding connection.

Power disconnect. The power switch disconnects the product from the power
source. See instructions for the location. Do not position the equipment so that it
is difficult to disconnect the power switch; it must remain accessible to the user at
all times to allow for quick disconnection if needed.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

The measuring terminals on this product are not rated for connection to mains or
Category 11, III, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels
removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components
when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged
or operates incorrectly. If in doubt about safety of the product, turn it off and
disconnect the power cord. Clearly mark the product to prevent its further
operation.

Examine the exterior of the product before you use it. Look for cracks or missing
pieces.

Use only specified replacement parts.
Use proper fuse. Use only the fuse type and rating specified for this product.

Wear eye protection. Wear eye protection if exposure to high-intensity rays or
laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if
a unit is moved from a cold to a warm environment.
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Important safety information

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean
the product.

Provide proper ventilation. Refer to the installation instructions in the manual for
details on installing the product so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or
otherwise obstructed. Do not push objects into any of the openings.

Provide a safe working environment. Always place the product in a location
convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads.
Improper or prolonged keyboard or pointer use may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an
ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with
handles for lifting and carrying.

Service safety summary

The Service safety summary section contains additional information required to
safely perform service on the product. Only qualified personnel should perform
service procedures. Read this Service safety summary and the General safety
summary before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power. To avoid electric shock, switch off the product power and
disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist
in this product. Disconnect power, remove battery (if applicable), and disconnect
test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric
strength after performing a repair.

MTSA-HW and MTSA-PC Analyzer Applications User Manual xiii



Important safety information

Terms in this manual

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Symbols and terms on the product

These terms may appear on the product:

®  DANGER indicates an injury hazard immediately accessible as you read
the marking.

B WARNING indicates an injury hazard not immediately accessible as you
read the marking.

B CAUTION indicates a hazard to property including the product.
When this symbol is marked on the product, be sure to consult the manual
to find out the nature of the potential hazards and any actions which have to

be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbol(s) may appear on the product:

A © b

CAUTION Protective Ground Standb
Refer to Manual ~ (Earth) Terminal tandby
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Preface

The MTSA MPEG system applications are described in the following three user
manuals:

B Analyzer applications
®  Generator applications

®  Carousel applications

NOTE. To view the full list of applications, find the MTSA-HW and MTSA-PC
Quick Start User Manual at https//www.tek.com.

The MTSA can be delivered to you as a rack mountable 1RU full rack instrument
(MTSA-HW), or as a standalone software (MTSA-PC). For product ordering
purposes, the following naming conventions are used in this manual:

B MTSA-HW, which is used for information that only applies to the
MTSA-HW instrument

B MTSA-PC, which is used for information that only applies to the standalone
software.

B MTSA: Used for information that applies to both MTSA-HW and MTSA-PC
products

Table i: Overview of the MTSA Analyzer Applications

Application Desktop icon
Transport Stream Compliance Analyzer (TSCA) — Real time and deferred transport stream analysis with

user-selectable MPEG-2, DVB, ATSC and ISDB conformance tests. Shows transport structure, header &
contents, hexadecimal packet contents, PCR timing /transport rate graphs and error message logs. \

T3 Compliance
Analyser

Packetized Elementary Stream (PES) Analyzer — PES analysis with selectable test options. Shows PES
program structure, header contents, packet contents, PTS/DTS timing graphs and analysis reports.

A
PES Analyser
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Table i: Overview of the MTSA Analyzer Applications (cont.)

Application Desktop icon

Transport Stream - System Target Decoder (T-STD) Buffer Analyzer — Analyzes program streams
modeling their behavior in, and their conformance to, the MPEG-2 T-STD Buffer Model. Includes a
trace facility.

Buffer
Analyser

Elementary Stream Analyzer — Elementary Stream analysis at video picture and audio level. This
includes vector graphs and macroblock picture quality.

ES Analyser

Xvi MTSA-HW and MTSA-PC Analyzer Applications User Manual



Preface

Product documentation

The following table lists the documentation available for your MTSA-HW and

MTSA-PC product:

Language Document title Part numbers Purpose
English MTSA-HW and MTSA-PC 071-3661-xx Describes how to install
Quick Start User Manual and get started using the
test systems.
English MTSA-HW and MTSA-PC 077-1600-xx Describes the operation
Analyzer Applications User of the following analyzer
Manual applications: TSCA,
PES Analyzer, T-STD
Buffer Analyzer, and ES
Analyzer.
English MTSA-HW and MTSA-PC 077-1601-xx Describes the operation
Generator Applications User of the following generator
Manual applications: Multiplexer,
MPEG Player, TS Editor,
ISDB-T Remux, Make
Seamless Wizard,
Transport Stream Cultter,
and Script Pad.
English MTSA-HW and MTSA-PC 077-1602-xx Data analysis showing
Carousel Applications User structure, bit rate,
Manual repetition rate, syntax
and semantics of data
items.
English MTSA-HW and MTSA-PC 077-1604-xx Describes known issues
Release Notes with the test systems.
English MTS4EA HEVC / AVC Video 077-1134-xx Describes the operation
and Compressed Audio of the advanced
Analyzer User Manual elementary stream
software.
English PQAGOOC and PQASW Picture ~ 077-1137-xx Describes the operation

Quality Analyzer User Manual

of the PQA application
software.
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TSCA - Getting started

MTSA-HW and MTSA-PC Analyzer Applications User Manual

The MTSA MPEG Transport Stream Compliance Analyzer (TSCA) enables
you to monitor and interpret the contents of real time, previously recorded, or
synthesized transport streams using the latest MPEG, DVB, ATSC, and ISDB
standards.

The TSCA is specifically designed to enable you to quickly locate and identify
problems within a transport stream using a minimum number of clicks.

By quickly identifying the problem areas, the TSCA software helps you save
time during the development and test of equipment, networks, and services. You
can configure the TSCA software to display stream information in user-selected
fonts. This feature enables you to view stream information in your local language
or to use custom fonts.

The TSCA software will run standalone on computers with the Microsoft
Windows 10 Pro operating system:

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View MNavigation Settngs CaptureVu™ Help

e

°

Restart

Ler

Open File...

=

Real-time
B Fle)NuPIns"" L Analvss‘
Programs | Tests | s1/pst | PIDs | Packets| NETT | Thumbnails || MPE Sessions|
Actions v | @ =

=-4Q) Transport Stream: d 4103, Network Name: Sandy —
@ Frogram 4167 (0x1047) BAC ONE ‘& El®a
@ P 00 (0x258) D Nuber of Programs 6

@ PD 01 (0x259) A Current TS bit rate 24.128 Mbps

% roow o 2 Current TS bit rate exduding hNull PID 22.116 Mb
@ P 503 (0x258) 2 urrent it rate excuding Nul ps

@ PID 850 (0x284) 11§

Standard... | Configuration...

Program Bit Rate Occupancy (Current] 3| ~Programs: Current Bit Rates
® 4167 BBCONE 6.096 Mbp
® 4231 BBCTWO  6.109 Mbp:
B ® 4351 BBC CHOICE 6.108 M
® 4415BBCNEWS 24 5989

® 4479BBCTEXT 0.899 Mbpf
@ Program 4231 (0x1087) BEC TWO &
@ PID £10 (0262) =R D g il ® 4se38BCPARLUNT 0993
Q@ Po 611 (0263) A 5 - # PID 3191 2.012 Mbps
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Figure 1: TSCA Program view - deferred analysis



TSCA - Getting started

TSCA features

Industry's fastest analysis engine enables reduced analysis time, rapid
development, evaluation, deployment, and diagnostics of next generation
DTV and IPTV systems and services

Support for a wide range of DTV standards, including MPEG, DVB, ATSC,
including A78 and SCTE 142, and ISDB. Specific service information (SI)
for terrestrial, cable, and satellite, plus regional variations of these standards
are also supported

A range of interfaces and analysis capabilities provide the necessary
connectivity to diagnose problems anywhere in the network environment,
whether that is in transmission links (RF or IP layer) or content processing
(TS layer)

Connection to both IP version 4 and 6 networks, including those using IGMP
and MLD multicast protocols respectively

Constant bit rate stream analysis (CBR)

CaptureVu technology captures and analyzes system events in real time and
deferred time to debug the intermittent and complex problems that traditional
analyzers miss

Multi input monitoring

Innovative program-centric user interface brings expert power to the novice
user

File Analysis and Real Time modes

The TSCA can be run in offline (or deferred) File Analysis or Real Time Analysis
mode.

The offline File Analysis mode is available on any recommended platform
(including the your own PC). In offline File Analysis mode, a static stream can be
analyzed and displayed; the content can then be inspected at leisure.
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Technical background

The analyzer has a client-server architecture. Every time the analyzer opens, it
starts two processes: tsca.exe, which is the client, and MpegCore.exe, which
is the MPEG analysis engine.

Additionally, when the analyzer opens for the first time, another single
process, CoreManager.exe, is started. CoreManager.exe forms an intermediary
between TSCA clients and MPEG cores. The tsca.exe, MpegCore.exe, and
CoreManager.exe processes use SNMP (Simple Network Management Protocol)
and HTTP (Hypertext Transfer Protocol) to communicate. The port numbers
used for communication are read from a configuration file, Corelnfo.xml. In a
default installation, the path to the file is:

C:\program files (x86)\tektronix\mpeg\mtsa\apps\tsca\xml\

The default port range is 15700-15800. You can change these values if they
conflict with other applications. You must have local administrator rights to be
able to use IP analysis. If you need to change your rights, please consult your
system administrator.

User interface

The TSCA software displays two primary views selected using tabs: Flex/u®
Plus and Analysis.

Using the FlexVu® Plus window, you can assemble up to four views that you select
from the Analysis window. This allows you to customize the view by selecting
the views that are most relevant to the analysis task. The Flex}u® Plus window is
described in detail in the MTSA-HW and MTSA-PC Quick Start User Manual.

The Analysis window uses a single main program summary window with different
context sensitive views contained within tabbed frames. This provides the
maximum amount of useful information, while keeping the screen from appearing
cluttered. From the main window, you can access the following views: Program,
Tests, Tables, PID, Packets, and Interface.

Program view  The Program view provides a fast overview of the transport stream contents in
terms of program content, bit rate use by each program, and TR 101 290 test
results.

Red, amber, and green LEDs highlight errors associated with each program, or
element of a program, within the transport stream. Red LEDs indicate that there
are current errors in the stream, amber LEDs indicate that errors have occurred
but are now clear, and green LEDs indicate that no errors have been detected.
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Tests view

SIIPSI (Tables) view

PID view

Packets view

Errors that are detected at lower levels in the program stream hierarchy propagate
up to the highest level. This allows you to monitor all of the programs in the
stream at a high level and then quickly go to lower levels as necessary to locate a
problem.

The Tests view enables you to isolate errors to the specific tests that have been
applied to the transport stream. The error log is automatically filtered by the
selected test, and can also be filtered by Packet Identifier (PID).

In addition to the standard first, second, and third priority tests included in
TR 101 290 standard, tests are available for Program Clock Reference (PCR)
jitter and program/PID bit rate.

A variability test enables you to test the changes in the bit rate of a specific PID,
and there are many tests that are specific to ISDB-T and ISDB-S streams.

The SI/PSI (Tables) view displays the service information tables that have
occurred in the analyzed stream that comply with the selected digital video
standard. This includes MPEG-specific program information, DVB service
information, and ATSC, ISDB program, and system protocol information.

The tables are grouped together by function and hyperlinks enable you to quickly
access related information within other tables.

The PID view displays information about all of the PIDs found in the transport
stream. When you select the transport stream, the associated summary view
provides a PID-oriented overview of the transport stream, displaying the relative
data rates of all of the PIDs contained within the stream.

The information can be displayed as either a bar chart or as a pie chart. Pop up
menus enable fast limit selection and links. Each PID is associated with a number
of tests. When one or more tests fail, each failed test will be listed under the
relevant PID. Select a specific PID to display a summary of all the associated tests.

Select a specific test to display the Event Log and Parameters for only that test.

The Packets view displays information about all of the packets found in the
transport stream grouped according to content. These groups include PID value,
SFN mega-initialization packets (MIPs) (DVB only), and ISDB-T and ISDB-TB
information packets (IIPs).

When you select a specific PID or MIP, only packets carrying that particular
PID or MIP are displayed. A section view is also available. Deferred analysis
of PCAP files allows you to see the Ethernet packets. The Packets view is not
available in real time mode. However, you can examine packets in a real time
stream by using the CaptureVu feature.
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Interface view  The Interface view provides a central location for information related to the RF
and IP interface cards (where installed):

B Test results
m  Graphical representation of specific RF and IP readings
B RF and IP readings and control settings

The graphical views display a selection of graphs of instantaneous measurements
and measurement trends. Also available is an Event Log.

The Interface tab is displayed only when an interface is installed.

CaptureVu feature

The CaptureVu feature captures a snapshot of system events in real and deferred
time, and allows you to debug the intermittent and complex problems that
traditional analyzers miss.

You can initiate CaptureVu either manually or automatically by associating a
CaptureVu Breakpoint with any test event.

When a breakpoint is detected, either manual or automatic, the stream is paused
and an in-depth deferred time analysis can be performed on stored data. This
powerful debug mode enables fast debugging of troublesome intermittent
problems.

Triggered recording

During real time analysis, stream information can only be held for a finite time
- eventually it will be overwritten by more up-to-date information. Triggered
recording allows a portion of a stream to be recorded and subsequently analyzed
in detail.

The following trigger sources and conditions apply:
®  Any test event

B Date and time

B Recorded file size can be specified

®  Pretrigger buffer size can be specified as a percentage of the overall file size
range from 0 - 100%
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Starting the TSCA software

The TSCA can analyze transport streams in either real time or file analysis mode.

Opening the TSCA  From the Windows Desktop, select Start > Tektronix MTSA > TS Compliance
Analyzer, or double click the Deferred Time Analyzers folder from your
desktop to then open the TSCA — Compliance Analyzer:

B rektronix MTSA
Buffer Analyser
Carousel Analyser

* Carousel Generator
ES Analyser
ISDB-T Remux
Make Seamless Wizard
MPEG Player
Multiplexer
OptionKey Wizard
PES Analyser
ScriptPad

= Stream Cutter

TS Compliance Analyzer

£3 15 Editor

Deferred
Time

Analyzers
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| M 5 | C\Users\Publ... ShortcutT... - O X

Home Share View Manage Manage O
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[ Desktop
¥ Downloads
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Documents 4 23 PES Analyser
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Deferred Time Analyz
wll B 7 >

The TSCA is opened, initially overlaid with either the Open File Analysis or the
Select Real time Interface dialog box as shown in the following figures. The
application opens the dialog box that was last opened.

¥ No File - MPEG TS Compliance Analyzer EIEIE)

Analysis View Navigation Settings CaphureWu™ Help

8 Flexvuptus] [£8 Open File Analyss ==l

Programs | Tests | Standard
Base Standard DYB, Region No Extensions
Using default scripts. Scripted validations are not enabled 2
Laokin: y Newvalme @~ (7 *[EE =]
T [ dwb_625_mcpe3 Advanced Settings | Favorite Files

<

() Mo PAT

Stream Bit Rate

Recent Items The stream bit rate is used a5 3 basis

For timing messurements during - Show fiter &)
- analysis. Please select how the bit rate Mean(Mbps) | Min(bps) | Max(Mbps)

is calculated:
Desktop _

(@) Prescan first | 100 PCRs

rescan all PERs in Fle

o () Manuslly set [0 Mbps
Timestamp Settings
L,I | ) Do not use Timestamps.

-

(@) Use Arrival Timestamps (if pres...

Computer
= Capturevu™ Settings [6+7]
Qg Fil name: g [7] Pause analysis at packst index -
Metwork  Files of bype: | MPEG Transport Stream Fies (*.mpg, *.mp o

3} T Ackual -

(J 2.1 Transport Qs
O 3.1b NIT Other ‘ ‘

Qz2@e

() 2.3.aFCR Repatition

(2 2.3.b PCR Discontinuity Indicator
O 2.4 PCR Awracy

() 25FTs

Qz6car

.1 Sync
O 1.2 5ync Byke
QD 1.3.apAT
() 1.4 Continuity

(2 3.2 5L Repatition
() 3.4.aUnref PID

(3 3AKFIT Other

75 Avaisbiity @\ Sync ()| 0.000000 Mbps @ 168 | 0| |DVE| | No Extensions| | [l

Figure 2: TSCA startup offline file analysis
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[E7 No File - MPEG TS Campliance Analyzer [=e=]=]

Analysis Visw Navigation Ssttings Captureyu™ Help

E FlexYuPlus™ ‘O Analysis

Programs | Tests | SIFSI | PIGs | Packets | | 79 Solect Real-time Interface @]

actions v | @ Standard

+(_) No PAT Base Standard DYB, Region No Extensions m}

Using default scripts, Seripted valdations are not enabled.

Inkerfaces

Select from the available interfaces ({6 ]

Show fiter (€
Mean(Mbps) | Mintibps) | MaxiMbps)

Interface Settings

Presets Selected Praset

These are the settings for the currently selected preset.
To browse the network for a stream, select the Browse... button.

Preset Name Preset -

|~ Device Settings B
IP Device Name Intel(R) Ethernet Server A,
Pazsive Made Wi
IP Address 0.0.0.0 (managed by opera..
Subret Mazk l(managed by operating sy... | =
Default Gatewsy (managed by operating sy..

|- Stresm Settings

Saurc Addrass 192.168.1 222
Destination Address 239,111 m
Destination Part 16324

Use RTP v true 2

& =

() 3.1.a NIT Actual .
() 3.1b NIT Other B
O 52 1 Ropmtion H

TJ L F Cormnay J 2.3.6 PLR Discortnuiy Thaicatar () 3.4.a Uniref PID
() 1.5.aPMT (D 2.4 PCR Accuracy () 3.5.a 50T Actual
Q LEPID Qz5pPT5 (D 3.5b 50T Other
QD z6CAT () 3.6.aEIT Actual
(3 3A.hFIT Other =

5 Availatiity @ |Sync () | 0.000000 Mbps @ 188| 0| DVB | Mo Extensions| | [l B

Figure 3: TSCA startup real time analysis
The opening dialog boxes allow you to:

®  Select the interpretation standard to be used for analysis. See step 2 in the
Interpreting a Stream section in this publication. You should always set the
stream interpretation standard before starting analysis.

and

m  Identify a stream file for offline analysis. See step 1 in the Off-Line File
Analysis section in this publication. Files can be selected either directly from
the disk drive or using shortcuts that you have defined.

or

®  [dentify an input (IP, RF, ASI) receiving a stream and start real time analysis.
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Interpreting a stream  You can set up the stream interpretation standard in the following way:

1. Click Change in the opening dialog box to open the Standard dialog box.

NOTE. The TSCA software analyzes streams in strict accordance with the
standards defined by the digital television authorities: DVB (Digital Video
Broadcasting), ATSC (Advanced Television Systems Committee), and ISDB
(Integrated Services Digital Broadcasting).

The TSCA software uses preloaded scripts that establish the expected content and
syntax of the analyzed stream. The analyzer is supplied with a comprehensive
range of scripts, which, in different combinations, can interpret the full range

of digital television standards.

2. Select the Base Standards and then (if available) select the Region. The
analysis scripts that will be used are displayed in the Script Files pane.

LSS o, ==

! .
&3 Open File Analy Standard and Region =]
Select a standard and region to use for analysis

Skandard
Base Standard DY r 1 LT - 1
Using default script Base Standard \DvE ¥ |Region  Na Extensions - |
Scripks
Look.in: [ Use Custom Scripts
= [] Enable scripted section validations during analysis (slower) Faworite Files
e
Recent Items Scripts Direckory |Z:Program Files (863 TekbroniximpegiMTS4000% Scripts | iced a5 & basis For
= - during analysis.
! m bekbroni. scp E bit rate iz
ﬂ Ethernet.scp
Deskiop m MPEG_Packet.scp 'G' PCRs
= ) DvE_SFI_MIP.scp e
b =
E B mpeg.scp = "
My Documents m dvb.scp e
= 5
" L M th.SCD G tarmps
. m mpe. scp F )
= tarnps (iF present
Computer B dsmce.scp hd pELTP
-,_.,h m int.scp = ﬂ
; &£
(_L\ B mpeg_pat.scp k. packet index
Ry ) DP1_SCTE3S.5cp .

) (oo ]

oK Cancel

Figure 4: Stream Interpretation dialog box
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3. Select OK.

4. The stream interpretation is now set. Select OK to close the Standard dialog
box and return to the opening dialog box. (See page 128, Script files.)

NOTE. The selected stream interpretation standard is not implemented until
stream analysis is started. If the Open Transport Stream dialog box is closed
without starting analysis, the stream interpretation settings are lost; they revert to
the settings that were in effect when the application was last closed.
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Offline file analysis ~ Perform the following steps to start analyzing a transport stream file:

1. In the Open File Analysis dialog box, browse to a transport stream file. If

necessary, select a file type from the Files of type dropdown list. Currently,
two types are available: MPEG Transport Stream files and PCAP files:

MPEG transport stream files contain interlinked tables and coded

identifiers, which separate the programs and the elementary streams
within the programs.

PCAP files contain raw packets of network data. A PCAP may contain

more than one session. You will need to select a session using the Browse
dialog box.

When you select a stream, the stream name appears in the File Name field at
the bottom of the window.

¥ Open File Analysis

Standard
Base Standard DVB, Region No Extensions
Using default scripts. Scripted validations are not enabled.
Look in: | (03 Streams v ‘ r __’-’II = ﬁ
. |2) Golddemos Advanced Settings | Favourite Files
’J I7) samples
=) 5ES Stream Bit Rate
Working.ilcab [’ﬂ The stream bit rate is used as a basis for timing
I Sym measurements during analysis. Plese sslact how
- B TekStreamer the bit rate is calculzted:
4] BBC 18UG27.mpg (8) Prescan first 100 PCRs
Control Panel | (2] EchoStaré 1-5\West-TP2.mpg () Prescan all PCRs in file
w SmallSports2_SMbpsSeamless. TRP O My =t |4 Mbps
i Timestamp Settings
,J (%) Do not use Timestamps
My Documents (O Use Arrival Timestamps (if present)
& () Use TTS Timestamps (if present)
@ CaptureVu™ Settings =
My R t
D;cufnc;nis D Pause analysis at packet indsx
p[:
Desktop
Flename:  [8BC1AUG27.mpq| |
Files of type: |MPEG Transport Stream Files (*.mpa, *.mpeg, *.trp, *.ts, *.r... |™ ‘

Figure 5: TSCA Open File Analysis (Offline) dialog box
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3. Calculating the stream bit rate: To analyze a transport stream correctly,

you must do one of the following:

= Calculate the bit rate from PCRs (Program Clock Reference) carried in
the stream

NOTE. When the TSCA software analyzes a transport stream, it compares the
bit rate of the stream to the expected rate. Errors are reported based on the
expected rate of the stream. To analyze a stream correctly, it is necessary to
know the original bit rate of the stream or to calculate the bit rate from PCRs
(Program Clock Reference) carried in the stream. PCRs are generated as a
stable clock reference and are added to the stream during its generation.
During analysis, the PCRs are extracted and synchronized with a local clock
reference.

= Know the original bit rate and enter it manually

= Use timestamps included with the stream

Advanced Settings = Favorite Files

Stream Bit Rate

The stream bit rate is used as a basis for timing
measurements during analysis, Please select
how the bit rate is calculated:

(®) Prescan first | 100 PCRs
(O Prescan all PCRs in file
(O Manually set 0 Mbps
Timestamp Settings
(®) Do not use Timestamps
(O Use Arrival Timestamps (if present)
CaptureVu™ Settings (o)
I:] Pause analysis at packet index
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4. After you select the desired stream, select one of the following methods for
calculating the rate of the transport stream:

= Prescan first nnn PCRs. The TSCA software calculates the rate of the
stream by prescanning the stream for embedded PCRs. The entry box lists
the number of PCRs that the TSCA software recommends are necessary
to determine the stream rate. You can use the entry box to enter a different
number.

= Prescan all PCRs in a file. The TSCA software calculates the rate of the
stream by prescanning the stream for all of the embedded PCRs.

= Manually set nnnn Mbps. The TSCA software uses the absolute value (in
Mbps) that you enter as the expected stream rate.

NOTE. If 'Use Arrival Timestamps' is selected, timestamps, which may have been
added when the stream was generated, will be used, in the analysis of the stream.

Using timestamps will override the PCR options ('"Prescan first nnn PCRs' and
'"Prescan all PCR in file').

A manually entered bit rate will override both PCRs and timestamps in the stream.

5. If the TSCA software cannot calculate the bit rate from the embedded PCRs,
or timestamps, a message box is displayed. You must enter an estimated bit
rate before the TSCA software can analyze the stream.

6. If the CaptureVu feature is to be used, the whole file can be captured or
analysis can be paused either by a previously set CaptureVu breakpoint or at a
specific packet.

7. To pause analysis at a specific packet, enable Pause Analysis at Packet
Index and enter a packet number.

With a file selected and the transport rate calculation set up, you can start the
analysis. (See page 23, Starting analysis.)
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Real time analysis  To start analyzing a transport stream received through an IP or a hardware (RF)
interface, select Real time from the toolbar and, in the Select Real time Interface
dialog box, select an interface from the Interfaces dropdown list.

Only installed interfaces will be shown in the dropdown list. For standalone
installations, only the IP interface is available.

E QAM-B - MPEG TS Compliance Analyzer = O

Analysis Navigation Settings CaptureVu™ Record Help

! FlexVuPlus™ &2 Analysis

Programs Tests :
SIPSI  PIDs  Packets Interface

Adions ¥ | show @ ¥ @ | % BB

Graphs —jg Interface EventLog

=) o B Trend Timescale : | Previous minute :
@ Lock —— =1 loreset | Default v| [ Edt..
= ] -ti =
E o gRMEn =2 [E? Select Real-time Interface b4 e e s !
=
@ MER Drift Limit Standard
() BER (Pre Reed-Solomon/BCH) Base Standard MPEG, Region No Extensions
[= o Power Using default scripts. Scripted validations are not enabled.

@ High Power Limit
0 Low Power Limit Interfaces -
° Power Drift Limit Select from the available interfaces |QAM-B
] Q Carrier Offset (TP
=] Q Interface Warnings
=@ MER Warning
@ MER Limt Warning
@ MER Drift Limit Warning
[+ O BER (Pre Reed-Solomon/BCH) War
= Q Power Warning

High Power Limit Warning
0 Low Power Limit Warning
o Power Drift Limit Warning
[]-O Carrier Offset Warning

Figure 6: TSCA Real time Interface dialog box

Real time analysis will not be available if the appropriate software key permissions
are not found. A warning message is displayed when real time analysis is not
available.

Make any necessary interface settings. Either select and apply a preset (a
predefined set of interface settings) or modify the individual interface settings.
During analysis, the interface selected will be shown in the status bar. (See
page 17, Setting up the IP interface.)
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Interface card overview

This section describes the configuration and interpretation of results of the RF and
IP Video interface cards that you can install in an MTSA MPEG test system.

The cards all use a common interface protocol for data handling and firmware
upgrading.

The interface settings described are as follows:

m  ASI: Ports 1 to 4 for input or output

m  SDR: RF for 8VSB, QAM A/B/C, DVB-T, or ISDB-T/Tb

®  DS2: RF for DVB-S or DVB-S2

®  10GS: Dual IP NIC for 1Gb or 10Gb Ethernet using 850 nm SFP+

Refer to the MTSA-HW and MTSA-PC Specification and Performance Verification
Technical Reference, for the interface technical specifications.

The RF interface measurements and graphs include a constellation diagram

with Input Power, MER, and BER measurements. A constellation diagram with
MER rings is also available with the QAM-B and 8VSB from the SDR card.

The installed interface cards can be used simultaneously with the internal NIC
(Network Interface Card) input. All interfaces have dual-level warning and failure
alarms, and graphs for long term trend monitoring.

The input card screen and configuration of the card depend on which interface
cards are installed. (See the following pages.)
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Interface card set up  The interface card configuration is set up when analysis is started by clicking

the

Real time icon.

The settings can subsequently be changed during the analysis from the Interface
view.

ILI QAM-B - MPEG TS Compliance Analyzer

Analysis View Navigation Settings CaptureVu™ Record Help

3 FlexvuPlus™ £ Analysis

Configuration..

Programs Tests :
SIPSI  PIDs  Packets Interface
Acﬁmsv‘%uw:),b@l%@

=] Q Interface Errors

@ High Power Limit

0 Low Power Limit Intexfaces

- Carrier Offset

= O Interface Warnings

=@ MER Warning

~(@ MER Limit Warning
@ MER Drift Limit Warning
] O BER (Pre Reed-Solomon/BCH) War
= o Power Warning

@ High Power Limit Warning
0 Low Power Limit Warning
° Power Drift Limit Warning
] Q Carrier Offset Warning

75 Avallabiity @)||Sync @ 26.970352 Mbps @ma}[ma\ Ewr:c

@ Lock ==
2-Q) MER I_I Select Real-time Interface
@ MER Limtt
@ MER Drift Limit Standard
£#-()) BER (Pre Reed-Solomon/BCH) Base Standard MPEG, Region No Extensions
= Q Power Using default scripts. Scripted validations are not enabled.

@) Power Drift Limit Select from the avalable interfaces | QAM-B

Trend Timescale : | Previous minute

|

No Extenions | Interface: Qam-| |l B

When real time analysis is selected and an interface is selected from the Interfaces
dropdown list.

1.
2.
3.

4.

Select Real time Analysis.
Select the interface from the Interfaces dropdown list.

Enter the interface settings required for Descriptions of the settings for each
interface card. (See page 72, SDR RF interface views.)

Select OK to start the analysis.

The name of the selected interface is displayed in the TSCA status bar.

16
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Setting up the IP interface

&) mtsa-q000003 - Remote Desktop Connection

Two Ethernet interfaces are standard on the network interface cards installed in an
MTSA-HW system; both are 10/100/1000 Base-T.

NOTE. This procedure assumes you have accessed the MPEG TS Compliance
Analyzer screen. Otherwise, you must double click the Real Time Analyzers folder
on your desktop and click the “TSCA with real time capabilities” application.
This action opens the MPEG TS Compliance Analyzer screen.

To set up the IP interface, you must:

1. From the MPEG TS Compliance Analyzer screen, click the Real time

button on the toolbar.

2. From the Select Real Time Interface window that appears, go to the
Interfaces section (located in the middle of the window) and select the IP
option from the Select from the available interfaces dropdown menu.

3. Still in the Select Real time Interface window, go to the Presets field under
Interface Settings , located at the left of the window, and then click the

& + (plus) sign.

tion Settings CaptureVu™ Help

Standard... | Configur,

B HexvuPlus™ £ Analysis

c e / ®

ation... Restart

Programs Tests SIfPSI PIDs Packets

Acons v | ¥ 7 B

4
»| Summary Thumbnails MPE Sessions

Q No PAT

Deferred

Time A...

Generators

Real Time

Analyzers

Utilities

E & £ NoPAT

Number of Programs 0

Mean| [0 Select Real-time Interface
Mean
Standard

Base Standard DVB, Region No Extensions
B <ing default scripts. Scripted valdations are not enabled.

Change...
Interfaces
Select from the available interfaces | 1P

Interface Settings
Presets

Selected Preset

These are the settings for the currently selected preset.
To browse the network for a stream, select the Bromse. .. button.

iDouble-dlick to add a preset|

oK Apply

Mean(Mbps)

- Min{Mbps) Max{Mbps)

Cancel

O 1.4 Continity

( 2.3.b PCR Discontinuity Indicator
Q 1.5.aPMT

v | 2.4PCR Acauracy

A [ 3.1.aNIT Actual
( 3.1b NIT Other
() 3.25I Repetition
Q 3.4.a Unref PID

v | 3.5.aSOT Actual

TS Availabiity @ |Sync (|| 0.000000 Mbps @ 188||0| | DVB| No Extensions| | [Iill] &
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Clicking the + (plus) sign indicated above enables you to make a selection in
the Selected Preset ficld and use the Browse (button) feature.

g‘l Mo File - MPEG TS Compliance Analyzer

— O >
Analysis View MNavigation Settings CaptureVu™ Help
E\I Select Real-time Interface x
iguration. Standard
FlexVuPlus™ Analysis Base Standard ATSC, Region No Extensions
! p Using default scripts. Scripted validations are not enabled. |
sI/psI PIDe Packete )| Summary Thumbnails.
Programe Tests Interfaces
Select from the available interfaces  |IP o=
Actions ¥ | o FHE
...... o Mo PAT E Q = Interface Settings
Number of Program: Presets Selected Preset
Mean TS bit rate These are the settings for the currently selected preset.
ean itra To browse the network for a stream, select the Bromse. .. button.
Mean TS bit rate ex
Intel(R) 1211 Gigabit Network Conne...

NA

0.0.0.0 {managed by operating system)

(managed by operating system)
(managed by operating system)

< o=

rea
| ok
O Priority Tests Eventlog
Q) L15ync ~ [ 2.1Transport ~ [ 3.4.a Unref PID

() 1.25yncByte

|15 Availabiity @|sync /[ 0.000000 Mbps @ 185 [o] |ATSC| N0 Extensions| | [l 6
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4. Click the Browse button to browse the network for a stream and obtain the
Browse for UDP flow screen.

&5 mtsa-q000003 - Remote Desktop Connection - [m] X
S
&
Analysis View Navigation Settings CaptureVu™ Help
nF
B FlexvuPlus™ £ Analysis
]
Programs Tests SIPSI PIDs Packets E
b} kel - T
Base Standard DVB, Region No Extensions = =
QD No PAT Using default scripts. Scripted validations are not enabled. [ T
‘ Interfaces
[E® Browse for UDP flow... X
Deferred
Time A... - - N | |
No device selected
IP Address Settings (N/A)
Passive mode (no outbound traffic)
Generators mode (issues and respe to ARP and other traffic)
o 2 Change
: No device selected
. IGMP Group Membership
Current Group: None Join Leave
Player >
No UDP flows detected (total rate 0 Mbps)
Transport Has TS | Source Port Dest. Port Bit rate (Kbps) | Bitrate Graph Multicast
Real Time
Analyzers
Selected Flow: Source Address 0.0.0.0, Destination Address 0.0.0.0:0 (UDP)
Utilities e
TS Availability @)||Sync (|| 0.000000 Mbps @ 188/ 0| |DVB| No Extensions| | [iil] 6
=: = 1:19PM
[] ds - o o A B ) = 158
>

Figure 7: ‘Browse for UDP flow’ window

MTSA-HW and MTSA-PC Analyzer Applications User Manual 19



TSCA - Getting started

5. From the Browse for UDP flow window that appears, click Browse Device

(on the top of the window) to select your device from the dropdown.

%5 mtsa-q000003 - Remote Desktop Connection

ce / ?
d... | Configuration... |Restart
B Flexvuplus™ £ Analysis
]
Programs Tests SI/PSI PIDs Packets E‘
ool e =
Base Standard DVE, Region No Extensions G
Q MNo PAT Using default scripts. Scripted validations are not enabled. = I
Interfaces

[E? Browse for UDP flow...

Browse Device

(0.0.0.0) Intel(R) 1211 Gigabit Network Connection (right NIC) ) | Min(Mbps)
23) Intel(R) Ethernet Server Adapter X520-2
Intel(R) Ethernet Server Adapter X520-2

Intel(R) Ethernet C: jon (2) 1219M (eft NIC)
B 15 ARP &N o1 e

Change
IGMP Group Membership
Current Group: None Joi eave
- >
No UDP flows detected (total rate 0 Mbps) =
Transpot | Has TS | Source Port | Dest Pot | Bt rate (Kbps) | Bt rate Graph | Mulbcast
Real Time
Analyzers Actual ~
Other
Selected Flow: Source Address 0.0.0.0, Destination Address 0.0.0.0:0 (UDP) petition
- efPID
K Cancel | Fpnal .
Utilities e

TS Availabilty @) Sync (|| 0.000000 Mbps @ 188 |0| | DVB| | No Extensions| | [ill

| H19PM

Figure 8: ‘Browse Device’ dropdown to select right NIC
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6. From the Browse for UDP flow window, select the device with the right
NIC in the Browse Device dropdown. Change or leave the IGMP in IGMP
Group Membership field.

Use right NIC
|

Browse De'vicel Intel(R) 1211 Gigabit Network Connection (right NIC) v
\Device\NPF_{0D59E689-548C-4D31-B2E2-6D4CI7B3A4CA}

E‘I Browse for UDP flow...

Browse for target el
device

IP Address Settings (managed by operating system)
Passive mode (no outbound traffic)
Active mode (issues and responds to ARP and other traffic)
IP Address: 0.0.0.0 (managed by operating system)
Subnet Mask: (managed by operating system)

Default Gateway: (ranaged by operating system) Change...

IGMP Group Membership
IGMP —|Current Group: 239.1.1.1 | Change... Leave
32 UDP flows detected (total rate 89.416 Mbps)

T2aNSpos St A + | Multicast

E g
|__uopl X | 64208 1900 o000l | V|

UDP 16385 3000

Highlight target
flow

Selected Flow: Source Address 192.168.1.78, Destination Address 239.1.1.1:3000 (UDP)

oK Cancel

Click

NOTE. If you have the option 10GS installed in your system, then you will have 4
NIC in the dropdown.
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7. From the Browse for UDP flow window, highlight the target flow from
the UDP flow listing window. Clicking the selected flow and then the OK
button will copy/paste the chosen UDP flow onto the Selected Preset field
in the Select Real time interface window. Note that the parameters from

the selected flow now show in the Selected Preset field. Click OK to start
the Real-time analysis

[E¥ No File - MPEG TS Compliance Analyzer

aniysis view Navigaton Setings Capturevu™ Hep

R

B Hexvuplus™ £ Analysis

¥ Select Real-time Interface
Programs Tests SIPSI PIDs Packets e ) .
Ackons v | @ (& Stnderd

s Standard OV Region o Extensions T
.
X

Q NoPaT Using default scripts. Scripted validations are not enabled. izt

Interfaces
1

|
[E? Browse for UDP flow.

Browse Device | (0.0.0.0) Intel(R) 1211 Gigabit Network Connection (right NIC) Show fAter @
‘\Device NPF_{0DS9E689-548C-4D31-B2E2-6DACITBIAICA}
1P Address Sattings (managed by operating system)
Passive mode (no outbound traffic)
Active mode (issues and responds to ARP and other traffic)
1P Address: 0.0.0.0 (managed by operating system)
Subnet Mask: (managed by operating system) =
Default Gatenay: (managed by operating system) —-
1GMP Group Membership
‘Curr:m Group: None

Leave

Selected Flow: Source Address 192.168.1.78, Destination Address 239.1.1.1:3000 (UDP)

T

TS Avaiabiity Q|| Sync ()| 0.000000 Mbps @ 188 0| |DVB |No Extensions | [il] B

Figure 9: ‘UDP flow’ selection in ‘Browse for UDP’ flow window

w5 View Navigation Settng

B Fexvuptus™ SO Analysis
8 Select Real-time Int X I
= = [E® Select Real-time Intedface

adiors v | @ @ Standerd
— | Base Standard DVE, Region o Extensions [
Q NePAT Usng default sopts. Spted valda ¥ons are not enabled. Gz

Interfaces
Select from the avalable interfaces | 1P

Interface Settngs

Presets Selected Preset b v ©

Theoe are the setinge forthe carrently sclectnd preset = |
button.

To browse the network for 8 stream, select the Srowse...

| 3.1 NIT Actual -
[+ - Q 3.1bNIT Other

— Q 3.251 Repetiton
‘ Q 34aunmelPi0
| Co Ay Concdl v | 352501 At
S 1

75 avatabity @)/ sync Q| 0.000000 Mops @ 18] 0] (D48 o Extersons 6

Figure 10: Flow information “copied/pasted” to ‘Selected Preset’ field
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Starting analysis
To start the analysis, follow these steps:

1. After you have selected the file for analysis or set up the real time interface,
click OK to continue.

The TSCA software starts analyzing the selected stream. During deferred
analysis, a progress bar is displayed. The TSCA starts reporting analysis
results. (See Figure 11.)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser 0EX
Analysis View Navigation Settings CaptureVu™ Help

[.:] Fle)NuPIus"" yel Analvss‘

Pragrams | Tests | s1/Psi | PIDs | Packets| 3| Summary | Thumbnais | MPE Sessions|
Actions v @ [F 7

=@ Transport Stream: Id 4103, Network Name: Sandy.

@) Program 4167 (0x1047) BEC ONE ‘&0 ‘E‘e = Wmf

[} ° Program 4231 (0x1087) BBC TWO '&n Mumber of Programs 6

Current TS bit rate 24.128 Mbps
Current TS bit rate excluding Null PID 22.116 Mbps

@) Program 4351 (0x10FF) BEC CHOICE &
@) Program 4415 (0x113F) BBC NEWS 24 ‘20
[ @@ Program 4478 (0x117F) BBC TEXT 11t
@) Program 4543 (0x118F) BEC PARLMNT

- 4479 (c117F) | N
@ [BEC PARLMNT  [4543 (0x11BF) | S 0.993 0.686 0.994]
@ [NULL PID 8191 (. | 2.012] Lsﬁi 2.324)
? BBC NEWS 24 4415 (0x113F) s 5.989 5.679] 5.995
| @ sBCONE 4187 (0x1047) ] 6.096 5.790] 6.115]
|@ |pBC CHOICE 4351 (0x10FF) | IS 6.108] 5.804) 6.166
BBC TWO 4231 (0x1087) | IS 6.109] 5.805 6.169

@ L13.aPAT @ 2.3.3 PCR Repetition @ 3.2 51Repetition (17)
@ 1.4Continuity @ 2.3.b PCR Discontinuity Indicator @ 3.4.a UnrefPID
@ L5aPMT () 2.4PCR Accuracy @ 3.5.3 50T Actual (14)
@ L6PD (44) @ 25PT5 @ 3.5b SDT Other =
@ 26car @ 3.6.3EIT Actual (58)
@ 3.6.bEIT Other v
< | b3 =
75 Avaiabiity Q@|[syne @| 22 128335 bps @ 188 204 511,360 Packets| | DvB) 1o Extersions | |l 6 LY

Figure 11: TSCA window showing analysis progress

2. When sufficient data has been gathered and the display has stabilized, you can
start using the TSCA to view the analysis.

3. To restart analysis of a stream, select Analysis > Restart Analysis.

4. To analyze another stream, open the Open File Analysis dialog box or to
select another real time interface, open the Select Real time Interface dialog
box.

MTSA-HW and MTSA-PC Analyzer Applications User Manual 23



TSCA - Getting started

Setting the stream content font

Selecting the display font

24

You can configure the TSCA software to display stream content information in a
user-defined font style or language, such as Japanese or Chinese.

NOTE. How the TSCA displays the text strings carried in the stream itself is
dictated by the TSCA font setting and by the interpretation standard that is used
during the analysis.

How the TSCA displays entries in the Event Log is dictated by the TSCA font
setting and fonts used by a your local computer. For example, if the default
language of the TSCA computer is Japanese, the event log will be displayed
in Japanese characters. You must choose a suitable font for the characters to
display correctly.

Perform the following steps to set the font that will be used by the TSCA software
to display stream content. You can configure the TSCA software to display stream
content using any font that is installed on your computer.

1. Select Settings > Configuration to open the Configuration dialog box.

2. Seclect Preferences > Font in the configuration navigation tree to display the
Font pane. (See Figure 12.)

3. The dialog box lists the default font that is used by your computer for the Log
Entries and Stream Content displays in the TSCA Ul Use Font Name and
Font Size dropdown boxes to select a desired font style and size.

4. Click OK to accept and save any changes.
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¥ Configuration
Filter: | £

EI-5tream
i i-Test Parameters

Use this page to change the fonts used throughout the application. For instance, when displaying

stream content in a language different from the operating system default, select a font that

supports the language's character set. Additionally, the font sizes may be increased to provide

better readability on small screens.
More information on what each font is wsed for is displayed by hovering the mouse cursor o ver the font row.

Font Mame

Loczbe Dafzult Font

@

<<default=> Normal Tahoma
Log Entries sfefaults= Normal SansSerif
Stream Content ==adefault== Normal Sansserif
Set to Default sets all the fonts to the name shown in the Locale
Default Font column and sets the sizes to Normal. c srad
Copy Standard sets the Log Entries and Stream Content fonts
to the currently selected Standard font mname and size, Eooystandad

Click Apply to immediately see effect of new font settings.

Figure 12: Selecting a display font from the Configuration dialog box

The ARIB specifications for the ISDB standards use private extensions to the
standard Unicode character set [0xE000-OxF8FF]. These extensions allow you to
add additional characters and nonstandard proprietary characters to an existing
font. The extension sets are provided as TrueType Extension files (*.tte). Any
extension sets should be installed using the Private Character Editor, supplied as
part of the standard MS Windows installation.

Loading a custom
extension font

To install a font extension set on your computer:
1. Open the MS Windows Private Character Editor.
a. Select Run from the Start menu.
b. Enter eudcedit in the Run dialog box and click OK.
2. After the Private Character Editor opens, close the Select Code dialog box.
3. Select Font Links... from the File menu.

4. In the Font Links dialog box, select Link with Selected Fonts.

NOTE. If you select Link with All Fonts, the following actions will overwrite
any existing font extension sets.
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26

10.

11.

12.

In the Select Fonts box, find and highlight the font to which you are adding
the extension. This font should be the one you selected in the TSCA font
preferences dialog box.

After you select the font to which you are adding the extension, click Save As.

In the Modify Private Character Filename dialog box, browse to the
TrueType extension file that you are adding (*.tte) and click Save.

In the Font Links dialog box, click OK.
Close the Private Character Editor window.

To verify that the font extension has been successfully installed, open the
Character Map application.

a. Select Run from the Start menu.
b. Enter charmap in the Run dialog box and click OK.

Browse through the font list for the name of the font to which you added the
extension. The term "Private Characters" should follow the font name. When
you select the font name in the list, you can view the extended character set.

Close the Character Map application.

The new font extension you installed should now appear as a font selection in the
Configuration dialog box. You must select the new font in the Configuration
dialog box before the new font will be used to display stream content.
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TSCA - Understanding the TSCA window

On start up, you can immediately open and analyze a transport stream. (See
page 6, Starting the TSCA software.)

¥ C:\est streams\Sym3.mpg - MPEG TS Compliance Analyzer
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TENNIS
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+4 start

Figure 13: FlexVuPlus window
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The analyzer window as shown in the following figure will be displayed when
the Analyzer tab is selected.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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Figure 14: Analyzer window

TSCA top level displays
The TSCA has two top level tabs: FlexVu Plus and Analysis.

The FlexVu Plus display enables the TSCA to perform like a 4-in-1 monitor on a
single incoming stream. The display allows you to select up to four concurrent
views of a monitored stream and provides the ability to configure each of the
four views independently. Setting up and configuring the FlexVu Plus display is
described in the MTSA-HW and MTSA-PC Quick Start User Manual.

The remainder of this section describes elements in the Analyzer window.
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TSCA window components

The TSCA window contains the following components:

Menu bar  The Menu bar provides access to a selection of system options using dropdown
menus. (See page 121, Menu bar and options.)

Toolbar  The buttons displayed on the toolbar provide shortcuts to often-used menu
options. Additional buttons displayed during real time analysis are shown in
the following table:

Table 1: Toolbar icons

Deferred and Real time Analysis

@ Opens the Open Transport Stream dialog box.
: Restart lysis.
l@ Restart Lnalysis estarts analysis
@ F 4 User actions are recorded during a session. The forward and
- arwEr back buttons allow you to step through the actions in order to
|° Back review or repeat them.
Opens the Preferences dialog box from which you can set your
i Preferences preferences.
CaptureVu
View CaptureVu status.
HD Resume file analysis.
|E| Stop and capture analysis.
Real time analysis
? View record setting.
O - Arm record feature.
FIm
B Start Start recording.
B stop Stop recording.
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Progress bar  The progress bar indicates the progress of processing during deferred analysis
of a stream.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew MNavigation Settings CaptureVu™ Help

'Y L i < ® | & | p

OpenFile... | Real-time... | Standard... | Configuration... | Restart | Complet= IEEIEIEEIEEIRE 100%

To stop the analysis process, click the Stop button on the toolbar.

Navigation view The left side pane in the main window is the navigation view and provides
the main analysis information for the transport stream in a number of forms:
Programs, Tests, SI/PSI, PID, Packets and Interface. Views are selected using
the tabs at the top of the pane. The background of each view is color-coded to
aid identification.

Detail view/panes(s)  The right side pane in the main window is the detail view and provides details
related to the selection made in the current navigation view. The overall view
may be subdivided into one or more panes; you can access individual views in
multiple pane views using tabs.

Status bar  The status bar, when not hidden, is displayed at the bottom of the main window
and shows a summary of stream statistics.

T5 Awailabiity Q)| |Svnc @) | 19.392559 Mbps @ 188 | 7| |ATSC || No Extensions || Interface: 4513 | |l B

Table 2: Field descriptions, from left to right

Field Description

TS Availability Indicates either that the stream bit rate has fallen below the
minimum value or that synchronization has been lost. (See
page 30.) The minimum stream bit rate is set using the "Min
stream bit rate for processing” parameter.

(See page 97, Parameter edit.)

Sync Shows the status of the MPEG sync loss test. Loss of sync
during analysis of a stream may mean that analysis of the
complete stream was not possible.

Bit rate Total bit rate of the transport stream. The packet value (188 or
204) is set using the Preferences feature.

(See page 103, Bit rates.)

Packet Size Packets in a stream can be either 188 or 204 bytes long. This is
detected automatically.

Stream Interpretation, This is the set of tests that is being used to analyze the stream.
Base Standard
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Table 2: Field descriptions, from left to right (cont.)

Field Description
Stream Interpretation, This subset of tests modifies the base standard; it may add
Region tests or modify existing ones.
Physical Interface The current interface for real time analysis.
Partial Reception (Available only for ISDB-T streams.) This icon indicates the
- E presence of partial reception data in the stream. The colors
Availability indicate the status as follows:
Gray: Partial reception availability is unknown.
Green: Partial reception data is available.
Gray + red cross: Partial reception data is not available.
Processing Throttle This icon consists of three adjacent LED indicators which
Indicator o show the status of the TSCA processing engine. The left

indicator shows the "strained" status (whether throttling is being
applied to cut down on the information being processed). The
central indicator shows the "overwhelmed" status (whether the
processing engine is able to cope with the amount of information
in the stream even after throttling). The right indicator shows
the status of the processing of Sl tables even after throttling.
The colors indicate the status as follows:

(See page 33, Error status LEDs.)

Green: OK

Amber: Processing was strained/overwhelmed,
but is currently OK

Red: Processing is currently
strained/overwhelmed

White: Processor state is unknown

Gray: Test disabled

E Shows the status of the system log, which records system-wide

System Log Status events, for example, scripting errors. The color of the LED (in

the body of the icon) indicates the most serious event state in
the log. When the top surface of the icon is gray, it indicates

that all entries in the log have been viewed. Double-click the

icon to view the log.

Gray: The log is empty

Amber: There are entries in the log, but none
since the log was last viewed

Red: There are new entries in the log
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Analyzer window - no  If'you choose not to select and analyze a stream, the screen will appear as shown in
stream available  the following figure. The analysis structure is present, but with no stream content.

“¥ No File - MPEG TS Compliance Analys:

B Fle)(VuPIns"“ yel Analvss‘

Programs | Tests | s1/pst | PIDs | Packets| §1[ summary | Thumbnaiks | MPE Sessions|
acens v O [H 2 o=
i B
Murber of Programs ]
Current TS bit rate 0bps

Current TS bit rate exduding Null FID 0 bps

Min(Mbps) | Max(

@ 1.1Sync Q (D 3.1.aNIT Acual ~
Q 125yncByte : (D 3.1b NIT Other ]
Q L3.aPAT (D 2.3.a PCR Repetition () 3.251 Repetition
Q 1.4 Continity (O 2.3.b PCR Discontinuity Indicator Q 3.4.aUnrefPID
Q L5.aPMT (Q 2.4PCR Accuracy (D 3.5.a SOT Actual
Q L&PID Q 25FTs () 3.5b SDT Other

QD 26CAT (D 3.6.3EIT Actudl A

=3
o
3

A
&
=

}TS Availability Q| sync ()| 0000000 Mbps @ 188 0] ,D_VEHNO Extensions| |i

Figure 15: Analyzer window - no file
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Error status LEDs

Error status LEDs are used throughout the TSCA interface to represent the status
of the tests applied to associated items, such as programs, tests, and PIDs. Colors
used are as follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but has been seen
since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

¢ Le

(Light Blue) Transient warning (warning not current, but has been detected
since last reset) (Interface tab only)

(Gray): Test disabled

(White) Test not applicable or unknown state

(Red) PID referenced but not found in the stream

8% L€

(Green) PID referenced but not found in the stream. Applicable test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes), the color represents the worst case of all
of'its tests and the worst case of all of the tests represented by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.

NOTE. The color scheme described here is used throughout the TSCA interface,
for example, the bit rate bars in the navigation views.

Test management context  Tests can be disabled and enabled as required using the context menu associated
menu options ~ Wwith the LED icon. However, it is important to note that the extent of the action

depends on the hierarchical level of the icon chosen. For example, choosing
Disable from a program node context menu will disable all tests in the program

group.

NOTE. In offline file analysis, if any disabled events are reenabled at the end of
analysis, the LEDs will become green. You will have to restart the analysis to see

the status of the test when the test is enabled.
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Context menus

34

Context menus provide an important way of navigating around the TSCA
application. They are available on most displayed objects, for example, program
tree nodes. These menus provide options relevant to the selected object. For
example, after failure, all tests associated with a node can be reset, by selecting
the context menu option Reset All Tests. The context menu options provide both
actions (for example, enable and disable a function) and quick links to associated
objects in other views.

Navigation view tabs

Program | Tests || SIPPST | PID | Packets : Surnmary | Mo
= —
E & B
Nodes @ Transport Streat: 1d 4103, Metwwork Mame: Sandy H A |—|
. [=-4@) Program 4167550 ChE = Pronram
Context menu (title bar) 0 QgPID = ER Frogram 4167 BBC OHE
..... .O FiD &0 1 Reset Bit Rate Limits F

...... a PIDEDZ (0  SekGit Rate Limits. ..
""" @ P E03 L Reset Bit Rakes (all programs)
----- Q) PID E50 (1

T $&PoEs
Context menu options ————— £ s Quick Links:

----- {QPE10051 PR view PMTPID 4167 (051047 in PID kres

=

Shiove Mean VYalues

T

""" b+ ABYET \fiew this program's PRT in 51 Tree
------ PID 1007 |
..... O PMT FID 4 @ Goto mext red LED in cuprent tre:a . =] I

Figure 16: Context menu (example)

To view context menus, right-click an object. The menus are associated with node
types (for example, a PID node). Node types can be displayed in more than one
view; for example, PID nodes are displayed in the Program view and the PID
view. All context menus have a title bar that indicates the selected node.
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TSCA - Using the Program view

The Program view is displayed when the Program tab is selected in the navigation
tabbed pane. The navigation view initially displays the top node of the program
tree, which represents the analyzed transport stream from a program perspective.
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Figure 17: Program view

The detail view shows details of the node highlighted in the navigation view.
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Table 3: Program view tabs

With the tree expanded, the navigation view shows the makeup of the stream.
(See Figure 17.) The stream display consists of the nodes as shown in the
following figure.

Programm | Tests | SIS | PID || Packets
Transport stream node
=] o Transport Stream: [d 1, Metweork kame: 2 —

1=

(=] O Program 1 Adherent | =
D PMT PID 100 (0xB4) \ Program node

Q) PID 110 (0xEE) Epil

Q) PID12000x7) A

-O PID 130 (0=E521 A Elementary stream node
() Program 2 Adherent || ‘=
() Program 3 Adherent Il =n
O Program & Adherent IV 2k
() Program S Adherent ' =k

EH ®HE

Figure 18: Program view nodes

The following table shows which information is available for each node.

Summary
/
Tabs / Now IP MPE Associated Graph - Graph - Event
Node Summary  Playing Graphs Sessions  Tests Bit Rate Timing Log Parameters
Transport ~ » 4 | v - - P -
Stream
Program  ~ 4 - - 4 s - v v
Elementary - - - - I s I V <
Stream
In DVB analysis mode, the MPE tab is always present. However, the MPE view
will be populated only when MPE data is present in the stream. (See page 112,
MPE views.)
Pressing the F3 key on the keyboard (or selecting Go to the next red LED in
current tree from one of the shortcut menus) will highlight the next red LED in
the current view. Only the lowest level nodes will be considered and highlighted in
the search since the parent nodes simply reflect the state of the lowest level nodes.
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Program navigation - transport stream node

The transport stream node represents the entire transport stream in terms of the
programs that it contains. The adjacent LED icon represents the status of the entire
transport stream; any status error in the stream will be represented by this LED.
When this node is selected, the detail view displays the transport stream summary.

The associated detail view provides a program-orientated overview of the
transport stream, allowing you to see the relative data rates of all of the programs
contained within the transport. A summary of the overall stream is also displayed.
The information can be displayed as either a bar chart or as a pie chart.
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The data rate of a program is the cumulative data rate of all the PIDs that are
associated with that particular program, including PCR and ECM PIDs.

NOTE. Components can be shared between programs, so the overall data rate
of all of the programs may appear to be greater than the total data rate of the
transport stream as shown in the status bar.
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Bar chart

Pie chart

You can display the transport stream bar chart by selecting the bar chart icon.
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BBC TEXT 4475 (0x117F) | =] 0.899 0,594 0,902 3.15%
BBC PARLMNT 4543 (0x11BF) | O 0.993 0.686 0.994 3.47%
@ [NULL PID 8191 (... [ . 2,012 1.895 2,324 8, 34%
@ [EEC NEWS 24 4415 (0x113F) o H 5.989 5.679 5.996 20,96%
BBC ONE 4167 (0x1047) R 6.096 5.790 6,115 21.33%
BBC CHOICE 4351 (0x10FF) | 5.108 5.504 6. 165 21.37%
BEC TWO 2231 (0x1087) | 6.109 5,805 6, 169 21,33%)

Each program identified in the stream is allocated one row of the table. Related
information includes the overall program status (icon), the program name,
program number, and the maximum, minimum and average bit rates.

In addition to the basic display, you can associate a maximum and minimum
threshold value with each program in the bar chart. (See page 103, Bar charts.)
For deferred analysis, where these values are set after analysis, the stream must
be reanalyzed for the new values to be applied. In real time analysis, the new
values will take effect immediately. The color of the bit rate bar indicates that the
program has stayed within the bit rate limits (green) or exceeded the limits (red).

You can display the transport stream pie chart by selecting the pie chart icon.

Summary | Thumbnails | MPE Sessions |

F ®|& Tonsport Stream 104103, Network hame: Sandybestn

Mumber of Programs 6
Current TS bit rate 24,128 Mbps
Current T5 bit rate excluding Mull PID 22,116 Mbps

Programs: Current Bit Rates

va

Program Bit Rate Occupancy (Current
4167 BBC ONE  6.096 Mbps

4479 BEC TE.
4543 BEC PARLMNT  0.993 Mbps
PID 8191 2.012 Mbp=
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The pie chart view is divided into two panes. The left pane shows the pie chart,
and the legend on the right provides a list of the component programs. Each
program is color-coded. The overall program status (icon), the program name
and number, and the bit rate are also provided. The values given in the pie chart
labels are bit rates expressed as percentages of the overall bit rate. The Null PID
is shown in this view.

The color of the bit rate labels (and the bit rate values in the legend) reflects
the status of the bit rate measurement, for example, green indicates that the
program has stayed within the bit rate limits, and red indicates that the bit rate
has exceeded the limits.

Click and hold one of the pie chart segments to temporarily display an information
label. Double-click anywhere in the pie chart to toggle the display of all of the
segment labels.

Historical multiplex graph  The historical multiplex view is divided into two panes. The left pane shows
the historical multiplex graph, and the legend on the right provides a list of the
component programs. Each program is color-coded. Related information given
includes the overall program status, the program name and number.

¥ GigE - Summary | Transport Streamn: Id 1, Network Name: ADHERENT NETWORK

Mumber of Programs 5
Current TS bit rate 41.471 Mbps
Current T3 bit rate excluding Mull PID 39.195 Mbps

Last 1 minute {1 second period) Programs

[ 5(0x0005) Adherent
B 4 (Dx0004) Acherent 1Y/
W 3(0x0003) Adherent I
B 2(0x0002) Adherent I
B 1 (0x0001) Adherent |

Figure 19: Historical Multiplex Graph

The Time Period dropdown list allows you to select a range of X-axis time periods.
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Test status panes

Event log

The lower view pane allows you to see a summary of the states of all the associated
tests as well as the event log for the entire transport stream (an unfiltered event
log). The test tabs that are available will depend on the interpretation standard that
you choose. For example, with the DVB interpretation standard, the available tabs
are TR 101 209 and Other. Other interpretation standards will generate different
tabs and different sets of tests. (See page 146, TSCA — SI/PSI nodes.)

When any test in the transport stream has failed (and has not been reset), you can
identify which individual tests have failed by observing the red LEDs.

You can use the shortcut menus to reset and disable tests, to set alarms, Capture Vu
Breakpoints and record flags, and to jump to associated tests.

The Event Log screen displays the log entries as shown in the following figure
for the whole transport stream. In deferred mode, the packet generating the error
report can be inspected by highlighting the error and selecting Go to packet
from the shortcut menu. Similarly, in real time analysis mode, and where an
event concerns a PID carrying a PCR, you can use the shortcut menu to jump to
the relevant PCR graph. Deferred PCAP file analysis enables a shortcut that
allows Ethernet packets to be viewed.

@ TR 101290 (133) | @ Other | Q) sFNError | = EventLog |

Transport Stream: Id 4103, Network Name: Sandy Heath

Time w |Desoiption

. 00:00:31.778 |TR 101 280 error : mini any section repetition error (id: DVE EMM, Interval: 80ms) end, durati... |5

° 00:00:31.657 |TR 101 280 error 1.5 PID_error pid 603 [0x25k6] timeout: start ?

3 00:00:31.652 |TR 101 290 error : mini any section repetition error (ld: DVB EM, Interval: 3ms ) start 508431
0 00:00:30.800 |SDT Timer error end, duration 2017ms 454124
i 00:00:30.797 |TR 101 280 error 1.6 PID_error pid 643 [0x283] timeout: start 7

i 00:00:30.784 |SDT Timer error start 7

3 00:00:30.714 |TR 101 230 error . mini any section repetition error (id: OWVE EM, Interval: 31ms) end, durati... 492752
3 00:00:30.671 |TR 101 280 error . mini any =ection repetition error (id: 0VE EIMT, Interval: Oms ) start 452055
ﬁ 00:00:30 885 |TR 101 280 error : mini any 2ection repetition error (id: DVE EIM, Interval: 130me} end, dura... |481853
3 00:00:30.608 |TR 101 290 error 1.6 PID_error pid 603 [0x25b] timeout: end, duration 3508ms 451043
i 00:00:30.58% |TR 101 280 error 1.8 PID_error pid 623 [0x261] timeout: start ?

i 00:00:30.523 |TR 104 280 error : mini any section repetition error {ld: 0VB ET, Interval: Oms) start 438673
Q 00:00:30.164 |TR 101 280 error : minimum any section repetition error (ld: DVB EIT, Interval: 482ms) end, dura... |483915 w

Figure 20: Event log

Three buttons are available in the Error Log toolbar: (See page 99, Event log.)

Table 4: Event log buttons

Icon Description

_h / g Pin log / Log is pinned

@ Export log

X Clear log
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MTSA-PC IP Graphs  The IP graphs, where available, are as follows:
B Packet Interarrival Time (PIT): Shows the mean interarrival time of [P packets.

B PIT histogram: Shows the distribution of packet arrival intervals. The X
axis contains accumulators where interval times are collected. The Y axis
corresponds to number of intervals that collect in each accumulator. (PIT
histogram graphs are only available when analyzing PCAP files.)

B FEthernet flow rate: Bit rate of the Ethernet flow being analyzed.

The available graphs vary, depending on which IP interface option is being used.
Unavailable graph names will be grayed out in the selection menu.

| Summary |Thumbnai|5 IP Graphs | gl

AddGraphE‘.| R :}EC ZRE

Available Graphs
Packet Interarrival Time (PIT)
Ethernet Flow Rate

v
v

Add All Graphs

Remove Other Graphs
Remove All Graphs

r

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 83, Graph
management.) (See page 89, Timing graphs.)
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MTSA-HW IP Graphs

MTSA-HW hardware provides additional IP measurements beyond those
previously list with the MTSA-PC product. The additional IP measurements are
shown in the MTSA-HW IP Graphs figure:

m  Packet Interarrival Time (PIT)

= PIT Histogram

m  RTP Dropped Packet Rate
m [P Errored Packet Rate

B RTP Out Of Order Rate

Summary Thumbnais [P Graphs

Add Graph 1

Data at Cursaor

uTc

Ethernet Flow Rate

IP Errored Packet Rate

aa B B

Trend Timescale : | Previous minute

- Date/Time - Mean PIT
- RTP Dropped Packet R... - Total Flow Rate
- RTP Out of Order Rate -

42
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Program navigation - program nodes

Each of the program nodes in the transport stream represents a single program
referenced within the stream. When a program node is selected in the navigation
view, the detail pane displays the details of the program. The LED adjacent to the
program node represents the status of its child nodes (elementary streams) and
the related tests.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Navigation Settngs CaptureVu™ Help

ation... | Restart

e—T - 4 ' |
Programs | Tests | s1/pst | piDs | Packets [ summary | Thumbraiss | @ Program Tests | Bitrate Graphs|
Acions v | @ [F[F

=@ Transport Stream: Id 4103, Network Name: Sandy

R Y coram 167 (0xna) oo O =4 E % [escone
(@ PID 600 (0x258) 'En D Program number = 4167 (0x1047)

@ P 601 (0x259) A
88 PD 602 (0x254) A
@ P 603 (0x258) =
(@) PID 850 (0x284) {31

Service Provider = BBC
Service Type = 1 (0x 1) (digital television service)

- §8 PID 851 (0x288) ¥ I

g oes: Eﬂfgg: [ The Sound Of Music 13:25 - 16:10 UTC

? 5 (0x3ED)

L 98 v 100 (ot [T 55c News 16:10 - 16:25 UTC

- §8 PID 1007 (0x3EF) 353 pu s @ P 600 {0x258)

=@ PUT PD 4167 (0x1047) B
@ Program 4231 (0x1087) BBC TWO 'Eh

a
5]
[l

\
@) Program 4351 (0x10FF) BBC CHOICE &0 e PEG-2 Video) in7 o 1 (e
& @ Program 4415 (0x113F) BBC NEWS 24 "3 Q601 (0x259) 1%03) (MPEG-1 Audio) 0.037 0 2 (0x2)
- @ Program £479 (0x117F) B8C TexT i [§8 502 (0x258) %03) (MPEG-1 Audia) 0.000 [] 5 (06,
@ Program 542 (x118F) BBC PARLINT A || ||yt e ey 02) (PES privaie data) T = s o
Q 650 (0x284) x0B) (DSM-CC U-N messages] 0.03 0| 101(xs5
[$8 651 (0xz88) XOB) (DSM-CC U-N messages 0.000 0| 102 (0xe8)
[§8 852 (0x280) %0B) (DSM-CC U-N messages 0.000 0| 103 (0x67)
[ 1005 [ox3ED) 1x0B) (DSM-CC U-N messages 0.130 0 110 (0x68)
[$8 1005 (px3EE) x0E) (DSM-CC U-N messages, 0.000 0 111(0x6F)
[$8 1007 (ox3EF) x0B) (DSM-CC U-N messages, 0.030 0| 1:2(xm)
@ 4167 (0x1047) 0.250 0

< | >

[ 1 I =
TS Avaiability @)||Sync QJ\F 24,128335 Mbps @ 188|204 511,360 Packets| | DVB | |No Extensions| [l B

The program detail view provides you with an overview of the selected program,
allowing you to see the relative data rates and stream types of all of the PIDs that
are associated with the program (including PCR and ECM PIDs). If the program
contains an MPEG2, H.264, H.265 (HEVC), or JPEG2000 video stream, it is
decoded to produce a thumbnail picture of the content; this is updated during real
time analysis. Similarly, where EPG information is associated with the program, a
summary (Now and Next program) is displayed. PID content is indicated using
icons. (See page 80, Icons.) Bar chart and pie chart views are available.
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VLC Media Player

PID related information is available under the Summary tab.

The Thumbnails tab displays thumbnails and details of the streams for each of the
programs (where available). (See page 95, Thumbnail views.)

The Program Tests tab shows tests related to the program. Similarly, the Bit rate
Graphs tab displays the program bit rate in graph form.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 97, Parameter edit.)

The Event Log shows the errors for the highlighted test. When no tests are
selected, the event log will show the events related to all tests associated with the
elementary stream selected in the program tree.

The VLC Media Player is a portable multimedia player for various audio and
video formats. The player allows program content displayed in the TSCA
thumbnails to be played in a larger window. The media player is automatically
accessed from the TSCA when you choose to view or listen to the video and audio
content of program streams.

NOTE. The VLC Media Player is not installed as part of the MTSA system.
Installation of the player is described in the MTSA-HW and MTSA-PC Quick
Start User Manual (Tektronix part number: 071-3661-00). You can find full
documentation of VLC on the Videolan Web site, http.//www.videolan.org.

To start the media player, click the start button (below the thumbnail) in the
Program Summary view.

% H® @ PID 600 (0x258)

The VLC Media Player opens and the selected program content (video and/or
audio) plays. To close the player, click the stop button (below the thumbnail).

NOTE. The VLC Media Player may open behind the TSCA window. Use the
Windows controls to bring it forward.
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Elementary stream
analysis

The elementary streams in the selected program can be examined in more detail
using the MTS4EA HEVC/AVC Video and Compressed Audio Analyzer. Select
the ES icon below each thumbnail picture.

Pl % @ PID 600 (0x258)

Program navigation - elementary stream node

Each of the elementary stream nodes in the program tree represents a single
elementary stream referenced by the parent program. When this node is selected,
the view pane displays the Elementary Stream summary view.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

Analysis View Navigation Settings CaptureVu™ Help

oy
B Fle)(\fuPIus"“ o) Analvss‘

Programs | Tests| SI/PSI| PIDs | Packets

1| o
>| @ Associated Tests | Timing Graphs | Bit rate Graphs

Actions ¥

9 ==

=@ Transport Stream: id 4103, Network Name: Sandy
=@ Program 4167 (0x1047) BBC ONE ‘&R

@ P 500 (0x258) ' ® =

@ PD 601 (0x259) A
88 D602 (0x254) A
+@ P 603 (0x258) =)
+(@) PID 850 (0x284) 13
- §8 PD 851 (028
88 P 652 (0c28C)
@ PID 1005 (0x3ED) 1Bt
88 PID 1006 (0x3EE)
88 pD 1007 (0x3EF) i1

() 1.4 Cantinuity

@ TERD

() 2.3.a PCR Repetition

(@ 2.3.b PCR Discontinuity Indicator
(D 2.4PCR Accuracy

Q 2.5°TS

Q 3.4.aUnrefPID

@ PID Occupancy

=@ PUT PD 4167 (0x1047) B
@ Program 4231 (0x1087) BBC TWO 'Eh
@ Program 4351 (0x10FF) BBC CHOICE '
+- @) Program 4415 (0x113F) BBC NEWS 24 ‘&0

(D PCR Overall Jitter (PCR_OT)

() PCR Frequency Offset (PCR_FO)
() PCR Drift Rate (PCR_DR)

() PID Eit Rate Variability

@ Program 4479 (0x117F) BBC TEXT 181 (Q Discantinuity
@ Program 4543 (0x11BF) BBC PARLMNT /3 =
—j EventLog |
1.6 PID PID 603 (0x258) R
Shov fiter @)
00:00:31.887 _[TR 101 280 error 1.6 PID_error pid 603 [0x25b] timeout: start ~
Q| 00:00:30.608 [TR 101290 error 1.6 PID_error pid 602 [0x25b] timeout: end, duration 3908ms
|@ | 00:00:27.89 (TR 101290 error 1.6 PID_error pid 603 [0x25b] timeout: start
[Q | 00:00:35.508_[TR 101 280 error 1.6 PID_error pid 603 [0x25b] timeout: end, duration 3808ms -
@[ 00:00:23598 (TR 101280 error 1.6 PID_error pid 603 [0x25b] timeout: start
'@ 00:00:22608 [T 101280 error 1.6 PID_error pid 603 [0x25b] fimeout: end, duration 3808ms
'@ | 00:00:19698 (TR 101290 ervor 1.6 PID_error pid 803 [0x25b] timeout: start
Q| 00:00:18.658 [TR 101 290 error 1.6 PD_error pid 603 [0x25b] tineout: end, duration 2059ms v
< | >

TS Avaisbiity )| |Sync @)|| 24.128335 Mbps @ 188|| 204 | 511,360 Packets | DVB || Mo Extensions| | [l
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When you hold the cursor over the elementary stream node, a tooltip provides the
stream type and description.

o Transport Strearmn: 1d 4103, Network Mame: Sandy Hes

Program 4167 BBC OMNE ‘e o) e iy

% 1.4 Cankin

b
$& rD AO2 (k258 A ftream type: 2 (0Or02) (MPEG-2 ¥ideo)
0 PID 503 (0% 2580 (=) PID carries a PCR
{Q PID 650 (0x284) 181¢ @ 23bPkR
$% P 551 (0x286) 1G4l (D 24PCRA
$¢ FiD 552 (0xzEC) 11 @ 25FTS
LN B 1A e el 34,8 e

An LED associated with each elementary stream node indicates the status of the
tests relating to the elementary stream.

When the selected elementary stream PID contains timing information, PCR
trend analysis views are also available, allowing you to display graphs of PCR
accuracy and PCR interval data. When the transport stream contains timestamps
data, the PCR overall jitter, PCR frequency offset, PCR arrival time, and PCR
drift rate graphs are also available.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 83, Graph
management.) (See page 89, Timing graphs.)
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@ |P - MPEG TS Compliance Analyser EEX]
File Mavigation Settings CaptureVu™ Record Help

B (@) restartanalysis | (QYack @ romad | B preferences P [a) @ |FURE @ am Bt W St

Program | Tests | sypst | Po | packets| || @ ssocisted Tests | Tiving Graphs | Bit rate Graphs|

Graph:
- Transpert Strean 1d 20, etwork Hame: TEK BEE ) AEEE B
Program 1 TEKT &1 Data at Cursor
PMT PID 4125 (0x1020) B

uTC 1,146,577,020,502,2... Date/Time 02/05/06 14.5200.502 0. Jitter
@ BT 7 e Inaccuracy - PCRArrival Interval 287 Drift
L@ PD 413 (0x1025) A Freq Offset - PTS Arrival Interval 267

8l I Ii'

5 fuvailability Q”Syn( °HB|t rate 0.221271 Mbps @ léB”Pa(k&t Size | ISE‘ |DVBHN0 Extensmns”]nterFate‘ P (RTP/UDP)‘

Figure 21: PCR Graphs view
The Associated Tests tab shows tests related to the elementary stream node.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 97, Parameter edit.)

Similarly, the Event Log shows the errors for the highlighted test. When no tests
are selected, the event log will show the events related to all tests associated with
the elementary stream that is selected in the program tree.
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TSCA - Using the Tests view

48

The Tests view displays test information that is relevant to the transport stream
being analyzed. The view is displayed when the Tests tab is selected in the
Navigation tabbed pane. (See Figure 22.)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettngs CaptureVu™ Help

= FIexNuPIus"" pA'ﬁNSE|

[ Programs | Tests | spst | PIDs | Packets|
Adions ¥ | show: i ¥ @ | W B

@ TR 101290 (133) | @ Other | O SFNError|

=@ * Priority 1 (44)
- E @ TR0 290 (133) @ L1Sync @ 2.1Transport 1.
g E::;:: ; o @ L28yncByte @ 2.2cRe (D 3.1b NIT Other
: @ Prioriy 3 (39) @ 13aPaT (@ 2.3.2 FCR Repetition @ 3.251 Repetition (17)
) @ other @ 1.4 Continuity @ 2.3.b PCR Discontinuity Indicator @ 3.4.aUnref PID
! @ sFNEmor @ L5aPMT (D 2.4PCR Accuracy (@ 3.5.2SDT Actual (14)
@ nformational Events. @ 167D (+4) 8 2.5FTS g 3.5b SDT Other
2.6CAT 3,6.3 EIT Actual (56)
@ 3.6.bEIT Other
@ 3.6.CEITPF
@ 3.7RsT
@ 38707

Test Fallures | < Event Log

@ NIT Actual Max Section Reptn Int (1) @ SDT Actual Timer (14)
@ NIT Actual Max Subtable Reptn Int (1)

@ 50T Actual Max Section Reptn Int (2)

@ 5DT Actual Max Subtable Reptn Int (2)

@ SDT Other Max Subtable Repin Int ()

@ EIT Actual PF Max Subtasle Reptn Int (6)

@ EIT Actual PF Min Any Section Reptn Int (56

|T5 Avallabiity QHSync Q” 24.128335 Mbps @ 188 ‘zm“ 511,360 Packets| | Dva| No Extensions | \:-:75‘

Figure 22: Tests Navigation view
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The view displays a test tree, which represents all tests that have been applied to
the analyzed transport stream. The following figure shows the nodes available

in the navigation view.

Program | Tests | SUPSI| PID || Packets

= oIEN
= @ TR101 280
i Friority 1
= ) Friority 2
Q) 2.1 Tranzport <
Q) 22CRC
Q) 2.3 a PCR Repstition
) 2.3 b PCR Discortinuity Indicstor
Q) 2.4 PCR dccuracy
= Q25PTS
D FID 210 (0x02) -—————————
) PID 220 (0xDC)
D PID 310 (0x138)
O PID 410 (0x194)
) PID 510 (0x1FE)
2 @ 25caT
Q25 CAT(Table D) <————
@ 25 CAT (Serambling)
() CAT man subtable Rl
0 Priority 3
QD Other =
() SFM Error

Figure 23: Test view nodes
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Test structure

50

The test tree structure represents all of the tests that can be applied to a transport
stream complying with a particular digital video standard: MPEG, DVB, ATSC,
and ISDB. The standard must be selected before beginning analysis. The test tree
contains nodes for each test that the analyzer can implement.

An example of a tree structure for a selected standard is the TR 101 290 group of
tests for DVB transport streams. (See Figure 23.) The Group node is split into
priority groups: First Priority, Second Priority, and Third Priority. Each of these
priority groups contains a number of individual tests.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettngs CaptureVu™ Help

@ TR 101290 (133) | @ Other | O SFN Error

*  Priority 1(44) # Priority 2

* Priority 3 (89)

@ Friority 1 (44)
Q Priority 2

@ L15ync @ 2.1Transport
@ 1.2SyncByte @ 2.2cRC

@ 26CaAT

(@ 3.1.aNIT Actual (2)
() 3.1b NIT Other

5@ Priorty 3 (89) @ 13aPaT (@ 2.3.2 FCR Repetition @ 3.251 Repetition (17)
@ 1.4 Continuity @ 2.3.b PCR Discontinuity Indicator @ 3.4.aUnref PID
@ 1.5aPMT (D 2.4PCR Accuracy (@ 3.5.2SDT Actual (14)
@ L5Pm (49 @ 2.5FTs (@ 3.50 SDT Other

@ 3.6.3EIT Actual (56)

@ 3.6.bEIT Other
@ 3.6.CEITPF
@ 3.7RsT

@ 38107

Test Failres | -4 EventLog

Faited within the
@ L6FID (44)

@ NIT Actual Max Section Reptn Int (1)

@ NIT Actual Max Subtable Reptn Int (1)

@ 50T Actual Max Section Reptn Int (2)

@ 5DT Actual Max Subtable Reptn Int (2)

@ SDT Other Max Subtable Repin Int ()

@ EIT Actual PF Max Subtasle Reptn Int (6)
@ EIT Actual PF Min Any Section Reptn Int (56

SDT Actual Timer (14)

|75 avaiabilty @ |sync || 24.128335 Mbps @ 188] | 204|511, 360 Packets | | DB o Extensions| | [l

Test grouping differs between digital video standards. However, all of the
currently implemented standards contain a subset of relevant TR 101 290 tests.
Note that in standards other than DVB, the tests are not numbered.

Where relevant, PIDs will be associated with a test in the test tree when the test
has either been disabled, or when it has failed.

The LED associated with each node indicates the status of the node and its child
node tests. (See page 33, Error status LEDs.) Total entries in the Event Log for
each group of tests and for each test are indicated in parenthesis; resetting a group
of tests or a test restarts the count in parenthesis.
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Test filtering  Interpreting the display of tests can be made easier using the three filter buttons at
the top of the Tests navigation view:

show: D ¥ @ | ¥ [ E

Grey White Green

Figure 24: Test filtering buttons

When a button is selected, it hides a category of tests in the test tree display, as
follows:

B Grey - hides disabled tests
B White - hides tests with unknown or not applicable status

®  Green - hides tests with OK status
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Tests navigation - all tests

The detail view when the All Tests node is selected. (See Figure 22.) In addition
to a summary of all tests, the event log shows the most recent 10000 events that
have occurred during analysis of the stream.

TeSt Failu res VieW @' C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser (=11}

Analysis View MNavigaton Setngs CaptureVu™ Help

Programs | Tests | sypst | PIDs | Packets|
Acbors ¥ | Shov: W ) W@ 9 [ D

@ ™ 101290 (133) ‘ @ other | Q) SFNEror

@ L15ync @ 2.1Transport @ 3.1.a NIT Actual (2)
@ 125yncByte @ 2.2cre (D 3.1b NIT Other

@ 13.aPaT @ 2.3.2 PCR Repetition @ 3.25IRepetition (17)
@ 1.4 Continuity

TR 101290 (123
@ Priorty 1 (44)
Priority 2

@ Priority 3 (89)

& @ otner @ 2.3.b PCR Discontinuity Indicator @ 3.4.2 UnrefPID
i é Q 5N Error @ 15apMT (Q 2.4PCR Acauracy @ 2.5.2 DT Actual (14)
@ informational Events. @ 167D (29 Q@ 25°Ts @ 3.50 SDT Other

Q@ 25caT @ 3.5. EIT Actual (56)
(@ 3.6.b EIT Other

@ 3.6.cETPF

@ 3.7RsT

@ 3.8TDT

:|| TestFaiures | —ja EventLog

Failed within the Last uy Failed o last update (2)
@ 15PD (39) @ NIT Actual Tmer (2)

@ NIT Actual Max Section Reptn Int (1) @ SDT Actual Timer (14)
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Figure 25: Test Failures screen

The Test Failures view provides an overview of the tests that have failed during
stream analysis. The view is divided into two panes. The left panes shows those
tests that have failed in the last second. The right pane shows those tests that have
failed, not including those that have failed in the last second, and are displayed on
the left side.

If a test fails, it will be displayed on the left side. When it no longer fails, it will be
removed from the left side and listed on the right side as a test that has previously
failed. If the test fails again, it will be removed from the left side and redisplayed
on the right side until it no longer fails.

Additionally, tests that have been listed (in either pane) in the last second are
displayed at the top of the list and shaded.
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Test navigation - test nodes

When you select a test node, the Associated PIDs pane displays a summary of
all of the PIDs and an event log listing all events that are associated with the
test. Where parameters are applicable to the test, you can modify them under
the Parameters tab.

reams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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Test navigation - PID nodes

Where tests have failed, the PIDs affected are listed under the test node in the Tests
navigation view. Selecting a PID will display the Event Log in the detail view.
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Edit Parameters...
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¥ Edit Parameters...

1.6 PID
The parameters for this test are listed below

3

Units Min Nominal Max

Set Al to Nominal H OK H Cancel

|T5 Avallabiity QHSync Q” 24.128335 Mbps @ 188 ‘zm“ 511,360 Packets | DVBH No Extensions | ‘E,@‘

NOTE. The screenshot also shows the Edit Parameters dialog box, which is
available from the PID node context menu. (See page 97, Parameter edit.)
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TSCA - Using the Tables view

The Tables view (SI/PSI tab) displays service information in tree form, as in the
other navigation views. The tree represents the service information tables that
have occurred in the analyzed stream and which comply with the selected digital
video standard. This includes MPEG program specific information, DVB service
information, ATSC and ISDB program information, and system information
protocol. The tree contains nodes for each table that is found; tables/nodes are
grouped together by functionality. The following figure shows an example of the
Table navigation view with DVB stream interpretation selected.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

Analysic View Mavigation Settings Captureyu™ Help

?
Open Fil tandard.. quration... | Restart

E FIexVuPIus““ pAnalvss|
Programs | Tests| SUPSI | PIDs | Packets

R Export...

B Jretic:
=-@R Programs (PATIPITISDT actual) Tables

PAT
=88 PuTs * Programs (PAT/PMT/SDT actual)
i (B PT Program 4167 (BBC ONE) * Networks (NITs)
Dot = PIT Program 4231 (BEC TWO) « Time (TDT/TOT)
PMT Program 4351 (BBC CHOICE) S TR AT

B PuT Program 4415 (BBC NEWS 24) * EPG (EIT/SDT/RST)
B PT Program 4479 (BBC TEXT)
i (B PNT Program 4543 (BBC PARLMNT)
" B8 50T actual
= & nstworks (NTs)
{8 This network (NIT actual)
(-8 Time (TDTITOT)
= £ EPG (EMSDTRST)
=& This Transport Stream (SDT/EM actual)
B8 SDT actual
=+B) Service 4167 (BBC ONE) (EIT actual)

B HowiNext (ET actual pif)
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£ Network 9018, Transport Stream 8184
g Network 9018, Transport Stream 12290
{89 Network 9013, Transport Stream 18334
{59 Network 3018, Transport Stream 20430
{5 Network 018, Transport Stream 24576
£ ~UETs (ungrouped)
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|75 avaiabity @ |Sync @) 24.128335 Mbps @ 188|204 511,360 Packets | va| o Extensions| | [l

Figure 26: Tables view

Every node within the service information tree has a corresponding summary
view. Nodes that represent tables will also provide you with access to the table
structure and hex data. (See page 57, Tables detail view - Section view.) (See
page 59, Tables detail view - SI repetition graphs.)

Some of the nodes that represent less common tables or table groups may not
have specific summary views available in the analyzer. In these cases, a generic
summary view is used.
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Table summary pane

56

EPG views

The table summary view provides a summary of the table related information for
the analyzed transport stream. There is a table summary view for every node of
the service information. The content is dictated by the selected node.

All summary views for nodes that represent an individual table or subtable

will display the table identity and version number of the table from which the
information is extracted. Where relevant, links (underlined text) are provided to
associated objects, for example, in the programs summary, links are provided to
the individual program summary views. Similarly, arrow icons provide links to
the electronic program guide (EPG) tables. (See Figure 27.) Where the section is
carried on a PID, a link is also provided to the PID view.

The following shows an example of the summary pane with the PMT PIDs node
selected in the navigation view.
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Figure 27: Tables view - Programs (example)

A specific departure from the Table Summary view described previously is the
EPG view that is displayed when a section of the EPG table is highlighted. For
a description of the general presentation of the EPG view. (See page 108, EPG
view.)
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Tables detail view - Section view

The detailed section view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. During real
time analysis, the view is continually updated.

The subtable identity, version, and section are displayed at the top of the table
pane.

NOTE. In deferred mode, where two or more subtables, versions or sections are
found in the stream, the relevant field is active, and an alternative selection can be
made from the dropdown list.

In real time mode, only the latest version and section can be viewed.
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The table pane shows all fields that make up a section (for example, PMT). The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. The container
can be expanded or collapsed by clicking the + or - icon.
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Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected table, version, and section. When a node is selected in the table pane,
the bytes that make up the selected node (including the subordinate nodes) are
highlighted in the hexadecimal data pane as shown in the following figure.
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Figure 28: Section payload

If the section is corrupt or empty, the hexadecimal view background is red instead

of blue.

The pause button in the detail window title bar allows real time section data to be
paused (or frozen), so that it can be examined in detail. The play button resumes
the real time display of section data.
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Tables detail view - Sl repetition graphs

The section graph view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. You can
view graphs of the following data:

m  Section repetition interval: This graph displays the interval between two
sections of a table on a particular PID.

m  Subtable intersection gap: This graph displays the interval between sections
in a particular subtable.

B Subtable repetition interval: This graph displays the time between receiving
one complete subtable and receiving the next complete subtable.

NOTE. Not all of the above graph types are relevant to all table types. (See
page 83, Graph management.)

Export SI/PSI as XML

The export control in the top left corner of the SI/PSI navigation pane opens the
Export SI/PSI as XML dialog box. Enter an output file name (and path) and
select the required options.

¥ Export SI/PSI as XML

Output File

|c: \temp\test, xmi| |@

Options

Indude 51 tree structure Incude subtable information

Labest version only [] Include section data

& File 'c:\temp\test, xml' already exists and will be overvwritten,

0K l [ Cancel
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TSCA - Using the PID view

60

The PID view displays information about all of the PIDs found in the transport
stream being analyzed. The navigation view contains the PID tree structure
representing all of the PIDs that have occurred within the transport stream.
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In DVB analysis mode, the MPE tab is always present. However, the MPE view
will only be populated when MPE data is present in the stream. (See page 112,
MPE views.)
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PID view - all PIDs

In the navigation view, PIDs are grouped under the following subordinate nodes:
B Reserved PIDs

m  Referenced PIDs

®  Unreferenced PIDs

®m  SI/PSI PIDs

m  User PIDs

B Obsolete PIDs (deferred analysis only)

The number of PIDs in each group is shown adjacent to the node. The root node
label shows the total number of PIDs found and the Network Name.

When highlighted, the All PIDs node displays in the detail pane all of the PIDs
that are found in the analyzed stream.

Each of these subordinate nodes contains PIDs belonging to that group. PIDs are
allocated during analysis, and the number of PIDs is identified for each node. You
can also allocate PID numbers to the User PID node, although User PIDs may not
necessarily have been found in the stream. This feature allows you to compare the
properties of one or more PIDs more easily.

The associated summary view provides a PID-oriented overview of the transport
stream, allowing you to see the relative data rates of all of the PIDs contained
within the transport stream. The information can be displayed as either a bar chart,
or as a pie chart. Columns in the summary views can be sorted in ascending or
descending order by clicking on the column header. PID related information is
available under the PID Information tab.

Each PID is associated with a number of tests. If one or more tests fail, they will
be listed under the relevant PID node in the navigation view. Selecting the PID
node will display a summary, in the detail view, of all associated tests that have
been found. Selecting a specific test in the Associated Tests pane will display the
Event Log and Parameters for only that test.
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PID view - detail view (All PID and PID Group)

62

The All PID and PID Group detail view provides you with a PID-oriented
overview of the transport stream. This view is displayed when any of the
main nodes is selected in the navigation pane: All PIDs, Referenced PIDs,
Unreferenced PIDs, or User PIDs.

The view shows the relative data rates of all of the PIDs contained within the
selected node. You can display the information in either a bar chart or a pie
format. The associated test states are shown in all views.
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Figure 29: PID Summary view

The PID Information view provides PID related information, for example, PID
type stream type, scrambled status and the presence of PCRs. Layer information
is also shown when analyzing ISDB streams. (See Figure 30.) The icons provide
an indication of the PID content. (See page 80, Icons.)

Where a PID carries video or audio, thumbnails are displayed under the Now
Playing tab.
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In deferred mode (or during CaptureVu analysis), you can view the packets
carrying a PID by highlighting the PID, and selecting the Go To Packets view from
the shortcut menu. The packet will be added to the PIDs list (in the Packets view).
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Figure 30: PID Information view

PID view - detail view (PIDs)

The individual PID detail view provides you with information about the selected
PID. This view will be visible when you select an individual PID node in the
PID tree. If a PID has failed a test, one or more test nodes are displayed as child
nodes of the PID.

The combination and detail of the views vary depending on the selected PID
type and node.

During deferred or captured analysis, the packets carrying the PID can be
examined in more detail by highlighting a PID, and selecting the Go to Packets
view from the shortcut menu.
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Ordinary PID selected

PCR PID selected

64

When a PID does not contain PCRs, the main view in the PID pane is the
Associated Tests view. This view lists the tests associated with the selected PID.
The status of the individual tests is indicated with LED icons. Also available are
Bit rate Graphs, which show the bit rate of the selected PID in graphical form.

Also on the Associated Tests tab is an event log and a parameters pane. The
event log shows all PID related events. If a test is selected in the PID pane, only
the events associated with that test on that PID are shown. Similarly, when a
test is selected, the Parameters pane shows the parameters associated with that
test (when applicable).

When the selected PID contains PCR information, PCR inaccuracy and PCR
interval data graphs will be displayed in addition to a bit rate graph. When the
transport stream contains time stamped data, the PCR overall jitter, the PCR
frequency offset, and the PCR drift rate graphs will also be available. For real
time IP analysis, the Packet Interval Timing (PIT) graph is also available. (See
page 92, PIT graph.)
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A Presentation Time Stamp (PTS) graph may also be available on PIDs carrying
audio and video information. And a PTS-PCR graph showing the variation
between the PTS and PCR values; this can help detect buffering issues.

(See page 83, Graph management.) (See page 89, Timing graphs.)
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TSCA - Using the Packets view

NOTE. The Packets view is available only during deferred analysis and CaptureVu
analysis.

Data in the stream is carried in 188- or 204-byte packets. The Packets view allows
you to examine the contents of each packet in the analyzed stream.
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The packet navigation view shows a tree structure which represents the packets
within a stream grouped according to content, including PID value, SFN
mega-initialization packets (MIPs) (DVB only), and ISDB-T information packets
(IIPs).

The All Packets, MIP and IIP nodes do not have any child nodes. The All Packets
node represents all of the packets in the transport stream. The MIP node represents
all of the DVB SFN MIPs in the transport stream. The IIP node represents all of
the ISDB-T information packets in the transport stream.

The PIDs node represents all of the PIDs that are of interest. You can add PIDs
in the transport stream to this node, and to PIDs that are contained within the
user PID list.
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Packet navigation bar

66

Selecting any leaf node in the packet tree will apply a packet filter to the associated
packets. For example, selecting a PID node will only allow packets carrying

that particular PID to be displayed in the associated summary view. Similarly,
selecting the MIP node will only allow MIP information to be displayed in the
associated summary view.

Double-clicking the Custom Packet Search node opens a dialog box in which
you can specify strings to search for.

In the packet summary view, you can use the top bar to navigate the packets
in the stream.

Current packet position

The navigation bar functionality depends on the selection in the packet navigation
view. If you select All Packets, the controls will operate on all packets. If you
select a single PID, a filter is in operation, and the controls will work only for
those packets carrying that PID.

Selects the first available packet (in the stream or carrying the
selected PID)

Selects the previous available packet (in the stream or carrying
the selected PID)

Selects the next available packet (in the stream or carrying the
selected PID)

Selects the last available packet (in the stream or carrying the
selected PID)

Opens the Go To Packet dialog box

o) (=] (]| o =]

You can also use the packet position bar to navigate through the stream. To do so,
use the cursor to point to and click the next packet to be displayed. Double-click
the packet number in the bar to open the Go To Packet dialog box. Enter the
required packet number and select OK. For both methods, remember that the
destination packet is dependent on the node selected in the navigation view.
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Packet navigation - filter nodes

The packet filters allow you to view packets carrying PID.

To inspect the sequence of packets carrying a particular PID, you must add the PID
to the PID Filters node in the Packet Navigation view. PIDs carrying sections can
also be viewed. You can add as many PIDs as are required. There are a number of
ways to add a PID to the node, as described in the following paragraphs.

—

Adding a PID in the Packet
view

In the Packet view, expand the PIDs node by doing one of the following:
= Double-click the child node (double-click to add a PID).
= Select Add PID... from the PIDs node shortcut menu.

2. Inthe Add PID... dialog box, expand the nodes, locate and select the required
PID.

3. Click OK.
ttings up the

The selected PID is added to the PIDs node, and the first occurrence of a packet
carrying the selected PID is displayed in the summary view.

Added PIDs will be stored when the application is closed. They will be reinstated
when the application is reopened. However, if a different stream is analyzed, the
stored PIDs may not be used.

Removing PIDs  All PIDs previously added to the PID node can be removed by selecting Remove
All from the PIDs node shortcut menu.
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Packet Detail view

68

The detail view shows the fields and data that are contained in a packet. The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. To expand or
collapse the container, click the + or - icon.

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected packet. When you select a node in the table pane, the bytes that make
up the selected node (including the subordinate nodes) are highlighted in the
hexadecimal data pane.
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The packet transport header bytes are displayed in red. Similarly, bytes greater
than 188 are displayed in gray. The adaptation field, where present, is displayed
in blue.

If the section is corrupted or empty, the background of the hex view is red instead
of blue.
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ISDB streams  The following figure shows an example of the packet detail view with an analyzed
ISDB-T stream. Note the IIP tab and the additional TMCC and IIP nodes.
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Figure 31: Packet view - ISDB detail -IIP
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TSCA - Using the Interface view

If real time analysis using an interface card is invoked, the Interface tab is
displayed in the Navigation view of the TSCA window.

NOTE. The Interface view is available only if an interface card is selected for
real time analysis.

Analysis View Navigation Setings Capture¥u™ Record Help

P HexvuPlus™| £ Analysis
[ rograns [ Tests [ s [ pioe [ Paceets | nterface
actons w | show: @ ¥ @ | ¥ @ E)

=@ iterface Errors.

@ BER (Pre Recd-Solomon/BCH)
Q Power
@ Fhase Noise.
Qonr
Q) Interface Warnings
@ WER Warning
@ BVl Warming
Q) BER (Pre Reed-Solomon/BCH) Warning
Q@ rowerwarning
@ Phase Noise Warning

{* JciR Warning

5 valabitty @) sync @[ 35.576577Mbps @ 153|185 |08 o Extensions| | nterface: DVB-52 Pk > Ast-2|

=L UES

Figure 32: Interface view - example

Two interface card test nodes are displayed in the navigation view: Interface Errors
and Interface Warnings. Each collection contains a range of tests. (See Figure 32.)

The detail of the interface view is different for each interface type.

70 MTSA-HW and MTSA-PC Analyzer Applications User Manual



TSCA — Using the Interface view

Detail view tabs

The detail view contains two tabs: Graphs and Interface Event Log. This section
describes the tabs in general terms. The following sections describe in detail the
tabs associated with each interface type.

Graphs  The Graphs tab contains instantaneous graphs and trend graphs.

The instantaneous graphs display instantaneous measurements in graphical form.
The trend graphs display trends in measurements in graphical form.

Interface event log  The interface event log displays a history of the events related to the item selected
in the navigation view.

Readings and controls

The right panel contains Readings and Controls. The Readings area displays
values received from the card itself.

The RF Lock LED conveys different types of information. If full lock onto the
channel is acquired and it is receiving the signal correctly, the LED will light up
green. When a signal is present but no lock is achieved, the indicator is red. When
no signal is found, the indicator is gray.

In the Readings area, the LED colors are as follows:

Green On
Red Out of range or failed test
Gray Off or not applicable

The Readings background colors are as follows:

White In range

Red Out of range; for example, too much or too little power or out of
order packets per second being greater than zero

Yellow Not recently updated

Gray Not applicable; for example, out of order packets not being

available when the UDP protocol is selected

The Controls area contains user controls. Values entered here will be applied to
the card and will affect its performance. These controls correspond exactly with
those on the Open Transport Stream dialog box.
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SDR RF interface views

This section describes the settings and displays associated with the SDR interface
cards.

RF interface -  The settings and displays of the SDR interface card for QAM-B: QAM (B)
QAM (Annex B) Interface Settings, QAM (B) Instantaneous Graphs, and QAM (B) Trend Graphs.
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Q Interface Warnings
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Figure 33: ‘SDR Interface for QAM Annex B’
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E\I QAM-B - MPEG TS5 Compliance Analyzer

Editing the QAM-B Interface Settings window. Start by selecting the Real-time

icon. The Select Real-time Interface window appears. Enter your desired

parameters and click OK.
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ﬂ Edit Interface Settings

Interface Settings
Presets Selected Preset
These are the settings for the currently selected preset.

Value @

While running the Real-time Interface, select Edit to change the RF parameters.

X
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The following QAM (Annex B) settings are available on the Transport Stream -
Real Time Analysis dialog box, and also in the Interface tab - Controls area:
Tuner Frequency, Modulation format, and Symbol rate.

Table 5: QAM(B) Settings:
Field

Description

Tuner Frequency (kHz)

This value, set in kHz units, is the center frequency of the channel to
be received. Any frequency can be entered. There is no need to follow
a channel plan.

Modulation Type

This drop down list allows 64 QAM or 256 QAM operation to be selected.
Note that SCTEQ7 and ITU-Tj83 annex B specify exact symbol rates for

the two modulation formats, so there is no dialog box to enter the symbol
rate separately.

Symbol Rate

Add or select it based on the modulation type. E.g. 64—QAM uses
5,056,941; 256-QAM uses 5,360,537

QAM(B) - RF Constellation
Instantaneous
graphs

I and Q data are collected from the QAM front end and displayed as a
conventional constellation. The samples collected are not real time, so
there is some dwell (delay) before a complete constellation is displayed.
The persistence of the display can be varied using the tool icon in the upper
right corner of the graph.

MER (Modulation Error Ratio) calculations are performed on the
constellation data according to the formulas in TR 101 290.

Trend Graphs (minute, 10 minutes, hour, day, or
week)

The trend graphs extend the principle of the instantaneous graphs by
graphing measurements over longer periods.

Each graph is associated with a measurement that is also displayed in the
Readings panel on the right side of the display. The measurements have
status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the
dropdown menu of the Add graph icon.

The following trend graphs are available for the QAM B interface card:
= RF Lock

= MER

B Pre-RS BER

E  [nput Level

®  Carrier Offset
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Table 6: QAM(B) Readings:

Item Description

Signal characteristics RF Frequency Selected RF frequency
Symbol Rate Selected Symbol Rate
Modulation Standard Selected Modulation Standard
Modulation Format Selected Modulation Format

Signal measurements Input Power Measured power in dBm
MER Measured MER in dB
Carrier Offset From selected frequency
Pre RS BER Measured Pre RS BER
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10 Gb/s NIC interface = The optional 10 Gb/s interface card provides dual SFP+ short wavelength optical
port with LC connector for 10 Gb Ethernet interface. The 10 Gb/s interface is
selected via the IP Device Name from the Real time IP interface dialog screen.

9 select Real-time Interface x
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Intel(R) Ethernet Server Adapter X520-2
[\Device\NPF_{F4BE3E63-D623-42A7-B09A-80AA24727050}]
Intel(R) Ethernet Connection (2) 1219-LM (left NIC)
[\Device\NPF_{30113005-E 1E3-465E-BE02-E543F9D 7800E}]

X fals=
Join IGMP version 2 multicast
MNeon-source-specific multicast

& [=

=y ] ==

NOTE. For the 10 Gb/s NIC interface, the IP device name to select is
Intel (R) Ethernet Server Adapter X520-2.
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DS2 Interface = The DS2 option provides L-Band support for DVB-S and DVB-S2 signals. The

menu below allows you to enter the L-Band signal (from 950 MHz to 2150 MHz),

or you can provide the LNB/LO frequency and then type in the IF number
(C-Band or Ku Band).

Graphs  —jd Interface Event Log

Trend Timescale @ | Previous minute

e

E‘I Select Real-time Interface

Standard

Base Standard DVE, Region No E i
Using default scripts. Scripted validations are not enabled.

Interfaces

Select from the available interfaces

This channel supports analysis of QPSK and 8PSK modulation modes.
Please use port 1 for 16APSK32APSK signal.

‘Warning : Changing modulation modes to unsupported modes will cause unreliable results,

Interface Settings
Presets Selected Preset

Default These are the settings for the currently selected preset.
Field

4bps@1sa| |No Extensions | Interface: DvB-52 (ort-2) | | [l &
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TSCA - Common user interface concepts

78

Many user interface concepts are used throughout the analyzer. The following
common elements are described in this section:

Windows management

Icons

Graph management

Timing graphs

Bit Rate graphs

PIT graph

Now Playing views

Parameter edit

Event logs
Bit rates
EPG view
MPE views

CaptureVu features

Triggered recording

Menu bar and options

Preferences

Script files
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Windows management

NOTE. For basic Windows operations, such as minimizing windows or using the
scroll bars, refer to the MS Windows documentation.

In addition to the standard windows management methods, the following controls
are added which allow the windows panes to be resized.

Horizontal and vertical = Horizontal and vertical control icons are placed between adjacent panes. Clicking
controls  on an icon will expand the adjacent pane in the direction shown by the icon.

:51,

AW
@ R et hlk[

Figure 34: Window size adjustments

The size of panes can also be controlled by placing the cursor over the horizontal
or vertical dividing bar so that it changes to a bidirectional arrow. The dividing
bar can then be dragged to the required position as shown in the following figure.

4
Pragram | Tests | SIPSI | PID | Packets k| Sumtaty | MPE Sessions
= a Tranzport Stream: Id 1, Netwwork Mame: |F |ﬁ Transport Stream: Id 1, Nei
() Program 1 Adherert | 'S L
® () Program 2 Adherent Il 425 - hluirrber
® () Program 3 Adnerert Il = Adherent | L
(D Program & Adherert 1V 0 O Adherent I 2
O Program 5 adherert W 2w O Adherent Nl 3
@  Adnerently 4
Q) Adherenty 3
O MULL PIC 8191 (0x...
4
Program | Tests || SWPS! || PID | Packets b| Summary | MPE Sessions
= i Transpart Stream: 1d 1, Metwork Marme: ADHEREMT NETWORK |E|$ Transport !

0 Frogram 1 Adherent | =e

Q) Procrarn 2 Adherert | = -I

(O Frocrain 3 Adherert Il i A8 Q@ Adherert |

(O Program 4 Adherent v n Q Adherert I 2

Q) Program & Acherent ¥ ‘G Q Adnerert I 3
Q) Adnerert v 4
Q) Adherert v 5

Q) MULL PID &191 C...
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Icons

80

Table manipulation

The following activities are available for data displayed in tabular form:

B Click a column header label to sort the section in ascending or descending

order

B Drag a column header label divider bar to adjust the column width

Select Resize All Columns to Fit from the context menu to adjust all columns

to fit the available display width

B Columns can be hidden or shown by selecting them in the header label
context menu

Icons are used in the TSCA to convey information about a node or function.

In this section, the icons used in the TSCA and the icons used in the quick link
section of context menus are described. (See Table 7.) (See Table 8.) (See

Table 9.)

NOTE. The display of all icons is context-dependent. Not all icons will be visible

in all views.

Table 7: Object identification icons

Icon

Description

Application Information Table (MHP)

Audio

Conditional Access PID

Data stream

& 0|2 |f| B

Packet

PCR

Program
=)= Programs
)

Sl table
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Table 7: Object identification icons (cont.)

Icon Description

{} Sl table container

= Sl tables

a Stream scrambled

= Subtitles

@ Teletext

_ Video

'E"; Video + audio

BOH Closed caption - CC-EIA608

18 Closed caption - CC-EIA708

Table 8: Interface management icons

Icon Description

Open transport stream

View CaptureVu settings

Capture analysis

B B e e & WG| o] &

Bar chart

Pie chart

Stacked graph chart
Link to

Preferences

Audible alarm

CaptureVu breakpoint
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Table 8: Interface management icons (cont.)

Icon Description

Graph management

BT Graph selection

@, Zoom in

@, Zoom out

Nz Show full dataset

| Hide/show limits

£ Hide/show settling time indicators
= Rotate graph view
Packet management

b Remove all PID packets
M Remove PID packet
]Ifﬁ Add PID packet

=5 PID packet group

P PID packet placeholder

Go to first packet

Go to previous packet

Go to next packet

Open Go To Packet dialog box

<
>
Go to last packet

Action control

= Go to previous view
lo Eack

Ia F— Go to next view
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Table 9: Quick link icons

Icon

Description

Go to next red LED in current tree

View this PID in PID tree

View packets with this PID

View packets in Packet tree

View PCR graphs

View this program's PMT in Sl tree

View this test in Tests tree

Graph management

A number of screens displaying graphs are available in the analyzer. The graphs
are described in the relevant sections of this manual. This section describes the
management of the graphs user interface.

Four categories of graph are available: PCR measurements, section timing, bit
rates, and PTS (Presentation Time Stamps).

PCR measurement graphs include:

PCR Drift

PCR Inaccuracy

PCR Arrival Interval
PCR Frequency Offset
PCR Overall Jitter
PTS - PCR Variation
DTS - PCR Variation

PTS interval graphs include:

PTS value interval

PTS arrival interval
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Measurement background

84

Section timing graphs include:

®  Section Repetition Interval

B Subtable Inter Section Gap

m  Subtable Repetition Interval

For streams received over IP, the PIT (packet interarrival time) graph is available.

The graphs that can be displayed depend on the selection made in the navigation
view. However, the menus and options for the graphs are similar and as described
in the following pages.

Measurement points (2048 maximum) are held in a circular buffer.

NOTE. A circular buffer is an area of memory used to store a continuous stream
of data by starting again at the beginning of the buffer after reaching the end.

A graph set for full display will show the current measurement points. During
real time analysis, the graph is constantly being filled (from the right to left), and
measurements moving off the left side of the display are lost. The time scale
(Y-axis) is started from zero each time that the node is accessed.

For some of the graphs, sufficient data must be gathered before meaningful results
can be displayed. The phrase "Settling Time" will be displayed briefly in the
graph area while the necessary data is gathered.
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Overview  The following figure shows a typical timing graph display. In this example, a
PID carrying PCR has been selected, and two graphs are displayed: PTS Arrival
Interval and PCR Arrival Interval.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysic View Mavigation Settings Captureyu™ Help

[*3 i / ® 0
Open File... | Rea-time... Configuration... | Restart | Complers ISEISEIRIIEN 100%

B FlexNuPIus"'[ pA"ﬂVS'E|

Programs | Tests || SI/PSL || PIDs || Packets| N

actons v | & [F D)

=@ Transport Stream: Id 4103, Network Namé | (| addGraph B} & & = B 4 | @&
=@ Program 4167 (0x1047) BBC ONE ‘&5 ot

() PID 80D (0x258) 'en )

Q@ rpen 10x253) A Inaccuracy - PCR Arrival Interval - PTS Arrival Interval 94

-8 Pooznesa) A PTS-PCR Variation 315

@ PD 603 idx258) =

- PD 850 0x284) Wi

- §8 P 821 i0x23B) i3

88 PD 852 02

(@ PID 1005 (0x3ED)

- §8 PID 1006 (0x3EE)

- §8 PID 1007 (0x3EF)

@) PMT PD 4167 (0x1047) B3

@ Program £231 (0x1087) BEC TWO '&

@ Program 4351 (0x10FF) BBC CHOICE| |-

Program 4415 (0x113F) BEC NEWS

£ @ Program 4479 (0x117F} BBC TEXT i

@ Program £543 (0x11BF) BEC PARLMY |©

TS Pkt 161,981 UTC 10,096,880 Date/Time 0:00:10.097

T Il

|T5 Availsbility QHSWC Q” 24.123335 Mbps @ 188 \ \2u4|| 511,360 Pad(ets‘ ‘DVE” No Exnensmnsl i &

Figure 35: Timing graphs

Within the category, the X axis is common to all graphs. A horizontal scroll
bar allows you to select an area for inspection when the graph extends beyond
the display area.

Cursor data and control A cursor can be displayed on the graphs, allowing you to see accurate
measurements in the adjacent data panel. You can place the cursor by clicking
any data point on one of the graphs. Note that the cursor is displayed at the same
point on all of the visible graphs. (See Figure 35.)

The cursor can be moved either by clicking a new position on the graph, or one
point at a time by using the left or right controls on the keyboard. When you
select a point, a tooltip provides the X and Y coordinates of the point; the values
of these will vary depending on the graph.

Data associated with the selected point is displayed in the statistics panel (above
the graphs). The displayed values (maximum, minimum, mean and standard
deviation) are calculated for all of the data that is received while the navigator
node is highlighted.

Similarly, data for all graphs is displayed in the Data at Cursor panel. A link to the
associated packet is provided in the context menu.
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Graph menu and toolbar ~ The Graph Toolbar allows you to select and control the available graphs. (See
Figure 36.) The graphs listed will depend on the interface in use.

Timing Graphs ﬂ Bit rate
E—k @ =ED B

5 vailable Graphs

i l'_-_‘Ls

v PCR Overall Jitker D:
x| PCR Inaccuracy P
9| o PCR Arrival Inkerval P

PR, Drift

T PCR Frequency OFFset B
=  PTS Arrival Interval B
=
E=
= + Packet Interarrival Time (PIT)
]
E Add all Graphs
a P E

Figure 36: Graph toolbar

At the left end of the toolbar, a dropdown menu allows you to select which
graphs are to be displayed. Only graphs for which data is available are listed.
(See page 89, Timing graphs.)

The remaining graph controls are as follows:

Icon Description

&, Zoom in

a, Zoom out

Nz Return graphs to full scale display (All graphs can be returned
to full display by double-clicking anywhere in the graph display
area.)

| Hide/show out-of-range indicators

£ Hide/show settling time

=y Rotate graph layout
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The graph context menu can be displayed by right-clicking anywhere in a graph
display area. The options on the menu are applicable to only the graph from
which the menu was selected.

PID 600 (Dx258): PTS Arrival Interval

B add/Remove Graph PCR Crverall Jikker
B Show Limits PCR Inaccuracy
PCR Arrival Inkeryal
H .
PCR Dwift
&, zoam In PCR Frequency Offset
9, Zoom Cut v PT3 Arrival Inkerval
iz add All Graphs |
Quick Links: CLALRERL A UL LLLTERA L | |
IR view Packet 310,311 in Packets Tree
)P 10T 0 P01 OO A 1 O

Figure 37: Graph context menu

The title bar displayed at the top of the menu shows which object the graph
applies to (for example, PID 600).

Adding and removing  Graphs can be added by selecting them from the context menu or from the
graphs  dropdown menu either in the toolbar or from the top right corner of any displayed
graph. All graphs can be opened by selecting Add All Graphs from the same
menu. Each graph type can only be displayed once.

Graphs can be removed by clearing them from the context menu or by clicking the
close icon in the top right corner of the graph to be closed.

Out of range indicators ~ Each graphed measurement has limits set by default (derived from the stream
interpretation standard) or that you modify. (See page 97, Parameter edit.)

Limits imposed by the test parameters can be displayed on a graph by clicking the
Out of Range indicator icon. (See Figure 38.) In this example, the PTS Arrival
Interval has been set at 700 ms. The area outside the limits is shaded (red). The Y
axis is rescaled to show the maximum and minimum data points.

Settling time ~ Some of the graphs in the TSCA require a number of samples to be available
before meaningful results can be displayed. The period during which sufficient
samples are being gathered is referred to as the settling time. During this settling
time, the graph is grayed out and displays the phrase "Settling Time".

Zoom feature  You can zoom graphs in and out using the controls on the menu bar or from the
Graph Menu. An area of a graph can also be expanded by holding the right mouse
button and dragging a rectangle around the area of interest.
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Zooming (in or out) is centered on the middle point of the graph, irrespective

of the cursor position. Both axes are expanded/contracted to accommodate the
revised display. The graph is expanded or contracted by 25% of the displayed area
each time that the control is used. Double-clicking on a graph rescales the axes
to show the complete plotted data set.

If you hold the shift key while you click the zoom control, the Y axis is locked
while the X axis is expanded or contracted.

If you hold the control key while you click the zoom control, the X axis locked
while the Y axis is expanded or contracted.

During real time analysis, expanding (zooming in) an area of a graph generates a
static snapshot of the graph. Because of the way that the measurements are stored
in the circular buffer, the display will eventually clear. The only way to redisplay
the graph is to return to full scale display.

(D Associated Tests | Timing Graphs | Bit rate Graphs|

R e e W EO D

Data at Cursor

Quick Links v

Packet
0. Jitter

how the aut of range indicators,

The minirum and maximunn limits For the displaved graph e 0:00:07 715

lare showen, The limits can be changed using the Parameters diglog,[ival Inte... >
5 FET —FIS R

Drift

TTival Inte... 100

Figure 38: Out of range indicator

88

va

(D Assoriated Tests | Timing Graphs | Bit rate Graphs|

urephz E a a '_}B: %E =il Quick Links | v
Dataat ol Hide the out of range indicators|

Packet 12377z OTC 7.715.122 Date/Time 0:00:07 715
0. Jitter - Inaccuracy - PCR Arrival Inte... -
Drift - Freq Offset - PTS Arrival Inte... 100
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Timing graphs

PCR Inaccuracy (PCR_AC)

PCR Arrival Interval

The following table shows the timing graphs that are available for PIDs carrying
PCRs. If a PCR PID is also carrying time stamp information, the full set of graphs
will be available. (See page 83, Graph management.)

Table 10: Timing measurement graphs

Graph Type PID + PCR PID + PCR + Timestamps
PCR Inaccuracy V I
PCR Arrival Interval V vV
PCR Drift Rate I
PCR Frequency Offset I
PCR Overall Jitter I

Descriptions follow of each of the measurements. Adjustments can be made to
each of the measurement parameters.

If the interval exceeds the limits displayed on the screen, the scale is adjusted
automatically as necessary to include the maximum displayed values.

NOTE. As with other parameter value adjustments, it is important to note where
the adjustment is being made from. If the adjustment is made with a test node
highlighted, all PIDs will be measured against that value. If the adjustment is
made with a PID highlighted, only that PID will be measured against the modified
value.

The PCR Inaccuracy graph shows the difference between the actual and expected
values for each PCR on the Y-axis. Expected PCR values are calculated from the
byte index of the PCR.

The default limits are set to £500 ns.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR accuracy error.

The PCR Arrival Interval graph provides a display of the time interval between
successive PCRs, during the last 256 PCRs. The interval is displayed on the
Y-axis. The default limit (Maximum Repetition Period set in TR 101 290 test
2.3) is 40 ms.

The PCR Maximum Repetition Interval limit can be adjusted by modifying the
PCR max repetition interval.
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PCR Drift Rate (PCR_DR)

90

PCR frequency Offset
(PCR_FO)

PCR Overall Jitter
(PCR_0J)

PTS and DTS graphs

This Drift Rate graph shows the rate of change of PCR Frequency Offset, which is
often very small. It is calculated using PCR Frequency Offset measurements.

The maximum PCR Drift Rate limit can be adjusted by modifying the Max PCR
frequency drift rate parameter.

The Frequency Offset graph shows the difference between the program clock
frequency and the nominal clock frequency (measured against a reference that is
not PCR or transport stream derived).

PCR Frequency Offset is a measurement of the error in the PCR frequency from
the specified 27 MHz; the MPEG specification sets the limits at+=810 Hz.

The Maximum PCR Frequency Offset limit can be adjusted by modifying the
"Max PCR frequency offset" parameter.

The PCR Overall Jitter graph shows the time interval between the actual value of
the PCR and its expected value based on its arrival time.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR overall jitter parameter.

Decode Time Stamps (DTS) and Presentation Time Stamps (PTS) indicate the
exact moment at which a video or audio frame has to be decoded or presented
to the user. The values of these time stamps are references to the program time
base, as indicated by the program’s associated PCR.

The decoding and presentation times for a frame will be different if the frames are
not transmitted in the order that they should be presented, that is, in video streams.
In streams which are not reordered, for example, audio streams, the PTS and
DTS values for a frame are identical.

The following PTS/DTS graphs are available for non-encrypted elementary
streams carrying PTS data:

PTS Value Interval. The PTS Value Interval graph plots the difference in value
between each PTS and the prior PTS. The time stamp value difference is displayed
in terms of time.

PTS Arrival Interval. The PTS Arrival Interval graph shows the difference in
arrival time between each PTS and the prior PTS.

PTS-PCR Variation. The PTS-PCR Variation graph plots the difference between
each PTS value and the value of the program time base at the moment the PTS
arrived. The program time base value at that point is interpolated from the
associated PCR values. The measurement is displayed in terms of time, and gives
an indication of how long after receiving the frame the decoder must wait before
presenting it to the user.
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DTS-PCR Variation. The DTS-PCR Variation graph shows the difference between
each DTS value and the value of the program time base at the moment the DTS
arrived. The program time base value is calculated in the same way as for the
PTS-PCR Variation graph. For video streams this graph is likely to differ from the
PTS-PCR graph, but for non-reordered streams it will display the same values.

The PTS-PCR and DTS-PCR graphs can be useful for detecting encoder timing
issues that are likely to cause receiver T-STD problems.

PTS processing for PES ~ The default behavior of the TSCA is to perform PTS, and DTS, where applicable,
Private stream types =~ measurements on audio and video PIDs. For PES Private (stream type 6) PIDs,
these measurements are only carried out for PIDs that are recognized as carrying
subtitle/closed caption information.

A parameter has been added that can override this automatic detection of
PES Private PIDs. The behavior can be changed for all PIDs by opening the
configuration dialog: Settings > Configuration... > Test Parameters. Locate
and set the parameter Process PTS for PES Private streams.

m  Set the value to 0 to select the default automatic behavior.
PIDs with stream type 6 will be processed only for PTS/DTS measurements if
the TSCA recognizes them as carrying subtitles and/or teletext.

B Set the value to 1 to force the TSCA to perform PTS/DTS measurements for
all PIDs with stream type 6.

®  Set the value to 2 to disable the PTS/DTS measurements for those PIDs with
stream type 6.

This parameter can also be adjusted for a specific PID. Highlight the required PID
in the PID view, and select Edit Parameters from the 2.5 PTS context menu in
the Associated Tests tab. This method affects the behavior of the selected PID
only, and will only take effect if the PID is marked as stream type 6 in a PMT.
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Bit rate graphs

Bit rate graphs are available on program and PID nodes. (See page 83, Graph
management.)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser =1

Analysic View Mavigation Settings Captureyu™

B Flexvuplus™ pA"ﬂWS'E|

Programs | Tests | SI/PSI || PIDs | Packets N (@ Associated Tests | Tming Graphs BltralﬁGraphs'
actons | @ (4] [ &
=@ Transport Stream: id 4103, Network Nam addeaph D} & & HEHE 2
=) Program 4167 (0x1047) BBC ONE &5 ot
PID 800 (0x258) Em
PID 601 (0x259)
PID 602 (0x254)
PID 603 (0x258) (=
PID 650 (0x284) 1511
PID 851 (0x28f
PID 652 (028
PID 1005 (0x3ED)

uTC 15,400,028 Date/Time 0:00:16.400 Bit rate

PID 1006 (0X3EE)
PID 1007 (0x3EF) 193¢ 164, 4933.12
@) PMT PD 4167 (0x1047) B3 .
@ Program 4231 (01087} BBC TWO = i

@ Program 4351 (0x10FF) BBC CHOICE|

@ Program 4415 (0x113F) BEC NEWS 2|
£ @ Program 4479 (0x117F) BBC TEXT
@ Program £543 (0x11BF) BBC PARLM

|TS Availsbility QHSWC Q” 24.123335 Mbps @ 188 ‘ ‘zm” 511,360 Pad(ets‘ ‘ DVE”Nn Exnensmnsl Liil=]

Figure 39: Bit rate graph

PIT graph

The PIT Graph displays the mean interarrival time of IP packets. This can be
viewed from the Transport Stream node in the Program view. It can also be
viewed alongside other timing graphs for PIDs with PTS, DTS, and/or PCR
information. This can help you coordinate apparent problems with PCR, PTS,
and DTS timing with IP packet timing.
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RTP Loss distribution graph

The RTP Loss distribution graph is available when analyzing transport streams
carried using RTP in real time, using the internal NIC or in file based analysis
(PCAP). The graph shows the distribution of RTP packet losses by plotting
loss duration (the number of consecutive packets lost) against loss distance (the
distance between one block of lost packets and the previous block). The color
of each point represents the count of occurrences of losses with a particular loss
duration and distance.

To access the graph while analyzing an RTP stream, select the transport stream
node in the Programs tree, and select the RTP Losses tab in the detail view.
Note that any losses that occur outside of the range of the graph are captured and
displayed in aggregate form at the top and on the right side of the graph. The
limits can be changed by selecting the Edit Parameters... button.
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The Edit Parameters dialog box allows you to alter the loss duration and loss
distance values which will increase or decrease the X and Y axis ranges.

@ Edit Parameters...

RTP Loss Distribution
The parameters for this test are listed below

RTP lass distribution rmax loss distance axis (100 Intzger... 1 100 1000000
RTP lass distribution max loss duration axis |10 [teger..| 1| 100 | 1000000

& Analysis has completed. Parameter changes will only take effect when analysis is restarted,

[ Set all to Mominal ][ oK H Cancel ]
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Thumbnail views

The Thumbnails tab displays video content at the transport stream and program
node levels. Icons at the top right of the now playing screen provide three levels
of detail and layout of the thumbnails: Thumbnails only, Brief Details, and Full
Summary. The following figures in this section illustrate the level of detail
provided by each icon.

The content of each program node can be viewed in more detail by clicking
the play button. This assumes that a suitable player application is installed, for
example, VLC Media Player.

In file analysis mode only, the program node content can be further analyzed
using the MTS4EA Video and Compressed Audio Analyzer (ESA). Select the ES
button to open the analyzer. The ES button will be hidden if either of the ESA
applications is not detected when the TSCA starts.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Navigation Settngs Captursyu™ Help

Az

ard... | Configuration...

Adionsy | & {2

Programs | Tests || sy/pst | PIDs || Packets 3 Summary | Thumbnals | MPE Sessions
[Test Padeets| | Summary | [ 14PE Sessions |

(=@ Transport Stream: Id 4103, Network Han| Enable Thumbnails Display Format: ‘ ‘ (=] =1
-4@) Program 4167 (0x1047) BBC ONE ' b, §
4@ Program 4231 (01087} BBC TWO ' - + BECTWO Only
-4@) Program 4351 (0x10FF) BBC CHON
@ Program 4415 (0x113F) BBC NEWS
-4@) Program 4479 (0x117F) BBC TEXT §
) Program 4543 (0x118F) BBC PARLH

75 Avalabilty @||sync @ | 29.128335 Mops @ 188 204] 511,360 Packets ‘DVB ‘NDExmsmr\s‘ ‘E

Figure 40: Thumbnail view - Thumbnail view
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@ C:\Streams\BEC1AUG27.mpg - MPEG TS Compliance Analyser

Apalysis Men Navigaion Settngs Caoturelu™ Hep
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& Q@ Program 4415 [@x1126)
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Re
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Figure 41: Now Playing - Summary view

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Navigation Settings CaptursMu™ Help

Open Fie... nfiguration

8 FlexvuPius™ | 42 Analysis

Programs | Tests | SI/PSI | PIDs | Packets 3| Summary | Thumbrais | pe Sessions
ackorsw | & [ [E

=@ Transport Stream: id 4103, Network Nat Enable Thumbnails
@ Program 4167 (0x1047) BEC ONE '&
@ Program 4231 (0x1087) BEC TWO '5 .
@ Program 4351 (0X10FF} BEC CHOIC

Program 4415 (0x113F) BBC NEWS
@ Program 4479 (0x117F) BBC TEXT |
@ Program 4543 (0x115F) BBC PARLM

Program 4167 (0x1047) BBC ONE Summary |

Stream type Now

The Sound Of Music
Video Attributes 16:10 UTC)

ontal Size: 720
rtical Sze

BBC News (
P EE e u

* Program 4231 (0x1087) BBC TWO

Stream type Now

Ready Steady Cock
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Figure 42: Now Playing - Detail view
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Parameter edit

Each of the error states displayed on the user interface are the result of making one
or more measurements or tests on the analyzed transport stream. The displayed
tests are derived from the selected interpretation standard. Additional proprietary
tests are also included.

Some measurements and tests translate directly to an error state, and others are the
result of a combination of tests. For many of the tests, you can affect the result
by varying parameters that influence the test result, for example, maximum and
minimum bit rate values, although the test result may not then conform to the
chosen interpretation standard.

The Edit Parameters window is available from test and PID context menus. The
following figure shows the parameters that are available for the TR 101 290 test
2.5. The PID test parameters dialog box shows the subset of parameters that
are available for a single PID under TR 101 290 test 2.5. (See Figure 44.) Not
all parameters applied to a test are necessarily applied to a PID, and not all test
have configurable parameters.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Mavigation Settings CaptureVu™ Help

| FIe*KVuPIus"“ £ Analysis

Programs | Tests | sPsI | PIDs | Packets N

Acions » | Showi ) W W@ W 3 =

=@ Stream Tests (134)

R 101290 (133)
@ Priority 1 (44)

riority 2

@ 2.1 Transport @ P> 601 (0x259)
@ 22CRC @ PID 602 (0x254)
@ 2.3.a PCR Repetiion Q PD 610 (0x252)
@ 2.3.b PCR Discontinuity Indicator Q PD 611 (0x253)
(D 2.4 PCR Accuracy Q P 612 (0x254)

PID 621 (0%26D)
Edit Parameters... PHEZR RN
=@ Other (1)
() SFN Error
@ Informational Events

Reset
Diszble
Enable

@ Edit Parameters..._ 3]

25PTS
The parameters for this test are listed below
Feld @

Value @D Units Min Nominal Mz
Disable All Tests
Enable All Tests

Audible Alarm -
CaptureVu™ Breakpoint o
Clear All Trigger Actions ] |Ho log entries were found
I [Bobgenines werelowe
& | 3

|75 Avaiiabiity @ [sync @|| 24.128335 Mbps @ 188 204 511,350 Packets| | DvB| | o Extensions, [ﬁ ﬁ]

Figure 43: Test parameters
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& C:\Streams\BBC1AUG27. mpg - MPEG TS Compliance Analyser [[=1 3]
Analysis View Davigstion Settings Captureyu™ Help

B FIexNuPIus"" £ Analys

| Programs | Tests | s1/pst | PIDs || Packets| : Associated PIDs

=@ Stream Tests (134)
=@ TR101280 (133) _
@ Priorty 1(44) chided in ths test
=@ Priority 2 @ PID 600 (0x258)

Actions ¥ | Show: i o @ | % [ 5

. @ 21 Transport @ PID 601 (0%259)
© ~@22cRC
@ 2 3.2 PCR Repetition @ P 610 (0x:

2 3.b PCR Discontinuity Indicator Q PID 611 (0x25;

2.4 PCR Accuracy @ PID 612 (Ox26:

~ @ 25FTS @ PID 620 (D26 dit Paramete

& @ 26 CAT @ PID 621 (Dx2el .
) PID 622 (Ox26t
® l;.mjf'&’f’ e 8PID 240 (2 — | The parameters for ths testare listed below
(D SFNErmor @ FID 641 (0x28
700 ms 100 700 5000
@ Informational Events : Q) PID 660 (0x23
Set Al to Nominal ] [ oK ] [ Cancel ]

Y ', View PID 602 (0x254) in PID Tree
—ja Event Log |

|= % »

e r@
H to log entries were found

& | B

|T5 Aavallabiity QHsync Q” 24.128335 Mbps @ 188 ‘zm“ 511,350 Packets| ‘ DVBH No Extensions | ‘E,g‘

Figure 44: PID test parameters

Each test parameter entry includes the following fields:

Description of the parameter.

Value - the current setting. If the setting is the same as the nominal value, an
icon will also be displayed in this field.

Units in which the measurement is made.

Maximum and minimum values. These are the maximum and minimum
values recommended by the selected standard.

Nominal value. This is the value or setting recommended by the selected
interpretation standard.

It is important to understand the difference between default and nominal values.
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If a parameter value is set for a test, it becomes the default value for the test and
for all PIDs subject to that test. PIDs using the default value will have a bullet
icon displayed in the Value field as shown in the following figure.

Figure 45: Parameter value - default icon

However, you can also set individual PID parameter values. The value set is
applied to only that PID, not to the other PIDs using the same test or the test
default value.

The nominal value is provided by the interpretation standard; it cannot be changed
using the user interface.

Changing a test parameter ~ To change the value of a test parameter:
value 4 Click in the Value field.
2. Enter the required value.

3. Press Enter.

NOTE. For a new value to take effect during offline analysis, the stream must be
closed. Select Restart Analysis to open and reanalyze the stream.

Access to all parameters  (See page 122, Configuration.)

Event log

The event log displays a history of events related to a selected item. When no log
is available, the message "No log entries were found" is displayed. In a log, events
are placed in chronological order (with the most recent at the top).

Event log displays are context-dependent; the view and object that is currently
selected will dictate the content of the associated log. For example, with the
transport stream node selected in the Programs navigation view, the associated
event log displays all events. Similarly, with a single PID selected, the associated
event log only displays events relevant to that PID. Exported logs are similarly
context-dependent; only currently displayed events are exported.
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Event log control

Event log pinning

Exporting the event log

The event log normally displays the most recent event at the top of the log. Past
events are scrolled down the screen; not all of these event entries can be viewed
on a single screen, even in a maximized Log view window.

If events are constantly being generated, an event entry may pass out of view
before you have a chance to examine it.

However, if you scroll down to view a past event, the viewing window will
remain fixed on that entry, even though events entries are still being added at the
top of the log view. This is evidenced by the scroll box continuing to advance
toward the bottom of the screen.

The event entry being viewed will eventually move to the bottom of the event log.
At this point the entry will be lost, the view will return to the most recent entries
at the top of the screen, and automatic scrolling will restart.

Another way of viewing a single event in a stream of log events is by pinning the

log. By pinning the log, you are taking a snapshot of the log at a particular moment
in time; you can move up and down the pinned log as required. Newly generated

events continue to be generated, but are not displayed until the log is unpinned.

You can pin the log by selecting the Pin icon or Pin Log from the context menu.

_Fi Shows that the log is not pinned
Select to pin the log
3 Shows that the log is pinned

Select to unpin the log

When the log is pinned, it displays against a blue background and the pin icon
changes.

Pinning the log may take a few seconds. The whole log is saved, up to 10000
entries.

The log will remain pinned until you select the Pin icon or display another TSCA
view.

You can export the log (pinned or unpinned) in either XML or CSV format.

You can export the log by selecting the Export icon or Export Log from the
context menu.

o

Select the format in which the log file is to be saved, either .xm/ or .csv, and
a location for the file.
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Clearing the event log

Color-coding events

MTSA-HW and MTSA-PC Analyzer Applications User Manual

You can clear all events from the event log by selecting the X icon or Clear Log

from the context menu.

Specific event types can be color-coded in the display to allow them to be

identified more easily as shown in the following figure. Color-coding can be

done from any event log display. The color-coding dialog box is available from
the event log context menu.

@ R 101 290 @ other | () SFNError | Evert Log |

28-Feb-2005

14:42:49.754 14607547

TR 101 280 error 2.5 (PTS_errar)

L ion
: Tirner pid 220 end, durstion 48ms

@  25-Feb-2005

14:42:48736 14606523

TRAM 290 error 2.5 (PTS _errar)

- Tirner pic 220 =tart

PRFeh. 2005

12QFR2IAF

TR AM 290 arrar 2 S (PTS arear -

Tireer il S0 start

. 28-Feb-2005 12084738 TRAM 290 error 2.5 (PTS_error) : Tirmer pid 310 end, duration 40ms
' 28-Feb-2005 12968636 TR 101 290 error 2.5 (PTS_errar) : Timer pid 310 start

. 28-Feb-2005 12966569 TR 101 280 error 2.5 (PTS_errar) : Timer pid 410 end, durstion 40ms
' 28-Feb-2005 12086204 TRAM 290 error 2.5 (PTS_error) : Tirmer pid 210 end, duration 40ms
' 28-Feb-2005 12965466 TR 101 280 errar 2.5 (PTS_errar) : Timer pid 410 start

. 28-Feb-2005 12965192 TR 101 280 errar 2.5 (PTS_errar) : Timer pid 210 start

0 28-Feb-2005 12063399 TR0 290 error 2.5 (PTS_error) @ Titner pid 510 end, durstion 40ms
o

<

Figure 46: Event log - color coding

1. Highlight the event type and select Color from the context menu as shown in
the following figure. The following figure shows the Color dialog box.

| @ TR 101 280 (248) | @ Other | () 5PN Errorl — Event Log |

TR 101 290 error 1.6 PID_error pid 603 [0:250] timeout: st

S05431

TR 101 230 error : minimum any =ection repetition error (ld:

494124 SOT Timer error end, durstion 201 ¥ms

TR A0 280 error 1.6 PID_error pid 643 [0x253] timeout: st
- 0T Timer error start
492752 TR 101 290 error : minimum any section repetition error (id:
492035

—4 PinLog

L — —

eset Colour
Reset All Colours

A M

TR 101 230 error : minimum any =ection repetition error (ld:

T AN T m i s i

T

Quick Links:

DK Wiew Packet 509,815 in Packets Tree

Figure 47: Event log - context menu - color
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Figure 48: Event log - color dialog boxes

2. Select the primary display color.

The color can be specified from the Swatches tab. It can also be specified
in HSB (Hue, Saturation, Brightness) or RGB (Red, Green, Blue) terms by
selecting the appropriate tab and entering the required values.

3. Select OK. All events of the same type are now highlighted in the selected
color.

The color-coding on a single event type can be removed by selecting Reset Color
from the Event Log context menu. Color-coding can be removed from all event
types by selecting Reset All Colors from the context menu.
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Bit rates

In a stream, bit rates are calculated and displayed for the following:
®  Transport stream

B Programs

= PIDs

The bit rates can be displayed in graphical form as a bar chart or a pie chart. The
management is similar for each graph type. In addition, a historical multiplex
graph can be displayed at the transport stream level.

Select the appropriate icon to switch charts:

Historical
Bar chart — F E =<— mu|tip|ex
T graph

Pie chart

Figure 49: Bit Rate display selection

Bar charts  The following information is included with the bit rate bar charts:
m  Error status (LED)
B Object name (Program or PID name)
®  Stream type (PIDs only)
B Bit rate bar including change bars and limit markers, where relevant

B Bit rate statistics (including the current bit rate, the bit rate expressed as a
percentage of the overall bit rate, and the maximum and minimum values
reached during analysis).
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Error indication

Range bar

Summary | Mow Playing | MPE Sessions |

|_ Q Transport Stream: |d 4103, Network Name: Sandy Heath

Mbmber of Programs: 6

lMean TS bit rate: 24.128 Mbps

Mean TS bit rate excluding Null PID: 22.126 Mbps

Mame Mumber Mean Bit Rate Mean

Q) MULL PID 191 (0%1FFF) | 2.002Mbps  8.30%  1.395Mbps 2.324 Mbps
@ EEC ONE 4167 N 5.079 Mbps  21.35%  5.790 Mbps 6.115 Mbps
@ BEC TWo 4231 | 5.102 Mbps  21.43%  5.805 Mbps 6,169 Mbps
@ BEC CHOICE 4351 ] 5,101 Mbps 21.43% 5.804 Mbps 6.166 Mbps
@ EEC NEWS 24 4415 | 5.989 Mbps  20.96%  5.679 Mbps 5.996 Mbps
@ EEBC TEXT 4479 | T 0.8353Mbps  3.10%  0.594 Mbps 0.902 Mbps
@ BEC PARLMNT 4543 - 0.975Mbps  3.42%  0.686 Mbps 0.994 Mbps

Figure 50: Bar chart

The bit rate bars are scaled so that all bars are displayed relative to the one with
the highest bit rate.

Column widths can be adjusted by dragging the line dividing the title bar to the
left or right with the mouse.

Two levels of error status are displayed in each row. The error status LED shows
the test status of the element, for example, a program. The color of the bit rate
bar indicates the bit rate status and whether the rate has exceeded the limits that
were set.

A range bar indicates the variation of bit rate in each program or PID. The ends of
the bar show the maximum and minimum values of the bit rate since monitoring
started.

Range bar

& 503 (0x25E) = |
& 550 (Dx282) o1
@ 551 (0x28E) it |
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Bit rate limits  Bit rate limits can be set on a program or PID bar. An error will be indicated
when the bit rate exceeds the limits set.

You can highlight the program or PID and select Set Bit Rate Limits from the
context menu.

o U LUsld) B8 FLUURIUL, U1 D0 | Sl b
QD 600 (0x2.., || b=h 2 (0x02) (MPEG-2Y,,. | I 4924, 09¢
@ 01 (0xz,,, PP 600 (0x258) 269,216 |
a 602 (0x2.., Reset &ll Tests 0.000 K
@ =03(0x2,,| Dissble Al Tests 0,000 K
() 610(0x2..] Enable Al Tests B 4575960
@ BLUDAZ. paser Bk Rates Livits ol
@ 612 (0x2.., 67,680 K
Q@ Bi3(0xz..) 0,000 K
Q) B20(0x2. ., 4871.45¢
) 521 (0x2..,  Show Mean values 66206 |
Q 627 (0x2.., Quick Links: £9,154 K
@ 523 (%20 PID yiayy this PID in PID Tree 0.000 K
Q@ 00z, L, Yiew PCR. Graphs B 4523328
Q) 6541 (02, 266.208 |
@ 543 (02 B, View Bit Rate Graph 0000 K
0 50 (02, i% “Wienw packets with this PID 249,760
8 50| Myiew sections on this PID 0.000 K
g BSZ (02, Q; a0 ko nesct red LED in current kree F3 QRO
Q) 653 (0x2... e 40,637 K

The Set Bit Rate Limits dialog box opens:

Number Cument Bit Rate Cument{Mbps) Mir{Mbps)

NMULL PID 8191 (0...
BEC ON

4167 (0x1047)

e

Set Bit Rate Limits for 'Program 4167 BBC ONE'
This dialog allows you to set the minimum andjor maximum bit rate limits for Program 4167 BEC ONE.
Note: the colour of the bar indicates whether the current vale is within the entered limits

Minimum Bit Rate Maximum Bit Rate i
; 4 Enable Limit
4,575.000| Kbps | 14,500.000 | Kbps i
3
Current Bit Rate: 6,095.712 Kbps
”
T T PO NULOTACY T TR el

You can enable the limits by selecting the Enable Limit checkboxes and entering
the required values. The cursor in the bar indicates the current bit rate. The limits
can also be changed by dragging the limit icons in the dialog box to the required
positions. The color of the overall bar in the limits dialog box indicates whether
the current bit rate is within the proposed limits. Select OK to close the dialog
box. The limit icons will now be displayed on the bit rate bar. The scaling of all
bars is recalculated to ensure that the maximum limit is displayed.
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During file analysis, you must close and reopen the file to reanalyze it and view
the effects of the limits. Real time limits take effect immediately. Limit values
are retained when the application is closed. Limits set for specific PIDs will be
applied (to a PID with the same number) irrespective of the stream being analyzed.

Setting (and resetting) the bit rate limits for programs and PIDs will automatically
update the Program Occupancy and PID Occupancy tests. To change the transport
stream bit rate limits, the parameters must be altered directly in the Transport
Stream Occupancy test. This can be found under the Other tab in the Tests view.

The Bit Rate Limits of al/ programs in a stream can be disabled and reset by
selecting the Clear Limits button at the top of the Programs screen.

Pie charts = The information shown in the pie chart is similar to the information shown in
the bar chart.

Summary | Mawe Plaving | MPE Sessions

E |_ Transport Stream: Id 4103, Network Name: Sandy Heath
Mumlbier of Programs: 6
lMean TS hit rate: 24.128 Mbps

Mean TS hit rate excluding Mull PID: 22.126 Mbps

va

Programs: Mean Bit Rates

Figure 51: Pie chart

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the right pane provides a list of the component programs. Each program is
color-coded. Related information given includes the overall program status (icon),
the program name and number, and the bit rate (bps). The bit rate expressed as a
percentage of the overall bit rate is displayed in the segment labels. The maximum
and minimum values are not shown.

Labels for individual segments can be displayed by holding the mouse button
down over the segment. All labels can be displayed by double-clicking anywhere
on the pie chart. If a segment label is hidden at the edge of the window, click on
a segment to display the label in full.
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Historical multiplex graph  This graph shows the bit rates for all programs in stacked area format. You can
select the time period over which the graph is calculated from the Time period
dropdown list.

¥ GigE - Summary | Transport Stream: Id 1, Network Name: ADHERENT NETWORK
Tr

Mumber of Programs 5
Current T3 bit rate 41.471 Mbps

Current T3 bit rate excluding Null PID 39.195 Mbps

Last 1 minute {1 second period) Programs

[ 5 (0x0005) Adherert v
W 4 (0x0004) Adherert v
W 3 (0x0003) Adherent Il
W 2 (0x0002) Adherent I
W 1 (0x0001) Adherent |
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EPG view

An electronic program guide (EPG), where present, is a schedule of events and
programs that are or will be available on each service. A short summary or
commentary for each event may also be included. Events for services that are
actually carried in the stream are referred to as "actual" and as "present" or as
"following" (labeled as "EIT actual p/f" in the navigation view).

A transport stream may also carry EPG information for other network services,
referred to as "other" (labeled as "EIT other p/f" in the navigation view).

NOTE. The examples shown in the figures in this section are of DVB transport
streams. The construction of SI and node names in ATSC and ISDB streams differ.

The EPG node in the navigation view contains and displays all of the program
information carried in the transport stream.

The content of the Detail view will depend on the currently highlighted EPG table
node. Nodes representing an individual table or subtable will offer the usual
Summary, Section, and SI Repetition graph detail views. However, the higher
nodes will display the programming information graphically as shown in the
following figure.

Title bar  Display time zone  Start time Display range
Analysis View MNavigation Settings Capture¥u™ Help
c® -
Open File...
B 6 ==
=] Flex\tuplus‘j £ Analysis |
Programs | Tests | SIPSI | pIDs | Packets :; Summar| |
= I This Transport Stream (DTEIT actual)
-8 Programe (PAT/PMT/SOT actual) — - —
B Networks (NTs) Display Time Zone Start Time Display Range
@ Time (TOT/TOT) icﬁn (GMT-+01:00) [Stream] v| 127 August 2001 15:00 v | D4 hours 00 minutes Nl
= EPG (ET/SDTRST)
2 grhumnspm Stream (SDT/ET actual) [<e ) (B Jump to Now & Lo 252
== sm an:tuﬂ\
T' | = [=<_l 15:00:00 16:00:00 j117:05:06 18:00:00 19:00:00 b]
Ime scale R E Service 4231 (BBETWU', (EIT actu:
: B Service 4251 (BBC CHOICE) (ET a [ o
Service/Subtable panel —= e PEOREN| | 11 o brimusic
-E) Service 4479 (BBC TEXT) (EIT actu BBC 1 17110
- Service 4543 (BBC PARLMNT) (EIT Cocnd 061360 (0xF208)
Event panel e — » The Weakes...
£ Network 9018, Transport Stream 1229 BBC 17:15t0 18:00
g Network 9018, Transport Stream 16384 51396
3 Network 9018, Transport Stream 2048 'BBC CHOICE
-9 Network 9018, Transport Stream 24578 BBC
B Al ETs (ungrouped)
£ Al SDTs (ungrouped) v | §BC News | sports...
& pswcc e -
Y
Source: table_id 78 (0x4E), version 12 @ 00:00:00, section 0 (carried on PID 18 (0x12)) ¥
Ready Steady Cook
- From 27-Aug-2001 16:30:00 to 27-Aug-2001 3
Event detall anel - 17:15:00 (duration 0:45:00)
p BBC TWO
Channel ID orig_net_id 9018 (0x233A), ts_id 4103 (0x1007),
service_id 4231 (0x1087) v
< >
< ] >
[1s Availabiity Q|| sync || 24. 128335 Mbps @188: 204|| 511,360 Packets | DVE |0 Extensions ﬁ 2]

Figure 52: EPG Summary view
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EPG node summary £l & Time (TOTAOT)

= EPG (EITASDTARET)
= This Transpart Stream (SDTEIT actual)
Be =0T actual
= B Service 4167 (BEC ONE) (EIT actual)
MovwwMest CEIT actual pif)
T E Service 231 (BEC TWioT (EIT actual)
# B Service 4351 (BEC CHOIWCE) (EIT actual)
+ E Service 4415 (BBC NEAZ 247 (EIT actual)
+ a Service 4473 (BBC TEXT) (EIT actual)
+ B Service 4543 (BEC PARLMNT) (EIT actual)
= Mletweark 9018, Transport Stream 5194 (SDTEIT ather )
Be SOT other
+ E Service 3253 (1TY 1) (EIT other)
¥ Q Service 3384 (Channel 47 (EIT cthet)
+ a Service 3445 (FilmFour) (EIT other)
+ E Service 3573 (ITY Sport) (EIT other)
+ E Service 3640 (E4) (EIT other)
+ Metweark 9018, Tranzport Stream 12290 (SOTEIT other)
+ Metweark 2015, Transport Stream 16334 (SDTEIT ather)

T B Metuenrk O S Tramsnart Strearm 20450 rSTEIT mthee

Figure 53: EPG nodes

For each node type, the detail view shows the following information:

EPG node Links to the EPG information for all the transport streams
described in this stream.

Transport stream Graphical view of the events identified in the service(s) belonging

summary nodes to a specific transport stream.

SDT nodes (Service Links to services identified in the Sl for a specific transport

Description Table): stream.

Service summary Graphical view of the events identified in the service.

nodes

EIT nodes Detailed view of event information for a single EIT subtable.
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EPG Summary view  The elements highlighted in the EPG Summary view screen are described in
the following table: (See Figure 52.)

Item Description

Title bar Displays the title of the currently highlighted service or transport
stream.

Display Time Zone Select the required time zone from the dropdown list. The time

scale will change accordingly. The time zone may be derived
either from the transport stream, UTC (Co-coordinated Universal
Time), or local time (as set on the host computer).

Start Time Shows the event panel start time and date. Other dates can be
selected from the dropdown calendar, and the display will scroll
to the selected date.

In deferred mode, the initial date and time will be dictated by the
information found in the stream. If the selected date is beyond
that held in the EPG information, the date will be automatically
set to the last date held in the information.

In real time mode, this information is updated regularly.

Display Shows the extent of the event panel. More detail can be
displayed by choosing a shorter time period. Select the required
range from the dropdown list.

Timescale Shows the start and end time of the current event panel. The
range is dictated by the Display field selection.
Service/Subtable panel When a transport stream EPG is selected, this panel shows the

names of the services currently displayed in the event panel.
The displayed services will vary depending on which node is
selected in the navigation view.

Event panel This panel shows the events for one or more services, depending
on the selected node. Individual events are color-coded and
shown as blocks; each block (and its associated tooltip) displays
event information that is extracted from the EIT. When a block
is selected, the complete event information is shown in the
event detail panel, including a link to the section carrying the
information.

Event detail panel Shows details of the selected event. The details are contained
in the EIT (event information table).

Events are color-coded as follows:
®  Red: Present event

m  Green: Following event

®  Blue: Schedule event

®  Yellow: (ISDB only) After event

110 MTSA-HW and MTSA-PC Analyzer Applications User Manual



TSCA — Common user interface concepts

ATSC EPG Rating and closed caption information carried in ATSC EITs is displayed in the
ATSC EPG view. The consistency of closed caption signalling between the PMT,
EIT, and the closed caption content of video streams (Stream Tests > Other >
Miscellaneous > Closed Caption Error) is tested. The presence or absence of
CEA-608 and CEA-708 closed captioning is displayed next to thumbnails for
video streams, along with the current program rating information as signalled in
the EIT. The following thumbnail illustration shows the closed caption presence
indication. Closed caption data (CEA-608 and CEA-708) is signalled in the PMT
and EIT; an inconsistency error is triggered if the presence of signalling and data
do not correspond.

Create [10.3] 1 TV-G
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MPE views
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Multi-Protocol Encapsulation (MPE) provides a mechanism for transporting data
network protocols on top of the MPEG-2 transport streams in DVB networks.
MPE data has been optimized to carry the internet protocol (IP). MPE covers
unicast (datagrams targeted to a single receiver), multicast (datagrams targeted to
a group of receivers), and broadcast (datagrams targeted to all receivers). The 48
bit MAC (Media Access Control) addresses are used for addressing receivers.

The MPE views display the MPE data flow that is available in the stream.

‘¥ localhost - MPEG TS Compliance Analyzer
File Navigation Settings Captursvu™ Record Help

i @Reman Arlysis OEack °=w:rw:u- & Freterences U @] @ B Qom B oo W

Fragram | Tests | SiPsi| PID | Packets | 3| Summery | MPE Sessions

E-@ Transport Stream I 4103, Netvork Name: Sanc
0+ Yrrogramm 4167 BEC ORE "=t

@ Frogram 4231 BEC TWO &0

@ Frooram 4351 BEC CHOICE ‘&3 e oy e o) 2

@ Program 4415 BEC MBS 24 2306| 01:00:5E:04:64:65) 192165.2510) 22540400101 UDP| 1054 sooi| 31452 | I | 4T v

@ Frooram 4473 BEC TEXT i

@ Frogram 4543 BEC PARLMNT

[

< u | 3 | |fiai T | &

T8 avaisbiity @ |Sync @Bt rate 33781013 Mops @ 138 | Packet Size - 18| 0] Mo Extensions | nterfacs : D Paratel] [

Figure 54: MPE view
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CaptureVu feature

The CaptureVu feature allows you to capture and analyze system events during
deferred or real time analysis to debug the intermittent and complex problems
that traditional analyzers miss.

The feature can be activated either manually by selecting the Capture button
during analysis or automatically by a CaptureVu breakpoint preset on a test. For
deferred analysis, a packet number can be identified, at which analysis will stop.
Any of these actions freezes the analysis and allows details of the analysis up to
that moment to be examined.

Links to the packet and the test (where applicable) at the point at which the
Capture button was pressed or a designated test failed are displayed in the
CaptureVu Settings dialog box.

NOTE. If a recurring test failure needs to be examined in its true context, it is
advisable to make a triggered recording. With pretriggering set, it is then possible
to examine the events surrounding a test failure. (See page 116, Triggered
recording.)
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Setting Up the CaptureVu  The feature can be activated when a test flagged with a CaptureVu breakpoint
feature  does not fall within the parameters set for the test. Breakpoints can be set at any
time. They will be activated during real time analysis as soon as the flagged
test fails. To operate successfully in a deferred analysis stream, the stream may
need to be reanalyzed.

You can set a CaptureVu Breakpoint as follows:
1. In either the Program or Tests view, locate and highlight the required test.

2. From the context menu, select CaptureVu Breakpoint.

-

Program | Tests | s1fpsi | PID || Packets|

Associated PIDs

= @ Al Tests 2.3.2 PCR Repet
=@ TR101 290
E|° Priority 1 Any PIDs listed below 3
=" Q Priarity 2 @ PID 600 (0x258)
...... (D 21 Transport @ PID 610 (0::262)
______ .- @ 22CRC @ PID 520 (Dx260)
______ £ PTID A40 (TR0
QD 232PCRRepetlion 5 5 pep peneition
...... “{J) 23k PCR Dizcontin —
------ i) 24 PCR Accuracy RERS:
_ ..... O 25 PTS Disable
- ) 2BCAT Trigger Action:
& ° Priarty 3 Audible Alarm
[+ Cther
[#-{_) SFM Error = captursyu™ Breakpaint

Quick Links:

‘ Ot Go ko next red LED iR current bree F3
T

Note the addition of the breakpoint icon beside the test entry.

F'mgraml Tests ISIﬁPSI PID || Packets

=g &I Tests
=4 TR 101 290
:. o Priarity 1
EI O Pricrity 2
© D) 21 Transport

...... O 2 ECRC .

; 2 3. PCR Repetition [5] &
Q 23b F‘CR Discontinuity Irndiestor
~{_) 24 PCR Accuracy

The CaptureVu breakpoint is now set. You can set as many breakpoints as you
require. The next time an error is detected on any breakpoint test, analysis (real
time or deferred) will stop and the test will be identified.
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CaptureVu analysis

The CaptureVu breakpoint will operate during real time and during deferred
analysis. The CaptureVu Settings dialog box is displayed as soon as a breakpoint
is reached or the CaptureVu feature is activated from the toolbar.

BEIH

1File. .. ime

E FIex\n‘uPIus‘M‘ p Analysis |

Aciors w | show: @ ¥ @ | & FH S

=@ Stream Tests (62)
=@ TR 101 290 (42)
- Priority 1
Priority 2 (1)
: @ 24 Transport
i@ 22cRe
I D 2.3.2 PCR Repetition
P @ 2.3.b PCR Discontinuity Indicator
. () 24 PCR Accuracy
L E-@2seTs(n
i@ 2BcaT
- @ Pricrity 3 (31)
- @ Cther (209
- () SFN Error
@ Informstional Events

¥

Programs | Tests | SI/PSI | PIDs | Packsts|

@ 1.2 5ync Byte
Q@ 1.3.apaT
@ 1.4 Continuity

¥ CaptureVu™ Status

a Real-time Analysis

State

&5 captured

(1)
@ 2.1 Transport
@ zzCRC
@ 2.3.a PCR Repetition
@ 2.3.b PCR Discantinuity Indicator
() 2.4 PCR. Accuracy
@ z5PTS(1)
@ 260CAT

(@ 3.4.3 Unref FID
@ 3.5.2 50T Actual

[ &5 capturs H Q) Restart Analysis I

Triggered at packet 935006 by 2.5 PTS

ctivate this dilog when Captureyu™ triggers

Tioss |

Failed outside the last update (1)

F.

@ 25PT5(1)

@ EIT Actual PF Min Any Secticn Reptn Int (40
@ EITPJF Presence (1)
@ EIT Syntax (200

The State panel in the CaptureVu Status dialog box displays the test and packet in
which the test has failed when a breakpoint has been set. Clicking either the test
or the packet identity will open the related view (Tests or Packets) and highlight
the test or packet.

You can activate this dialog box when the breakpoint triggers. When enabled, the
Capture Vu setting dialog box is opened automatically when a breakpoint occurs.

The CaptureVu Settings dialog box can also be viewed at any time by selecting
the CaptureVu Settings button on the toolbar.

With the CaptureVu feature activated, all of the TSCA tools are available for you
to analyze and inspect the saved information.

NOTE. In Packets view, only the packets contained in the last 200 MB are
available for analysis.
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Resuming analysis

Triggered recording
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You can resume deferred analysis by selecting the Resume Analysis button from
the dialog box or the toolbar.

NOTE. When you select the Resume Analysis button, analysis will continue from
the point at which analysis was paused.

Similarly, you can resume real time analysis by selecting the Restart Analysis
button from the dialog box or the toolbar.

NOTE. While real time analysis is paused, further analysis is stopped. When the
Restart Analysis button is pressed, analysis is restarted at the current time.

During real time analysis, stream information can only be held for a finite time.
Eventually, the stream will be overwritten by more up-to-date information.

To examine events that occur in real time mode more closely, recordings can be
made manually or automatically. Recordings are saved to hard disk and can be
subsequently analyzed and examined in more detail.

The Triggered Recording setup is accessed using Record > Record Settings on
the menu bar; the Recording Settings dialog box is displayed. The dialog fields
are described in the following illustration and text:
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Table 11: Record settings

Command

i‘ﬂ Record Settings @
o Armed | | 10%
Recording is armed. l o Arrm ] | [ stop |

Target file

Path |D:\Test.mpg

File Size Pretrigger
o
150 ME L
i 50 ]
45z &k 27,651 Mbps 15ME (45 &k 27,651 Mbps)
PID Filker

COnly include the Following PIDs in the recording. ..

PIDs

Trigger

(@ Manual Test Failure Tirmed

[¥] Activate this dialog when recording starts

Figure 55: Record Settings dialog box

Function

Source selection

Source Transport
Selection

Record transport stream packets in an mpeg file (default selection).

Record transport stream packets in an mpeg file (default selection).

Status bar

Indicates the trigger status (Ready, Armed, Recording, or Complete) and the pretrigger/recording
progress. The status and progress are also displayed on the toolbar in the main window.

Target file Path

Enter the file name and path for the recording or use the browse button to find and select an
existing file name. If this file name already exists, you must approve the overwriting of the
old file when recording is initiated.

File Size

Enter the file size required in megabytes. For example, for a stream at 30 Mbps, a file size of
600 MB would record approximately 160 seconds of stream information.

Pretrigger

A proportion of a stream can be recorded before a trigger event occurs. (See page 119,
Pretrigger recording.) Enter the pretrigger size (as a percentage of file size) that is to be
recorded. (Pretrigger is not available when recording from an IP input.)

PID Filter

PID numbers cannot be entered directly into the PIDs field. Use the adjacent browse button to
open the Select PIDs dialog box and select PIDs to be recorded. The resulting recorded stream
will contain only the identified PIDs. (See page 120, PID selection.)
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Table 11: Record settings (cont.)

Command

Function

Trigger

Manual

The event that triggers the recording can be one of four types, selected from the drop-down list.
In each case, the trigger is set and pretrigger recording starts when Arm is selected. Pretrigger
recording must be complete before triggered recording will start.

Recording will start when the Start button is pressed. IP analysis supports only manual
recording.

Test Failure

Recording will start when an error occurs on a flagged test.

Tests are flagged by highlighting a test in the Program or Tests view and selecting Record from
the context menu. The record icon is displayed next to the test.
g 31 .aMT Ach

g 2.1 Transport
(D 3.1k NIT Cthe

@ 22¢Re

Q 2.3.3 PCR Repetition
@ 2.3 PCR Discontin
@ 2.4 PCR Accuracy Reset

@ 25PTS Disable :
@ 25 car L Harm |

8 Capturevu™ Breakpoint

Test: 2.3.a PCR Repetition

Go ko Test

T
@ 22CRC

D 2.3.a PCR Repetition >
O 2.3 b PCR Discontinuity Indicator

D 2 4PCR Arcuracy

You can set the Record flag on as many tests as you require; recording will be triggered by the
first flagged test that is encountered.

Timed

Recording will start when the time and date set in the Start recording at field is reached.

You can enter the date and time manually (in the format displayed). The date can be selected
from the drop-down calendar.

For all trigger types, except manual, when recording is complete, the starting packet is indicated
in the Record Settings dialog box. Click on the packet number to display it in the Packets view.

Arm button

Places the recording function into an armed state. If a pretrigger value has been specified, the
pretrigger recording will start (as shown by the progress bar). Full recording will start when
any trigger requirements are met.

Stop button

Only active during recording, this button either disarms the previously armed trigger or stops
recording immediately. Any recording made up to the point when the button is pressed will
be lost.

Start button

118

For manual recording, this button becomes active after arming and any pretrigger conditions
have been met; when pressed, recording will start immediately.

The Recording Settings dialog can be left open while waiting for a recording to

take place. If, after setting up the recording, the dialog is closed, the recording can
be controlled from the toolbar.
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Pretrigger recording  Setting a pretrigger size allows the condition of the final recording to be examined
both before and after a trigger event. Pretriggering a recording allows a section of
a recording to be recorded before the trigger event. The pretriggered portion of
the file is filled and written over repeatedly until the trigger event occurs.

Pretrigger recording starts when the trigger is armed by pressing Arm. (See
Figure 55 on page 117.)

c CAUTION. Recording may fail if the hard disk is unable to match the data
rate of the stream. This can be caused by a fragmented hard disk. Regular
defragmentation of the hard disk is recommended (refer to your Windows help).

NOTE. No timestamps are stored when performing a recording through an IP

NIC interface.
i‘ﬂ Record Settings @
€ Armed | | 10%
Recording is armed. [ o Bt ] | B stop |
Target file
Path |D:\Test.mpg
File Size Pretrigger
150 ME ' 10%
o S0 1oo
45z &k 27,651 Mbps 15ME (45 &k 27,651 Mbps)
PID Filker

COnly include the Following PIDs in the recording. ..

PIDs

Trigger

(@ Manual Test Failure Tirmed

P start
Activate this dialog when recording starts

Figure 56: Record Settings dialog box - Recording in progress
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PID selection  PIDs can be selected for recording.

To identify PIDs for recording, select the PID Filter browse button in the Record
Settings dialog box to display the Select PIDs to include dialog box.

¥ Select PIDs to include...

Select one or more PIDs.
Chonose PIDs by selecting them from the PID tree or tvping them in to the PID text box below the tree.
‘fou can select multiple PIDs as well as PIDs which are not currently present in the stream.

Using the mouse: Select rultiple PIDs with Skift depressed For cantiguous selections and L&l For non-coantiguous zelections,
Using the keyboard: Enter PIDs between 0 and 8191 in decimal ar hex (using the Ox preficl, e & 3, Svdo-fe 5, f20-35

=) Reserved PIDs (5) %
~(@) PID 0 (0% - PID 0 (PAT) B3

() PID 16 (0x1 0 - PID 16 (MIT or 5Ty B3

- PID 17 (0x117 - FID 17 (SDT, BAT or STy B3

() PID 18 (01 2) - PID 18 (BT or 5T B

- PID 20 (0x147 - PID 20 (TOT, TOT or =T) B

(@) PIDr 8191 (01 FFFY - PID 8191 ¢Null)

EIQ Referenced PIDs in stream (20)

(@) PID 100 (OxE4) - PT B3

(@) PID 110 (0EE) - 2 (D02 (MPEG-2 Yiden) ‘) 3
(@) PID 120 (078D - 4 (004 (MPEG-2 Audia) 7

() PID 130 (0E2) - 4 (004 (MPEG-2 Audin) 7

(@ PID 200 (0xcE) - PMT 3

Q) PID 210 (0D2) - 2 (Ox02) (MPEG-2 Viden) s

~(@) PID 220 (0xDC) - 4 [0x04) (MPEG-2 Sudio)

(g PID 230 (OIEE - 4 (04 (MPEG-2 Awiddio) J3

~(@) PID 300 (0x12C) - PMT B

() PID 310 (0136 - 2 (0x02) (MPEG-2 iden) ‘2 (E)

(@ PID 320 (0x140) - 4 (0x04) (MPEG-2 Audio)

PID(s) |18, 300, 310, 320, 330 |

W

Ok, H Cancel ]

Figure 57: PID selection

PID numbers to be recorded can be entered directly in the PID(s) field or selected
using the mouse pointer in combination with the Shift and Ctrl keys. PIDs that are
not currently present in the stream can also be entered.

If the Only include the following PIDs in the recording check box is selected in
the Record Setting dialog box, the TSCA will record only packets that include
the selected PIDs.
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Menu bar and options

The Menu bar provides access to a selection of major system options using
dropdown menus. The menus and their options are described in tables listed in
this section.

Table 12: Analysis menu options

Command Function

File Analysis. Opens the Open File Analysis dialog box

Real time Analysis. Opens the Select Real time Interface dialog box

Restart Analysis Restarts the current analysis

Save Captured Stream... Saves the captured stream (200 MB maximum). Only available
in real time mode

Save TS Packets... Saves the transport packets from a PCAP (packet capture) file
with the current IP filtering. Only available in deferred mode

Recent Files Lists the most recently analyzed files. Select a file name to
reanalyze the file

Close Analysis Stop and close the current analysis, leaving the TSCA open

Exit Exits the TSCA

Table 13: View menu options

Command Function

Show Toolbar Show/hide the toolbar

Show Status Bar Show/hide the status bar
Tear-Offs > Lists the open tear-off screens

Table 14: Navigation menu options

Command Function

Back Returns to previous view

Forward Goes to next view

FlexVu Plus Goes to the FlexVu Plus screen

Select Tree > Allows selection of a navigation view (Programs, Tests, SI/PS],

PIDs, Packets, Interface)

MTSA-HW and MTSA-PC Analyzer Applications User Manual 121



TSCA — Common user interface concepts

Configuration
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Stream

Table 15: Settings menu options

Command Function
Configuration... Opens the Configuration dialog box
Standard... Opens the Standard dialog box

Table 16: CaptureVu menu options

Command Function

CaptureVu Status... Opens the CaptureVu status dialog box

Capture Pauses the current analysis to allow detailed inspection
Resume Resumes analysis - only available in deferred analysis mode

Table 17: Record menu options

Command Function

Record Settings Opens the Record Settings dialog box.
Arm Arms the record function.

Start Starts recording.

Stop Stops recording.

The Record menu is only available during real time analysis

Table 18: Help menu options

Command Function

About... Displays application and system information.

Select Settings > Configuration to display the Configuration dialog box. Two
configuration categories are offered in the Configuration dialog box: Stream and
Preferences. Several subcategories are also offered.

Use this category to modify stream-related settings.

Item Description

Enable thumbnails Thumbnail views of program content will be displayed when this
option is enabled.

Reset Actions The Factory Default button restores all configuration items to
those set in the factory. All parameters, including the interface
card settings (where installed), will be reset.
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Stream - test parameters ~ All parameters are accessible from the Settings > Configuration > Stream > Test
Parameters window. Parameters are initially listed in alphabetical order. To
quickly search for a parameter, enter text in the search field, for example ‘BER'.
Only parameters containing the entered text in their description will be displayed.
You can clear search text by selecting the button adjacent to the search field.

¥ Configuration

ier seardh quer “u| Test Parameters @
-Stream Use this page to edit the parameters for the tests in the tests tree. Not all tests have editable parameters - those that do are
est Parameters listed below.
. _BCRFilters A tests can ko be edited via s right-cick menu,
references
.-Font Use the fiter fo restrict the fisted parameters, eg typs "PCR” to show PCR related parameters,
*~Decode Filter: | Enter fext o fiter the table |[:

100
I~ ms 100 10000 100000
" linteger.| 5 5 100
CAT max subtable repetition interval |
:alill.:le: 10000 boooo |
nits: ms e |
Min: 100 om0
Nominak 10000 B
Max: 100000 1
=] 0 0 i
Pkts/m [ 100 10000
|Integer. 2 3 &
ms 500 2000 30000
ms ] 5 100
linteger B 5 100
ms 2000 10000 120000
ms 0 2 100
fintsger | 5 25 w |,

Figure 58: Configuration - Test Parameters

Parameter values can be changed in the same way as individual parameters. (See
page 97, Parameter edit.) Changes made to values in this dialog box are also
applied to the individual PID parameters, since changes made here become the
default value for the parameter.

Select the Set All to Nominal button to return all parameter values to their
factory settings. During file analysis, you will need to restart analysis for the
new parameter settings to take effect.

Stream - PCR filters  The PCR measurements provided by the MTSA Transport Stream Compliance
Analyzer are defined by TR 101 290. Appendix I of TR 101 290 describes the
measurements in detail, and also introduces the concept of the "demarcation
frequency" at which PCR errors are separated into drift errors or jitter errors.
Errors below the demarcation frequency are measured as drift, while errors above
that frequency are measured as jitter.

TR 101 290 also defines three standard demarcation frequencies, MGF1 (10 mHz),
MGF2 (100 mHz), and MGF3 (1000 mHz), at which the PCR measurements can
be made, and provides for a user-definable demarcation frequency, MGF4.
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From the menu bar, select Settings > Configuration > Stream > PCR Filters to
open the PCR Filters dialog box. (See Figure 60.) Any PCR error below the
low-pass filter cut-off frequency will be measured as drift; any error above the
high-pass filter cut-off will be measured as jitter.

The filters can be set to any of the standard MGF profiles, or a user desired
cut-off frequency, by selecting MGF4 and entering a value between 1 mHz and
10000 mHz (10 Hz).

Alternatively, these filter values can be changed by selecting Settings >
Configuration > Stream > Test Parameters from the menu bar, filtering the
appropriate parameters, and making the required changes.

Test Parameters &
Uz= thiz page to edit the parameters for the tests in the tests tree. Not all tests have aditablz parameters - those that do are
listed below.

A t=st's parameters can also be edited vis its rightclick menu,

Use the fiter to restrict the listed parameters, eg type "PCR" to show PCR related parameters.

Filter: |~pass filter Ex
mHz 1 10 10000
mHz o 100 10000
Figure 59: PCR parameters - Filter settings
¥ Configuration E|
|Zx| PCR Filters @
-Stream Use this page to set the PCR drift and jitter cutoff frequencies.
-Test Parameters Any PCR error below the low pass filter cutoff frequency will be measured as drift, while any error above the high pass filter
S cutoff will be measured as jitter.
El-Preferences For more information about these demarcation filters, se= ETSI TR 101 290 (5.2.2 and Annex I),
s-Font
+Derode PCR_FO/DR Low Pass Fiter

(3 MGF1 (10mHz) - Default
() MGF2 (100mHz)

() MGF3 (1000mHz)

MGF4 mHz.
e

Measurement settling time: 500s

PCR_AC/01 High Pass Filter
() MGF1 (10mHz)

(=) MGF2 (100mHz) - Default
() MGF3 (1000mHz)

Measurement settling time: 50=

Parameter changes will take effect only after analysis is restarted.

Figure 60: Configuration - PCR Filters
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Table 19: PCR settling times

Note that the TR 101 290 drift limit of £75 mHz/s is only defined at a demarcation
frequency of 10 mHz. As the low-pass filter frequency is increased above that
value, more of the PCR jitter will be measured as drift, and so the measured drift
values will increase. If you are attempting to check that your source PCR clock
is compliant with the TR 101 290 limits, the low-pass filter cut-off frequency
should be set to 10 mHz.

Settling Time. All of the PCR measurements that depend on demarcation filters
have a settling time.

The measurements will not return valid values before this time elapses. The
settling time is indicated on the PCR graphs in the TSCA.

This settling time is inversely proportional to the cut-off frequency of the
demarcation filter. This means that there is a trade-off between reducing the filter
frequency to improve drift measurement accuracy and increasing the time it takes
to obtain any drift measurements at all.

Filter cut-off Settling time TR101-290 profile Comments

10 mHz 500 s MGF1 TSCA default for PCR_FO/DR low-pass
filter cut-off; drift limit of£75 mHz/s is only
applicable at this level

100 mHz 50s MGF2 TSCA default for PCR_OJ/AC high-pass
filter cut-off.

1000 mHz (1 Hz) 5s MGF3

1 mHz - 10,000 mHz 5000s-0.5s MGF4 User-defined profile

For more information about PCR measurements, please read the PCR
Measurements Primer, available on the Tektronix Web site (www.tek.com).
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Preferences

Use this category to modify general preferences.

‘¥ Configuration @

Enter search query | S| Preferences ®

=-5tream Use this page to madify general preferences.
Test Parameters
1|, PO Eters Default File Folder [C:\ [ -
g
+-Fant e o . =
Maximum File History Size 4
‘--Decode g E

Timezone for timestamp display ‘ Local N

Packet Size used for TSbitrate 188 (%

Optimise for UI performance [

Colour Scheme | Default v

Figure 61: Configuration - Preferences

Default File Folder: Set the default folder that will be shown when first
displaying the Open File Analysis dialog box in a session.

NOTE. Navigating away from the set folder within the open dialog box will
change the default folder shown for this session only.

Maximum File History Size: Specify the maximum number of file names to be
shown in the Analysis > Recent Files list.

Timezone for timestamp display: This setting affects the display of timestamps
in the event log.

The available timezones are: Local: The timezone set on the PC running the
client application UTC: Universal Coordinated Time Remote: The timezone set
on the system running the analysis engine

Connecting to a remote machine, the Local and Remote settings will produce
different timestamps if the client and device are in different timezones.

When connecting to localhost, the Local and Remote settings will yield the
same displayed timestamp, since the client and remote software are on the same
machine, for example, an MTSA instrument.

Packet Size used for TS bit rate: Specify the packet size (188 or 204) to be used
to calculate the transport stream bit rate. This is displayed in the status bar.

Optimize for Ul performance: Under some circumstances when analyzing
large files or using low specification instruments, the user interface may appear
to freeze. Enabling this feature will cause the user interface to refresh at more
regular intervals, thus reassuring you that the analysis is progressing.

Color Scheme: Select the background color for all graphs. When Default is
selected, the graphs are based on a white background. When Instrument is
selected, the graphs are based on a black backgrounds.
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Preferences - font  The Font preferences option allows you to specify the display font and size for log
entries and stream content. Place the cursor in the field to be changed and select
the font name or font size required from the displayed dropdown list.

¥ Configuration r5_<|
E |5 Font ®
S-Stream Use this page to change the fonts used throughout the application. For instance, when displaying stream contentin a
i..Test Parameters language different from the operating system default, select a font that supports the language's character set. Additionaly,
i..PCR Filters the font sizes may be increased to provide better readability on small screens.
[=-Preferences More information on what each font is used for is displayed by hovering the mouse cursor aver the font row.
i..Decode Font Name Font Sze
<<default=> Normal Tahoma
==default=> Normal Sansserif

<<default-> Normal Sansserit

Set to Default sets ll the fonts to the name shown in the Locale Set to Defadlt

Default Font column and sets the sizes to Normal.

Copy Standard sets the Log Entries and Stream Content fonts
C Standard

to the currently selected Standard font name and size. opYy StEnoan

Click Apply to immediately see effect of new font settings.

Figure 62: Configuration - Preferences - Font

Preferences - decode  The decode preferences relate to the VLC Media Player that can be used to play
elementary stream video and audio content.

[ configuration X
Fiter: « Decode ®
=-Stream Use this page to select a player application to decode the video. When analysing a stream in real-time
Test Parameters mode, the data can be streamed to a local port. Changing any settings on this page will stop any
PCR Filters current decode session.
=)-Preferences
Font Select Player

VideoLAN VLC
Selected Player: C:\Program Files\VideoLAN\VLC \vic.exe

A Analysis has completed. Parameter changes will only take effect when analysis is restarted.

oK Apply Cancel

Figure 63: Configuration — Preferences — Dcode

VideoLAN VLC: Selecting the VLC setting indicates that a stream should be
sent to the VLC Media Player.

UDP Network Stream: The UDP setting, which is only available for real time
systems, is used to designate the port over which streams should be sent to
external players, for example, the MPlayer. The UDP Destination can be set
either automatically or manually.
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Script files

128

In the TSCA, scripts provide a method of interpreting and displaying standards
during analysis. Scripts provide templates, which determine how the SI
information found during stream analysis will be displayed. The scripts must cater
for all the information that may be found in a stream, including the various table
types found in all of the identified standards. To this end, it has been found that
the best approach is to make the scripts modular; each script module deals with
different aspects of the SI and standards.

For example, when DVB is identified as the standard against which to analyze,
the scripting dialog box displays a list of Script modules. Additionally, when it
is known that tables or descriptors not commonly carried in the identified base
standard and region are likely to be included, extra scripts can be written and
added to the Script Files list to be used for the analysis.

Essential scripts are installed and enabled using the Stream Interpretation dialog
box. In the absence of any enabled scripts, only the PAT table will be analyzed,
and all other data will be presented as private data.

Scripts can be customized or new scripts can be written to analyze private data.
With the Custom Scripts checkbox enabled, if a suitably configured script

is selected and enabled before a stream is analyzed, custom data will also be
analyzed when the stream is opened.

Scripts can be selected and enabled when files are open; analysis will restart
as soon as any changes as accepted.

A script file will not be used for analysis until it is present in the Script Files panel
of the Open Transport Stream dialog box.
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Setting stream  Set the stream interpretation as follows:

interpretation .
¥ Standard E|

Standard and Region
Select a standard and region to use for analysis
Mote: Changing the standard or region and pressing OK will restart the analysis

EBase Standard | ~ | Region |N-:- Extensions ~ |

Scripts

[]Use Custom Scripts

[] Enable scripted section validations during analysis (slower)

Scripts Directory | ‘

LJBL .

FEEEEEEEEEED
N| @« P

LY

l OK M[ Cancel

Figure 64: Stream Interpretation dialog box

1. Select Settings > Standard to open the Standard dialog box or select
Change from the opening dialog box.

2. From the Base Standard dropdown list, select the required base standard.

The selected standard will dictate the availability of options that are available
in the Regions dropdown list.

3. From the Region dropdown list, select the required region.

The regions list allows country-specific extensions to be added to the base
standard scripts. If No Extensions is selected, only the standard scripts are
listed in the script list. The remaining country-specific extensions add extra
scripts to the current listing. Scripts that will be used are listed in the main
pane.

Scripts listed by default are resident in the default
installation directory (program files\missing files
(x86)\tektronix\mpeg\mtsa\scripts). Other directory locations can
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Custom script selection

be specified in the custom script selection mode. All selections will be
retained between TSCA sessions.

4. Select OK to confirm changes.

Scripts are syntactically analyzed when the OK button is selected. A fault in the
syntax of a script will not necessarily prevent a stream from being analyzed, but
it may result in an incomplete analysis of the stream. Errors in the script syntax
will be noted in the stream log.

When the Custom Scripts checkbox is enabled, the buttons beside the script listing
become active and custom scripts can be selected in addition to the standard
scripts. Some script names in the listing are dimmed; these are considered to

be essential and cannot be removed.

¥ Standard

Standard and Region
Select a standard and region to use for analysis
Mote: Changing the standard or region and pressing OK will restart the analysis

Base Standard |D*.fB w | Region |N0 Extensions
Scripts

L]

Use Custom Scripts

[] Enable scripted section validations during analysis {slower)

Scripts Directary ‘C: Program Files\Tektronix\mpeg \MTS400\Scripts

@ tektronix. scp

B Ethernet.scp

3 MPEG Packet.scp
&4 DvB_SFN_MIP.scp
@ mpeg.scp

m mhp, scp

@ mpe, scp

B dsmec.scp

@ mpeg_pat.scp
F4 DPI_SCTE3S.8cn

() (8] [@]®] (n]le] @] (]

[ OK %H Cancel ]
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The buttons operate as follows:

Button Operation
Resets the script list to the default list for the standard and
B region.
@ Opens the script selection dialog box. You can highlight the
required script and select OK. The script name is added to the
Script Files list.
Removes any script name highlighted in the Script Files list.
Scripts are applied to streams in the order that they are listed
in the Script Files list. Use these buttons to move a highlighted
script up and down in the list.
- Opens the highlighted script in ScriptPad (the Tektronix script
[« 4 editor).
Verifies the syntax of the scripts listed in the Script Files pane. A
message window lists any errors found.

If the standard script list has been changed and you want to return to the default
list of scripts, highlight the Base Standard and Region required, and select the
default script button. The list will be overwritten with the default list.

More information about ScriptPad can be found in the MTSA-HW and MTSA-PC
Generator Applications User Manual.
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Scripts directory

Script validation

The Scripts Directory field indicates the root directory for scripts named in the
Script Files list when analysis starts. If scripts are not present in the scripts
directory, the interpretation and validation of the SI will be incomplete.

NOTE. If the script list is modified in any way, always use the n button to verify
the changes.

Scripts can be selected from any directory (using the + button). If the directory
is not the same as that identified in the Scripts Directory field, the path (either
relative or absolute) will be displayed with the script name in the Script Files list.

NOTE. The Scripts Directory browse button allows you to specify a default
directory for script selection. The browse window does not display the scripts
available. If you need to see the scripts available, use the Windows Explorer.

If the standard script list has been customized and you want to return to the
default list of scripts, highlight the required Base Standard and Region and select
the default script button. The list will be overwritten with the default list.

NOTE. Each Base Standard and Region combination can be individually
customized.

Validating scripts checks the syntax of the listed scripts.

If the "Enable scripted section validations during analysis" check box is enabled,
the scripts are checked during analysis to ensure that the data as defined by the
scripts is as expected (for example, values are within specified ranges). A fault in
the syntax of a script will not necessarily prevent a stream from being analyzed,
but it may result in incomplete analysis of the stream. Errors in script validation
will be logged in the stream error log. Enabling this check box may have an
impact on real time analysis.
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TSCA - Task examples

The examples in this section describe how to locate a fault or information using
the analyzer.

To use this section, you should have a basic understanding of the analyzer user
interface and be familiar with the more important aspects of digital television
transport stream structure and interpretation standards.

The MPEG Test System is a tool which allows you to analyze a transport stream
and then examine it in detail. Errors in the content can be identified and examined
to byte level.

Because of the comprehensive nature of the analyzer, there are a number of ways
of achieving your objective. In these examples, one or more ways are described to
achieve the objective.

Error status  LED icons are used throughout the analyzer interface to represent the status of
the tests applied to associated items, for example, programs. Colors used are as
follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but
has been seen since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

€L e

(Light Blue) Transient warning (warning not current, but has
been detected since last reset) (Interface tab only)

(Gray): Test disabled

<

L | (White) Test not applicable or unknown state

oo

% (Red) PID referenced but not found in the stream

3 (Green) PID referenced but not found in the stream; applicable

test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes) or a navigation tab, the color represents
the worst case of all of its tests and the worst case of all of the tests represented
by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.
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Which tests have failed in an analyzed stream

In this example, the analyzer has just finished analyzing a stream. The Program
navigation view is initially displayed with the transport stream tree collapsed. The
transport stream error LED is red, indicating that one or more tests have failed.
(See page 33, Error status LEDs.)

Method  With the Program tab still selected, view the tests summary view (bottom right).

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser EEX

Analysic View Mavigation Settings Captureyu™ Help

| FIexNuPIus"" pAHHWSE|

Programs | Tests | 51/Pst | PIDs | Packets| [ summary | Thumbnais | MPE sessions|
actons v | O [{ 5

- @ Transport Stream: id 4102, Netwark Name: S = ==
(- @ Program 4167 (0x1047) BBC ONE '&Zn ‘E‘Q Za Transport Stream: Id 4103, Network Name: Sandy Heath

- @ Program 4231 (0x1087) BBC TWO '&k Number of Programs 6
Current TS bit rate 24.128 Mbps
Current TS bit rate excluding Null PID 22.116 Mbps

- @ Program 4251 (0x10FF} BBC CHOICE ‘&%
@) Program £415 (0x113F) BEC NEWS 24 '
(- @) Program 4479 (0x117F) BBC TEXT 3i{
& ° Program 4543 (0x11B6F) BBC PARLMNT

Curent Bit Rate: <) | Min{Mbps) Mo

[ ]

4167 (0x1047) I N 6.095| 5,790 6.115 71

4231 (0x1087) | 6.108] 5.805] 6,169 21,

BBC CHOICE 4351 (0x10FF) | 6. 10# 5.804 . 166) 2L
BEC NEWS 24 4415 (0x113F) — 5.983 5,679, 5.936 0,
BBC TEXT st xit7r) M 0,895 0.554 0902 3.
BBC PARLMNT (4543 (0x11BF) [ M 0.993] 0,686 0.994 3.
| b3

@ 1.1Sync @ 2.1Transport @ 3.1aNIT Actual (2) ~
@ 1.2SyncByte @ 22ccRe (2 3.1b NIT Other m
@ L3apPAT @ 2.3.2 PCR Repetition @ 3.251 Repetition (17)
@ 1.4 Continity @ 2.3.b PCR Discontinuity Indicator @ 3.4.aUnrefPDD
@ 153PMT (D) 2.4PCR Accuracy @ 3.5.2 50T Actual (14)
@ 167D (44) @ 25FTs @ 3.50 50T Other
@ 26cCAT @ 3.5.2 EIT Actual (56)
@ 3.6.bEIT Other L
@ 36.cETTPF
¢ I 5 @ 3.7RST ]

i T T 1 7
TS Availabilty g‘lsync Q@)|| 24128335 Mbps @ 1881\31‘,[511,360 Packets| | DVB| No Extensions| i ‘

Figure 65: Failed tests - example

Identify the tests that have failed (red LED). The following tests have failed in the
test summary view (TR 101 290 tab): (See Figure 65.)

®  First Priority: 1.6 PID

B Third Priority: 3.1a NIT Actual; 3.2 SI Repetition; 3.5a SDT Actual; 3.6a
EIT Actual

Remember that the tests may be distributed over more than one tab in the test
summary view; the color of the LED on the tab helps you locate the failed tests.
(See Figure 65.)
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You can view a test (and see other PIDs that it has failed on) by highlighting a test
and selecting "View this Test in Tests Tree" from the shortcut menu:

@ Laari
1 6 PN (44Y

Edit Parameters...

Reget
— Digable —
— Ensble :

Enable All Tests
Audible Alarm

Captureyu™ Breakpoint
Clear All Trigger Actions

04

—

act Dizable All Tests e
dnm

View this Testin Tests Tree

You can also display the fault by expanding the tree in the Tests navigation view
until the fault is revealed.

Expanding the test itself reveals the PIDs that have failed the test.

Programs | Tests | SI/PSI | PIDs | Packets

Actions ¥ | Show: W) I @ | @

=@ Stream Tests (134)

= @ TR 101 290 (133)

. =@ Priority 1 (44)
0 1.1 Sync

- @ 1.2 Sync Byte
@ 1.3.a PAT
(@ 1.4 Continuity
G- 1.5.a PNT
EX" J16PD (44

------ @ PD 502 0x254)

------ @ P 503 (0x25B)

O on 517 netEDy
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How many PIDs are there in a stream?

How many PIDs are referenced?

How many are unreferenced?
For this task, the PID navigation view is used to view information about
individual PIDs in the transport stream. Under the All PIDs node, which displays
all of the PIDs in the summary view, there are four subgroup nodes: Reserved

PIDs, Referenced PIDs, Unreferenced PIDs, and User PIDs. The number (in
parenthesis) in each node gives the number of PIDs found during analysis.

Method  Select the PID navigation view.

1. Expand the All PIDs node to display the subgroups (and their quantities).

Program | Tests SIJ’F'SI| F" | Packets

Al Picls (4487 r'-let'-.-'-.-'-:nr'h:.r'-l atme: Sandy Heath

2. Expand the All PIDs node to display the subgroups (and their quantities).

Program | Testz | SRS PID | Packets

c Al Pidz [ d8): Metwork: Mame: Sandy Heath
() Reserved PIDs
° Referenced PIDs in stream (41
Q Unreferenced Pl in stream (0]
Q) User Pids: (1)
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What tests have been applied to a program PID?

1. Select the Program navigation view.

1 .
Program | Tests | SWPSI | PID | Packets i| @ sssocisted Tests | pTg Graphs || Bit rat

= ° Transport Stream: [d 03, Metwork Name: Sancy PID 6803 [0!255] Stream wpe. f
= @ Prooram 4167 BEC OME ‘=m

QD PID 600 (0x258) =il
Q PO BT (0x258) A () 1.4 Cortinuity
% roe02 (0xz2s8) B O 16 PID
Q IR = Q 2.2.a PCR Repettion
0 PID 650 (03284 j#1i \_) 2.3.b PCR Discortinuity Indicator
98 D851 (0:288) 1316 () 2.4 PCR Accuracy
$8 PID 652 (0x25C) 104 QD 25PT3
Q) PID 1005 (Dx3ED) 331 () 34.aUnrefFD
$¢ PiD 1008 (03EE) B4 O PID Ot cupsrey
& PID 1007 (D3R d84t J PCR Overall Jiter (POR_QU)
0 PMT PID 4167 (0x1 0477 () PCR Freguency Offset (PCR_FO)
@ FProgram 4231 BBC TWO 'an @ PCR Dritt Rate (PCR_DR)
@ Frogram 4351 BBC CHOICE 'ax Q FID Bt Rete Wariabilty
@ Frogram 4415 BEC NEWS 24 &p @ Discontinuity

= @ Program 4479 BEC TEXT 4t

2. Expand the Transport Stream tree until the required PID can be highlighted.

In the Associated Tests view, note the tests that are enabled. Gray LEDs indicate
tests that have been disabled, and white LEDs indicate tests that are not applicable
to the selected PID.
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Establish the stream type of a PID

Method 1 1.

Select the Program navigation view.

Frogram |Tes‘ts SIPS! | PID || Packets

(D Aszsocisted Tests | PTS Graphs | Bit raf

ot

= '° Transpatt Stream: 1d 4103, Metyvwark Mame: Sandy PID 503 [oxsz] Stream wpe: i

= ° Pragratn 4167 BEC OME 2x

() PID 600 (0%258) "2 (T
() PIDBO1 (0x259) A
$roo0zoxasm A
[®Fi0 603 ( ]
Q) PID 50 (0284 jog1e
$8 riD B51 (0x28E) d01¢

98 PiD B52 (0x25C) il

Q) PID 1005 (0x3ED) 1§

$% PiD 1006 (0x3EE) §§4

$% PiD 1007 (0x3EF) 164
) PMT PID 4157 (0:1047)
@ Frooram 4231 BEC TWO
° Program 4351 BBC CHOICE ham
@ Frogram 4415 BEC MEWS 24 e
i @ Program 4470 BBC TEXT 146

() 1.4 Cortinuity

Q15PD

() 2.3.3 PCR Repetition

() 2.3h PCR Discartinuity Indicator
() 2 4PCR fecuracy

() 25PTS

() 3.4.aUnref FID

O PID Qoocupancy

\._J PCR Overall Jitter (PCR_CJ)

\) PCR Frequency Offzet (PCR_FO)
@ FCR Diitt Rste (PCR_DR)

D PID Bit Rate Variabiity

@ Discortinuity

2. Expand the Transport Stream tree until the required PID can be highlighted.

3. Keep the cursor over the PID. A tooltip will display the stream type.

& PID 602 tﬂx?ﬂ.&) A
e ] -

Q) PID B50 (0x284) j310

() 2.3.a PCR Repeti
() 2.3.h PCR Dizcon

‘ @ 15FD

$8 P 651 (Dx28E) j3Etrean type: 6 {DxD6) {PES private data)|rac

% P 652 (0x280C) G

H\’ |'.,)2.5PTS
- "

The tooltip is available wherever the selected PID node is displayed (for example,
in the PID navigation view).
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Method 2 1. Select the Program navigation view.
2. Select the program node.

3. In the summary view, select the Summary tab.

Programs | Tests || SIPSL "E" Packets| : Summary |Thumbnai|s || @ Program Tests " Bit rate GraphsI
Actions v @ 3] [

E\‘ Tranzport Stream: Id 4103, Network Name: Sa —3
=R Y0rogram 4167 (0x1047) BBC ONE =i |§| ® I ;

..... @ PD 00 (0x25e) En ) Program number = 4167 (0x1047)
----- @ PD 601 (0x259) A Service Provider = BBC
----- 8 P60z (0xesa) A
----- @ roc0z (02sE) B semvice Type = 1 (O 1) {digital telovision’ service)
----- @ posso 0224 i Now/Next
----- $8 PD 651 (0xzzB) B
_____ $8 P 652 (0x28C) B m The Sound Of Music 13:25 - 16:10 UTC
----- @ PD 1005 (0x3ED m
----- $8 D 1006 (0x3EE) BBC News 16:10 - 16:25 UTC
..... $8 P 1007 (0xaEF) 181 > -
----- @ Pt PD 4167 (0x1047) B

(- (@) Program 4231 (0x1087) BBC TWO 'k - - PID variability o e

- @ Program £351 (0x10FF) BBC CHOICE '&n O 500 (0253) = 2 002) {PPEG 2 i) 07
i@ Program 8415 (0x13F) BEC NEWS 24 ' O 601 (0x259) A 3 (0x03) (MPEG-1 Audin) 0.037
- @ Program 4479 (0x117F) BBC TEXT i 8 202 (0x25A) 2 3 (0x03) (MPEG-1 Audio) 0,000

Note the Stream Type column in the display. The stream type is given for each
PID in the selected program.

How many programs are there in the Stream?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and note the number of program nodes.
(See Figure 66.)

3. The Summary view (bar chart or pie chart) also displays a program count.

| B Fexvuplus™| £ Anaivss|

Programs ]Tests | sijpst | PIDs | Packets| W summary [ Thumbrais || MPE Sessions|

B
B. Tranzport Stream: Id 4103, Network Name: Sa |§|G‘ -~ —‘.
. Program 4167 (0x1047) BEC ONE & = -

Program 4231 (0x1087) BBC TWO '&n Number of Programs &

@ Program 4351 (0x10FF} BBC CHOICE '=» Current TS bit rate 24.138 Mbps

-@ Frogram 4415 (0x113F) BEC NEWS 24 ‘el
Program 4479 (Ox117F) BBC TEXT 191¢

@ Program 4543 (Ox118F) BEC PARLMNT

Current TS bit rate exduding Mull PID 22.116 Mbps

Figure 66: Program count
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What are the contents of the Programs?
And what Pids are they on?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and a program node as shown in the
following figure.

3. Note the number of program PIDs. Each PID is accompanied by an icon
indicating the stream type. Hold the cursor over a PID node to display more
information.

4. The Summary and the PID Information views also display the program PIDs.

E FlexVuPlus™ D Anah'si's‘

Programs | Tests || s1/pst | PIDs | Packets|
Actions w Q‘ =

EI. Transgport Stream: Id 4103, Network Name: 53
EI--. Program 4167 (0x1047) BBC ON E}'ﬂ‘

LY

sumnmary | Thumbnails || Q Program Tests " Bit rate

e S

..... o PD 500 (0x253) 'E)ﬂ A Proaram numhbar — d167 leT)

IIIII o PD 801 (0x255) 1 Prugram 4167 (0% 1047) BE!C_ONE o B

..... $8 P 602 (02en) 2 Service Type: 1 (0x 1) (digital television service)

..... @ 0203 (0.2e6) Service Type = 1 (0x 1) (digital telev
----- @ PD 650 (0x284) 11 _
----- $8 FDEs1 (0x28E) il

..... 8 Po 52 (0x28c) hB4 (2270 e Sound Of Music

----- Q PID 1005 (0x3ED) 1341

---- $8 rD 1008 (ox3EE) i m RAC Hews

----- $8 P 1007 (0x3EF) B4

----- @ PUT PID 2167 (0x1047) B3

4@ Program 4231 (0x1087) BEC TWO &
i+ (@) Program 4351 (Dx10FF) BBC CHOICE %k
- Program 4415 (0x113F) BBC NEWS 24 = fnt vz T T

P
D)

@

=]

=1
=

=

e

n

=
@
1§

Figure 67: PID count
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What is the bit rate of each PID in a program?

Bit rates are displayed in the Program and PID summary views. The bit rates
displayed depend on the node highlighted in the navigation view.

Table 20: Bit rate views

Bit rates displayed in

Navigation view Node Summary view

Program Transport Stream All programs

Program Program Program PIDs

PID All PIDs All PIDs

PID Secondary nodes PIDs in secondary groups
(Reserved, Referenced, PIDs

Unreferenced, and User)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettings CaptureVu™ Help

| FIexNuPIus"" pAHHWSE|

Programs | Tests | SL/PSI | PIDs | Packets| ¥|| Summary | Thumbnails | (@) Program Tests | it rate Graphs |
actons v | O [{ 5
] ransport Stream: 4 4103, Network Hame: S = S
* Jrrogram 4167 (0x1047) BBC ONE = ‘E‘Q TTETE
@ PD 800 (0x258) ‘=S Program number = 4167 (0x1047)
~Q Poen zso) A Service Provider = BBC
-8 PD 602 (x258) A
@ P 603 (0x258) = Service Type = 1 (0x 1) (digital television service)
@) PID 850 (0x28A) p— l
+-$8 PID 851 (0x28B) MM
88 P 652 (mezse) Bl m The Sound Of Music 13:25 - 16:10 UTC
(@ PID 1005 (3ED) m
L §8 =0 1008 (oxaeE) B BBC News 16:10 - 16:25 UTC
. §8 PID 1007 (0x3EF) 184 bu Q@ PID 600 (0x258)
@) PMT PD 4167 (0x1047) B3 Show fiter @
@ Program £231 (0x1087) BBC TWO '&n ]
i@ Program 4351 (0x10FF} BBC CHOICE & 0 o (MPEC-2 ticeo)
%@ Program &415 (0x113F) 8BC NEWS 24 ||| | g1 (x259) 3 (0%03) (MPEG-1 Audic) 0.037
@ Program £479 (0x117F) BBC TEXT i§4{ 188 02 (0xz58) 3 (0x03) (MPEG-1 Audic) 0000
@ Program £543 (0x11BF) BBC PARLINT '@ 603 Bx258) & (0x08) (PES private dats) 1.000
Q [550 (0x284) 11 (0x0B) (DSM-CC UM messages) 0.008
(98 [551 (0x288) 11 (0x0B) (DSM-CC U-N messages, 0.000
(88 552 (0x250) 11 (0%0B) (DSM-CC U messages 0.000
@ |1005 (0x3ED) 11 (0x0B) (DSM-CC U messages, 0.100
|98 [1008 (0x3EE) 11 (0x0B) (DSM-CC U-N messages; 0.000
|98 [1007 (0x3EF) 11 (0x0B) (DSM-CC U-N messages] 0.000
(@ (3167 (0x1047) T 0.250
< | > £ >
s Avaiabilty lesync Q|| 22128335 Mbps @ 188|204 511,360 Packets| | Dv8 | o Extensions| | [l =]}

Figure 68: Program PID bit rate - bar chart

The PID bit rate summaries can be displayed as either bar charts or pie charts by
selecting the appropriate icon at the top left of the Summary view.

Barchat —— & a ~ Piechart
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M FlexNuPIus"" pAnawsk|
Pragrams | Tests | 51PSI | PIDs | Packets| 3| summery | Thumbnaii | @ Program Tests | Bitrate Graphe)

actons v | O [{ 5

£ @ Transport Stream: ld 4103, Network Name: S

oy || || = ¢ EeE——
@ PD 800 (0x258) ‘=S Program number = 4167 (0x1047)
Q oot ivse) A Service Provider = BBC

88 PD 602 iDx254) A
Service Type = 1 (Ox 1) (digital television service)

[ The Sound Of Music 13:25 - 16:10 UTC
BBC News 16:10 - 16:25 UTC
m > @ PID 600 (0x258)
@) PMT PD 4167 (0x1047) B3 J X
@ Program 4231 (0x1087) BBC TWO &0 PID Bit Rate Occupancy (Current) § (PO CnE AR

@ Program 4351 (0x10FF) BBC CHOICE ' | |-
(@ Program £415 (0x113F) BBC NEWS 24 '&f |
@ Program 4479 (0x117F) BBC TEXT 1546
@ Program £543 (0x11BF) BBC PARLINT

Cumulative Bit rate: 6.114 Mbps 4.926 Mbps

Kbps

48 760 Kbps:
Obps
0bps
PID 1005 (0x3ED) 51.136 Kbps
> PID 1006 (Ox3EE) 0 bps
> PID A 3EF) Obps
7) 18.048 Kbps

< | >

|T5 Aavallabiity QHsync Q|| 24128335 Mbps @ 188 | 204) 511,360 Packets| DVB| Mo Extensions| ] g‘

Figure 69: Program PID bit rate - pie chart

A selection of statistics for each program or PID is shown in the charts. Either
current or mean bit rates can be shown by selecting the Show Mean Values option
from the Summary view shortcut menu. For deferred analysis, the current bit
rate is the final bit rate.
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You can also display a bit rate graph for the highlighted node by selecting the Bit

Rate Graphs tab

B Flexvuplus™ £ Analysis

reams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysic View Mavigation Settings Captureyu™ Help

Programs | Tests | SUPS | PIDs | Packets|

Actions ¥

@O

ogram 4167 (0x104

@ P 800 (0x258) 'En il
Q PD 601 (1x259) A
-8 PD 602 (x258) A

=@ Transport Stream Id 4103, Network Name: 5
&

Data at Cursor
uTC

T
#{| summary | Thumbnails

@ Progran Tests | it rate Graphs |

addeaph ] | @, & W HE @

- Date/Time

@ P 603 (0x258) =
@) PID 850 (0x28A]
8 P 851 (0x2sm
88 PD 832 (0x28C)
(@ PID 1005 (3ED)
- §8 PID 1006 (0x3EE) |
.8 PID 1007 (0x3EF)
@) PMT PD 4167 (0x1047) B3
- @ Program £231 (0x1087) BBC TWO *&»
i@ Program 4351 (0x10FF) BBC CHOICE '8
@ Frogram £415 (0x113F) BEC NEWS 24 '
£ @ Program 4479 (0x117F} BBC TEXT}
@ Program 4543 (0x11BF) BBC PARLINT

< ] |

|TS Availability QHSWC Q” 24.128335 Mbps @ 188 ‘ ‘zm”sn,aﬁn Pad(ets‘ ‘ DVE”Nn Exhensmnsl

Figure 70: Bit rate graph
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What is the latest version number of the Program Association Table (PAT) in

the SI?

144

Tables and their versions can be found in the Tables (SI/PSI) view. When a node
representing a table is selected in the navigation view, the table identity and the
version are displayed in summary view (top right) as shown below.

Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

B FIexNuPIus"" pA"ﬂVS'E|

[ Programs | Tests| SUPSI | PIDs | Packets| | summary | section | s1 Repetition Graphs|

R Export...

=B Tables
=88 Programs (PATIPUTISOT actual)

Table ID 0, Version 12 @ 00:00:00 (carried on PID 0) *

8 P

PAT
Ll

B Networks (NTs)

&) Time (TOTAOT) Transport Stream ID = 4103 (0x1007)
&3 erc EmEDTRET) Network_PID = 16 (0x10)
& psw-cc
GPrograms
4167 (0x1047) FID 4167 (0x1047)
4231 (0x1087) PID 4231 (0x1087)
4351 (Ox10FF) PID 4351 (0x10FF)
4415 (0x113F) FID 4415 (0x113F)
4479 (0x117F) PID 4479 (0x117F)
4543 (Ox11BF) PID 4543 (0x11BF)

4

v

|T5 Aavallabiity QHsync Q” 24.128335 Mbps @ 188 ‘zm“ 511,350 Packets| ‘ DVBH No Extensions | ‘E,g‘

Figure 71: Table Identity and Version (summary view)

The table identity and version can also be seen in the table header using the Tables
(SI/PSI) section view as shown in the following figure.

| Surmrmary | Section | Sl Repetition Graphs

i

Frogram | Te.-sts| ] | FID || Packets |

= Tables Subtable [table_id 0 (0=0], transport_stréam
= Eg Programns (PATPMTAEDT actual) ersion |0 @ 00:00:00
PATR
28 PuTE {} PaT

= {} table_header

@ table id = 0 (0x ) (PAT)  <«—— Table identity
zection_syntax_indicator =1
Mgtweorks (NTs) section_length = 33 [0x21]

°
@
Titne (TOT/TOT) @ transport_stream_id =1 [0x1]
gl EPG (EIT/SDTIRST) @ version_number = 0 [0x0] . Version number
@
@
?

B8 SDT actual
E=] Bouguets (BATs)

currert_next_indicator =1
zection_number = 0 [0x0]
lmzt_=zection_number = 0 [0x0]
= {} programs
{} program_numioer = 0 [0x0]

Figure 72: Table Identity and Version (section view)
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Examine a transport packet

A transport stream packet is a unit of data that contains a header and a payload.
The Packets view allows individual transport stream packets to be identified and
examined.

Navigating around the = The navigation bar at the top of the Packet summary view is used to move
packets  between packets. How the controls work depends on the selection in the Packets
navigation view. If All Packets are highlighted, the controls will operate on all
packets. If a PID has been identified, added to the PIDs node and highlighted, the
controls will operate only on packets carrying the selected PID.

EIKIERER| o 059659

Current packet position

The packet position bar shows the position of the selected packet in the stream.

The controls work as follows:
Selects the first available packet (in the stream or carrying the
selected PID).

Selects the previous available packet (in the stream or carrying
the selected PID).

Selects the next available packet (in the stream or carrying the
selected PID).

Selects the last available packet (in the stream or carrying the
selected PID).

Opens the Go to packet dialog box.

)| ()] ) L | =

The packet position bar can also be used to navigate through the stream. You can
use the cursor to point to and click the next packet to be displayed. Similarly,
double-click the packet number in the bar and enter the required packet number in
the Go to packet... dialog box.

Looking at the packet ~ When you have identified and selected a packet, the Packets summary view
displays the interpreted code and the raw data in hexadecimal and ASCII format.
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TSCA - SI/PSI nodes

Primary nodes

The Tables view (SI/PSI tab) displays the service information in tree form. The
tree represents all of the service information tables found in the analyzed stream
that comply with the selected digital video standard (including MPEG program
specific information, DVB service information, and ATSC and ISDB program and
system information protocol). The tree contains nodes for each table found; tables
and nodes are grouped together functionally.

This section identifies the nodes that may be present for each standard.

The following figure shows an example of Table navigation view with DVB
stream interpretation selected.

The following tables in this section show the nodes that can be displayed in the
SI/PSI navigation view depending on the selected interpretation standard and the
content of the stream.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View MNavigation Settings CaptureVu™  Help

’

Ope: Configuration..
P FlexvuPlus™ ‘
[ Programs | Tests| SUPST | pips || Packets

g Eport...

=3 ~
@8 Programs (PATPWTISDT actual) Tables T

B pat
E-A8 PUTs * Programs (PAT/PMT/SDT actual)

+-8) PMT Program 4167 (BBC ONE) * Networks [NITs)

v g PMT Program 4231 (BBC TW} « Time (TDT/TOT)

+-8) PMT Program 4351 (BBC CHOICE)| $ e gl PR

B PUT Program 4415 (83C NEWS 2 * EPGEVSDIRS])

8 PMT Program 4479 (BBC TEXT) * DSM-CC

- (B PUT Program 4543 (BBC PARLMN
B8 soT actual
(-5 Networks (NITs)
) Time (TOTITOT)
[+ EPG (EMSDTIRST)
=-£9 psu-cc

£ PD 850 (0x284)

= (3 DSM-CC U-H Messages

~ B3 psisy
B ous)

(8 DSM-CC Download Data Messag
9 D 653 (0x28D)

-3 PD 851 (0x295)

£ PD 1005 (0x3ED)
-5 PD 1008 (0x3F0)

£ P 1011 (0x3F3)

-85 PD 1014 (0x3F8)

3

< | = k3 >

Ts Avalabity Q)| sync D) 24.128335 Mbps @ 188|204/ 511,360 Packets | DVB ||No Exr.ensmns; | B

Figure 73: Primary SI/PSI nodes (DVB example)
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Table 21: MPEG SI/PSI

Primary node Subsidiary node
TS info
TSDT
Programs
PAT
PMT PIDs
Conditional access
CAT
Other Tables
Table 22: DVB SI/PSI
Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
PMT PID +
SDT
Bouquets
BAT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
DT
EPG
This TS
SDT Actual
Service (number,
name)
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Table 22: DVB SI/PSI (cont.)

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
Now/Next (EIT P/F)
Schedule (EIT
schedule)
Other TS
SDT Other
Service (number,
name)
Now/Next (EIT P/F)
RST
MHP apps
Other tables

Table 23: ATSC SI/PSI

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info

MGT
Programs

PAT

PMT PIDs

VCT CIT

ETT-V
Conditional
access

CAT
Ratings

RRT+
Time

STT
EPG

Source/Services

EITO > EIT127

Directed
channel
change

DCCTid +

DCCSCT
Other tables

148 MTSA-HW and MTSA-PC Analyzer Applications User Manual



TSCA — SI/PSI nodes

Table 24: ISDB-S SI/PSI nodes

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
SDT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
EPG
This TS
SDT Actual
Service
(number,
name)
Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)
Other TS
SDT Other
Service
(number,
name)
Now/Next (EIT
P/F)
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Table 24: ISDB-S SI/PSI nodes (cont.)

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)
Maker
id/model id +

Other tables

Table 25: ISDB-T and -TB SI/PSI nodes

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
SDT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
EPG
This TS
SDT Actual
H
Service
(number,
name)
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Table 25: ISDB-T and -TB SI/PSI nodes (cont.)

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

Service
(number,
name)

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

Service
(number,
name)

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

SDTT

SDTT(H)

Maker
id/model id +

SDTT(L)

Maker
id/model id +

Other tables
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PES Analyzer - Getting started

The Packetized Elementary Stream (PES) Analyzer performs a series of user
selectable conformance tests on a previously recorded file. Files can be interpreted
according to either the ATSC or DVB standards. Once the file is analyzed, users

can view the results of the selected tests and browse through the content of the
PES packets.

ﬂ!__ Tektronix MPEG-2 PES Analpser - Ad_10s.mpg

Filz  Edit %ew ‘“Window Help
M=l alz| EmdT aal |
@ Ad_10: mpo - Progiam Stuctule 0] =] 0 Ad_10s. mpg - Event Lag - 0] x]
B Program 1 Frog. 3 Audio (PID 107]. PES Packet 80 FTS Enor. PTS difference is greater than 700ms <
Yides, [PID 289.0:0121) Prog. 3 Audio [PID 106]. PES Packet 80 : PTS Enor. PTS difference iz greater than 700ms
MPE[; Audio IP’lD 2900401 22 Fron 3 Audin (PID 1071 PFS Packet 75 PTS Fuor PTS difference i armater than 70
MPEG Audin, (PID £8 ﬁxmse] @ Ad_10s.mpg - PTS/DTS View Prog. 1 Video (PID 289) M= E3
o MPEG Audio, [PID 89,0:0053) EPEFEI BPBEPEPBPEBEPBI BPEBP Diata 3t Cursor IA
MPEG Audio, [PID 30.050054) [ 80ms™™ 3 - - i I TR . o 0 ALY Number
+ Program 2 | ! I —
= Frogam 3 : ; N ; N e
£ Progand i : ] : | PSP e
+ Program 5 i 0
| | ] | ] At
! H L H H L H 41638591
d0ms-| -2 R R R R Rl B B e i I B == R
{ : : : : : : brs
i ! ! ! ! ! ! Not Present _ —
strean | | | | | | | Frame Sate
id | Mok Valid
{ : : : : : : Frams Type
| OO | 0005 widen,_shsam | | I
: : C : : Firofike & Level
Rl i Sl Sl SR s e B S Fieserved & Reserved
PES data 0000 D120 ° 0240 0380 ° 0430 DEO0 0720 0840 [T ChomsFamat
scrambling PES alignment [ *PTS Acoess unit time (3] Ressrved
control | PO indicator | +DTS [um of durations) Polure Sze H sVl
L [[=—= g i g ‘ . i g g i T
afer han T00ms
-
= PTS
[ ¢ [0 ]]| Packet Humbes [0 Gt || [Prog. 1video PID 289) ]
[TS Packet 1083 | ' P

Information can be viewed in graphical and textual formats. To analyze and view
the Transport Stream packets, use the companion program TS Analyzer, which
can be run at the same time as this PES Analyzer.

The functionality provided includes:

B Display of program structure showing the programs contained within the
transport multiplex and the PES streams which make up each program.

m  Display an interpretation of PES packet for individual packets.

®  Hexadecimal representation of PES packet.
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Starting the program

154

m  Extraction and display of Presentation Time Stamp (PTS) and Decoding Time
Stamp (DTS) information from the PES packet header.

B Display of access unit information for video and audio access units.

NOTE. The examples shown in this chapter are taken from both ATSC and DVB
compliant transport streams. An example of each type is sometimes shown

as a reminder that both standards are supported or where a difference needs
explanation.

Start the program from the Start menu.

B rektronicMTSA

T#‘ Buffer Anabyser

Carousel Analyser
Carousel Generator

ES Analyser

ISDB-T Remux

Make Seamless Wizard
MPEG Player
Multiplexer
Optionkey Wizard

PES Analyser

SecriptPad

TS Compliance Analyzer

T5 Editor
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Alternatively, you can double click the Deferred Time Analyzers folder from
your desktop and then open the PES Analyzer application.

Deferred
Time
Analyzers

Iﬂ T | Clsersh,..,

Home I Share I‘-.Fivax-".rI

"~

Shorteut ...

FManage

A » Deferred Time Anal...

Mame

Manage

v O

a

Initial appearance

7 Quick access
LI| Buffer Analyser

B Desktop 8 Carousel Analyser
‘_ Downloads Y8 ES Analyser
= Documents
= Pictures = B
Deferred Time Analyz & v <
Siterns 1 item selected 1.05 KB

X
2]

Search De

Once the program has started and is ready for use it will open a Main Window.

When the program first starts it looks as follows:
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3 PES Analyser - O e
File View Settings Options Help

M| & 2] BlEmmEl &]a)

} 1 | . ||| Packet Mumber ID Goto | | I j
PES Analyser [ [NUM [Nt Valid [

N

The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window or moved to either side or the
bottom of the main window.

The Status Line at the very bottom of the window may be hidden from view.
Because no file is open, it is displaying a message that the TS packet number
is Not Valid.

Above the Status line is the Slider bar. This has three groups of controls for
selecting streams and packets within a file. This may be moved to the top of
the window.

Initial menu options  PES Analyzer presents different menus and options, depending on whether a file is
open for analysis. The menu options available when no file is open, are as follows:

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.
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File menu options. The File menu contains the options listed in the following
table.

Table 26: File menu options

Command Function

Open... Opens an MPEG file for analysis. The
program opens the file selection dialog
allowing the user to choose the required file.

Print Setup... Opens a dialog for selecting which printer
and associated options to use.

1 <filename> A list of the four most recently analyzed files.

2 <filename> If the program has recently been installed the

3 <filename> list may be empty or hold less than four files.

4 <filename> Selecting a filename opens that file for
analysis.

Exit Finishes running the program.

View menu options. The View menu contains the options listed in the following
table.

Table 27: View menu options

Command Function
Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the status bar.

Settings menu options. The Settings menu contains the options listed in the
following table.

Table 28: Settings menu options

Command Function

Test Options Opens a dialog for setting the Conformance
Test Options for analyzing and interpreting
the PES information in stream files.

Options menu options. The Options menu contains the options listed in the
following table.

Table 29: Options menu options

Command Function

Limit Repeat Errors Lists the first 20 occurrences of each error
type in the event log.
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Options

158

The MPEG and ATSC Conformance Test Options for MPEG and ATSC may not
be modified when a file is open. To change them, all files must be closed, the test
options modified, and the file opened again.

Select Test Options from the Settings menu to open the Conformance Tests dialog.

@MPEG-2 PES Analyser

File Wiew BSIUGNEE Options  Help

El Dﬂl Test Options I | |

NOTE. The Settings Menu is only available when there is no file open. It is hidden
when a file is opened and redisplayed when the file is closed.
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Conformance tests  The dialog box contains two tabbed pages containing tests relating to MPEG and
ATSC files, respectively. Note that the MPEG tests are sufficient for DVB streams.

Test of PES header syntax (MPEG). The tests of PES header Syntax are based on
the conformance requirements laid down in the standards document ISO/IEC
13818-4 for Packetized Elementary Streams

Each check box uses the same name for a particular test as the standard. For
example, to test conformance to the standard for the length of PES packets select

the PES_packet length option.

Test Settings E I
MPEG | aTSC |
— Test of PES header Syntax
[V ‘packet_start_cade prefid [V PTS interval <700ms
v stream_id ¥ rep_chil
¥ PES_packet_length V' wariginal_stuff_length
v PTS_DTS flags [V stuffing_byte
¥ PES_header_data_length v padding_byte
[ CRC
[Mate: this option may add up
to B0% to the analysis time]

| Ok | Cancel HElD

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.
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Test of PES header syntax (ATSC). When the ATSC Stream box is checked,
selected streams are interpreted according to the ATSC standards, A/52 and A/53

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

Test Settings I
MPEG ATSC |

¥ ATSC Stream

— Test of PES header Spntax

I PES_scrambling_controt ¥ PES_piivate_data_flag

¥ ESCR_flag W pack_header_field flaq

[V ES_rate_flag W program_pkt_seq counter_flag
¥ PES_CRC_flag WV P-STD_buffer_flag

[¥ | data_alignment_indicator
[video anly]

| ak I Cancel HElm

For streams in a DVB standard stream, leave the ATSC Stream option unchecked.
The ATSC Stream option is disabled (grayed out) if the software license is only
for the DVB standard.
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Opening a file

Opening a file from the
menus and toolbar

Any file holding a recorded or synthesized sample of a stream can be opened
for PES Analysis by this program. To analyze the Transport Stream packets,
open the file in the TS Analyzer. A file can be opened by both the TS and PES
Analyzers at the same time.

To open a file select the Open option from the file menu. If the required file is in
the list of recently analyzed files then it can be opened from the list to save using
the Open file dialog. Alternatively, use the Ctrl+O keyboard shortcut.

ﬁ:HPEE-Z PES Analyser

Eiew Settings Help

_ I
Print Setup. ..

1 Ad_10z.mpg
2 4d Bs.mpg

3 4d Tminmpg
4 Ad Bz.mpg

E =it

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol:

Eﬂlﬁ'l fﬁ'l ?l
by

Once a file is open this button will be disabled, which is shown by being "grayed
out".
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Window layout ~ Program Structure and Event Log windows are opened as soon as the file is

opened. The layout of the windows will have been saved from the last time the

program was used. If the program has just been installed, the windows will be in
the application default Cascade arrangement, which looks like this:

@ MPEG-2 PES Analyser - Ad_10s.mpg M= B

File Edt View Optiors Window Help

=5 &2 [EEmm| S

@ Ad_10s.mpg - Progiam Stucture I [=]

Bl @ #d_10s.mpg - Event Log [_[O]x]

Category Feference Comment

- | @ Information Starting Analysic

| D Tine 00:01:02 Analysis Complete Interval

i

.

.

B

| | |
| } 4| ‘ Packet Number [ Goto | | [Prog. 1 viden (PID 289] =l
PES Analyser [ [NUM [T5 Packet 1043 [ 4
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Many users rearrange the windows so that the Program Structure and Event Log
windows do not overlap. The examples in this manual often use this arrangement:

i! MPEG-2 PES Analyser - Ad_10s.mpg =] B3
File Edit Yiew Dptions ‘window Help
]| 32| [@Blmm| 2|
i!j_AdJ 0s.mpg - Program Structure J[=] B || & Ad_10s.mpg - Event Log (=] B
EF-— Program 1 Category Rsference Comment
{3, video, (PID 283.0:0121) @ Information Starting Analysis

Budio, (PID 230.040122)
Audio, [PID 88,0:008)

Audio, [PID 83,0:0053)

Audio, [PID 90,040054]

- Program 2

- Program 3

- Program 4

- Program 5

Time

00:01:02

Analysis Complete It

al
D HPackelNumbEr 0

} Goto “Frng 1 Videa [PID 289) =l
FES Analyser [ [NUM [T5 Packet 1043 [ 4

NOTE. The above example is from a transport stream interpreted and labeled
according to the DVB standard. If the ATSC Stream option is set the elementary
streams will be interpreted and labeled according to the ATSC standard. For
example: audio streams would be labeled AC-3 Audio, instead of Audio or AAC

Audio.
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PES analysis

The PES Analyzer program now starts to analyze the file for conformance to the
selected tests. Due to the very efficient algorithms used by the program, it will
analyze large files in a few minutes. Other algorithms have been seen to take
much longer. The rightmost pane in the Status bar shows a progress indicator

during Analysis.

As the file is analyzed messages are written in the Event Log and the structure

diagram is drawn in the Program Structure window. When the processing is

finished an "Analysis Complete" message is written in the Event Log.

=
Ele Edit View Window Help
=R B ]
Qo omloreey Evenilog | M|
Program 1 Category Reference Comment o
3, Video, [PID 289.0:0121] & Information Starting Analysis J
Audio, [FID 250.0:0122) €3 Ermor Prog. 3 Audia (PID 107). PES Packet 3 PTS Enor. PTS difference is greater than 700ms
Audio. [PID 88.0+1058) €3 Enor Prog. 3 Audio (PID 106], PES Packet 3 PTS Ennor. PTS diference is grester than 700ms
Audie, [PID 63,0x0053) €3 Error Prog. 3 dudio (PID 107). PES Packet 4 PTS Enor. PTS diference is greater than 700ms
Audio. [PID 30.0:0034) Q Error Prog. 3 Awdio (PID 108). PES Packet 4 PTS Enar. PTS difference is greater than 700ms
;;Zg;:zi €3 Enor Prog. 3 Audio (PID 106], PES Packet 5 PTS Enror. PTS diference is grester than 700ms
Program 4 €3 Enmar Prog. 3 Audio (FID 107). PES Packet 5 PTS Enor. PTS difference is greater than 700ms
Frogram 5 Q Error Prog. 3 Audia (PID 107), PES Packet & PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 108], PES Packet B PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 7 PTS Enar. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID 107), PES Packet 7 PTS Emar. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 8 PTS Enar. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID 107), PES Packet & PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 107], PES Packet 3 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 3 PTS Enar. PTS difference is greater than 700ms
Q Errar Prog. 3 Audio (FID 107], PES Packet 10 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio [PID 106). PES Packet 10 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID107). PES Packet 11 PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 108], PES Packet 11 PTS Enor. PTS difference is greater than 700ms
QI Eror Prog. 3 Audio [PID 1061, PES Packet 12 PTS Enor. PTS \I:I\fferencs is areater than 700ms _'LI
l L4

| HPackelNumher |4El

| [Prog. 1vide (PID 289) =l |

[T [NUM [TS Packet 41311 [
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PES Analyzer — Menus and controls

When a file is open the program presents a different set of menus and options.
They change as soon as the Program Structure and Event Log windows appear.
For example, the Open file commands are replaced by Close file commands.

Toolbar

d=] sl?| |2 mnjn = &l

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Closes the current file. This button becomes enabled the
moment a file is opened and analysis starts. If the wrong file is
being opened, or the wrong options are selected, clicking on the
button will abandon the analysis and close the file.

Open a file. This button is disabled when a file is open.

|2

Print the contents of the current window.

Opens a dialog which displays the program version number.

Toggles the Event Log window. When the button is in this state
the window is not visible and clicking on the button will open
the Event Log.

Toggles the Packet Hex view window. When the button is in
this state the window is not visible and clicking on the button
will open the Hex view.

Toggles the PTS/DTS view window. When the button is in this
state the window is not visible and clicking on the button will
open the PTS/DTS view.

Toggles the Header Interpretation window. When the button is in
this state the window is not visible and clicking on the button will
open the Header Interpretation.

Zoom In on data in the PTS/DTS view. This button is only
enabled when the PTS/DTS view is the current window.

Zoom Out from the data in the PTS/DTS view. This button is
only enabled when the PTS/DTS view is the current window.

B | |m |

5]

|

& |12
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The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this click on the background inside the Toolbar, that is, not on one of the
buttons, and drag into the main window area. The result is a self-contained
window which looks like this:

I |
H=| 32| 2laomD| &|a]

To replace the Toolbar on the window border drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edges.

Status bar

View the PTS/DTS Analysis [ |TS Packet 1043 | 4

The Status bar may be hidden from view, but if visible is always at the bottom of
the main window. It displays the following information about the program and
keyboard states:

Message Field
Gives a description of any Keyboard
button or ogtion over which Mode
the curzor iz placed.
Way also showy ather
non-critical messages,

g

TS Payload Unit Start
Displays number of TS

packet in which current
PES packet starts

Anahysis Status
Dizplatys & progress
indicatar wvhile 5 file
iz being loaded.

Indicators

TS Packet 1043

Namal

Actie

[CaP [NUM TS Packet 1043 | 2

ﬂ!; Tektronix MPEG-2 PES Analyser
File Edt [P window Hel

= " o Toolbar =
w Status Bar

The message changes 10
describe the function of the buttan
aF mendU option ower which the

mouze painter is placed.

w Event Log
Hesx
|rterpretation
PTS/DTS Timing

(The des=cription iz =till displayed
if the button or option is unavailakle,
e greyved out )

ier the PTS/DTS Analwsis | | TS Packet 1043 | ‘/f:l
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Slider bar

S | » IHPa-:kel Humbe [0 Golo |H|ng_ 1 Video [PID 228) =]

The Analyzer can display the contents of any PES packet in the currently loaded
file. Packets are numbered, within a PID, according to their position in the file; the
first PES packet of each PID being PES packet 0 (zero). The Slider bar displays
the packet number and the PID for the current packet.

The slider bar controls are as follows:

Slider

Slider Move to Move to
Scrolls through packets of previous next
the selected type in the file. packet packet
4
A\ 7l
Start End
of file of file
Packet number Packet Number Goto Button
Shows current packet number. Selects packet shown
New values can be typed in. in Packet Number

Facket Mumber |?3 N 5ot

click in the )
Packet Number then click

Field and type in on the Goto
the new value Button.

To select
a packet by
number
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Packet type - elementary
stream

Selecting packet type

168

Packet Type Drop Down Arrow Button
Shows currently selected "Drops down’” the list of
Elementary Stream. Streams to choose from

||F'ru:ug. 2Wideo [PID 305) j

Like the Toolbar the Slider bar can be dragged from the edge of the main window
into a floating pallet; to do this click on the background inside the Slider bar

and drag it into the main window area. The result is a self contained window
which looks like this:

=
| J ] |PacketNumber [54 |lProg.2Video (PID 305) vl

To replace the Slider bar on the window border drag it over the border until the
outline changes shape. Unlike the Toolbar it can only be placed on either the top
or bottom edges.

The Slider and Packet Number can only select packets in the currently selected
program stream. The stream is indicated in the Packet Type dropdown list and by
the magnifying glass symbol in the Program Structure window. A new stream
may be selected from either the list box or the window.

& Ad_10s.mpg - Program Structure =] B

[=]- Program 1
e Wideo, (PID 289.0:0027)

Elementary Stream n':'«.ud?o, [PID 290,001 229
by selecting the Name in - Audio, [FID 88, 0x0058)
the Program Structure or Aud!ﬂ, [FID B9.0:0059)
from the List in the Slider s Padio, [PID 50.0x0058)

Bar "List Box”. iz} Program 2
‘--Q Video, [PID 308,001 31)

e fdio, [PID 306,0:0132)
e Budio, [PID 96,0x0060)
[
[

Choose an

— e i,

PID 57, 0=00851)
Prog. 2 &udio [PID 308 e i, [PID 98, 0:0062]
Prog. 2 dudio [PID 36] - Program 3
Frog. 2 &udio [FID 37) - Progiam 4

Prog. 2 Audio [PID 98)
Prag. 3 Widen [PID 160
Piog. 3 Audio [PID 104]
Prog. 3 Audio [PID 105)
Prog. 3 Audio (PID 105)
]
]
]
]

- Program 5

Frog. 3 audio [PID 107
Frog. 4 Yideo [FID 161
Prog. 4 Audio (PID 112
=== Praq. 4 Audia [FID 113

ﬂ:“ Prog. 2 ¥ideo [PID 305] | ]

vl
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Menus and options

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

File menu options  The File menu contains the options listed in the following table.
Table 30: File menu options

Command Function

Close Closes the current file. This option is available as soon as
analysis starts. If the wrong file is being opened, or the wrong
Conformance Tests are being run, selecting this option will
abandon the analysis and close the file.

Print Prints contents of the current window.

Print Setup Selects printer and configuration.

Exit Closes any file that is open and terminates execution the
program.

Edit menu options ~ The Edit menu contains the options listed in the following table.
Table 31: Edit menu options

Command Function

Copy Copies the contents of the current window to the MS Windows™
Clipboard, from which it can be pasted into a document in
another application.

Copy TS Packet Allows the user to select an AU (access unit) within the PES
Analyzer, and then copy the TS packet number onto the
Windows clipboard. The Stream Analyzer may then be started
and Paste TS packet selected to go to the packet number
retrieved from the clipboard.

View menu options ~ The View menu contains the options listed in listed in the following table.

Table 32: View menu options

Command Function

Toolbar Shows or hides the Toolbar, which provides a set of convenient
shortcuts for the more frequently used menu options.

Status Bar Shows or hides the Status bar.

Event Log Shows or Hides the Event Log.

Hex Shows or Hides the Hex view.

Interpretation Shows or Hides the Packet Interpretation view.

PTS/DTS Timing Shows or Hides the PTS/DTS Timing Analysis window.
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Options menu options ~ The Options menu contains the options listed in the following table.

Table 33: Options menu options

Command Function
Limit Repeat Errors Only lists the first 20 occurrences of each error type in the event
log.

Window menu options ~ The Window menu contains the options listed in the following table.

Table 34: Window menu options

Command Function

Cascade Arranges all the windows so that they are neatly stacked; only
the title bars show behind the active window.

Tile Reduces and moves windows so that they can all be seen at
once.

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program's main window.

1 <window title> Makes the named window active, putting it on top of any

2 <window title> windows which had been hiding all or part of it.

3.. etc.

Help menu options ~ The Help menu contains the options listed in the following table.

Table 35: Help menu options

Command Function

About PES Analyzer... Opens a dialog that displays the program version number.
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PES Analyzer — Packet Hex view

lﬁ Ad_10z.mpg Hex View - Prog. 2 Yideo (PID 305) PES Packet 171

00000 00 00 071 B0 00 00 B0 50 05 21 08 17 B4 B3 00 00 i
oooto 01 00 00 1A 4B DB B& 00 00 01 BS 85 59 57 98 00
00020 00 00 01 01 32 BF 23 20 8B EE O3 EY &D 9B 10 7F
Oo030 EF 03 78 3C C6 A9 61 66 51 BF 10 B4 62 C5 AS 92
00040 35 COCF 2C 43 66 41 C3 70 7B C3 Aa 81 66 DC 04
Oo00s0 21 24 70 AB AS 04 26 A0 50 73 03 BG AD 89 D4 27
000ED D4 1C 73 83 834 7 61 DE B0 5 EA 07 2D 40 A2 EA
noo70 05 C7 70 14 4E 85 D503 9E A1 EE EO 2D DC OB AE
00080 04 FD B4 As 1B EE 02 CB 3C F8 7D FC C7 07 05 BC
00090 o5 50 F7 20 53 3C 63 4F 4E 04 CF 17 A4 BE BV 02
000s0 CE 35 DA 05 7E 6O 69 D4 EF 52 10 C2 D4 13 6C ED
000B0 32 4F 4F 4E 15 D2 D291 E3 29 6E SO B3 1B F1 13
000CO 46 32 CA 73 OB 92 34 Ba 71 80 44 25 B0 00 00 O
00000 02 32 37 E2 OB BB 06 2D 11 AS A7 4E 99 46 F2 43
O00EO &8 24 BE DO 01 EC 0F &1 74 7F CF 40 1B B4 00 1C
OOOFD 32 81 4C 41 €2 00 o6 91 1A SA 0z 02 EO FF 9F 18
00100 43 28 2C 05 CC BO 30 DO BE EG B9 68 C4 70 63 18
00170 00 40 02 D0 15 80 00 A3 26 1A 74 21 D3 0B 0A &8
00120 BY 47 FC F2 00 3B 63 59 00 EE 64 2C 06 40 03 96
00130 E4 B9 6B AD 15 44 34 EO FF SE O6 01 ES 02 B &7
Oof40 30 01 FE 02 88 6D CEAD2D1 D8 X 9 1F EOCC 79 LI

OO En._ MO0 C1 an an w0 Ol a0 0. O 20 A0 A0 01 of Nih DA

This is the lowest level view of the PES Packet data. It displays the contents of
every byte in hexadecimal. Each byte is represented as a pair of hexadecimal
digits. The window may be resized to display 16, 32, 48,... bytes of information
on each row.

The four digit numbers in the left most column are the addresses of the first (that
is, leftmost) byte in the row. The addresses are shown in hexadecimal.

'ﬂ Ad_10s.mpg Hex View - Prog. 2 Yideo [PID 305) PES Pack

OO0 00 00 01 ED 00 00 80 20 05 21 04 17 B4 B3 00 00
oo o1 00 00 1A 4B DB B3 00 00 01 BS 85 55 57 33 00
00020 00 00 01 01 32 BF 23 20 8B EE 02 EF AD 98 10 7F

M NM 72 90 rfE A9 FR1 BE R BF 1N BRA E> 'R AR 92

Column of bytes addressed

Address Column
showing address
of byte immediately
to the right
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Packet header

The Hex view displays the bytes holding PES Packet header information in
magenta color text. For example here is a packet containing a PTS field, from a
video stream:

'ﬂ Ad 10z.mpg Hex Yiew - Prog. 2 Yideo [PID 305] PES Packet 171  [Hj=] E3
00 00 0 EOO0 0D 80 80 058 21 0A 17 B4 B3 00 00
3 :

o

D
0oos0 21 24 70
00060 Cd 1C 73 &
0oo¥n 05 CF 70

et NA Fh |

bytes carrying header
information displayed in
magenta colour text

7 M7 NR P

The most significant two bits of the eighth byte (that is, the byte at address
0x0007) contain the PTS DTS flags. The ninth byte (address 0x0008) contains
the PES header data_length, which specifies how many additional bytes are
present. In the above example:

PTS DTS flag=2
PES header data length =5

These specify that there is a 5 byte Presentation Time Stamp (PTS) field in
the header. The contents of the PTS are 21 0A 17 64 B3 and they follow the
PES header data length.
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The preceding packet, from the same stream, carried both a PTS and DTS field:
PTS DTS flag=3

PES header data length = 10 (shown as 0A in hexadecimal)

'ﬂ Ad 10s_mpg Hex View - Prog. 2 ¥ideo [PID 305] PES Packet 170 [Hi=] E3

00 0001 EO Q0 00 280 Co0s 31 0A 17 3003211 0A
17 48 93

23
A2 DB
D154 B4

DO0ED D& 30 6D — 00 1E 84 04
Qo070 o FC 77 19 bytes of header 1EBAD A
information including the

DTS and PTS fields

Instead of having to interpret header information from the Hex view, the PES
Analyzer provides the Header Interpretation window. This interprets the header
and displays the contents, in table form, according to the MPEG-2 standards.
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PES Analyzer - Event log

Categary Reference Cormmenk -
ﬂ Imformation Starting Analvsis J
Q Error Prog. 3 Audio [PID 107), PES Packet 3 FT5S Enor. FTS difference i greater than 700mz
EB Error Prog. 3 Audia [PID 108). PES Packet 3 FTS Enrar. PTS difference is greater than 700m:
€3 Error Prog. 3 Audio [PID 107). PES Packet 4 FTS Enor. PTS difference iz greater than 700ms
€3 Enrar Prog. 3 Audio [PID 106), PES Packet 4 PTS Emar, FTS difference i greater than 700ms
Q Error Prog. 3 Audio [PID 108], PES Packet 5 FT5S Enor. FTS difference iz greater than 7 00mz
€3 Errar Prag. 3 Audio [FID 107). PES Packet 5 PTS Emar. PTS differenice is greater than 700ms
€3 Enrar Prog. 2 Audio [PID 107), PES Packet & PTS Emar, FTS difference i greater than 700ms
Q Error Prog. 3 Audio [PID 108], PES Packet £ FT5S Enor. FTS difference i greater than 700mz
EB Error Prog. 3 Audia [PID 108). PES Packet 7 FTS Enrar. PTS difference is greater than 700m:

'E:]' Errar Prog. 3 Audio [PID 107). PES Packet 7 FTS Enor. PTS difference iz greater than 700ms

E:i Error Prog. 3 Audio [PID 108], PES Packet 2 FT5S Enor. FTS difference i greater than 700mz

Q Error Prog. 3 Audio [PID 107). PES Packet 8 FT5S Enor. FTS difference i greater than 7 00mz

€3 Error Prag. 3 Audia [PID 107). FES Packet 3 PTS Enar. PTS difference i greater than 700m:

€3 Enrar Prog. 3 Audio [PID 106), PES Packet 3 PTS Emar, FTS difference i greater than 700ms

f:’ Error Prog. 3 Audio [PID 107), PES Packet 10 PTS Enor. PTS difference iz greater than 700ms

E:’ Error Prog. 3 Audio [PID 108). PES Packet 10 PTS Emor. PTS differance iz greater than 700ms

€3 Enrar Prog. 3 Audio [PID 107), PES Packet 11 PTS Enor, PTS difference is greater than 700ms

Q Error Prog. 3 Audio [PID 108), PES Packet 11 PTS Enor. PTS difference iz greater than 700ms

€3 Error Proa. 3 Audio [PID 1061, PES Packet12 ~ PTS Enor. PTS -Ijifferen-:e i& qreater than 700ms hd
L o

The program always opens the Event Log window when it starts to analyze a
file. As the file is analyzed the program writes the results to the window as they
are produced. When processing finishes an "Analysis Complete" message is
appended to the report.
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Packet selection

If a warning or error message gives a packet number, that packet may be inspected
by selecting the message. For example, here is an extract from a file with PTS
errors on two of the Audio streams:

¥ Erroi Fiog. 34udio [FIL TUB). FES Packet & Fl3 Emor Fi s diterence is geaker than Ulms
e’ Errar Prag 3 Audia [PID 106), PES Packet 7 PTS Errar. PTS differenice iz greater than F00ms
' Prog. 3 Audio [PID 107]. PES Packet 7 PTS Enor, PTS difference iz greater than 700ms
Q Ermar Prog. 3 Audio [FID 106). PES Packet 8 PTS Error. PTS difference is greater than 700ms
& Brre 2 Andis (PID ANTY PES Palat 0 BTE Frrmr PTE differemee is areater Hyam T0ms

Clicking on the message for Prog. 3 Audio (PID 106), PES Packet 78 selects both
the program stream and the packet. This is reflected by the Slider bar, in the
Program Structure, Hex view, Header interpretation and PTS/DTS views.

The Slider bar will look like this:

| Packet Murmber |? [Efa] {a] | IF'rn:-g. Jadwdio [PID 107 j

In the program structure view, the magnifying glass icon, Q, appears on the
selected stream:

ﬂ test_seamless.mpg - Program Struct... =] B2

g Pogamtr

............. Video,

o, [PID 280,0:0122)

-« Audia, [PID 88 0R0058)
[
[

FID 283.0x0121)

- Audio, [PID 89.0:0055)
............. Audin, [PID 90, 0:0054]
e [— F'mgram 2
B Frogram 3
............. Yiden, [PID 160, 0x0040)

[
L [FID 104,0=:0082)
- budio, [PID 106,0-00869]
[
{

------------- Audin, [PID 105, 0=006A]
A2, Audia, (FID 107 0<006E)
[ Program 4
e — Program 5

If the Hex view and/or Header Interpretation windows are open they will be
updated to show the contents of the selected packet. If the PTS/DTS view window
is open the cursor is placed on the packet and the panel showing the Data at
Cursor is updated.
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Having selected the packet it can now be inspected with other tools. The
information in the Header Inspection and Hex view windows will look like this:

g test_seamless.mpg Header Interpretation - Prog. 3 Audio [PID 107) PES Packet 7  [H[=] [EY !

T }si=
pack st .
shart sltream zglfet _5 df"
code id i 5 dif
prefix ? 'S dif
0x000007 | 04C3 audic_stream] 0=0BB2 Fs di
1S diff
PEs [ oo | et original [ PT5 | . [ £ ?.5';" addtiorall peg | g [[5 dif
serambling| i slignment ] coppnght]  or DTS i rate "t:j C.E'fpl" crc |exter |[5 di
control | PO indicatar copy | Flags ag flag n;'l‘;; If?a; flag fla |5 diff
00 00 | 0w0 D40 | 040 | OwZ | Ox0 |Oe0| OO | Ow0 JOx0| 0Ox |[[5dN

'ﬂ test_seamless.mpg Hex Yiew - Prog. 3 Audio (PID 107) PES Packet 7

00 0D 07 L3 0B BZ 60 80 05 23 4€ C3 7D oF 20 47
PTS 0010 45 A7 78 F1 17 DAB3J 0B 24 22 6C 24 B2 7C 1& 30
00020 D7 SE CO A2 05 FD 97 21 EC 80 F9 44 CC B1 BD 24
00030 61 DS OC 52 F9 F& B 41 BO 5F 40 9€ 07 BC 5F 2B
1404032073] \nap4n 0C E1 OC 2E 65 CB 03 D2 EB 10 88 63 31 90 DC 25
= 0050 24 B9 43 67 BO 83 52 D1 A8 1F 42 F1 50 CE G4 A8

NO0G0 4C 92 02 GC 0B D5 DE 38 C3 04 B3 24 B4 CC 1 4D

“““ M o AU Mumber
R 36

Woow Stream Type
s u Audio
PRl IR EREEEE Femm e S EaR H PES Packet Mumber
n ?

u PTS
_____ o 1404092079
" |0

H 1 [MPEIGT]
B Layer
----- - 2 [Layerll]
u Bitratelndesx
" 10 [192kbit/s)
" Frequeticy
L e i e e e H n 48000Hz

M tods

" 0 [Stereq)

" tdode E stension
0.000 0840 1.680 2 E.JEI 33&0 4200 & DQEI 5.ai4 0

®PT5 Bccess unit e (3] Coppright

+DTs [sum of durations) = HDEE
riginalCopy hd

H
e

-

4 1 ' 1 ' 1 % 1 ' 1 ' 1 |

This shows all the PES packets for the selected PID. See the section on the
PTS/DTS view for more information on selecting a particular packet.
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PES Analyzer — Packet header interpretation

QE Ad_10z. mpg Header Interpretation - Prog. 2 Video [PID 305] PES Packet 171

packet PES
prefis length
(000007 | Ow00ED video_stream] 0«00

FES data original | FT5 g5 | D3M additionall pec | ppg | PES

scrambling PES; alignment | coppright]  or  |DTS E“SCH rate lrlcc||< ':fc'flj"" cre | extension hsatder
cortiol | PP | indicator copy | flags ags flag I'l;ll;ge If?a; flag flag Ie:g?h

5] i) 5] IR Os0 [ Ox | Ow0 [Ow0f 0a0 IR 5] 00 [Is]

FT=

42316377

PES
packet
data
bytes

This window interprets and displays the header of the currently selected packet.
The above example shows a packet which carries a Presentation Time Stamp
(PTS).

The relationship between the top row of information displayed in the Header
Interpretation, for this packet, and the Hex view is:

pafkf‘ t PES

. lerugth
prefis

Ox000007 | 0=00E 0 video_stream | O=00

= A 1 1 E E O] deo [PID 1 H F 3 e - [Of =
0O000 (00 00 OT{EC{O0 OOfs0 80 05 21 04 17 64 B2 00 00 “
IR BER 00O 0o 01 BR B8R KRR RY 98 00
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The next row completes the compulsory header information. The mapping
between the Header Interpretation and Hex view is:

- DSM | additional FES
PES data orignal | PTS ES | FES] PES
scrambling DEET?G' §Iig_nment copyright| or |DTS Eflig? rate nt':nl:ﬁzllfe ?:%’ cic | extension h::?:'
cantrol imdicatar copy | flags flag flag flag flag flag length
0=0 0xz0 0=0 0x0 00 | 0x2 | 0x0 |0x0] 00 0x0 0=0 0x0 0:5

lﬁlAd_l Ds.mpg HexView - Plog. 2 Vided IPiD 305) PES Packet 171 [H[=] E3
rY

00000 00 00 07 E0 00 00[80[80]05[21 o0& 17 64 B3 00 00
oot Moo oo 148 4B NDIE BE M BS 8% 5 R7 93 NN

The last row is a reminder that after the header comes the packet data. Any other
rows represent additional fields, such as the Presentation Time Stamp (PTS)
carried in this example. The relationship of these rows to the Hex view is:

FES
packet
FTa data
btes
42N 637
B A 1 1 B B Prog deo [PID 1 = = - 4
00000 00 00 01 E0 00 00 80 20 05421 0% 17 B4 B3 {00 00 -

oo |01 00 00 14 4B DB BS 00 00 01 BS 85 55 57 33 00
00020 |00 00 01 01 32 BF 23 200 8B EE 03 E7 AD 9B 10 7F
0oa30 |[EY 03 78 9C Ck A3 61 66 51 BF 10 B4 62 C5 A5 92
00040 |35 CO CF 2C A3 55 41 C3 70 7B C3 &4 81 66 DC 04

RN 2 24 70 AR AR MDA 28 AN RN 7R N2 PE AN 29 1A 27

The size of the header depends on the fields it carries. Here is the Header
Information view of the preceding packet which carries PTS and DTS fields:

& Ad_10s. mpg Header Interpretation - Prog. 2 Video [PID 305) PES Packet 170 = =1 I
e
Pafk?‘ \ PES
! length
prefix
0000001 | 000ED video_stream | 0x00

L DSM | additional FES

FES data original [ FTS ES | PES| FES
scrambling pigﬁty slighment| copyright| or (DTS Eflsags rate rtnrnlj:lke ?:f%'" cre | extension hz:ﬁ:'
contral indicator copy | flags flag flag flag flag flag length
0x0 00 00 0x0 0s0 J0x3 | 040 J0=0] Ow00 0:0 | 0x0 0x0 (1)

PTS DTS

423837 42312777 =
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PES Analyzer - Program structure

The Program Structure window displays a list of all available programs and the
elementary streams that they contain. It shows which stream is currently selected
for inspection and may be used to select a different stream.

The example below shows a program structure from a file conforming to the
ATSC standard.

ﬂ ATSC_10s.mpg - Program Structure [_ 8] =]

| Program 3
Q Wideo, [PID 49,0:0031)

e ATSE Audio, [PID 52 020034)

e TSE Prosgramm [dentifier, [PID 51,040033]

= Program 4

e Widea, [PID B5,0x0047)

e BTSC Audio, (PID 63,0:0044)

e TSE Prosgramm [dentifier, [PID B7,0x0043]

[ P[Dgham 5]

The example below is a program structure from a file that is compliant to the
DVB standard.

ﬁ, DVEB_10s.mpg - Program Structure

H=]
[=- Program 1
- Yideo, [PID 2858,0:0121)
e i, [PID 2900800 22)
: Audio, (FID 83.0:0058)
- Audio, [PID89.0:0059)
e Audia, (PID90.0x0054)
[3 ~ Program 2

(P10 305,0:0131)

Audio,
- dydio,
o dudia,
Audio,
Program 3
Frogram 4
- Program &

(P10 306,001 32)
(P10 96, 0:0060]
(PID 97 .0:00E1]
(P10 38.0=0062)
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The diagram

180

The Program Structure is displayed by the program as soon as a file is opened. As
the file is analyzed, the top levels of a structure diagram are drawn in the window:

ﬁ:_.ﬁd_‘l 0s_.mpg - Program Stiuchure Hi=1E
= Program 1
q Video, [FID 289,001 21)

[
e Byadio, (PO 230,0:00 22)
Audio, (FID 88,0:0058)
(
[

e fadio, (PO 89, 0x0059)
e Sytdiin, (PID 90, 00054
[#]- Program 2
[ Program 3

An Elementary Stream is selected by default. The Program Structure view shows
the selected stream and other streams in the same program. The first program is
expanded to show the streams in the next level.

Streams in the other programs are initially hidden from view.

The structure is represented by a tree diagram, with the "root node" or highest
level component at the top. Components which contain more information beneath
them in the structure are indicated by a square box.

Components that are connected to a branch of the tree without a square box are
leaf nodes. In this case the Video and Audio elementary streams are leaf nodes.
They display the lowest and finest level of detail.

Nodes can be expanded and contracted by clicking on the square box.
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Selecting a packet type

When a file is first opened and analyzed a stream will be selected by default. The
type is indicated by the magnifying glass symbol, Q, in the Program Structure. It
is also displayed in the Packet Type "list Box" on the Slider bar. A new stream
may be selected from either the list box or the window.

ﬂE Ad_10s.mpg - Program Structure [_ (O] =]
[ Prrogram 1
Choose an e Widen, (PID 283.0:07127)
Elementary Stream e i, (PID 290,0u0122)
by selecting the Name in zuj!o’ EE:E ggg”gggg%
the Program Structure or Azd:z’ FID EIEI’EI:DDE-’-‘«]
from the List in the Slider - Progtam 5 ’
Bar "List Box =<3, Video, [PID 305.0:0131)
e Audio, (PID 306,0:0132)
e Adin, (PID 96, 0x0060)
: o fyudi, [PID 97.040061]
. 2 Swdio [PID 306) k g Audio, [PID 33,0=0062)
;mg_ gzuﬂiu %;:B g?} - Program 3
1ad. 2 Audio
Prag. 2 Awdio (PID 98] Bl Progeam 4
Frog. 3 Yideo [FID 160] el Frogram 3
Prog. 3 Audin (FID 104)
Prog. 3 Audio (FID 108)
Prog. 3 Audio (FID 108]
Prog. 3 éudio [PID 107)
Prog. 4 VYidea (FID 161)
Prog. 4 Audio (FID 112)
——Fiog. 4 Audin [FID 113) Tl
ﬂ]| Piog. 2¥iden [FID 306] ]
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PES Analyzer — PTS/DTS timing analysis
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(%63 PES Analyser - [HEVC samplelmpg - PTS/DTS View Prog. 654 H.265 Video (PID 2895]] [ [ B ]
{3 File Edit View Options Window Help _[=][*
15| 83| EeE D ala)

Data at Cursor
AU Number
; AU Size
: 2338168 bits
Stream Type
' HEVC Video
PES Packet Number

10
PTS
2149968
DTS
2148466
; Frame Rate
: 59.94 fps
: Frame Type
! IIDR][SPS][VPS][PPS]
: Aspect Ratio
: 111 (Square) !
H Chroma Format
4:2:0
Picture Size (Hx V)
3840 x 2160
: Profile
: Main 10 Profile

Level
Level 5.2
Tier
Wain Tier
| »PTS Acoess unittime (3] Progressive/Interlaced
+0TS [sum of durations) Progressive
+ < | Packet Number [Prog 654 H.265 Video [PID 2955 |
PES Analyser NUM [T5 Packet 2632

The PTS/DTS view shows timing analysis of the selected stream. The x-axis
shows the duration of the stream in seconds. The y-axis shows the differences
between the expected and actual DTS values. A vertical blue line is used to show
the difference between the PTS and DTS for each Access Unit (AU). Therefore, a
compliant stream will exhibit each DTS on the Oms y-axis. Streams with errors
usually exhibit a "stepped" graphical effect.

Any AU in the stream may be selected to view additional information in the
panel on the right. If the panel is not tall enough to show all of the information a
scroll bar appears.
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When first opened the entire stream is shown. Even a small file may display data

points packed too closely together to be read; for example, here is just under
12 seconds of video:

@ PES Analyser - [HEVC samplel.mpg - PTS/DTS View Prog. 654 H.265 Video (PID 2995)] { o|&® i—]
(1) File Edit View Options Window Help _lla] =
H= gz Eenm ala

s

Data at Cursor
AU Number
10
AU Size

2338168 bits
Stream Type
HEVC Video
PES Packet Number

17ms,

2143466

Frame Rate
A2Bms + |-

5094 fps
Frame Type
[IDRI[SPS][VPSIIPPS]
‘Aspect Ratio
141 (Square)

Chroma Format

4:2:0
Picture Size (Hx V)

2 3 3840 x 2160

Profile

Level

7774 9.559

Bms -
oood 2113 4008 533*3

11544 13430 15315 17.200 19.0%5 209‘71 285 2474 25525 22511 ' 31.931 Wain Tier
Access unit time [3]

+DTS (sum of durations)

)

Srogressive/Interlaced
‘ }

Main 10 Profile

Level 5.2
Tier

Progressive

| o ||| Packet humber [0 [Frog. 654 H.265 Video [FID 23851 =]

NUM |TS Packet 2632

PES Analyser

A longer sample may appear as a solid band of blue
To see the individual packets or access units click on the Zoom In button on
the Toolbar:

=] &2 = @m | &l
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In this example, clicking on the Zoom In button a few times gave a much clearer

view:

e

=[] x

13 PES Analyser - [HEVC samplelmpg - BTS/DTS View Prog. 654 H.265 Video (PID 2095)]

(T} File Edit View Options Window Help

Hl=| 8*| BEEm A
P B B P B B P B B P

B B P B B P B | P B B P B B P B B P B B Data at Cursor
AU Number
1537
AU Size
155344 bits
Stream Type
PES Packet Number

1537
PTS
4441257
DTS
Mot Present
Frame Rate

59.94 fps
Frame Type
B

Aspect Ratio
111 (Square)
Chroma Format
420
Picture Size (H x V)
3840 x 2160
Profile
Main 10 Profile
Level

Level 5.2
25E42 25675 25709 25742 25775 25809 25842 25875 25909 25942 25976 26009 26042 26076 26126 Main Tier
HPTS Acoess unit fime [5) Drogressive/Interlaced
+DT5 [sum of durations] Progressive
‘“.““‘““‘““‘““‘““‘““‘““‘“““‘-J‘.‘.“.‘.“.‘.“
— 4 ‘ Packet Number  [1537 [Prog 654 H 285 Vvideo (PID 2395) =]
NUM (TS Packet 444478

PES Analyser

The blue # crosses of Presentation Time Stamps and the magenta 1 crosses of
Decoding Time Stamps can now be differentiated.

To Zoom back out click on the Zoom Out button as many times as required:

le| sz Ep/an al
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Access unit selection

The triangular cursor above the graph indicates the selected access unit. Extra
information about that access unit is displayed in the Panel on the right of the
Graph.

23 PES Analyser - [HEVC samplel.mpg - PTS/DTS View Prog. 654 H.265 Video (PID 2995)] o
(13 File Edit View Options Window Help

Hel sl?|Eemo akl

P B B FP B B P B B P BB P B B P B I P B B P B B P B B P B B
v

Data at Cursor
AU Number
1537

: AU Size
H 155344 bits
Stream Type

HEVC Video

i | PES Packet Number

: 1537
PTS

4441257
DTS

: Not Present

: Frame Rate

: 59.94 fps

: Frame Type

B

: Aspect Ratio

: 111 (Square)

H Chroma Format
4:2:0

i [ Picture Size (Hx V)

| 3840 x 2160

1 Profile

: Main 10 Profile

: Level

: : : : : : : : Lo Level 5.2

B o e e S ket g L s et e ety e e e oty R el T 1 s
J5E42 25675 25709 25742 25775 25809 25842 25875 25903 25942 25976 26009 26042 26076 26126 Main Tier

*PTS Access unit time (5] Drogressive/Interlaced

+0TS [sum of durations) Progressive
4| | Packet Number [1537 [Fion. 654 H.265 Viden [FID 2935] =]

PES Analyser NUM |TS Packet 444478

Scrolling the view

The Slider at the bottom of the window indicates where the displayed packets /
access units are in relation to the rest of the file. It can be used to scroll the display
through the data in the same way as a standard window scroll bar.

Slider Control

Shows position of selected access unit

within the file. Drag the control to move
the View Bar. When released it returns

to show position of selected access unit

View Bar

Shows size and position
of visible area of the
graph within the file.

First
Access unit
inFile

Last
Access unit
inFile

Latest
Access unit
in View

Earliest
Access unit
in View

To scroll the stream through the view drag the Slider Control left or right with
the mouse. After dragging the Slider Control it returns to the previous position
showing the location of the selected access unit.
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Video streams

186

Click the mouse pointer on the white space either side of the View bar to center
the displayed graph about the currently selected access unit.

When an access unit is selected on the graph, the Slider Control is automatically
repositioned within the View bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.

Selecting an Access Unit on the graph also changes the selection for all of the
other views to the packet containing that Access Unit.

%53 PES Analyser - [HEVC samplel.mpg - PTS/DTS View Prog. 654 H.265 Video (PID 2995)] ol ) [
@ File Edit View Options Window Help -] x

Hl=| g2 [@nma ala
F B BE P E B P B B P

B B P B B P B | F B B P B B P B B F B B Data at Cursor
AU Number
1537
AU Size
155344 bits
Stream Type
PES Packet Number

1537
PTS
4441257
DTS
Not Present
Frame Rate

5094 fps
Frame Type
B

Aspect Ratio
1:1 (Square)
Chroma Format
%20
Picture Size (Hx V)
3840 % 2160
Profile
Main 10 Profile
Level
Level 5.2
T e e e e i T e S T R i s SR x e
25642 25675 25708 25742 25775 25809 25842 25875 25503 25942 25976 26003 26042 26076 26126 Main Tier
=PTS Access unit time (5] rogressive/Interlaced
+DTS [sum of durations] Progressive

= | v ||| Peckethumber [1537 [Prog. 654 H.265 Videa (PID 2895]  _~ |

PES Analyser NUM TS Packet 444478

MTSA-HW and MTSA-PC Analyzer Applications User Manual



PES Analyzer — PTS/DTS timing analysis

The panel on the right shows information about the selected access unit. For video
streams these are always complete packets. Some of the information shown in the
panel is specific to video streams, that is, frame rate and frame type.

The graph shows the frames of video in transmission order analysis and, when
"Zoomed In" close enough, the type of each packet plotted along the x-axis. The
graph scale is drawn in gray dashed lines. It is the equivalent of the scale or
graticule on an oscilloscope or logic analyzer.

Frame Type
Shown when there is space to
display the characters.

y-axis shows any Olms P
differences between |

> .
the PTS / DTS times Line colour and
and the calculated cursor show selected)

arrival times of the ! sp ! access unit :
Access Unit. PSR RN LR AN . R I R

It also indicates the
difference between

PTS and DTS times. . .

: R N R A N
Erames.plgtteglg 000 0.080 060 0,240 0320 0400 0480 0560 0
ransmission .r er ®PTS Accers unit ime ()
along the x-axis +DTS [sum of durations)

X-axis The x-axis shows the nominal time of an access unit. The first access unit
displayed is taken to have a nominal time of zero. Each access unit has a nominal
duration, calculated from parameters within the elementary stream. These
parameters include "low_delay" and "repeat_first field", which allow analysis of
effects such as 3:2 pulldown. These effects alter the access unit duration, which is
nominally equal to a video frame period.

Y-axis  The position on the y-axis of a PTS or DTS shows the relative timing of the
timestamps. The first timestamp (PTS, or DTS) is taken to have a y-value of
zero. Each Subsequent timestamp has a y-value given by the difference between
their timestamp and the first timestamp, less the difference in nominal time of
their access unit and the first access unit.

The solid blue vertical lines show the time difference between the PTS and DTS
from the same Access Unit.
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MPEG video streams  The panel on the right shows information about the selected access unit for MPEG
stream.

¥ Ad_10s.mpg - PTS/DTS View Prog. 1 Video (PID 289)

E P E P B I B PB PBPEBEPUEBE P Diata at Cursar s
Blms r= =3 = mm = e ey e B e e e e e s E AL M umber
151

E Stream Type
! ideo

E PES Packet Mumber
: 151
4DmS'F"""'i """ [ AT==f1-"" [t aTTTro- r==°--- A== PTS

42249391 —
DTS
42242191
Frame Rahe
20 fpx
Frame Type
F!

Dk - -+ - - - o s b ichelnts sl il R #- -t

h7E0 hHB40 H320 E000 ED0BO  EBI1ED G240 'B.3B
HFTS Access unit time (g)
+0TS [sum of durations)

Profile & Level
Mair & kain

Chroma Format v|

1 1 ' 1 ' ' “ . ' ' ' ' 1 1

H.264/AVC video streams The panel on the right shows information about the selected access unit for AVC
stream.

1063 H264_atsc_19,392_rbps-PES - PTS/DTS View Prog, 1 18486-10/H.254 Video (PID 33) = 5|
P s P B P T F D P 9§ F B P 8 F 8§ P B F & P U |
10308ms e eneoeeeeee enneennnen s PR R I S I St S 21 Number
f f T ! ! ! ' [ 557
Stream Type
PES Packet Nurnber

FTS
1819662
DTS
Mot Present
: Frame Rate
N 59.940 fs
: Frame Type
B
Bspect Ratio
Reserved
Chroms Format
42:0
Picture Size (Hx¥)
320240
Prafile
' ' : : ' ' ' ' : : : Main Profile
! ! : : ! ! ! ! : : : Level
2061ms : ; i ; ; ; i ; ] 71
: Frogressive/Interlaced

1 Progressive

e

O toomoeee S A et LERELEEEL bonnmnnonr el T B ]
3103 914 917 9.20 9.24 9275 9.30 93 9375 9409 9459
%PTS ticcess unit e [5)
+DTE fsum of durations]
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H.265/HEVC video streams  The panel on the right shows information about the selected access unit for HEVC
stream.

(L3 PES Analyser - [HEVC_Harmaonic_PES - PTS/DTS View Prag. 1 H.265 Video (PID 101)] o lre =)

3 File Edit View Options Window Help [=]=]x]

H|=| g/t [EEmz gl
B B B E B B B B

B B

5 8 6 B B B | B B B G B B B B B B B B B B B B B B B B Data st Cursor |
A0 Hurmber
369
Al Size
30704 bits
Seream Type
HEVC Video
2l PES Packet Number
2368

150ms

TS
3117905645
DTS
3117893131
o7 Frame Fate

59.94fps
Frame Type
[

Aspect Ratio
11 (Square)
Chrora Farmat
420
Picture Size (H V)
1280720
Profile
1294 Wain Profile
Level
Level 4.1

TTTTTTTTTTTTTTT%

TTUDEE anets 4G A0SE 4DGSS 41028 410R2 41095 41028 410R2 41195 41228 41262 1295 41328 4132 4139 41420 41462
HPTS Bccess urit tine )
0TS {5 of chaations)

[TSPacket 92437

i

PES Analyser [
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Audio streams

190

ﬂ: bt_bbc.mpg - PTS/DTS Yiew Prog. 4167 Video [PID &00)
Feo B 5B P B B AP GBE B LB OCEE PR
oy D.ata at Cursor

120ms == -==---=- flmmmmmm fmmmmme s AT T =il AU Humber
324
Stream Type
Yideo
PES Packet Mumber
324
Bl
1607845392
0TS
1607934592
Frame Hate
25 fog
Blmg - R R R T Frame Type
|
Azpect Hatio
9+1E
Profile & Level
bain & Main
Chioma Format
4:2:0
Picture Size [H V]
720w B7E
Picture Structurs
Frame Picture
A== it il p WEY Delay
N ERG35
WEV Bulfer Size
112
Lo Delay
Falye
Progressive Frame
Falze
Progressive Sequence
Falze
Top Field First
] - oM L R ¢ % s
{0 0 o =i e s e by e ey |l et oy S ol i sl A i i
12600 12720 12840 12960 Yo [A—
HPTS Access unit ime (3] TR Ty
+OTS [sum of durations] 16:9(shtpret] 4: Scent)

The panel on the right shows information about the selected access unit. For video
streams, these are always complete packets. The frame rate and frame type shown
in the panel are specific to video streams. The "Picture Size (H x V)" information
is taken from the display horizontal size and display vertical size values in the
sequence display extension. If that is not present, the horizontal size value and
vertical_size values in the sequence header, as modified by the sequence header
extension values horizontal size extension and vertical size extension in the
sequence header extension are used.

Some of the information shown in the panel is specific to audio streams.
AC-3 Audio streams will differ from Audio streams.
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The graph shows timing analysis of the PTS. There are no DTS in an audio
stream. Select an access unit by clicking on it with the mouse. Clicking between
two PTS will select an access unit that does not carry a PTS.

o_;Ad_1 0z.mpg - PTS/DTS Yiew Prog. 2 Audio [PID 306]

e T --a:eaae? G R LE L ELE /
;;;J : : Solid line and N
Difference cursor show selected
between the . . access unit . FES
PTS and the / : , : - g N
calculated )
arrival time . . ; . . . R S
of the : : E : : : Lo :
Access Unit. & . . , , , . . . I
7 SE SRR ORI 0 VA5 O SN St SO S O
2286 ZBE4 3072 3480 388 42396 4704 HAT2 BYE0 —
=PT5 Aocess unit tine [2)
+0TS [0 of durations) —
: 1 () 1 JI 1 [ 1 1 1

The graph scale is drawn in gray dashed lines for each value on the axis. In this
example there are only two values on the y-axis, at 0 ms and 24 ms.

AC-3 audio streams

@ ATSC_10s.mpg - PTS/DTS View Prog. 3 AC-3 Audio (PID 52

Data at Cursor | -

32ms roomooo- AL Murber
41
Stream Type
AC-3 Audio
PES Packet Mumnber
41
PTS
412033750
o]
AC-3 audio
Bitratelndex
384khit/s
Frequency
43000Hz

.
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
'
'
'

|

e e e e e D B 5 T

o6, e e D e X e e

0,765
®PTS
+DT5

0.928

1088 1248 1408 1868 1728 1.888

Bit Skearn Mode
Complets Main (CM) 7

Azcess unit bme [5)
[zum of durations)

Audio Coding Mode

342 -

The Data at Cursor panel of the PTS/DTS view shows different information for
AC-3 Audio streams. Otherwise the window works in the same way as for Audio
streams.
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AAC audio streams

@ T5020804_cut.mpg - PTS/DTS View Prog. 140 AAC Audio [PID 532) =] I

Data at Curgor I -

21..“8,__.....:.. --—-—-|—-—----v‘v—'—'l—"""""""""_'_"':'----_-': Al Mumber
' ' 1 i LAl
' : : Stream Type
i ' ! AAC Audio [ADTS
! H ! PES Packet Mumber
LAl
PTS
37302608
D
|1 (MPEGL
Layer
0 [pac
Pratection Absent
u]
Prafile
1[LC]
Sarnpling Frequency
48000 Hz
Channel Config
0

Original/Capy
O riginal

1 Copyright |0
i Ma start in frame

! ! ! . . ! ! ! ! Frame Lenath
(s X6 36 56 K 3 Ko KoMK P P 56 3 3 I KK ICICIK S 9 3 96 e e I D06 9 S 5 5 I 384 butes
047 0512 0597 0683 0768 0893 0939 1024 1103 1195 120 Buffer Fulness
=PTS Access unit time (5] 0 [0x0 —
+0T5 [sur o durations) Raw Drata Blocks

nl

==

[ R S ' ' ' ' ' ' [ ' ' ' ' [

The Data at Cursor panel of the PTS/DTS view shows different information for
AAC Audio streams. Otherwise the window works in the same way as for Audio
streams.
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E-AC3 audio streams

The Data at Cursor panel of the PTS/DTS view shows different information for
E-AC3 audio stream.

(Y HBOGrey EAC3 bitstream-PES - PTS/DTS Yiew Prog. 1 Videa (PID 48) = |[@ =
EPED P FD I BB P BOPE B P B DP BB DO P oD P B ey

mnms:’"' A [ [ ST [ [ T T Al Number
! : : : : ! : : ! 202
Stream Type
Wideo
PES Packet Mumber
202
PTS
£63930
DTS
Mot Present
Frame Rate

3000041001 fps
Frame Type
B

L S A F I [ A I R i F I N e
: Aspect Ratio
9+16
Profile & Level
Main & High
Chroma Format
42:0
Picture Size (H =)
1820 = 1080
Picture Structure
Frarne Picture

WEW Delay
| : : : : i : : | 37026
s - H ; H ; : H ; H VBV Duffer Size
Loy Delay
False
Progressive Frame
False
Progressive Sequence
False
Top Field First
False
Repeat First Field
| H H | H False
OmgK-m e e e 3 e L EtE L B e T et LTl SRR LE T I ot SEE TEEL Pt e S
6.273 £.340 6,405 6473 6.540 B.EO7 BE73 B.740 6,907 6.874 6.940 7.007 7.074 7140 7207
®PTS Access unit ime (5]
+DTS [sum of durations)
| —

MTSA-HW and MTSA-PC Analyzer Applications User Manual 193



PES Analyzer — PTS/DTS timing analysis

194 MTSA-HW and MTSA-PC Analyzer Applications User Manual



T-STD Buffer Analyzer - Getting started

The T-STD Buffer Analyzer models the behavior of the buffers in the hypothetical
Transport Stream System Target Decoder, as specified in ISO/IEC 13818-1. It
can process video, audio, and system control streams. The results of the analysis
are displayed as graphs of the buffer capacity over time and a log of exceptions
and noteworthy events.

IM T-STD Buffer Analyser. - sample_stream.bmr

File Edit View Options Process Trace MWindow Hel
C[sIR) ) S12) & s
#'sample_stream.bmr - Stream List

¥, Transport Stream
= €8 Program 1
(& FID 100 (System) Unpracessed i
- PID 110 Stream Type: 2 (0x02) (MPEG-2 Video) Processed W 1500%f--——---
< PID 32 Stream Type: 27 (Ox1b) (H264 Video) Frocessed i
-2 PID 35 Strearm Type: 4 (0x04) (MPEG-2 Audin) Unprocessed
2 PID 36 Stream Type: 4 (0x04) (MPEG-2 Audin) Pracessed ©S00% -
& Frogram 2
#  Program 3 -
i+ (@ Program 4 - B00%

0:11.988 023936 0:36.904 0:47 872 0:59.833
0:59.839

ample_stream.bmr - Event Log for PID 32 deo Multiplex Buffer (MB1) - Pid 32
TS Packet | Evertt Type Comment

i Log Started Starting the Video buffer model
0 General Event  Frame Rate = 25.00 fos -

o Concral Event  Profile: Bascline, Lovel: 5.1 _ 1500% -
o

o

General Event B size: 512 bytes, RX rate: 36000000 bytes/s - 100.0%
GeneralEvent  MB size: 160000 bytes, rate: 30000000 bytes/s -
0 General Event  EB size: 30000000 bytes - oo
142518 General Event  Ignoring out of range DTS 39,2802 Seconds
143052 General Event  Ignoring out of range DTS 39.36002 Seconds
143054 General Event  Ignoring out of range DTS 39.40002 Seconds

e e A0 aAaen ce e = - 059833

- 5o | 0:0:000, 0.0 |
0:0.000 0:11.968 0:35.904 0:47.872 0:53.839

Blsample_stream.bmr - Trace

Eorcd o | Twe | D ' S LA IR i

Tirme 110

10
110
10
10 %

— - 5 0:0.000, 0.0
110 18 Pict. _ 500%
110 il 0:0.000 0:11.968 0:23936 0:35.904 047,872 0:59.839
210 0:59.839

Buffer Analyser | UM 4
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Suitable streams

Table handling

Multiple PAT and PMT
versions

MPEG-2, DVB and ATSC

196

tables

Any valid MPEG file, recorded or synthesized, can be processed by this
application. A valid file is one that starts on a transport stream (TS) packet
boundary (the first byte of the file must contain the first byte of a TS packet).

The Buffer Analyzer will process video, audio, and system control streams that
are compliant with the 1996 standard ISO/IEC 13818 parts 1-3.

The Buffer Analyzer is able to analyze the following types of elementary streams:
MPEG1 Audio and Video, MPEG2 Audio and Video, H.264 Video, H.265 Video,
MPEG2 AAC Audio, MPEG4 Audio (Only LC and SBR profiles) and AC3 Audio.
It also supports HEAAC along with the above elementary streams.

The Buffer Analyzer will handle transport streams that contain PCR and/or
PTS/DTS discontinuities. The PTS/DTS and PCR in a stream must, however,
use the same timebase.

The Buffer Analyzer is unable to work on scrambled streams. If it fails to make
sense of a stream, use TS Analyzer to determine if the stream is scrambled.

Buffer Analyzer forms a list of elementary streams that are present in the transport
stream. This is called the Stream List. It creates the Stream List by reading

the first occurrence of the Program Association Table (PAT) and Program Map
Table (PMT).

If more than one version of the PAT and/or PMT are present, TS Cutter can be
used to isolate a particular section for analysis.

Only PIDs carrying MPEG-2 PSI tables are included in the System model. Any
DVB or ATSC tables that are present in the Transport Stream are ignored.
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Starting the program

MTSA-HW and MTSA-PC Analyzer Applications User Manual

B rektronix MTSA

Buffer Analyser
Carousel Analyser
Carousel Generator

ES Analyser

[5DE-T Remux

Make Seamless Wizard
MPEG Player
Multiplexer

OptionKey Wizard

PES Analyser
ScriptPad

Stream Cutter

T5 Compliance Analyzer

T5 Editor

Deferred
Time

Analyzers

Start the program by selecting Start > Tektronix MTSA > Buffer Analyzer , or
double click the Deferred Time Analyzer folder from your desktop and select
Buffer Analyzer.
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J

| |4 ¥ | C\Users\Public\Desktop).. O X

“ Home Share View " ﬂ
4 » Deferred Time Anal... w U Search De
*  Name
# Quick access o
7 Carousel Analyser

& Downloads * %3 ES Analyser

[2 Documents * 3 PES Analyser

[&] Pictures *

ﬁ.l T5CA - Compliance Analyzer
Deferred Time Analyz # » <

»
5 iterns =

Initial appearance  Once the program has started and is ready for use, it will open a main window.
When the program starts, the Main Window will look like this:

m T-STD Buffer Analyser ‘;”E”X‘

File Yiew Help

08| & S| 2| ll v5|ms|mslec| & | wil | 4 | Q|cﬁ1|[§ﬂ ;\l

Buffer Analyser

[ T

The Toolbar (row of buttons above the dark gray area of the empty window) can

be hidden from view, moved to a separate window, or moved to either side or the
bottom of the main window.

The Status line at the very bottom of the window can be hidden from view. It
displays information about the application and keyboard status.
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Initial menu options

Settings

The application presents different menus and options, depending on whether a
file is open for analysis. The menu options available when Buffer Analyzer has
just been started, or after a file is closed, are: File menu options. The following
table lists the File menu options.

Table 36: File menu options

Command Function

New Opens file selection dialog to select an MPEG stream file for
analysis.

Open Result Opens an existing BMR file to review results of a previous

analysis. The application opens the file selection dialog allowing
you to choose the required file.

Print Setup... Opens a dialog for selecting which printer and associated
options to use.

1 <filename> A list of the four most recently used BMR files available in disk.

2 <filename> If Buffer Analyzer has recently been installed, the list may hold
) less than four files.

3 <flename> Selecti fil hat BMR file f i

4 <filename> electing a filename opens that ile for review.

Exit Finishes running the program.

View menu options. The following table lists the View menu options.

Table 37: View menu options

Command Function

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar.

Settings... Opens the Settings dialog for specifying Video Buffer Sizes and

Video Data Transfer method.

(A check mark next to an option shows that the toolbar is currently visible; no
check mark means that it is hidden.)

Various configuration parameters, including Packet Interpretation, Pre-Scan
Packets, PES Private Interpretation, Video Buffer Sizes, Video Data Transfer
method, and Audio Buffer sizes can be modified before and after opening an
MPEG file. When a file is open, one or more streams can be analyzed, the settings
can be changed, and then other streams can be analyzed with the new settings. If
the settings are changed, to reanalyze streams analyzed with previous settings, the
MPEG file must be closed and opened again.

It is a good idea to check the settings before opening a file to verify the method
with which video streams will be analyzed.
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System settings

Select Settings from the View menu to open the Settings dialog.

[T MPEG-2/H.264 T-STD Buffer Analyser

Filer
e

v Toalbar
D v Status Bar

5 Ettiﬁgs v

This opens the Settings dialog, which has three tabs: System, Video and Audio.

. ==

System | Video | Audio |

Packet Interpretation ———— Pre-5can Packets
" MPEG2 v Al Packsts
'y

MPEGZ / ATSC I—_I 3000 packets

H265 Video _~ | PES Private Intempretation

AC-3 Audio

AAC Audio

MPEG2Z Audio

MPEG4 Audio

MPEGZ Video

H264 Video

These options can only be set before analyzing a file. They are disabled (grayed
out) while a file is open.

The MPEG2 / ATSC option is available on ATSC or ATSC/DVB dual standard
MPEG Test System products. It is disabled (grayed out) on single standard DVB
systems.

Packet interpretation. Specifies which standards will be used for interpreting the
packets in the Transport Stream when a file is opened for analysis

The options are:

MPEG2 Interprets the packets according to the standards for DVB
streams.
MPEG2/ ATSC Interprets the packets according to the ATSC standards. This

option is required if AC-3 audio stream content will be analyzed.
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Pre-Scan packets. During the initial processing of an MPEG file, a number of
packets are prescanned for information that will result in a more accurate analysis
of the initial parts of the transport stream

The greater the number of prescanned packets, the greater the chance of locating
all of the information required for accurate analysis. The drawback is increased
processing time. By default, 10000 packets are prescanned, which should be
sufficient for most streams, excluding High Definition Video.

All Packets Select this check box to cause all packets to be prescanned.
If this check box is selected, the packets field will be disabled
(grayed out).

Packets If the All Packets check box is not selected, enter the number
of packets to be prescanned in this field.

PES Private interpretation. This setting specifies the model type to use for streams
signaled as PES Private (stream_type = 6)

The selections available include the following: AC-3 Audio, AAC Audio,
MPEG-2 Audio and Video, MPEG-4 Audio, H264 Video, H265 Video and
System. The default setting is AC-3 Audio.

Select H.265 Video for HEVC stream.
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Video settings Settings

Systen  Yideo lAudiD ]
Buffer Sizes

+ Automatic

" Marual " Leak Mathod

" BV Delap Method (MPEG-2 only)
hdB - ,7 Bytes
EB : ,7 Bytes

)

Data Tranzfer

% Automatic

Default Frame Rate
|25 ﬂ Framesds

o ]

Cancel ‘

Buffer size. Specifies the sizes that will be used for the Main and Elementary
Buffers, when interpreting the stream. The options are:

Automatic

Manual

Automatically detects the buffer sizes from the Sequence
Headers and Extensions in the elementary stream being
processed. This is the default option when the application is
started.

Enables the size of the Main or Multiplex buffer (MB) and
Elementary Buffer (EB) to be specified manually. The MB and
EB fields are available for editing when this option is enabled.

Data transfer. By default Buffer Analyzer inspects the stream to determine which

transfer method to use

This can be overridden if required. The options are:

Automatic

Leak Method

VBV Delay Method

Examines the stream to determine the transfer method. This is
the default option when the application is started.

Initiates modeling of the stream using the Leak Method. H.264
and H.265 streams support only this method but the option can
be kept as Automatic.

Initiates modeling of the stream using the Video Buffer Verifier
(VBV) Delay Method. This option is specific to MPEG-2.

Default frame rate. The frame rate is one of the parameters that is searched for
during the prescan phase of analysis. However, if it is not found, the default value
selected from the dropdown list in the Default Frame Rate field is used.
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Audio settings =, X

Systen  Yideo lAudiD ]

Buffer Sizes Data Tranzter

& Automatic & Automatic

" Manual " Leak Method

B - ,7 Byles " BV Delap Method (MPEG-2 only)
EB : ,7 Bytes

Default Frame Rate
|25 ﬂ Framesds

Ok | Cancel ‘

Buffer Size. Specifies the size that will be used for the audio buffer when
interpreting the stream. The options are as follows:

Automatic Examines the stream to determine the transfer method. This is
the default option when the application is started.

Manual Enables the size of the buffer (B) to be specified manually. The
B field is available for editing when this option is enabled.

AAC. Select the number of AAC channels required from the dropdown list

Within the ADTS (Audio Data Transfer Stream) fixed header, the channel
configuration field is used to indicate the number of channels required by AAC. If
the number in this field is zero, the value in the AAC Default channels field is used.

NOTE. The associated ADIF (Audio Data Interchange Format) is unsupported.

Refer to Information technology - Generic coding of moving pictures and
associated information, Part 7: Advanced Audio Coding (AAC) ISO/IEC
13818-7:1997

NOTE. Remember that if the settings are modified, the new settings are used for
all video streams that are subsequently processed. The settings are reset to the
default option when the application is started.
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Opening an MPEG file

Any file holding a recorded or synthesized sample of a Transport Stream that
carries video, audio, and/or system control streams can be analyzed. These files
are referred to as MPEG files to distinguish them from Buffer Model Results
(BMR) files. The results of analysis are written to a BMR file.

Opening a file from the  To open a file for analysis, select the Open Result option from the File menu.
menus and toolbar  Alternatively, use the Ctrl+O keyboard shortcut.

[File View Help

Mew Ctrl+M
Open Result Ctrl+C
Print Setup...

NOTE. The list of previously used files shows BMR not MPEG files, as can be
seen by their .bmr extension.

There is a shortcut button for the New command on the Toolbar:

‘ G| DA I ‘?I N

In response to the New command, the Buffer Analyzer opens a file selection dialog
to choose an MPEG file for processing. When the MPEG file has been chosen,
then BA is ready to analyses the stream. By default Buffer Analyzer will create a
BMR file with the same name of stream file but with a different extension (.bmr).
User can preserve this result file in stream location by selecting the ‘Save Result
File’ menu item in Options Menu. By default BMR file delete after the analysis.
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Opening a BMR file

An existing Buffer Model Results (BMR) file can be opened to review the results
saved in it from previous Buffer Model Analysis.

Opening a file from the ~ To open a BMR file, select the Open Result option from the File menu.
menus and toolbar  Alternatively, you can use the Ctrl+O keyboard shortcut.

IFiIe| View Help

Mew Ctrl+N
Open Result Ctrl+0
Print Setup...

If the required file is in the list of recently analyzed BMR files, it can be opened
from the list to save using the open file dialog.

There is a shortcut button available on the Toolbar for opening a file, which has
the standard file open symbol:

O[F(E] ] S(2] ] fsle=le ] w0

MTSA-HW and MTSA-PC Analyzer Applications User Manual 205



T-STD Buffer Analyzer — Getting started

Window layout
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The Stream List window opens as soon as either an MPEG or BMR file is
opened. The application inspects the file to find what program streams are present
according to the Packet Interpretation setting. For example:

I T-S1D Buffer Analyser - Sym3.bmr
File Edit VWiew Options Process Trace Window Help

O || | & S[ R M| mo[re]oe|= |« | wi|zE] ] B2]=] Q

BE' Sym3.bmr - Stream List

Transport Stream
rogram 1
& PID 100 (System) Unprocessed
<= PID 9 Stream Type: 2 (0x02) (MPEG-2 Yideo) Processed
J3 PID 120 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed
JJ PID 130 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed
Program 2
PID 200 (System) Unprocessed
< PID 210 Stream Type: 2 (0x02) (MPEG-Z Video) Unprocessed
JJ PID 220 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed
J3 PID 230 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed
“Fo PID 260 Stream Type: 14 (0x0g) (MPEG-2 Auxiliary) Unprocessed

Buffer Analyser UM y
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Initial processing of MPEG files

If an MPEG file is opened, the program performs initial analysis to form the
Stream List and calculate the mean transport rate. All streams in the list are
marked as Unprocessed, because no analysis has been performed on them in
this session.

To build the Stream List, the MPEG file is scanned for the PAT and PMT table
contents. It is assumed that the contents are constant, which is the general case.
If the program changes in a drastic way, such as streams disappearing between
PMTs, the model will give meaningless results.

Only the first occurrence of complete PAT and PMT are read when forming the
Stream List. Use TS Cutter to isolate a section when multiple versions of the
tables occur.

A number of packets in the file are scanned for the Sequence Header and
Extension start codes (containing profile and level) (See page 199, Settings.) for
more information. If they are not found the Main Profile and Level setting are
assumed together with the maximum VBV buffer size.

Initial processing of BMR files

If a BMR file is opened, the State column indicates which streams were processed.
The file only holds results for those streams marked as Processed. To obtain
results for unprocessed streams, the original MPEG file will have to be opened
again and analyzed.
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T-STD Buffer Analyzer — Menus and controls

Toolbar

208

When a file is open, the program presents a different set of menus and options.
They change as soon as the Stream List window appears. For example, the Open
file commands are replaced by Close file commands.

S| 2| %l ro|wewnfer|a| || ] Gf|m]| G

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Opens file selection dialog to select an MPEG stream file for
analysis. This button is disabled (grayed out) when a file is open.

Opens a dialog to select a BMR file to review the results of a
previous analysis session. This button is disabled (grayed out)
when a file is open.

L=

Closes the current file. This button becomes available the
moment a file is opened. If the wrong file is being opened, or the
wrong options are selected, clicking on the button will abandon
the analysis and close the file.

Opens the Settings dialog.

|2

Prints the contents of the current window.

Opens a dialog that displays the program version number.

Analyzes the stream(s) from the PID(s) that are currently
selected in the Stream List. This button is only enabled when
one or more PIDs that are marked as unprocessed are selected.

& = |10 &

The next group of five buttons open Results views for the selected streams.

E| Opens a graph of the Transport Buffer for the selected stream.
This button is only enabled when the PID of a Processed stream
is selected in the Stream List window.

E| Opens a graph of the Multiplexing Buffer of a video stream; Main
Buffer of an audio stream or of a system information stream.
The button is only enabled when the PID of a Processed stream
is selected in the Stream List.

E| Opens a graph of the Elementary Stream Buffer for the selected
video stream. This option is only available when a PID carrying
a Processed Video stream is selected in the Stream List.
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E| Opens the Event Log for the selected stream. The button is
only enabled when the PID of a Processed stream is selected in
the Stream List window.

i| Opens all of the relevant graphs and the event log for the
selected stream. This option is only available when a PID
carrying a Processed Video stream is selected in the Stream List.

The remaining buttons control display options for Graphs of buffer analysis
results.

Toggles the graph displays between having all points drawn and
sampling the points for drawing.

Synchronize Graphs toggles the graphs between using the
same position and zoom settings or operating independently.

1 Auto Scale toggles the selected graph between fixed and auto
scaling of the y axis.

Zoom In increases the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.

EENE S

Zoom Out reduces the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.

Reset Zoom resets the magnification of the currently selected
graph from zoomed to original state.

fo

=

q | Trace analyzes the message logs. You can view the message
log that is produced by the Buffer Analyzer.

The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this, place the mouse pointer on the background inside the Toolbar, (not
on one of the buttons), hold the left button down, and drag into the main window
area. The result is a self-contained window that looks like this:

= |2 ) 8|2 % ==l o] | wiE <] QlaE]| G

To replace the Toolbar on the window border, drag it over the border, until the
outline changes shape, and release it. It can be placed on the top, bottom, left
or right edge.
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Status bar

.Fur Help, press F1

[

v

The Status bar may be hidden from view, but when visible, the Status bar is
always at the bottom of the main window. It displays the following information
about the program and keyboard states:

Message Field

Gives a description of any
button or option over which
the cursor is placed.

Keyboard
Maode
Indicaters

TS Payload Unit Start
Displays number of TS

packet in which current
PES packet starts

Analysis Status
Displays a progress
indicatar while a file
iz being loaded.

Way alzo show other
non-critical messages,

g

| TS Packet 1043

Naim al
At
CaP [NUM [TS Packet 1043 | v

The messadge changes to
describe the function of the button
oF ment aption aver which the

mouse poirter is placed,

nalpser - Ad 53 bmr

Optionzs I
(The description is stil displayed MEg Frocess Window |

if the buttor or option iz unavailable.
e greyed o)

Diaw &l Points '
Synchroni

Auto Scale % Axis

S

View the FTS/DTS &nalvsis

[

[T5 Packet 1043
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Menu options

The available menu options are listed in the following tables.

Table 38: File menu options

Command Function

Close Closes the current file. This option is available as soon
as analysis starts. If the wrong file is being opened, or
the wrong options are selected, selecting this option
will abandon the analysis and close the file.

Print Prints contents of the current window.

Print Preview

Prints contents of the current window.

Print Setup Selects printer and configuration.

Trace Print Font Selects the font to be used for printing text.

Options Colors Not available with Buffer Analyzer.

Exit Closes any file that is open and terminates the
program.

Table 39: Edit menu options

Command Function

Cut Moves the currently selected records from the main window to

the clipboard.

Copy Copies the contents of the currently selected records to the
clipboard. They are not removed from the main window.

Delete Deletes the selected records from the main window.

Delete Except Deletes all records except those selected from the main window.
Delete All Deletes all records.

Select All Selects all records.

Table 40: View menu options

Command Function

Toolbar Shows or hides the Toolbar.
Status Bar Shows or hides the Status bar.
Settings... Opens the Settings dialog.

Global Event Log
Transport Buffer Opens a graph of the Transport Buffer for the selected PID.

Shows or hides the Global Event Log window.

Main Buffer Opens a graph for the selected PID in the Stream List. The
graph shows results for the Main Buffer of audio and system
streams or the Multiplex Buffer for video streams.

Elementary Buffer
PID Event Log

Opens a graph of the Elementary Buffer for the selected PID.

Displays the Event Log for the selected PID.
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Table 40: View menu options (cont.)

Command Function
All Buffers Opens all graphs and the log for the selected PID.
Trace Generates a detailed trace log.

Table 41: Options menu options

Command

Function

Draw All Points

Toggles between drawing all points on the graphs, drawing
every nth point. ‘n'is calculated from the total number of data
points and the screen space for the graph.

Synchronize Views

Toggles the graphs between using the same position and zoom
settings and operating independently.

Auto Scale % Axis

Toggles the selected graph between fixed and auto scaling of
the y axis.

Save Results File

Toggles between saved bmr file to disk (MRU file list updated)
and delete when file is closed.

Table 42: Process menu options

Command

Function

Process Streams

Applies the stream(s) from the PID(s) selected in the Stream List
to the System Target Decoder Buffer Model.

This option is only enabled when one or more unprocessed PIDs
are selected in the Stream List.

Table 43: Trace menu options

Command Function

View

Column Opens the column definition dialog box for selecting the columns
of information that has to be displayed.

Font Selects the font that is used for displaying the text of detail
message log records.

Colors.... Selects background and text colors that are used to display
each type of message.

Newest End Displays the newest record.

Show

Markers Shows markers permanently while using Trace with the Buffer

Analyzer.

General Text

Shows or hides general messages. For example, messages
indicating the start of processing for a particular PID.

Fixed

Shows or hides information such as transport rates and buffer
sizes.
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Table 43: Trace menu options (cont.)

Command Function

PCR Timestamp Shows or hides messages about PCRs and associated
instantaneous transport rates.

System... Selects which types of system messages to show.

Audio... Selects which types of audio messages to show.

Video... Selects which types of video messages to show.

Table 44: Window menu options

Command Function

Cascade

Tile

Arrange lcons Arranges any minimized windows along the bottom of the main
window. Aligns icons of any minimized windows at the bottom
of the program's main window.

1 <window file> Lists all of the available windows. A check mark indicates the

active window. Select an option to bring that window to the top.

Table 45: Help menu options

Command Function

About Buffer Analyzer... Opens a dialog that displays the program version number.
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The Stream List is displayed in the form of a tree view. The tree view is grouped
and sorted by the program numbers with the label for the PIDs, stream types,
and the states displayed. The Stream List displays all the elementary streams in
the file. An unprocessed state is indicated by the black label and the processed
state is indicated by the green label.

The ‘+' symbol displayed to the left of some icons indicates that the item includes
lower-level stream components that are not displayed. The symbol changes to

‘=" when the lower level components are displayed. To expand the hierarchy,
click on the ‘+' symbol. Similarly, to collapse the hierarchy, click on the ‘-' of
the selected upper-level icon.

The System, Audio, and Video PIDs of a specific program number are displayed
as leaf nodes of the same level.

# h264_with_audio.bmr - Stream List

YL Transport Stream

= & Program 1
FID 16 (Systern) Processed
< PID 17 Stream Type: 27 (Ox1b) (H264 Yideo) Processed
13 PID 20 Stream Type: 4 (0x04) (MPEG-2 Audio) Processed

Stream Type includes Video, Audio, AC-3 Audio, AAC Audio, System, or
Private. Private streams cannot be processed, but may show more information
about the type, for example ISO/IEC 13818 Auxiliary. The Packet Interpretation
from the System tab of the Settings dialog box sets the standard that is used for
identifying these types.

The preceding example is from a DVB compliant transport stream.

An ATSC stream might look like this:

?f-' atsc_ba_test.bmr - Stream List

SE Transport Stream
—I-5Y Frogram 1
PID 16 (Sysbemn) Unprocessed

w PID 1 Stream Type: 2 (0x02) (MPEG-2 ¥iden) Processed
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This tree view lists processed (analyzed in the buffer model) and unprocessed
streams. A stream may be processed only once when the file is open. To process a
stream again, the file must be closed and then opened again.

When an MPEG file is first opened, the program streams are all marked as
Unprocessed. Unprocessed state indicates that no buffer analysis has been so far
performed in this session so far.

If a BMR file is opened, the streams state will be displayed as processed or
unprocessed. The file only holds results for those streams marked as Processed.
To obtain results for unprocessed streams, the original MPEG file must be
reopened and analyzed.

Selecting streams

To analyze or open the results views for a stream, or streams, they must first be
selected in the Stream List. To select a stream, click on the PID number.

For example, click on PID 1 Stream Type text to select the Video stream carried
in PID 1.

E h264_ with_audio.bmr - Stream List

‘i Transport Stream

=3 Program 1
PID 16 (System) Unprocessed
S JFID 17 Stream Type: 27 (0xlb) (H264 Yiden) Unprocessed
Jd PID 20 Stream Type: 4 (0x04) (MPEG-2 Audin) Unproressed

By using the Shift and Control key, you can make multiple selections for all the
tree nodes.

You can select the highest level node to process all the descendent nodes. For
example, selecting the highest level transport stream node will process all the
PIDs or selecting a specific program level node will process all the PIDs of that
program.

To select a contiguous range of streams: click on the first streams PID, then hold
the Shift or A key down and click on the last stream's PID number. If the required
streams are not adjacent, hold the Ctrl key down and click on the PID number
for each stream.

All streams can be deselected by clicking the mouse pointer outside the tree view
data. To deselect a particular stream while leaving the others selected, hold the
Ctrl key down, and click the stream's PID number.

MTSA-HW and MTSA-PC Analyzer Applications User Manual 215



T-STD Buffer Analyzer — Stream list

Processing streams

When one or more streams are selected from the Stream List, they can be analyzed
in the buffer model.

To start analysis, select the Process Streams option from the Process menu.

T-5TD Buffer Analyser - atsc_ba

Alternatively, click on the Process button in the toolbar.

[ | B & ? M re|uz|ee|e | 4 | wa| E| | &[5

Ql

You can also process the highlighted streams by selecting Process Streams from
the shortcut menu.

B8 h264_ with_audio.bmr - Stream List

L. Transport Stream
=18 Program 1

----- PID 16 (System) Processed

o) Unprocessed

i) Frocessed

Tr:ﬁsp ot Buffer
Main Buffer
Elermentary Buffer
PID Event Log

&ll BufFers

Glabal Event Log
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When H.264/H.265 streams with SEI (HRD) parameters are processed, a dialog
box is displayed, prompting you to either continue or abort the processing of
streams. If you continue, the STD leak method will be used for analysis. If you
abort the process, the state of that stream will be displayed as aborted.

HRD parameters detected (PID: 35)

HRD Parameters are present, however STD leak method is
used for analysis,
Do yau wank bo continue?

[ Do nok prompt again

Continue | Abort

NOTE. For HRD model analysis, use Tektronix MTSA-PC HEVC / AVC Video and
Compressed Audio Analyzer.

Supported profiles and  Buffer Analyzer supports 6 Profiles for MPEG-2 video: Simple, Main, SNR,
levels  Spatial, High, and High 4.2.2 (ISO/IEC 13818 part 2 section 8.5).

Buffer Analyzer supports 7 Profiles for H.264: Baseline, Main, Extended, High,
High 10, High 4.2.2, and High4.4.4 (ITU-T H.264 Annex A).

It supports 4 Levels: High, High - 1440, Main, and Low (ITU-T H.264 Annex A).

Buffer Analyzer supports the Main, Main 10 and all the Range Extension profiles
in HEVC (H.265). All specified levels and Tier in HEVC are also supported
(ITU-T H.265 Annex A).

Startup  The hypothetical T-STD specified in ISO/IEC 13818 part 1 section 2.4.2 assumes
a processing steady state. To handle the startup processing before reaching the
steady state, Buffer Analyzer performs as follows:

m  The fraction of the first video frame leading up to the first picture start code
is not passed through the Buffer Analyzer. This is because it is not possible
to determine whether the Leak or VBV Delay method is being used. During
this period, the PES header, Sequence Header, and Extension information are
extracted. This information is used to determine the initial DTS, size of the
MB and EB buffers.

B  The Decoding Time Stamp (DTS) for the first frame is assumed to be correct.
It is used as a base for the timing of all subsequent frames. MB underflow
errors are suppressed during the first frame.

If the DTS of the first frame is not correct, use TS Cutter to remove the suspect
frame(s) from the file.
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Approximations ~ The application uses the following approximations to model the behavior of the
hypothetical T-STD:

B Data is processed one packet (188 bytes) at a time. An underflow/overflow
condition that occurs and clears within the period of one packet will be missed.

B Processing one packet at a time causes the buffers to be emptied in block
fashion, thus giving a stepped graphical output.

m  Slight quantization effects occur because the model is processed at discrete
time intervals, corresponding to a single packet length. This may affect the
VBYV Delay calculations. The timing intervals for transferring frames from
MB to EB are dynamically adjusted to compensate.
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T-STD Buffer Analyzer — Event and message logs

Global event log

The T-STD Buffer Analyzer allows you to access the Global Event log and the
PID Event log. You can use the Trace to create a log containing a more detailed
analysis of the entire process.

The views can be synchronized by selecting the Synchronize Views option from
the Options menu. While Synchronize Views is enabled, a change to any view is
immediately applied to all the other views.

Building Program T able

Packet Size = 188 bytes

Seatring PCR'z

Mean Transport Rate = 8.000 Mbit/s
Firished Pre-processing

?_ﬁ' atsc_ba_test.bmr - Event Log EE{
|Euilding Program Table A

Freparing Program 1 Spstern Fid for processing
Pracessing selected streams
Pracesang Interval = 0,00:00; 00

Preparing PID 1 for processing
Frocessing selected streams
Pracessing lntereal = 0:00:00: 00
Pracesaing A ate = 79, 999264 Mbit/s

| £

The Global Event Log displays: reports from the initial analysis, PID independent
information (Transport Stream errors) and high level details for each stream
processed.

For details of events detected during the processing of a stream, open the PID
Event Log for that stream.
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PID event log

220

Event selection

B8 atsc_ba_test.bmr - Event Log for PID 16

Tirne: T5 Packet Event Type Commenk
Qoad 0 Log Started Starking the Systems buffer model
oo o0 General Evert TB size: 512 bytes, R rate: 125000 bytes)s
ool o General Evert B size! 1536 bykes, R rabe 16000000 bytesis (127999,999 ¢
o:oon 3 TE Cverflow Start Stark of TB overflow
Q0007 34 Fatal Error TE i full, [nata being discarded
00007 39 T8 Overflow End End of TE awetflow
< >

An Event Log window may be opened for each PID that has been or is currently
being processed. Results are written to the log as they are produced. All time and
packet numbers are given, relative to the start of the file.

Selecting an event row from the Event Log will place a cursor at that time in
each of the Buffer Results graphs. To select an event, click on the row of the
desired event.

BB Test2.bmr - Event Log for PID 610 [ (O] x]
Time TS Packet Event Tupe Camment -
012080 E4254 B/MWB Overflow Start  Start of MB overflow I—
12110 B4413 Gereral Event WBY _DELAY penod exceeds avalable time befare dec
12117 B4450 BB OverflamEnd  End of ME overflow
012118  EB4457 General Event VEY_DELAY peniod excesds avalable time befors dec
0165273 81238 B/MB Overflow Start  Start of MB overflow
115352 B16R General Event WBY DELAY penod exceeds avallable ime before dec
15403 8197 B/MB Overflow End  End of MB averflow
IE (115 697 Jeetks B/ME Qverflowe Start Start of ME averflow
015737 94028 General Event VBY_DELAY penod exceeds avalable time before dec
015802 24052 Feneral Event WBY_DELAY penod exceeds avallable ime before dec
016872 854423 B/MB Overflmm End  End of MB averflow
1E6.095 85614 B/MB Overflow Start  Start of MB overflam -
.| | 2y

To deselect an event, click the mouse pointer outside the data column.
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Trace

The Trace is used for analyzing the message logs produced by the Buffer
Analyzer. The message logs may be useful for in-depth analysis of the internal
processing, particularly for the video stream type. Trace has filtering capabilities
that allow you to focus on message types of particular interest.

Trace record is displayed only for processed streams.

H 264_with_audio.bmr - Trace

Description
B occupancy 2072 bytes. Bemoving frame of size [H
576 bytes:
Frame rate= 41.67 1ntDT5= 21374226
Pes Header found at m_B[39898] len= 3464:

PTS 1981261087: Frame decode set to 237.515
{look ahead=0.024)

B occupancy 2048 bytes. Bemoving frame of size
576 bytes:

(=] e Y ] (=]

Frame rate= 41.67 1ntDT5= 21376386

B occupancy 2010 bytes. Bemoving frame of size
576 bytes:

Frame rate= 41.67 intDTS= 21378546:

B occupancy 2132 bytes. Removing frame of size
576 bytes:

Frame rate= 41.67 1intDTS= 21380706

B occupancy 2146 bytes. Removing frame of size
576 bytes:

Frame rate= 41.67 intDTS= 21382866:

B occupancy 2058 bytes. Removing frame size
576 bytes:

Frame rate= 41.67 intDTS= 21386026

= (ol ] (ol ] (=l ()

[7983 Trace records [0 Selected Y

User interface  To start Trace, select the Trace option from the View menu.

Alternatively, click the Trace button in the toolbar.

Clee) @] @12) @ =lolrle ] | wls]a] alalE Q

Frace window

Trace displays the detailed message log in the main window. It has a Status bar at
the bottom of the window and a scroll bar on the right side.

The Status bar can be hidden from view, but when it is visible, it is always at the
bottom of the main window.

Detailed message records ~ These are displayed in the trace window as a table. Each record is represented
by a single row of the table. The window displays buffer sizes, transfer rates,
profiles, levels, and frame rates that are used for the analysis. The window also
displays the data movements between buffers and their occupancies with respect
to time and packet numbers.

The example shows a log in which a PID (PID 17) carrying video was analyzed
and another PID (PID 20) carrying audio was analyzed.

MTSA-HW and MTSA-PC Analyzer Applications User Manual 221



T-STD Buffer Analyzer — Event and message logs
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Selecting records

The types of messages that are displayed in the trace window is selected from
the Show menu.

To move forward and backward through the log, use the scroll bar on the right
of the window, the Page Up, Page Down, Cursor Up Arrow, and Cursor Down
Arrow Keys.

NOTE. If more than one PID is processed concurrently by the Buffer Analyzer,
the records will be interleaved in the Trace display. Unless this interleaving is
required, processing one PID at a time will make it easier to follow the messages
for each stream.

Records may be selected for printing, copying, deleting, and other Edit menu
operations. To do this, they must first be selected.

A single record can be selected by clicking on it. To select a contiguous range of
streams, click the first record to be selected and then hold the Shift down and click
the last required record. Alternatively, click the first record, hold the left mouse
button down and drag the pointer to the last record.

Selected records are repainted in the highlight color scheme. By default, this is
black text on a magenta background. For example:

HMpeg_with_PER.hmr - Trace

Description

ITS 28553 Pes Packet 0:

Picture 1 decode set to 0.337
ahead=0.168):

KB Picture Header (1) moved to EB:
MB occupancy 170 bytes:
DTS 32153 Pes Packet 1:

Picture 2 decode set to 0.377
ahead=0.188):

KB Picture Header (2) moved to EB:

B a3
Edi m 1S 35753 Pes Packet 2:
e D gy i Picture 3 decode set to 0.417

Show ¥ ahead=0.207):

Delete

Delete Except B Picture Header (3) moved to EB:

e MB occupancy 170 bytes:
Delete Al DTS 39353 Pes Packet 3:

Picture 4 decode set to 0.457 (look
Select Al ahead=0.208):

B Picture Header (4) moved to EB:
MB occupancy 165 bytes:

[1748 Trace records |1 Selected 4

The selected records can be edited and viewed by using the shortcut menu option.
You can edit (cut, copy, delete) records, define the Trace (column, font, colors),
and select messages (System, Audio, Video) to be displayed in the Trace. You can
also show/hide general text, fixed, and time stamp features.
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Column options
Column option from the View menu.

Column Definition

Columns |

¥ Source
¥ Time

[” Packet
[+ Type

¥ |dentity
¥ | Decoded

X

[ o |

Caticel

A column is shown for each option that is enabled and is indicated by a check
mark. Clicking on an option toggles it between being shown and hidden.

Fonts  The font of the messages displayed in the Trace table can be changed using the

Font dialog box.

Font: Font shyle;

To set the columns of information that are displayed in the Trace table, select the

Bold

Reqular
[talic

Bk Antiqua

M CentSchbook BT Bold Italic
ﬂ Certuny

(} Certury Gathic

B Century Schoolbaok 5%

(} Bockman Old Style. —

— Sample

AaBbYyiz

Script:

I'Western

=

This font style i imitated for the display. The clozest matching stole

will be uzed for printing.
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Color schemes

You can select the font, font style, size, and script from this dialog box. A sample
of the selected font is displayed in the Sample display box. Click OK to see the
selected font in the Trace table.

The color scheme for each message type and for highlighting selections can be
changed using the Select Colors dialog box.

Select Colors x|

Highlight r Test Colar
= ok,
M arkers -- --
General Test
MFED FIXED HE N —
MPEG PCH o
MPEG Sv'5 B _
MPEG ALD AL 1 1 _—
MPEG ALID B
MPEG ALID TIME - Background
MPE VID MB
MPEG VID EE HEEN Reset Al

FMPEG VID WVEY ;I

To modify the color schemes, select the Colors option from the View Menu.
This opens the Select Colors dialog box.

Select the message type to be changed from the list box on the left. The current
color scheme will be displayed in the Sample under the list box. Click on the
swatch (colored square) in the Text Color and Background panels for the required
text and background colors.

Repeat the procedure for each message type that is to be changed and click OK.

The Reset button restores the selected message type to the default color scheme.
The Reset All button restores all the color schemes to their defaults.
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T-STD Buffer Analyzer — Results graphs

Common features

The axes

Zoom

The results of the analysis are plotted on a separate graph for each buffer. When a
graph is opened for a stream that is still being processed, each result is plotted as
soon as it is produced from the model.

All of the graphs have a similar format and controls.

All of the graphs plot time from the start of file on the x-axis and current space
used in the buffer on the y-axis.

When the results graph is first opened, the entire graph is shown. Even a small file
may display data points packed too closely to see the features clearly. For example,
here is just under 20 seconds of a video stream that generated several events:

B B Rt e = e e
0 | ( :
O e

# Audio Main Buffer (Bn] - Pid 36 EEE
LIS bl Heddinah o ik s dona oo "
BBl 1% :
DR P11 0 | 3 O S A o 8 A 5 O 8 5 (O I --
" snox! - f f=-f- 141 { remeetefl X ' [ ! -
< 0% 1 5 | RN OO | RS ) | S N N
nox
0.0.000 0.4.000 08000 012000 016,000 20,000
. 0:20.000

LR (LS L LU AL R L
1000

Even this small sample holds some solid bands of blue lines and green event
markers, from which only general trends can be determined.

To change the time scale (x-axis) to resolve finer detail, click on the Zoom In
button on the Toolbar:

Dlwlml = ?I ! TE:l]!-[EIE EL

| wilz ]| @lalFE al

Zoom in as many times as required to achieve the desired magnification. The
magnification is doubled each time the button is clicked.
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Scrolling the view

226

In this example, clicking the Zoom In button three times gave a much clearer view:

(=9

B Audio Main Buffer (Bn) - Pid 36

B38%? . $
I 77} e QI TR, PSR e 0 T oy
- ;.'7_.17,:----- T S (RN W CO——
4 N
| esox | i ;
1 5387.:‘"' SRR " S . O SY.. -, - N_—_
T oseEn -

- 4BAx . ; !

W0 PR B Y | T
03634

06634
8694

To Zoom back out, click on the Zoom Out button as many times as required:

{2 5] S(2] 8] =[] | wizla] QIAE G

Each time the Zoom Out button is clicked, the magnification is halved, until the
full graph is again displayed.

The slider at the bottom of the window indicates where the displayed area is in
relation to the rest of the file. It can be used to scroll the display through the graph
in a similar way to a window scroll bar.

Slider Control

Shows either: the center of the visible
area of the graph, or the position of the
cursor in both the file and visible area.

View Bar

Shows size and position
of visible area of the
graph within the file.

Start of file

End of file

To scroll the stream through the view:
®  Drag the Slider Control left or right with the mouse.

m  Click the mouse pointer in the slider bar (either the clear sections or the view
bar) to the side of the Slider Control.

When a time or event is selected on the graph, the Slider Control is automatically
repositioned within the View bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.
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Event markers A graph may show one or more green triangular markers along the top. Each
marker indicates the time a particular event, listed in the PID Event Log, occurred.

! Audio Main Buffer (Bn) - Pid 36

VWRRWVTW SO ST SRR VO S TR e
n i

20

i nanzj’

',EW_;.. A4105 0S| AVAI L DAHARL IR ISARIAE 1T I R SOSSE— S—————————"

e |25.n}:§r— A O e
0 A LED]

- 1000 ¢

750%

0.0z |

250% |

B Lo R :

00,000 011968 1:2293 035904 o47872 053839

Only events that relate to the points plotted on the graph are displayed in that
graph. An event relating to a Video Multiplex Buffer will only be marked on the
Video Multiplex graph and not on the Elementary or Transport Buffer graphs.

Double-clicking on a marker will display a pop up window. This shows the time
and a brief description of the event that is marked.

# Videa Multiplex Buffer (MB1) - Pid 32

200.0%
Time 0:36.562
= : H MB Faited 1o Eniply .
175.0% - - ans = - — Buffer MB Faled to emply within 1 second
T 1500%
RIZE0R | o= o ————————————————————————— e e S G
. 1000% |
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For example, selecting an event relating to the Elementary Buffer from the Event
Log of a video stream will place a cursor at the time of the event in the buffer
results graphs. Looking at the graphs, a marker of the event has been placed on
the Elementary Buffer graph, but not the Multiplex Buffer graph.

& figh2. bmr - Event Log for PID 49

Tima TS Paket | Evert Type | Comment A
0:12.059 155434 B/MB Qverflow Start  Start of MB overflow
0:12,525 161503 BJMB Overflow End  End of MB overflow
0:12,928 166691 ME Faledto Empty  Buffer MB Failed to smply within 1 sacond
0:13563 174832 BME Overflow Start  Start of MB overflow
0:14,103 181344 BJMB Overflow End  End of MB overflow
0:14 492 186857 ME Faledto Empty  Buffer MB Failed to empty within | second ‘
0:14/631 160635 BB Overflow Start  Start of MB overflow =
0:14.644 LB6G20 B/MB Overflow End  End of MB averflow [
0:15.086 194282 B/ME Qverflow Start  Start of MB overflow
0:15,103 194733 BJME Overflow End  End of MB averflow
0:15.123 195003 BJMB Owerflow Start  Staet of MB averflow
0:15.355 197986 BJME Overflow End  End of MB averflaw
0:15,631 201543 BJME Overflow Start  Start of MB overflow ¥
< I >

] N |

, h\'f A

i MU DRV TARITENAL

[T I S
00,000 04188 08376 012564 016752 0:20.940

0:20.340

“I?E.DH:P cmmeen - setaseaas
S0 § oo st
- 1250% e i
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Synchronize views  Graphs of results can be open for one or more streams. For each stream, one or
more graphs can be displayed. The graphs can have their zoom, cursor position
and visible section manipulated separately or all the graphs can be synchronized.
For example, in unsynchronized operation, the open graphs might look like this:

¥ Video Elementary Buffer (EB1) - Pid 512

015578

0:10.386

This pair of graphs show different periods in the file at different magnifications.
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To synchronize the views, select the Synchronize Views option from the Options

menu.

| Options | Process Trace Wind

] Draw All Points
Synchronise Views
Auto Scale % Axis

v Save Results File

Alternatively, click on the equivalent shortcut button.

Do || o S %] M| ze|xe|=mle ]| iz«

This will apply the zoom, cursor, and visible section of the active window to all of
the other graphs. While Synchronize Views is enabled, a change to any graph is
immediately applied to all the other graphs.

¥ Video Elementary Buffer (EB1) - Pid 512

Synchronise Yiews

.........................................................................

0:15578 o207 025,964
0:25.964

015578
0:25.964

(10,386
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The Trace table can also be synchronized with the other graphs by enabling the
Synchronize Views icon. While Synchronize views is enabled, a change in the
selected event of the Trace table moves the cursor position of all other graphs
accordingly. Similarly, a change in any of the graphs moves the highlighted event
of the Trace table accordingly.

E!ﬂnnl_onlpul!.hml - Trace

) I i 0
0.0%
0:2.407, 0.0
ST st sk e audlames s pi g U S gL T RO s RO S S R g s s e s e e

To separate the control of the graphs, disable synchronize views by selecting the
menu option or by clicking the shortcut button again.

Selection  The cursor can be repositioned within a graph by clicking on the required point.
This is useful when Synchronize Views is selected as a way of marking the same
time in all the graphs for ease of comparison.
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Auto scale

The scale on the y-axis of the graphs shows space used in the buffer as a
percentage of total space. By default, all of the graphs have a vertical scale that
goes from -50% to 200%. The following illustration is an example.

—_

# Video Elementary Buffer (EB1) - Pid 32 =3

0:0.000 0:11.968 0:23.936 0:35.904 0:47.872 0:59.839
053.839

Selecting the Auto Scale % Axis option from the Options menu changes the
y-axis for the active graph.

[ Options | Process Trace Wind

I Draw All Points
Synchronise Views
Auto Scale % Axis

v Save Results File

Alternatively, select the equivalent shortcut button.

D || | e8| SR A z=|==fee o] - | il E] ] RIG[E] Q

Autn Scale %

The y-axis is now drawn so that the full scale contains the range of values in the
graph, to the nearest 25%. For example, if the range of values was from 30% to
64%, the y-axis would go from 25% to 75%.
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The earlier example will be rescaled to look like the following:

#Video Elementary Buffer (EB1) - Pid 32

1000

800

BO.0%

40,00

20.0%

0.0z
(0:0.000 0:11.968 0:23.936 0:35.904 0:47.872 0:53.8339

— 059,839
!

To revert to the default scale, select the menu option or click on the shortcut
button again.

Draw all points ~ The graphs will often contain more data points than can be resolved on the screen.
By default, to avoid drawing points on top of each other, the application will plot
every nth point. This also speeds up the drawing process. How many points to
plot is determined from the available width of the graph on the screen and the
total number of points to plot.

Use the Draw All Points option to look for outlying points and to resolve the fine
detail when the display is zoomed in on the data.

Selecting the Draw All Points option from the Option menu will cause the
application to plot every point.

[Gptions] Process Trace Wind

Draw All Points
Synchronise Views
Auto Scale %6 fxis

v Save Results File

Alternatively, select the equivalent shortcut button.

=121 7] B2 W] =elolele| - | wisl4] alal al

For larger files, this might take much longer than the default option. The option
may be disabled by clicking on the shortcut button again or deselecting the option
from the menu. This can be done even while the analyzer is still redrawing the
graphs.
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Elementary Buffer graph

B Video Elementary Buffer (EB1) - Pid 39 EExK

0:0.000 0:4.000 0:8.000 0:12.000 0:16.000 0:20.000

— 0:20.000

An Elementary Buffer graph can only be opened for Video Streams, since these
are the only type that have an elementary buffer.

Elementary Buffers are not allowed to overflow, so the graph of the results never
goes above 100%. The graph uses the scale -50% to +250% to make comparison
easy.
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Multiplex or Main Buffer graph

B Video Multiplex Buffer (MB1) - Pid 39 FEX

0:0.000 0:4.000 0:8.000 0:12.000 0:16.000 0:20.000

= 0:20.000

For Video streams this graph shows the results for modeling a Multiplex Bufter.
For Audio and System Control streams the graph shows the results for the Main
buffer. The title bar shows the stream type.

Here is an example to show the title for a graph of a System Control stream.

B System Main Buffer (Bsys) - Pid 36

P N e RO T O R e ol R L

[:0.000 [0:4.000 00:8.000 0:12.000 0:16.000 0:20.000

— 0:20.000
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Transport Buffer graph

% [=mmmmmmmmmem o nmno e T R ECCCRTEEETEE PP :
176.0% p----m-msmmmmmem oo T R Recinmimis s s i e e :

T 150.0%

RT3 S T ] RET TR Feenmmmammmeeee e :

_1000%

ﬂ"- 0:0.000 0:11.968 023,936 0:35.904 047872 033839
(59 839

The Transport Buffer graph shows the results of modeling the Transport Buffer
for Video, Audio, or System Control streams. The type of stream is shown in the
title bar. In the above example, the results plotted are for a Video stream carried
in PID 305.

Here is an example of an audio stream.

¥ Audio Transport Buffer (TBn) - Pid 320

Tl e e e e e e

B [ - mmmmmmmmm o s mm oo T

" 1s00%

il e e - — O ——— e b :

- 1000%
o R e

T URUUUUURUINS | SO S oo

=i H ------- (T AR l"N"iﬂ"'ﬂ""";r'{"""""'";'"n""\""

ooz

B 1 P EITREERRRES Y. S—— - O

DD e o
0:0.000 0:11.968 0:23536 0:35.904 0:47.872 059,833

W, 0:59.839
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Elementary Stream (ES) Analyzer is an MPEG (Motion Pictures Expert Group)
stream analyzer that allows all MPEG-1 and MPEG-2 streams to be quickly
analyzed. Developers of MPEG compliant encoder and decoder systems, or field
application engineers (FAEs) supporting MPEG-based products will find ES
Analyzer a powerful and easy-to-use tool and debugging aid.

ES Analyzer provides the following facilities:

B Analyze in detail and verify whether MPEG-1 system and MPEG-2,
video, and audio streams conform to MPEG standards. (A built-in stream
demultiplexer makes it possible to analyze elementary streams embedded in
a transport stream. All streams are checked for both syntactic and semantic
conformance. Syntactic conformance means conformance with the MPEG
language, while semantic conformance relates to the field value and range
restrictions.)

B Quickly zoom from transport streams, through PES and video streams into
GOP, pictures, slices, and all the way down to the macroblock layer.

®  Play out audio streams to MPEG-1, MPEG-2, Layers I and II, and Dolby
Digital (AC-3) standards.

B Audio play to soundcard.
B Analyze Layer I, Layer II audio data, AC-3 audio, and AAC audio.

B View video output with the incorporated video player and analyze picture
data for any frame.

B Produce picture quality analysis data including Quantizer Scale distribution,
motion vectors graph in a picture, and macroblock and picture size plots.

m  View the coded block patterns that have been extracted.

= Display and analysis of DCT coefficients for each macroblock in a picture.

B View interpreted and hexadecimal view of headers for all streams.

®  Display and analysis of DVB Teletext information.

B View and analyze DVB subtitle content.

B View and analyze ATSC closed caption to EIA608 and EIA708 standard.

B View PID spectrum analysis for transport streams.

B Analyze multiple streams in batch mode through the regression testing mode.

B Quickly navigate through stream hierarchy using the powerful and easy to use
graphical interface including the Stream Properties summary window.
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m  ‘Seekback' at all levels, allowing users to go back in a stream at all levels, thus
allow more flexibility in navigation.

B Set a level to report errors, filter them, and also store errors in log files.

NOTE. It is assumed that you are familiar with MPEG compression standards and
terminology. If you are new to MPEG and want to know about MPEG compression
standards and terminology, refer to the documents: ISO/IEC 11172 (Vol. 1, 2, 3
and 4) for MPEG-1 and ISO/IEC 13818 (Vol. 1, 2 and 3) for MPEG-2 basics.
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Starting the ES Analyzer

The program can be started by selecting the ES Analyzer application from the
Start > Tektronix MTSA menu or double-clicking the Deferred Time Analyzers

folder from your desktop, and then selecting the ES Analyzer.

. Tektronix MTSA

T’(l,‘ Buffer Analyser

Carousel Analyser
Carousel Generator

ES Analyser

ISDB-T Remux

Make Seamless Wizard
MPEG Player
Multiplexer

OptionKey Wizard

PES Analyser

SariptPad

Stream Cutter

TS Comphiance Analyzer

TS Editor
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Deferred
Time

Analyzers

' \ﬂ 5 | C:\Users\Public\Desktop\.. —_ L]
Home Share View v 0
T » Deferred Time Anal... v O Search De
~
g Name

3 Quick access
%LII Buffer Analyser

B Desktop o 'ﬁ Carousel Analyser
; Downloads * ﬂ ES Analyser
] Documents of 33 PES Analyser
[&=| Pictures 4 %8 TSCA - Compliance Analyzer
Deferred Time Analyz # v <
5 items

Initially an empty shell window is displayed. It is necessary to open a stream
before any screen details can be seen.
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Opening an MPEG stream

1. To open a file, select the Open... option from the File Menu or select the
corresponding icon on the toolbar.

The following dialog box appears:

open _________________ EHE

Look, i I £ viden
cact_015(1)mpg
zuzi_ 0715 mpg
zhip.mpag
File narme: Iu:-au:t_[l'l 51 ].rpag Open I
Files of type: IKnnwn Formnats j Cancel |
Open &3 |f.‘._ut.;. j [T Hex Window

ES Analyzer displays a standard windows Open dialog box with two
additional fields: Hex Window and Open As.

2. Select the file you want to open.
The types of files that can be opened are as follows:
= Transport stream files
= PES stream files
= Elementary stream files

= MPEG-1 and MPEG-2 files
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= Regression scripts

= Mask files

NOTE. If you want ES Analyzer to automatically detect the type of MPEG
stream the file contains, let the default Auto remain in the Open as field.

If you want to open the file as a specific type of stream and do not want ES
Analyzer to detect it, select the stream type in the Open as field.

If you open an MPEG stream as an incorrect stream type, numerous errors
may be reported and ES Analyzer may also behave unexpectedly.

If you open an ATSC stream as auto and the stream contains no PSIP service

information, the AC-3 audio may appear as C!) and not decode. Close the
file and reopen with ATSC Stream selected from the Open as field; the AC-3
audio will now decode correctly.

3. Enable or disable the hex window.

ES Analyzer parses and demultiplexes the opened MPEG stream, and displays
the packet header fields in two formats - interpreted and hexadecimal.

= If you want ES Analyzer to display the packet header fields in both the
formats, interpreted and hexadecimal, check the check box next to Hex
Window. (The hexadecimal format is displayed in a separate window.)

= If you want ES Analyzer to display the packet header fields only in the
interpreted format, let the default remain. (By default, the check box next
to Hex Window is clear.)

NOTE. If'you do not enable the Hex Window when you open a stream, you
cannot enable it later when ES Analyzer is parsing the stream.

4. Click Open when you are through with this dialog box.
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Understanding the main window and icons

ES Analyzer allows you to view multiple programs and streams simultaneously.
The tree view area on the left side displays the stream hierarchy. For the currently
selected stream, the details of the header are shown on the right side. Errors, if
encountered, are logged in the error log window at the bottom. A summary of the
stream parameters is displayed in the Stream Property window. The status bar at
the bottom of the window displays the current status and stream characteristics.

' Tekironix MPEG-2 ES Analyser - [Sym2.trp]

) File Edit Yiew Window MNode Settings Help Menu Bar =18 x|
- - k3
|ZleEfFrr ST ]8]S &0 ok i Q 55| 3 | Toorsa]
B g TPT ~ Transport Packet Head
< PROGRAM 1
g FROGRAM 2 FID 0 Packet Type [PeT  Tronspot Evorlndicator 3¢
&7 FrOGRAH 3 Transport Serambling Contiol [Not Goramble | *daRtatian Field Cntal Payload Uit Start 7
& Tree Vi iy Ganeyen 3 Adaptation Field " Payload o/ Transport Priority *®
= ree view
=& | Window - Adaptation Field
Ebg w=oruf, MPEG 2 udio
T s£s098) Adaptation Field 152 Splice Counidown A Rlandom Access Indicator %
- @2 PROGRAM 6 IFCIR B2 1A, PCR: Extension i ES Priority Indicator x
B @) PESIFID=10], MPEG 2 Video OPCR Base Ni: OPCR Estension NA Discontinuity Indicator »
= @ VE.5[224] -~ Transport Private Data Bytes Window displaying ‘
i GOP & interpreted data
B {8 FES(FID=620), MPEG 2 Audio L—J
] sEs(32)
- Adaptation Field Extension
AF Extension Length Ni Splice Type: MNA LTW Difset Ni
DTS Mest Ha Fiecewiss Rale M LTW Vil Flag [
Stream Property [ Value |
« File Name 5 \Frojects\StieamshFormahl
+ FlleSize 58566 KB
~ Sueam Type Tiansport

* Video Tracks 1

= fudio| Stream Property

* Tuped "

. Type W'"° 47 40 00 33 BE 00 FF FE-FF FF FF FF FF FF FF FE-FF FF FF FF FF FF FF FF
F] F]

FF FF FF FF FF FF FF FF-FF FF

* User Dala Streams: 0 EF FF FF FE FF FF FF FE-FF FF F |\ puoo | FF-FF FE EF FE FF FE EF FF
* Totel Programs: & FF ¥F FF FF FF FF FF FF-FF FF « UISPIaY  yF_FF FF FF FF FF FF FF FF
 SenviceTyps: VB FF ¥F FF FF FF FF FF FF-FF FF window FF-FF FF FF FF FF FF FF FF
FF ¥F FF FF FF FF FF FF-FF FF Fi FF-FF FF FF FF FF FF FF FF
FF FF FF
1 Tl [ T [Len D:00] Offset
LOCATION | MESSAGE B

TPT->PESPID=410). MPEG 2 Audio->AES (195 Iritilizing AES streamn

( . ..
TPT->PESIPID=510). MPEG 2 Audio->AES(196)... Initidizing AES - -
TPT->PES[PID=620), MPEG 2 Audio>AES(192).... Intislizing 4ES| Error Log Display Window
TPT->PESIPID=H10). MPEG 2Video>VES(224)>  Initializing VES

( 0. )

TPT->PES[PID=610). MPEG 2%idea->WES(224)->  Thizis an MPEG-2 Yideo Elementary Stream -
4] | >
For Help_ press F1 [  [Psckeli47873  |PIDO packet#iO0 |Off 0+895400(8993336]

Tool bar  The Tool bar provides a means of accessing frequently used menu bar commands
quickly; each icon represents a menu bar item. Icons will display a tooltip
description when the cursor is rested over it. The tool bar illustration below does
not show all of the buttons.

= |2 Elfforan He 18| 2 @ | 0| o/l Q565

The following table lists the function of each icon and also indicates when the icon
is available. Availability refers to an icon being enabled or disabled with respect
to selected nodes in the left tree view window; disabled icons are ‘grayed out'.
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Table 46: Tool bar icons

You can toggle the tool bar display by selecting/deselecting the Toolbar command

on the View menu.

Availability
Icon Function (Enabled/Disabled) Menu bar equivalent
= Opens an MPEG stream, a saved Always enabled File > Open...
regression file (.REG file by default),
or dumped reports
~ Restarts analysis from the beginning Enabled for all nodes Node > Initialize
L

of the selected parent or child
stream

Extracts a PES, Audio, or Video
stream from a multiplexed stream

Enabled for all the
embedded stream
nodes (PES, VES, AES)

Node > Dump Stream

[oipaT) |

Allows navigation to the selected
TPT packets; used in conjunction
with the Next icon

Enabled for Transport
and Program

100 _,E

Enables navigation to the nth packet
at TPT node or the nth GOP at
GOP node or nth frame at AES
node. Used in conjunction with the
adjacent button

Always enabled;
disabled only for VES
node

Allows navigation to the
next/previous packet of the
selected node

Always enabled;
disabled only for VES
node, or at end of file

Next/ Previous Packet/
GOP

)

Toggles Start and Stop to run
through Test mode

Only enabled at GOP
level

Start Stop

Toggles between hexadecimal and

Always enabled

2 decimal display of data in fields
t Shows or hides the error log window  Always enabled -
k3 Shows or hides the Hex Viewer, Enabled if Hex Window -
=i which displays data in hexadecimal is checked when
opening a stream,
otherwise always
disabled
3 Enables or disables packet view Enabled only for PES -

analysis that displays the PID
spectrumal format

o

Allows zooming into any part of
data being displayed; useful when
viewing Motion Vector display in the
Slice And MB tab

Always enabled
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Table 46: Tool bar icons (cont.)

Availability
Icon Function (Enabled/Disabled) Menu bar equivalent
ﬁ (lefticon) Shows Frame Size Statistics for Enabled only for GOP Frame Sizes
different frames within a GOP node (Disabled if the
Picture Player tab is
selected)
—_— Shows Slice Size Statistics, i.e., Enabled only for a GOP Slice Sizes
ﬁ (ighticon) information about the sizes of the node from within the
slices within a Picture in a GOP Slice And MB tab
Allows viewing the version and Always enabled Help Topics

2

copyright information

Working with ES Analyzer
commands

When using ES Analyzer, you can issue commands in one of three ways:

® By clicking commands on the menu bar; this also includes the keyboard
shortcuts, which are shown next to the menu bar entries

B By clicking icons on the toolbar

m By clicking the right mouse button and selecting a command on the quick

menu

After you have invoked ES Analyzer, you need to select the bit stream file

you want to be analyzed by clicking Open on the File menu or by clicking the
appropriate icon on the toolbar. If the bit stream file is a valid MPEG file, ES
Analyzer displays the first packet of the top level stream. Now you can use
commands, described below, to navigate randomly to any part of the stream. You
can also run through a selected embedded stream using the Go command.

Tree view and navigation

=gk TPT
- @f PROGRAM 1
- @f PROGRAM 2

=) @f PROGRAM &
=] i PES(PID=610), MPEG 2 Video
B vES(224)
: P W Gop
= 8 PESIFID=620). MPEG 2 Audio

....... @ AES[192)

Figure 74: Icon function availability (enabled/disabled) Menu bar equivalent
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The tree view window displays the stream hierarchy of the currently opened
bit stream file. Each node in the tree view represents a level of hierarchy and
is displayed with:

B An associated icon (the icon varies depending on the type of stream that the
node represents; these are displayed in the following table).

B A tip that describes the kind of stream represented by the node.

m  The PID associated with the node, if applicable.

Table 47: Navigation icons

Icon Stream type representation
ﬁ Transport stream.
@ Program stream.

['jl r__:'-;_} System stream.
==

Packetized elementary stream (PES); PES containing a video

@ @ or audio stream, respectively.

A 5 Audio stream; an MPEG-1 and/or MPEG-2 audio stream.
il

TEXT Teletext.

Dn Dolby AC-3 audio stream.

- £ Video stream; an MPEG-1 and/or MPEG-2 video stream.

If Closed Caption data is detected during analysis, ‘CC' is added
to the video icon.

[:D User data stream.
" Group of pictures (GOP).
ilgli pofp (GOP)
buE DVB subtitle PES.

ET

Suffix 1 and 2 in the Tree View icons (Video and Audio Elementary Streams)
refer to MPEG-1 or MPEG-2. Note that MPEG-2 streams can contain MPEG-1
audio information.

NOTE. If packets are scrambled or if stream analysis (AAC Audio) has been
excluded by dongle, ES Analyzer does not display them.
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Navigating through ~ When an MPEG file is initially opened, ES Analyzer automatically determines the
streams  kind of MPEG stream it is. For a valid MPEG bit stream, ES Analyzer opens the

tree view with a node for the top level stream contained in the file. By default,
the stream hierarchy is expanded to only one level. You can expand/collapse a
node by clicking it. You can select the stream to be viewed at any level displayed
in the tree view window by simply clicking the left mouse button on the specific
node. Automatically, the window on the right is refreshed to display the header
and related information for the selected node.

ES Analyzer gives you full flexibility in viewing streams at any level. You can
navigate through the stream independently at each level of the stream. For
example, you may be viewing the first PES packet of a PES Stream, but in the
embedded VES stream, you may be viewing the last GOP that is not contained
in the first PES packet.

Using GoTo, Next and Previous commands. These commands are applicable to all
types of streams and assume that you have opened a valid MPEG file

Each of these commands can be executed for any node that is displayed in the
stream hierarchy tree where each node is either a GOP or a valid MPEG stream
(embedded or top level).

m  Step forward/backward to the Next/Previous packet or GOP in a video stream
for the selected node.

B Position the file pointer to the nth packet or GOP in a video stream or frame in
an audio stream for the selected video/audio node.

B Position the file pointer to the nth packet of the selected PID; this is applicable
to MPEG-1 system streams and MPEG-2 transport and program streams.

m  Position the file pointer to the first packet of the selected node.

B Save the embedded stream corresponding to the selected node in a separate
file.

m  Toggle between hexadecimal and decimal display.

®  Use the Transport Stream PID drop-down list to select a PID and navigate to
the selected PID using the Next button.
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Header, extension and hex displays

Header display window

Extension displays

248

The header display window shows the current header and related information for
the selected node in a read-only mode. The fields are interpreted and displayed.
The header is not displayed syntactically. Wherever field codes represent specific
values, the corresponding value is shown rather than the code itself. For example,
in a video sequence, although Chroma format is a two-bit code, it is displayed
with the interpreted value of 4:2:0 or 4:2:2 or 4:4:4.

You can view field values in decimal or hexadecimal format by clicking the
appropriate icon on the toolbar. One bit fields are displayed using one of three
icons:

Table 48: Header icons

Icon Field value representation

v One-bit field was set to 1

%4 One-bit field was set to 0

@ One-bit field is not applicable here

Almost all MPEG headers allow stuffing bytes and have marker and unused bits
defined in their syntax. Although all these are parsed and checked for correctness,
they are not displayed since they do not provide any meaningful information.

Wherever appropriate, ES Analyzer provides visual feedback, by the use of color,
to represent different states.

Besides this generic structure, individual headers may have special displays.

For example, the video sequence header has a lot of information to be displayed
in a small area. This is achieved by using tabbed folders for all the MPEG-2
extensions (see the following illustration). The tab corresponding to an extension
is disabled if the corresponding extension does not appear in the sequence header.

When an extension appears in the video sequence, its presence is also
communicated by the changed color of text (in red) on the corresponding tab.

B OME |@CE | roe | 2rssE | Q@r7sE |BUp | macrE |

8 (16 (19 (22|26 |27 |29 |34
16 (16 |22 | 24 |27 |29 (34 | 37
19 (22 |26 | 27 |29 |34 | 34 | 38
22 (22 |26 | 27 |29 |34 | 37 | 40
22 |26 |27 (29|32 |35 | 40 | 48
26 (27 |29 |32 |35 |40 | 48 | 58
26 (27 |29 |34 |38 | 46 | 56 | 69
27 (29 |35 |36 | 46 | 56 | 69 | 83

Load Intra Quantizer Matrix

Load Non Intra Gluantizer M atris

Load Chroma Intra Quantizer Matrix

Q000

Load Chroma Mon Intra Quantizer M atrix
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Hex display window The hex display window shows a hexadecimal dump of header bytes contained in
the header being currently displayed in the header fields display window. This is
useful if you are used to viewing the headers in the hexadecimal format rather
than the interpreted format that is displayed in the header display window. Also
able to be displayed are sequence information at VES level and frame information
at GOP level (as shown below).

00 00 00 00 01 00 01 14-23 9B BG 00 00 00 OO0 00-01 BS 85 55 57 9C 00 00 EI
oo OO0 00 00 OO 00 0O 0O0-00 OO OO OO OO OO OO 0OO—-0O0 OO OO OO OO OO OO OO
00 00 00 00 D01 01 7A 14-36 24 24 22 CO 34 &1 43-E2 E0 C8 00 30 32 80 0C
75 39 CC E1 2B 00 DE C7-94& 47 27 84 A7 10 79 BA-69 60 40 08 1D 6E C2 40
3D EB AE 20 8B EB 3C F1-33 44 0A 71 87 1C 9F 43-88 C1 8C 80 3E 86 C7 BA ll

[ BN | Gyl | Offset 0:0i0) Len O=0{0)

! !

Go to field Find field

The data collection for the hex display window can sometimes be memory
intensive and can affect ES Analyzer's performance. You can turn on the hex
display or turn it off according to your requirements by checking or clearing the
check box next to Hex Window in the Open dialog box. If you have not enabled
the Hex Window option when opening a stream, you will be unable to open it
when ES Analyzer is parsing the stream. However, you can dynamically turn off

the Hex Window, whenever you want, by clicking the Show/Hide Hex Viewer
$

icon on the toolbar if you enabled it when you opened the stream (see details
in the Opening an MPEG Stream section).

The hex window displays a hyphen (-) after every eight bytes for display purposes.
The status bar in the hex window displays the current cursor position's byte offset
from the start of the header. If you select a sequence of bytes in the hex window,
the size and the byte offset from the start of the selection appears in the status bar
when you release the mouse button.

00 00 01 E0O 00 oODEEiemeiCIFEcip il BE5 DD 1F E0-01 7D 9D

[Oifset 0:5(5) [Len OxE[E]

To search for a specific byte pattern in the Hex Window:

1. Type the pattern in the Find field, on the left of the Find button, on the status
bar.

2. Click the Find button.

The specific pattern will be searched from the current cursor position. If the
pattern is found, it is highlighted in the hex window. If the pattern is not found,
you will hear a beep. The search loops back to the beginning of the file and
subsequent occurrences of a pattern can be found by clicking the Find button.
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To position the cursor to a specific byte location from the start of the packet header:

1. Type the byte position in the Goto field, on the left of the Goto button, on
the status bar.

2. Click the Goto button.

The cursor will be positioned to the corresponding byte location in the header in
the hex display window.

Summary of displayed information (Header and Hex displays). The following
table summarizes the information displayed in the hex window that corresponds
to the information displayed in the header display window.

Table 49: Hex Headers display

Header display window

information Hex dump in the hex display window
Transport packet header. Header data of the current packet.

PES Header. Header data of the current packet.
MPEG-2 Program stream - Pack Header data of the current packet.
Header.

MPEG-1 System Stream - Pack Header data of the current packet.
Header.

Video stream - Sequence header / All the video level information which is above the GOP level.
sequence extension.

Video stream - When viewing All the information for the currently selected picture. When the first picture is selected in the
picture at Picture or Slice level picture slider, data corresponding to the GOP header (if available) along with first picture data
display (with video analysis setting appears. For all pictures other than the first picture in the GOP, only picture data is shown. The
set to Macroblock level). subsequently read sequence header and extension data is updated in VES node.

Video stream - Hex data display Same as above.

when viewing picture at Slice level
display (with video analysis setting
set to Picture level).

Video stream - Hex data display Same as above, but with the following exception.

when viewing picture in Picture Picture data includes only picture header and extension data. No slice or macroblock level data
display form (with video analysis is shown. However, when you go down to the slice level display by clicking the Slices button,
setting set to Picture level). ES Analyzer appends slice and macroblock data in the current picture data for the hex viewer.

When you return to the Picture display dialog, ES Analyzer continues to show the complete
picture data. The pictures for which you do not step down to the slice level, you'll still be shown
picture data that includes only the picture header and extension data.

Audio Stream Both frame header and audio data is shown.
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ES Analyzer - Error testing methods and outputs

ES Analyzer can error check an entire stream in an automated manner (regression
test). Part of a stream, triggered from a node for a specific program, can be
manually checked (run though mode).

Regardless of the stream type, testing is only possible at the compression layer;
it is the task of Tektronix TS Analyzer and PES Analyzer to test at the systems
layer. However, you can still view the headers of the transport and PES packets,
but note that no tests are performed (either run-through or regression).

Both test modes will produce screen or file output error messages. Manual test
is also possible by examining the various block/slice/vector and picture display
menu screens.

Error filters can be applied to the tests, and fields selected to allow diagnostics up
to the error point to be dumped in a file for ‘pre error point' analysis.

Run Through Stream test mode

Error display window

This is operated by highlighting the test node - usually the GOP filmstrip icon - of
the appropriate program, then clicking on the Start/Stop (green ball) in the top
toolbar.

The stream will be run though and errors reported in the error display window.

The error display window displays information, warning and error messages
generated by the run-through test mode for a specific program node.

LOCATION | MES SAGE

TPT-»[PSl)-» Packettf 142300: Programit 9001: Beading PMT ...

TFT-»[PSl)-» Packetif 15500; Programit 9003 Reading PMT ...

TPT-»[PSl)-> Packeti 15500 Enorin PMT: coded ES_info_lenath excesds remaining valid lenath of the packet
S TPT->[PSl}-» Final CRC value = 3814643333, (should be O

TPT-»[PSl)-» Packetit 16425: Pragramit 9005 Reading PMT ...

TFT-»[PSl)-» Packetif 16485 Enorin PMT: coded ES_info_lenagth exceeds remaining valid lenagth of the packet
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252

For each message, the following are shown:

B An associated icon that indicates the kind of message (the icons E, I, and S
shown below indicate a syntactic error, information, and a semantic error,
respectively):

@0s:

where:

E = protocol syntax (Rules) error.

S = semantic-parameter or data range error.

I = Information only; not an error. Both E and S should be regarded as errors.

B A string that identifies the exact location in the bit stream where the error was
encountered; the format of the string is:

(STREAMTYPE) -> (STREAMTYPE, STREAMID) -> (NODE) (packetNumber)

For example, the following string identifies an error in packet number 2 of the
MPEG 1 audio stream on PID 210:

TPT->PES(PID=210), MPEG 1 Audio->AES0(2)
®m  The message string associated with the message.

Double-clicking a message in the error display window lets you view more
detailed information about the message.
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Error filtering

Configuring and filtering ~ You can configure and filter the kinds of messages you want ES Analyzer to
messages for display ~ report. You can turn on/off messages of any type (Information, Errors, Semantic
checks) to be reported for the entire stream, or any node in the stream hierarchy
displayed in the tree view. You can also store the displayed messages in a file
or clear the message window.

To configure messages:

1. Click the right mouse button anywhere in the error display window.

LOCATION
TFT[Packetfa7043]->

5 TPT[Packett Dump To File
TPT->PES(FI Clear Log *window
TPT[Fackett

5 TPT[Facket
TPT->PES[FID=32], PES Packetz containing Privat

Filter Messages...

2. Seclect Filter Messages from the context menu that appears:

The Filter Message dialog is displayed. The dialog box contains two tabbed
pages: Global and Node.

Message filtering - global. The Global Message Filter tab provides settings that
can be used to select which messages are enabled and disabled and how many
times enabled messages are to be displayed
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The rules created are global; that is, they will be applied to all nodes in the active
stream. Rules to be applied to a single node (such as PSI, PES, VES) can be
added from the Node tab.

|
] NoDE |

—Mezsage Category IAII 'I
& Disable Messagels) of IA|| 'I bype

™~ Disable Message Mumberis)

" Report Message Number(s) maimum of I :l, times
| g Aled Rule I | n Save Rules...l | Dq' Load Rules...l
—Rules

> RemeyERLE I
P FREmLvE L] |

Cloze |

The top half of the Global tab contains:

B A dropdown list from which the category of messages can be selected to
which rules are to be applied, and

B Three options for the display of messages.

As rules are created using these fields, they should be added to the Rules text field
below by selecting the Add Rule button.
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The three options are as follows:

B Disable all messages on the basis of severity, that is, Info (I), Semantic (S)
or Error (E). Enable the Disable Messages(s) of checkbox, select the type of
message to be disabled and press the Add Rule button. Note that the rule is
added in the Rules text field.

Filter Mezzage

GLOBAL | NODE |

Mesrage Categary IAII hd Ii

* Disable Mezzage]s] of &l v | fpe
Al
" Disable Meszage Humberiz) |1nfo

(5 Emartic

Errar

Rules

[izable Al Semantic Twpe Messages

B Disable messages on the basis of message number. Each message is assigned
a unique number based on the type of streams it is related to; a tooltip will
be displayed when the cursor is passed over the message number. Enable
the Disable message Number(s) checkbox, select the message numbers to
be disabled and press the Add Rule button. The Shift and Control keys can
be used to make multiple selections. Note that the rule is added in the Rules
text field.
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GLOBAL | NODE |

—Mezzage Categomy I,.ﬁ_|| vl
" Disable Messagsls] of I vl tppe

¥ Dizable Message Mumber(s]

" Beport Message Numbers) I—{ Infoll] :Get_macroblock_bwpe(]: unrecoc

Rule:

Diizable b eszage - #1001
Diizable Meszage - #1003

B Report repeated messages only a specified number of times. Enable the
Report Message Number(s) checkbox and select the message numbers to be
disabled. The Shift and Control keys can be used to make multiple selections.
Select the maximum number of times that the message is to be reported and
press the Add Rule button. Note that the rule is added in the Rules text field.

L |

&+ Feport Message Humbers)

mazxirnurn of I-m YI tirmes

Rule
|V Fieport Msg #1000 kax. of 10 Times

Fieport Msg #1003 Max. of #$10 Times

Combinations of message rules can be created; they will need to be created and
added one at a time.

Rules can be removed individually (Remove Rule button) or globally (Remove
All button). Rules that are already set cannot be edited; they must be removed
and recreated.
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Rule sets can be saved and reloaded as required using the Save Rules... and Load
Rules... buttons. Message Filtering - Node.

1. Select a stream in the left scroll window and then select the types of messages
you want to be filtered out. By default, all messages are displayed for a stream.

Filter Massage I

GLOBAL  NODE |

Pleaze Select a Stream Please Select Meszages ta Filker Out

F'ES[F'ID=ESD],MF'EI;| E Q Al Messages
------ @ PES(PID=23], MPEG
...... @ PES(FID=83), MPEG

------ £B) FES(FID=A0), MPEG
=) PESIPID=305), MPEI M Generlrioma

EQ VES(224] — l:l S Semantic Enors

- il Goe

------ @ FES(FID=30E], MPEI
...... () PES(PID=58), MPEG
------ 8 PESIPID=57). MPEG
B PES(PID=398), MPEG

PES(PID=160), MPE!
-8 VES(z2)
Sl GOP
J R 4 .

CLOSE |

= If you want your message filter(s) to be applicable to all streams opened
until now, select it for the entire World. This option will apply the filter(s)
to all nodes displayed in the tree view window.

= If you want your message filter to be applicable to all streams, irrespective
of whether they are opened or not, click the Set for all Streams button.

2. Click OK to accept to changes; Cancel to close the dialog box without
applying the changes.
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To store the displayed 1. Click the right mouse button anywhere in the error display window.

MESSAges: 5 Select Dump To File from the menu that appears.

LOCATION
TRT[Packet#37048)->
S TPT[Packett Durp Ta File
TPT->PES(P! Clear Log Window ing Privat

TPT(Packett Eilter Messages...
5 TPT(Packettroeeror

TPT->PES[PID=32). PES Packets containing Privat

3. The Dump Message dialog box is displayed. Enter the name of the file in
which you want to store the messages.

=

Click the Save button when done.

To clear the windows 1. Click the right mouse button anywhere in the error display window.

g

Select Clear Log window from the menu that appears.

LOCATION
TPT[Packet#37048]>

S TPT[Packett Curmp Ta File
TPT-=PES[PI
TPT[Packetk Filter Messages...

S TPT[Packettreeere
TPT->PES[PID=32]. PES Packets containing Privat

ing Privat

Clear Lag “Window
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Status bar

During regression and run-through mode, progress through the stream is indicated
by the status bar at the bottom of the main window. The status bar is split into
multiple fields and displays the following:

m A progress bar indicates the approximate byte position in the file for the
currently selected stream.

NOTE. Since you can view each embedded stream inside a multiplexed stream
independently, it is possible that in each embedded stream you may be viewing
packets which are far apart in the stream. In such cases, the file pointer will be at
different positions for each embedded stream and the file progress bar is updated
according to the stream being currently viewed. The byte offset in the file for the
currently displayed unit of data is also displayed in the status bar. For example,
when you are viewing a Packetized Elementary Stream (PES), the byte offset of
the first byte of the start-code of the currently viewed packet in the opened file is
displayed in the status bar. Similarly, when viewing a GOP in a Video stream
that is embedded in a Transport stream, the byte offset of the start code of the
corresponding GOP in the file is displayed in the status bar. More details are
given with the explanation of status bar with each individual stream.

B Characteristics of the stream being currently viewed. These vary with the
stream and are described in detail for each stream in subsequent chapters
in this book.

B The state of the status bar display can be toggled by selecting/deselecting the
Status Bar command on the View menu; that is, View > Status Bar.
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Regression testing and error log files

Regression test window

260

With ES Analyzer, you can regression test MPEG streams (with errors being
saved to log files) and save data from selected fields to report files for viewing
later (see the section Reviewing a Report for details).

To perform a regression test, close the file, if it is open, using the File menu.
Select File > New Regression Script.... Note that disk drive icons are displayed
on the right side of the directory window; you may need to scroll right to
view/access them.

'!;'Iri'-Tektmnix MPEG-2 ES Analpzer - [Mask3]
| Fie Edt Yiew wWindow Help _ Iﬁllﬂ

Message
Settings

Noitream
Llptions

|Cunenl Directory: 5:%ProjectstSheamsz\Candidate‘mpeg]_ streams

B [ 100arads.m1s [ g duck.mpg [ gpromomplmpg (] mediaplaper_mpeq]
= LR =t =D =GN =k
=35

Streams Selected for Regression

Wiew Eeparts | | Start Hegras sian I Help |

Double-click on the file you require and it should appear in the lower window
Streams Selected for Regression with an orange question mark to the left of
the file name.

When regression is finished, this will turn to a red or green ball, depending on the
errors found. A default log file name is entered; it can be renamed by clicking on
the double-arrow button to the right of the name. After regression testing, the log
file can be viewed by double-clicking on the log file name.

Error messages written to the log file can be controlled via the Message Settings
screen.

The button View Reports is only available to show dump/.dat files if they have
been set up beforehand (see Select Fields and Reviewing a Report sections).
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Setting up the regression You can select multiple streams for regression from the displayed list of files. (To
select multiple files, double-click a file or select it and then drag-and-drop it in the
lower window.) The streams selected for regression appear in the lower window.

Streams Selected for Rearession | Diefault Dir: C:Nw INDOYW'SSTEMP [Change ...) |
% k:\projects\Steams\Candidate'Mischdfl_cut mpg C:AufIND OWSATEMPIA _cut_mpag.log
% k:hprojeotshStisamshCandidatesMischmntest_orig.mpa C:AwIND OWSATEMPSmintest_onig_mpa.log

For each stream, the following are displayed:
®  File name.

®  Default log file where the messages for the stream will go. You can change
this by clicking the icon displayed next to the log file name. ES Analyzer
displays a default directory where all log files are created that store the results
of the regression. You can change the directory for storing log files by
clicking the Default Dir... button.

B The stream type. Initially this is not known and is set to Unknown. Once
the regression is complete, this is updated to reflect the type of stream that
the file contains.

B An icon indicating the state of the stream. Initially, when a file is selected,
the icon appears as a question mark indicating an unknown status. After the
stream is regression tested, the icon changes to red if the regression reported
errors, or changes to green if there were no errors.

Regreszion Bunning. __ !EIE

Fie Name | File Size | File Type |
@ C-\mpegstreamsimlvhbombs_ 000, 14316364 [ideo Elementamy Stre...

| Heagression Cnmplete@i tinimize: ESAnalyser

For a regression test, you can also select embedded streams that correspond to
nodes in the tree view for a stream hierarchy. You can do this by clicking the
Streams Option button in the regression test window; see Reviewing a Report
below. This displays the settings for the current stream. By default, the tests
are enabled for all types of streams, which you can disable. Saving a regression
script also saves these settings.
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Running the regression

Viewing and saving results

Message settings

Once you have set up a regression script, you can run it by clicking the Start
Regression button. A status window displays the continuous status of the
regression. If you want, you can cancel the regression anytime by clicking the
Cancel Regression button in the status window. When the regression is complete,
the state of the regression run on each stream is displayed in a dialog box through
the changed icon which is red (for failure) or green (for success), and the updated
file type. The icon remains a question mark if the file was not a valid MPEG file.

You can view the error log file created for any stream after it has been regression
tested by double-clicking the specific bit stream file in the regression test dialog
box. You will need to associate files of the type *.log with a text editor of your
choice. You may do so through the Explorer. Click View > Options to display the
Options dialog, and then click the File Types tab. By default, ES Analyzer opens
the log files with the application with which they are currently associated.

You can save the regression script and the results in a regression script. To save
the file, choose Save As from the File menu. The file is saved as a binary file and
also saves the regression results. You can reload the regression file including the
results of the last regression whenever you want. Regression can also be run on a
previously saved regression script file.

Messages sent to the log file can be controlled through the Message Settings
dialog box. Rules to be applied to messages can be created as required. The
operation of this dialog box is similar to Message Filtering. For more information
(See page 253, Error filtering.)

Reports and field selection

262

Creating a report

You can save and review reports consisting of field value dumps of specific fields
when you regression test a stream. To review a report, it must first be created by
selecting the fields to be viewed, then setting up and running the regression, and
finally selecting the View Reports button (it is also possible to select and open
multiple reports).

A regression report is packet-by-packet details listed with information fields you
can choose. A report is not an error list, although errors detected may appear in it.
A report can be used to examine run-ups to problems (pre-trigger).

Before starting a regression test, select the Stream Options button in the
Regression test window. Ensure that the Dump Fields checkbox is enabled and
select the adjacent Select button. You can then add the fields to be listed in the
dump file columns (individual fields or all fields).

You can check the dump in file box and name your dat file or use the default
VES.dat or AES.dat.
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Do this for video & audio elementary streams.

To select fields.

1. Click the Stream Options button in the regression test window to display
the following screen.

i Mask2 |
— Streams to be Analyzed
Analyze Dump Fields Dump in File
Q idea Elementary Streams IMacrohIock Level vl v ¥ Select.. | IC:\TEMP'\VES.dat _I
@ Audio Elementary Sheams ¥ [ isEEEt ID\TE'\"”:"\"'B'ES":‘at J
— Durnp Olption
& Complete Stream " Part of Sheam t i i Stee L HE]E IU
™ Hexadecimal Dump " Decimal Dump

2. Enable and disable the streams using the checkboxes in the Analyze column.

Deselect the streams you don't want ES Analyzer to analyze. By default,
all the streams are selected.

3. Ifyou want to analyze Video Elementary Streams, you may either select
Macroblock Level or Picture Level from the adjacent dropdown list.

4. Select the streams for which you want to dump data by enabling the checkbox
under the Dump Fields column.

5. Click the highlighted Select button to display the Select Fields dialog box.

Select Fields

Figlds Excluded: Figlds Included:

=]|
Laner Copynght
1 |Mode Extengion Dk |

Sampling Freguency
Bitrate Emphasis
tode

5B Limit Sdd All
Pratection Bit
Padding Bit
Frivate Bit
Original or Copy
CRLC Check
Bound

Cancel

{Delete

i

Delete &l
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6. Finalize the list of names by adding/deleting the field names in the Fields

Included list box and click OK.

= If you have selected a video elementary stream, ES Analyzer also displays
options in the Select Fields dialog box.

— Dptiohz
—%ES —GOP
Add Al Delete All Aadd Al Delete All
— Dizplay Extension——— — Picture
Add Al Delete Al Add Al Delete Al

— Scalable Extension E =tension
Add All Delete Al |7 Add All [Delete All

You may click the appropriate buttons to select fields specific to these options.
This is a quick way to add/delete specific fields into the Fields Included list
box; otherwise, you will need to manually find and add fields from the Fields
Excluded list box.

For example, if you have added all the fields from the Fields Excluded list
box, and now want to delete VES-related fields from the Fields Included list
box, you may click the Delete All button in the VES section. You can also
click the Add All button under Display Extension to add related fields to
the Fields Included list box.

You may also double-click a field name displayed in the left list box to include
it in the right list box.

Specify the file into which you want the fields to be dumped.

You may type the filename (*.dat) or select one by using the browse button
next to the default filename.

8. Specify the dump options.

Durip Optiohs
+ Complete Stream " Park of Stream el rir Siee B¢ ID
" Hewadecimal Dumnp & Decimal Dumnp [’\X&

If you select Part of Stream, the Maximum Size (MB) field is enabled and you'll
need to specify the size of the stream from which the fields will be dumped.

Once you have specified the fields, return to the regression test window by
clicking the button next to the Stream Options button.
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Reviewing a report A sample report looks like this:

Collecting Statistics for " C:\mpegstreams\mls\bird4.mpg"

Date 04/02/98 Time: 16:38:42

PacketNo.  SCR Fixed Flag Audio Bound
0 1 1
1083 1 1
1083 1 1
3250 1 1
4334 1 1
5417 1 1
6501 1 1
7585 1 1
8668 1 1
9752 1 1

© 00 N O O B W DN -

—_
o

NOTE. The “dump files have the default extension of . dat.

Demultiplexing transport streams to PES or elementary output files

It is possible to select a given stream node in navigation view (such as PES
video/audio) or VES audio/video (but NOT gop). The diskette icon will highlight
on top toolbar at the left when the function is available. Select the icon, name the
dump file and select it's type if required. ES Analyzer will then create a PES

or elementary stream.

This stream can be loaded back into the ES Analyzer to be checked, and then it
can be used as input to Tektronix Multiplexer application to create a transport
stream with SI/PSI to your specifications.
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ES Analyzer — Working with transport and PES streams

Using Packet view

266

ES Analyzer displays transport packets in a specific way that is useful for
analyzing the Transport stream and also for quickly accessing a packet at random.

== T5020804_cut. mpg - packetview =] I

— PID Number

| carpiDsy  [E0EAT

For Help. pres: F1 |PID 2191 |PACKETH 128 A

The packet view window can be displayed by clicking the Show/Hide Packet [l
view icon on the toolbar. A window appears that shows a spectrum of the packets
in the order in which they appear in the transport stream. Each PID is assigned

a color and each packet is represented using a single line of the corresponding
color. By double-clicking the spectral line for any packet, you are positioned to
the corresponding packet in the main window of ES Analyzer.

Packet view communicates with ES Analyzer's main window through OLE. You
can selectively turn on/off the display of spectral lines for any PID in the Packet
view by clicking the corresponding color index in the Packet View dialog. The
color index is also a toggle for display. You can also view distance graph between
packets of the same PID by just viewing spectral lines of the corresponding PID.
To switch back to displaying all PIDs, double-click the All index (represented by
white color).

NOTE. When you first open Packet view, it displays just the front page of the
stream, so that not all of the PID numbers present in the stream are displayed in
the button boxes below the main display. If you want to see them all, drag the
horizontal scroll bar pointer to the far right, all of the PID number buttons will
then be displayed (this could take a few seconds for large stream files).

Packet view does not operate when a program node is highlighted; it works in all
other nodes in navigation view.
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Understanding PES

A Packetized Elementary Stream (PES) as the name suggests is composed of
contiguous packets of an elementary stream with packet headers, as shown

in the following illustration, prepended to the packet. A PES occurs only in
MPEG-2 streams and its structure has been adapted from the packet structure of
the MPEG-1 System stream.

For more information on PES streams, refer to the ISO/IEC 13818-1 document.

— PES Header

Steam D |22 Packet Number I‘I FES et = |
Stream Type IViden skream Pracket Length ID

— Optional Field:

PES: Priarity V4 Header Data Lergth |5 Previaus PES Packet CRC |NA

Copyright v 4 . ESCR Base INA
Additional Copy Info INA

Original or Copy \/ ESCR E stension INA

i Mat bled
PES Scrambling Control I ot serarbles ES Rate [bits/s) INA

Drata Alignment Indicator Ve

PTS_DTS Flags v X s [37220887 DTS [Na.

DSM Trick Mods Field

Trick Mode Contral INA Field |d INA
Frequency Truncetion IN-“- Field Fiep Cortral IN-“-

Intra 5 lice R efresh Q

An embedded stream is checked when you navigate through one. For more
information, refer to Navigating through Streams. (See page 247, Navigating
through streams.)

For PES streams, you can:

®  Run through the stream. (See page 247, Navigating through streams.)
B View packet headers with their decoded fields.

®  View an embedded elementary stream.

®  View PES extension (if received).

Explaining the Status bar ~ The status bar, for PES streams, displays the following:
display

ForHelp, press F | |Packet# 1 | | | | |Off 733(2dd) |

B Packet number, which is the number of the current packet in the PES stream.

= Byte offset in the file, which is the first byte of the Pack header being currently
viewed in both the hexadecimal and decimal formats.
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ES Analyzer — Working with video streams
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ES Analyzer performs detailed checks on MPEG Video streams. Video streams
are complex with an embedded hierarchy. Structurally, a Video stream consists
of a video sequence that has a start code, end code, sequence header, and any
number of group of pictures (GOP). Each GOP consists of a GOP header and a
group of pictures. Pictures may be of different types (I, B, or P). Pictures can
also be frame pictures that correspond to progressive video or field pictures that
correspond to interlaced video. Pictures are broken down into a slice structure
and each slice consists of macroblocks.

For more details, you may want to refer to the documents ISO/IEC 11171-2 and
ISO/IEC 13818-2 that describe the MPEG-1 and MPEG-2 video standards.

Using ES Analyzer, you can:
®m  View the sequence header along with the extensions.
B Navigate through a stream. (See page 247, Navigating through streams.)

B Run through a stream with the option of analyzing the stream at the picture
level or at the macroblock level.

When analyzing a group of picture, you can:
®  Randomly access any picture within the group.
B View the picture type spectrum and picture size plots.

®  Zoom into any picture and see its details at the slice or macroblock levels, or
view the encoded picture. You may also use the video or picture player to play
the entire video and pause at any picture when you notice a degradation in
quality; you can then review the details of this picture down to the macroblock
level. ES Analyzer provides an easy mechanism to switch between the Picture
display and the data analysis display windows.

m  Select any macroblock and examine its detailed coding.

B Perform picture quality analysis with special displays of quantizer scale
distribution, slice size distribution, macroblock-size spectrum and motion
vector plots.

m Interpret any video descriptors received in the higher level streams and
validate them against the stream.

When analysis with the DCT option is enabled, you can:
= View 8x8 coefficients for all macroblocks within a picture.

B View coefficient tables for y, cr, cb, luma and chroma pixel data.
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Viewing the sequence header

The sequence header is interpreted and displayed as shown below.

— Sequence Header
Harizontal Size |192U Frame Rate |2EI.9?D Fiz Constrained Parann: x
Wertical Size |1 080 Bitrate |1 2000000 | Bitsds Load Intra Quantiser M atrix v
Aspect Fatio IS:‘I E WEW Bulfer Size |1 222656 Butes Load Marrlntra Quantiser b atris \/
~ Sequence Extension
Level IHigh Prafile IMain Chroma Format |4:2:|j
Frogressive Sequence x Liow Drelay x Eszape Bit x
— Sequence Display Extension
Dizplay Size
Calor Description e Yideo Format  |Unspecified Vi ’7 Horizortal [Nz Wertical N2
Color Description
Color Primiaries [He,
Transfer Characteristics JMNA
I atrix Coefficients M
UserData
HA |

NOTE. Placing the cursor over either Load Intro Quantizer Matrix or Load
Non-Intra Quantiser Matrix, displays the applicable quantizer matrix. The check
mark icon indicates that the matrix was received in this sequence header.

For MPEG-2 streams, an optional sequence extension and user data may also be
received. User data is displayed as a hex dump. If data is in the ASCII format, the
ASCII equivalent is displayed next to the hex dump.

For Help, press F1 mmm  |?500fps [g:2:0 [ [ [ [

The picture rate, chroma format, and the video type (NTSC/PAL/Unspecified,
etc.) appear in the status bar when the sequence headers are displayed.

The information whether the stream is an MPEG-1 or an MPEG-2 stream is
displayed in the tree view window as a single numeral (1 or 2) on the node icons.

Within a sequence, you can view the GOPs by clicking on the GOP icon in the left
side hierarchy view of the stream. The GOP node appears below the sequence
header node.
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Viewing the GOP and picture header

When displaying a GOP, ES Analyzer shows you a window with three tabs, as
shown below.

CEOTTRGTHENYTTT Slice And MB Picture Player

Briefly, the contents of each tab are explained below. For details, see the specific
sections: Displaying the GOP Header, Displaying the Slice and Macroblock, and
Using the Video Viewer for Picture Analysis.

The GOP tab displays the following:

GOP header data.

A slider for the pictures in the GOP. The slider can be used to randomly access
any picture within the GOP; the slider moves in steps of two to facilitate
working with large GOPs. The slider lists the pictures in the received
(decoding) order.

GOP position transport controls lie to the left of the slider bar

B A

Using these controls, any picture can be selected within the GOP. The controls
include Start and End GOP controls and Next and Previous I frame jump controls.
Note that the [ frame controls only works in streams where multiple I frames are
present between GOP sequence headers.

270

Picture header display for the picture selected in the slider.
Picture extensions (applicable only to MPEG-2).
The Slice and MB tab:

Takes you inside a specific picture and provides detailed information down to
the macroblock level.

Allows you to generate picture quality plots.

Allows you to view a picture frame by frame and view macroblock level data
for a selected macroblock in the picture.
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Displaying the GOP header

The Picture Player tab allows you to play and view the video output on your
screen.

NOTE. ES Analyzer synchronizes the picture being currently displayed by the
video viewer with the picture/data that is displayed on the other tabs: GOP

And Picture and Slice And MB. For example, if you select a macroblock and
switch from the picture display to the other picture-quality analysis tabs, the same
macroblock remains selected for easy identification.

As an aid to locating a stream, you can click on any open GOP icon in the tree
view to switch picture displays in the stream multiplex.

The GOP header is an optional header and it is displayed, as shown below, when
received.

|

R

=]
=]
=]
o

R

Frame Pict

& NE N NE|

=| =
ii

The lower part of the display also shows the picture extensions that have been
received.

[ uartizer M atrix Exkengion
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Video analysis settings. Analysis of GOPs can be carried out at picture level or
macroblock level

This will affect the speed at which the ‘next GOP' is analyzed. The setting is
selected from the Video Analysis Settings dialog.

Select Menu Bar > Settings > Video Analysis. The following dialog is displayed:

Video Analysiz Settings E |

Picture level analpsiz =

Macroblock level analysis eyl |

tacroblock Shadding Scheme
Baszed on Macroblock Size [

Based on Prediction Type [

Picture level analysis provides faster analysis but error reporting at the macroblock
level is suspended. Macroblock level analysis provides error reporting but at the
cost of analysis speed.

Status bar (in GOP mode). When ES Analyzer displays the GOP and picture
headers, the status bar, as shown below, displays the:

= Picture rate

B Chroma format

m  Video Type (NTSC/PAL/Unspecified etc.)
B GOP number of the current GOP

B Picture number of the currently selected picture, relative to the current GOP
(the first picture is given the offset 0.)

B Picture display number, which gives the picture number in display order,
relative to the first GOP received. This represents the actual picture display
number. It is calculated by adding the temporal reference of the current
picture to the cumulative picture display number prior to the GOP.

Displaying the picture ~ The GOP header tab has a slider for selecting the picture whose details you want
header  to display. The header for the selected picture is displayed below the GOP header
in the same dialog box as shown in the earlier illustration.
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Displaying the picture ~ For MPEG-2, several picture extensions may be received. The picture coding
extension  extension is always displayed, while the other picture extensions are displayed
on tabbed folders, as shown below. The tabs for each of these extensions are
enabled and the text on the tab appears in red, only if the corresponding extension
is received in the stream.

BOME |@ce  |@lroe | iPPssE |QPTSE |BUD | wicPE |
Load Intra Quantizer Matriz 0 E LR e e
Load Nan | izt Matii ) 16 (16 |22 |24 | 27 |29 | 34 | 37
oad Non Intra Guantizer Matris 19 |22 | 26 | 27 | 29 | 34 | 34 | 38
Load Chroma Intra Quantizer b atrix 0 22 (22|26 |27 |29 (34|37 | 40
Load Chrama Mon Intra Quantizer M atriz 0 22 |26 |27 | 29 | 32 | 35 | 40 | 48

26 (27 |29 |32 | 35| 40 | 48 | 58
26 (27 |29 |34 |38 | 46 | 56 | B9
27 (29 |35 |36 | 46 | 56 | 69 | 83

All tabs with red text represent extensions that have been received for the current
picture. The next section describes each extension and its interpretation.

NOTE. These tabs will only operate if the appropriate extensions are present
within the stream under test.

All four matrices will only display if they are downloaded with certain stream

types for example, HDTV streams. - indicates that only the default matrix
will be displayed.
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Explaining the picture extensions.

QME (Quantizer Matrix
Extension)

This allows the quantizer matrices to be downloaded for any
picture.

At most four matrices can be downloaded, namely,
intra-quantizer matrix; non-intra-quantizer matrix, chroma
intra-quantizer matrix, and chroma non-intra-quantizer matrix.

The QME tab displays through a check mark the matrices that
were downloaded. A downloaded matrix is displayed when you
move the mouse over the name of the specific matrix.

CE (Copyright Extension)

This indicates any copyrights on the video. The copyright field
is interpreted and displayed.

PDE (Picture Display
Extension)

This extension gives display extensions for MPEG-2 video.

PSSE (Picture Spatial
Scalable Extension)

This is received when the spatial scalability of MPEG-2 video is
used in the video stream.

PTSE (Picture Temporal This extension is received when the temporal scalability of
Scalable Extension) MPEG-2 video is used in the video stream.
UD (User Data) This displays any user data associated with the picture in

hexadecimal format. If the data represents ASCII text, the ASCII
text is also interpreted and displayed.

CPE (Camera Picture
Extension)
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Displaying the slice and macroblock

ES Analyzer allows you to take a microscopic view of a picture by letting you
view the picture's slice and macroblock structure.

To view slice details of any 1. Select the picture by using the picture slider on the GOP And Picture tab.
PICtUre: 5 Click the Slice and MB tab.

The macroblocks for the selected picture are displayed as shown below:

GOP And Piciure e Aud M | Picture Player I
¥ FRAME Rz
ISIice Dizplay  MB Size Display | O-Scale Code Dlspla}ll Mollon\u’ectorD\sp\a}lI Picture Display

iy Toolip |

Macroblock Mumber : 2
ME Intra
DCT Type
ME Quantizer Scale
CEP

ME Size

—Wectors——

EEEEEEE

— Slice:

Priority Breakpaint IF Quantizer 5 cale IS_ Slice Extension Flag @ Intra Slice @ Picture |0 |Ma Fiow Mumber |1_
[ Macroblock.

tacrablock Intra “ Macroblock Quant x Frediction Type e | ST Code Flag x

Macroblock Pattern x Quantizer Scale IS— Iaotion Yectar Format e | ST Class IU_

tacrablock Mation Backward x DCT Type [Frame | Motion Vector Count NA— STw Code lW

Macroblock Mation Fonaard X Macroblock Size T Dkl @ Macroblock Address |2_ CBP IW

The Slice dialog box graphically displays the slices and macroblocks in the
picture and also displays the:

m  Slice header for the selected slice.
B Macroblock details for the selected macroblock.
B Picture Quality data, which overlaps the slice display area.

B Decoded field/frame for the selected picture.
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Explaining the slice and
macroblock display

When displaying the slices, the current picture is represented by its constituent
slices; see the above illustration. You can move the mouse to any slice and select
it using the left mouse-button. The slice header display shows the header for the
currently selected slice. MPEG-1 slices can span multiple rows and the display
shows the same.

Slice display is color coded. Intra-slices are shown in green color, while slices
that do not have this flag set are displayed in gray color.

Within a slice, the macroblocks are also shown. You can select a macroblock in
the slice using the left mouse-button. The header and information of the currently
selected macroblock is displayed below the macroblock display. Skipped
macroblocks in a slice are shown using a different color and cannot be selected.

When viewing the slice display, you can move forward to the next picture or
backward to the previous picture. You do this by clicking the picture navigation
buttons on the top right corner of the dialog box. You can also return to the GOP
display and select a specific picture. When moving backward, you cannot cross the
GOP boundary; however, when moving forward, you can cross a GOP boundary.

When displaying macroblocks, the status bar looks like this:

[For Help, press F1 m  |2500fps [420 [GOP#1 [Pic#tz  [Display#1 |[0Off5233(2417)

Viewing coded block
patterns for a macroblock

276

While in the slice and macroblock level display, you can view the coded block
pattern for any macroblock (except for the skipped macroblocks). This is
displayed in the last field (CBP) as shown below.

Prediction Type Dual Fri STW Code Flag x
kotion Wector Format Field ST Class a
bAotion Wectar Count 1 STW Code

Ok v kdacroblock Address I 8z CEF IDDDDDD

Depending on the chroma format, the coded block pattern is displayed as a
sequence of 6, 8, or 12 bits. From left to right, the bit pattern represents the blocks
in the macroblock as they are numbered in the standard MPEG specifications. For
more details, see the ISO/IEC 11172-3 and ISO/IEC 11318-3 documents.
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Analyzing picture quality

Viewing the macroblock  The Macroblock Size display provides a color-mapped two-dimensional graphical
size spectrum  plot of the macroblock size and type distribution in a picture; it is plotted as an

overlay on the slice display area. This plot can be viewed by clicking on the MB
Size Display button in the Slice and MB tab. The types of all macroblocks in
the picture are color-mapped; a key is shown at the right side of the display and
described below (see Macroblock Colors). Skipped macroblocks are displayed in
dark green. The macroblock size for the selected macroblock is displayed in the
macroblock field display area below it.

GOP And Picture Sl Aud M1 I Picture Player |
Slice Display I MB Size Display | B-Scale Code Displayl Mutim\"eclurDisplayI Picture Displayl Closed Caption Displayl
Toalip
i~ Macroblock Colors
Field Based
Frame Based
16 8MC
‘ Duial Prima
I
~ Wectors——
N | FF
Macroblock Number : 468 I BF
Motion Vectar Parameters(in units of Pixel]: e
MY Backward TopField  » -2.0,y: -15.0 FTF
MV Backward Bottom Field = 4.0,y 29.0 I e
Other Parameters: I BVL
ME Intra =  FalSE
DET Type - FELD | Fer
MB Quantizer Scale = 7
= 101 | B8F
B Size [Bits] = 14 I—
D.T.F.
O U O A O o o
T [oaF
A 1 U A v
Slic
’7 Friarity Breakpoint [N Quantizer Seale (13 SIiceEHlensiDnFlag@ Intra Slice ® Picture [0 |NA Raow Number |1 ‘
Macmblock
Macroblack Intra X Macroblock Quant e Prediction Type FigldBased | STW Code Flag x
Macroblock Pattern v Quantizer Scale 7 Mation Vecter Fomat|Fisid STW Class IU
Macrablock Motion Backward e DCT Type Field Maotion Vector Count |2 ST Code INA
Macrablack Motion Farward x Macroblack Size 45 DMY 3 Macroblock Addiess ID CEF IUUUU11
Macroblock Escape IU
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Macroblock colors. The color-coded macroblock type represents the prediction
type employed

Field Based Predictions are made independently for each field by using data
from one or more previously decoded fields.

Frame Based Predictions are made for the frame using the data from one or
more previously decoded frames.

16 x 8 MC (16 x 8 motion compensation) In which two motion vectors are

used for each macroblock. The first motion vector is used for the
upper 16x8 region, the second for the lower 16x8 region. In the
case of a bi-directionally predicted macroblock a total of four
motion vectors will be used since there will be two for forward
prediction and two for the backward prediction. 16x8 MC is only
used with field pictures.

Dual Prima Only one motion vector is encoded (in its full format) in the bit
stream together with a small differential motion vector. In the
case of field pictures, two motion vectors are then derived from
this information. These are used to form prediction from two
reference fields (one top, one bottom) which are averaged to
form the final prediction. In the case of frame pictures, this
process is repeated for the two fields so that a total of four field
predictions are made. This mode is only used in P-pictures
where there are no B-pictures between the predicted and
reference fields or frames.

NA Not Applicable - Refers to the instances where there is no
prediction in the macroblock.

(For more detailed information, refer to ISO/IEC 13818-2 : 1996, Information
Technology - Generic coding of moving pictures and associated audio information,
Part 2 Video).

Viewing the quantizer scale =~ Quantizer scale distribution for the macroblocks in a picture is plotted where
distribution  the picture slice is displayed. This gives you a graphical view of the scale code

distribution and lets you visually check any obvious scale code problems. This
plot can be viewed by clicking on the Q-Scale Code Display button in the Slices
dialog box. The scale codes of 1 through 31 are mapped to shades of green with
1 being mapped to the lightest shade and 31 to the darkest (black). Skipped
macroblocks use the same scheme but are mapped in shades of gray. The value of
the scale code for the selected macroblock is displayed in the macroblock field
display area below it.
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Viewing the motion vector ~ ES Analyzer gives a detailed graphical display of motion vector for the selected
plots B or P picture. Both MPEG-1 and MPEG-2 type vectors are interpreted and
displayed.
To view motion vectors (applicable to only B or P pictures).
1. Position the cursor to the picture for which you want to see the slice size plot.

2. Move into the slice display dialog box.

3. Click the Motion Vector Display button in the slice display dialog box.

GOP And Piciure Elice Awd bl | Picture FPlayer |
BFRAME < pr
Slice Display | MB Size Display | @-Scale Code Display ”thr[)isplay PFicture Dlsplayl
|- Toaltip
¥
'» :
f I ~Wectars——
v

Macroblock Mumber : 516

tation Wector Parameters(in units of Pixel):

I MY Forward Top Field w28, 30
[ MY Forward Bottorn Field = 1.5, . 30

F.F.

B.F.

MY Backward Top Field = -1.0,y: -3.0 FTF
Y M Backward Bottom Field = 0.5, -1.0
Other P 3
5 MB Intra = FalSE )
OCT Type =  HNA
MB Quantizer Scale = 10 X
CBP = 00000
ME Size = 33 I DTF
[ e o o L 0. e o
[ R Y 3 [ | I D.B.F
T Y 05 [
(T Y T Y ol [
— Slice:
Pririty Breakpaint INA Guantizer Scale |1 1] Slice Extension Flag 3¢ IntraSlice 3 Picture ID [Na Fow Number IW 2
— Macroblack
Macroblack Intra x Macroblock Quant x Prediction Type FieldBa  S5TW Code Flag X
Macroblock Pattern X Quantizer Scale I'ID Motion Yectar Format  |Field 5TWw Class ID
tacrablock kMation Backward ‘/ DCT Tupe MA Mation Vector Court [< ST Code INA
tacrablock Mation Fonward v Macrablock Size 33 Dby x Macroblock Address |51 E CEP IUUUUUU

MTSA-HW and MTSA-PC Analyzer Applications User Manual 279



ES Analyzer — Working with video streams

For each macroblock, the motion vectors corresponding to it are plotted to scale
as a directed arrow. The direction of the arrow represents motion coding for the
macroblock from the reference frame to the current frame. Different types of
vectors are plotted in different colors. You can also selectively choose to display
different motion vectors by using the buttons on the right.

FF Forward Frame BF Backward Frame

FTF Forward Top Field BTF Backward Top Field

FBF Forward Bottom BBF Backward Bottom
Field Field

DTF DMV Top Field DBF DMV Bottom Field

If a button is grayed out, the associated vector is not currently available.

The motion vectors are plotted for the luminance blocks. They are to scale (in the
resolution of full pel or half pel) according to the pel resolution fields received.
For each macroblock, multiple vectors may be received. All or some of them may
be displayed simultaneously.

When Tooltips are enabled, a summary of parameters is displayed in a popup
window.

For MPEG-1 that has only frame pictures, two kinds of motion vectors are
applicable -forward frame (for P and B pictures) and backward frame (for B
pictures).

For MPEG-2 video, additional vectors may also be coded, which are: forward
frame (for P and B pictures), backward frame (for B pictures), forward top field,
backward top field, forward bottom field, backward bottom field, dual prime top
field, dual prime bottom field.

ES Analyzer interprets all the above vectors and lets you view them graphically.
When motion vectors cross the picture boundary, an error condition occurs and
the same is reported in the error log window. In this case, the vector is drawn
until the edge of the picture display.
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Reviewing the decoded  ES Analyzer decodes and displays the selected picture when you click the Picture
picture Display button. You can view I, B, or P frames or fields (only for MPEG-2).

GOP And Picture Bliee Aud M | Picture Player I
P ERAS ME
Slice Display | MB Size Digplap | 0-Scale Cade Displayl Mation Yectar Display ” Picture Dizplay

i

Toaltip |
- I
ac_:roblock Hurnber: 1685 ) Show Grid |
e e s e
Other Parameters: Mectors——
" o N
MBE Quantizer Scale = 9
IEIBBPSize = oo |?
e
[eer
[o7r
[er
- Slics
PFriciity Breakpaint M4 Quantizer Scale l?_ Slice Exterion Flag 36 IntaSlice Y€ Picture 1D [Ma Fiow Number|4—
— Macroblock
Macroblock Intia X Macroblock Quant J Prediction Type [ha | ST Code Flag x
Macroblock Pattern e Quantizer Scale IS— Motion Yector Format Ha | ST Class IU_
Macroblock Mation Backward b 4 DCT Type Frame Mation Yector Count e ST Code IW
Macroblock b ation Fonaard b 4 Macroblock Size 6 | DMy 0 Macroblock Address IF CBF IW

ES Analyzer also allows you to view the previous and the next decoded picture
(whether frame or field) by clicking the appropriate buttons. The actual size of the
picture is displayed and if the picture is larger than the picture display area, scroll
bars will appear. For the picture being viewed, you can select a macroblock by
clicking the left mouse button anywhere in the picture display area. When you do
s0, the slice and macroblock area below the picture displays the slice and MB data
for the currently selected macroblock.

If Tooltips are selected, a summary of the macroblock information is displayed in a
popup box. When you switch from the picture display to the other picture-quality
analysis tabs (e.g., MB Size Display, Q-Scale Code Display or Slice Display), the
same macroblock remains selected for easy identification.

You can also enable a macroblock grid on the displayed picture by using the Show
Grid button to easily identify and select macroblocks.
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282

The picture display has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scalable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

Main Profile @ High Level (MP@HL)
Main Profile @ Main Level (MP@ML)
4:2:2 Profile @ Main Level (4:2:2P@ML)

Viewing the decoded picture with motion vector plots. The decoded picture can be
further enhanced with an overlay of motion vector plots.

The interpretation of the display corresponds with the description in the previous
section - Viewing the Motion Vector Plots.

To view the vector plots for the currently displayed picture:

Select the Show MV button on the right side of the picture.

The vectors displayed will depend upon the selections made from the
remaining buttons on the right side of the screen.
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GOP And Picture Sliee fud WG | Picture Plyer |
PFRAME |
Slice Display | MB Size Display | 0-Scale Code Disp\ayl Motion Yector Dizplay ” Picture Dizplay

Toolip

acroblack Mumber - 165 g
Mation Vector Parametersfin units of Pixel): _IShUW i

Y Fonward Frame w 00,9 000 gpn D[:Tl

Other Parameters:

B Inta = FALSE —Vectors——
DCT Type = FRaME
ME Quantizer Scale = 3 FF.
VB 5ie Dow | TR
B.B.F.
~ Slice:
Pririty Breakpaint [MA Cuantizer Scale l?— Slice Extension Flag x Intra Slice x Picture ID IW Fow Number |4—
r— Macrablock
Macroblock Intra b 4 Macioblock Cuant ¢ Prediction Type Na | ST Code Flag X
Macroblock Pattern v Quantizer Scale IS— Iation Yector Format e | ST Class ID_
Macroblock Motion Backward % DCT Type [Frame | Mation Vector Caunt e ST Code IW
Macroblock Motion Fonward X Macroblock Size 6 | Dby Q Iacrablock Address IF CBP IW

The picture display has the following limitations:

B When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those
that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

B  For MPEG?2 scalable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES
Analyzer.

B For MPEG?2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

NOTE. Make sure that your monitor's display properties is set to either 24 or
32-bit true color; otherwise, you may find a distortion in the colors in the picture
being displayed.
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Displaying DCT coefficients. The Discrete Cosine Transformation matrix of each
block in a selected macroblock can be seen by selecting Settings > DCT Display
from the Menu bar

The DCT Display option is available only when viewing the details of GOP in
Video Stream Analysis. Enabling the DCT Display option will enable Show
DCT button next to the displayed picture in Slice & Macroblock Tab, Picture
View Mode.

GOP And Picture Sice Aud W | Picture Player |
Slice Display | MB Size Display | -Scale Code Display | Motion Vector Display |[Ficture Displey
g R e T oaltip
- Show MV |

Motion Vector Parametersiin units of Pixel):
MY Backward Top Field = 85 y -
MY Backward Bottom Field »: -4.5. »:

Other Parameters:

ME Inbra =  FALSE
DCT Type = FIELD
ME Quantizer Scale = 14

CBP 111100
ME Size (Bitz) 151

NTE
: DCT Yalues for Macroblock N 5
SelectBlock Decoded DCT YValues Inwvarsa DCT Values
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
v [0]1] 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
0 0 il 0 0 il 0 0 i 0 0 il 0 0 0 [
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
b 0 0 0 ] 0 0 0 0 0 0 0 0 0 0 0 0
[ & | 0 0 0 0 0 [ 0 0 [ ] 0 0 0 0 0 [
0 0 i [ 0 i [i 0 i ] 0 i 0 0 0 [
Cr 0| o 0 D | o 0 D | 0 0 D | o0 i 0 | 0 | O 0

The Show DCT button is used to toggle the DCT Coefficients display. To view
the DCT values of the a macroblock, select the macroblock; a window containing
details of coded and decoded DCT values will be displayed.

: DCT Values for Macroblock No: 642 Block No: D

Select Block Decoded DCT Valuas Invarse DCT Values
[ | [1202] 24 T 0 0 0 0 0 0 223 [ 223 [ 224 [ 225 | 226 [ 227 [ 228 [ 228
v ] [z o 0 0 0 0 0 0 208 | 207 | 206 [ 205 | 204 | 202 | 201 | 201
ﬂ 71 -16 0 0 0 0 0 0 177 | 176 | 173 [ 170 | 166 | 162 [ 160 | 158
33 | -16 0 0 0 0 0 0 160 | 159 | 156 [ 152 | 148 | 145 [ 142 | 140
Ch 16 0 0 0 0 0 0 0 139 | 138 | 137 [ 135 | 132 | 130 | 129 | 128
D 0 0 0 0 0 0 0 0 MslMs (a3 nm3afnz |21
-19 0 0 0 0 0 0 0 110 | 110 | 109 [ 108 | 108 | 107 [ 106 | 106
Cr IE ] 0 0 0 0 0 1} 0 103 | 103 | 102 (100 | 99 97 96 96

Note that the luma (y) control has four selections (0, 1, 2 and 3) which correspond
to an 8x8 pixel corner of the 16x16 pixel selected macroblock. Chroma
sub-sampling (Cb and Cr) will display matrices for the color differences between

frames.
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The picture display has the following limitations:

B When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those
that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

B For MPEG?2 scalable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES

Analyzer.

B For MPEG?2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

DCT Value display - version changes. The diagram also indicates the changes that
occurred between ES Analyzer, Version 1.5 (MPEG Test System, Versions 6.4
and 6.4.2) and ES Analyzer, Version 1.6 (MPEG Test System, Version 6.5). The
"windows" referred to are those in the DCT Values window.

Compressed Data Stream

v Y

4
The Codad DCT values (lefi-hand window)
measurad in the stream before WLC and
RLC (entropy) decoding

WVLC Coding Table —»| VLC + RLC Decoder |

MEEG Test System, Version 6.5

applied, i.e. after the de-quantising .—/
process.

|
1
1
1
1
I The Decoded DCT Yalues (lefi-hand
I - window) measured affer VLC and
: ¥ RLC {entropy) decoding,
1 . R ~ |
| Quantization Table - De-quantizer i
| |
| |
| I
1 |
|
: v |
1 |
| Inverse DCT i
1 MPEG Test System, Versions 64 & 6.5 |
1 The data shiown in the right-hand window |
= —|ig thatafter the Inverse DCT algorithmis F——=———=———=|——==—=—— 4

Mote the window name changes:

Inverse DCT Values - Right window (6.5}

Dacoded DCT values - Right window (6.4)

Decoded

picture

RLC - Rin Length Coding

VLG - Vadiable length Cading 8 x 8 block
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Configuring video analysis

286

settings

The video analysis or picture analysis default settings can be set as required.

NOTE. The selected Video Analysis settings will not affect analysis on either the
Slice and Macroblock or the Picture Player pages. On the Slice and Macroblock
page, analysis is always at the macroblock level. On the Picture Player page,
analysis is always at the picture level.

Video analysis settings. Select Settings > Video Analysis... from the Menu bar.
The following dialog box is displayed:

Yideo Analysis Settings E3 I

Picture level analysis &

Macroblock level analysiz Carcel |

Macroblock Shadding 5 cherme
Bazed on Macroblock Size 8

Bazed on Prediction Type is

Select Picture level analysis to view frames quickly.

Select Macroblock level analysis if pictures/frames are to be analyzed at
the macroblock level.

When Macroblock level analysis is enabled, select the shading scheme required.
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Picture display settings. A number of display and vector parameters are set from
the Picture Display Settings dialog

Select Settings > Picture Display... from the Menu bar. The following dialog
is displayed:

Picture Dizplay Settings E3 I

— Digplay Order of Pictures
(® Prezentation Order Q) Decoding Order

— Matian Yector Overlay Colowr Selection
O wihite (&) Veckor Dependent
) Black (@] Background Diependent

Cancel |

Display Order of Pictures Select Presentation Order or Decoding order
Motion Vector Overlay White: All vectors will be displayed in white.
Colour Section Black: All vectors will be displayed in black.

Vector Dependent: Colors will correspond to the vector selection
button colors.

Background Dependent: Colors are combined with picture
background to provide a contrast.

MTSA-HW and MTSA-PC Analyzer Applications User Manual 287



ES Analyzer — Working with video streams

Viewing the slice size  For any picture, you can also view the slice size distribution.

distribution
To view the plot.

1. Position the cursor to the picture for which you want to see the slice size
plot on the GOP And Picture tab.

2. Move into the slices display by clicking the Slice and MB tab.

3. Click the Show Slice Size Statistics icon [ on the toolbar.

NOTE. The Show Slice Size Statistics icon ] is grayed out on all tabs except
the Slice and MB tab.

The plot appears in another window.

Slice Size Spectrum for GOP Mo. 1 Picture Mo. 2 I
1.00

0.90i

0.40 =
0.700 —
0.60
0.50
0.40
0.30

0.20
0.10
1

Slice Size (KBytes)

Slice No.
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Viewing the frame size
spectrum

You can view the picture spectrum for a GOP and the frame size plots.

To view the plot.
1. Display the GOP for which you want to see the Frame Size Spectrum plot.

2. Click the Show Frame Size Statistics icon Iﬁl on the toolbar.

The following plot is displayed. Each bar represents the frame size in kilobytes:
Frame Size Spectrum for GOP Mo. 1 E
48.0]

43.3
38.5
33.8
23.4

24.1 P p P p P
19.3

Frame Size (KBytes)

14.4 B B B B B B

9.7
4.9
U U U —

0 1 2 3 4 5 [} 7 8 9 10 11

] ok |

Selecting the Show Data Distribution button will further enhance the plot by
showing the content of each frame.

Frame Size Spectrum for GOP No. 1 E
48.0

43.3

38.5
33.9
20.8
24.1
19.3

Frame Size (KBytes)

14.4

Ficture Size [Bytez]
9.7
4.9

UD Mv DCT
H N

P
]

B

Frame Mo.

P P P
E E E UszeData Size [Bytes] ;
Motiontector Size [Bytes] =
[ICT Size [Bytes) =
—t t —t—— t —t—— t —t t t
0 1 2 3 4 5 3

7

Content is color-coded as shown by the key in the bottom left corner. Details of
the content of each frame are displayed when the cursor is moved over a frame.
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Using the video viewer for picture analysis

The video viewer (or Picture Player) allows you to play a video stream and
display the decoded picture on the screen. The picture player playback speed may
vary from real time according to the ES Analyzer processor speed. You may
also notice certain pauses in the display at regular intervals. These pauses occur
at GOP boundaries. The Remote Control (described below) allows you to pause
and resume the display at any frame. You can also restart the display from the
beginning of the current GOP, or from the start of the video sequence.

The number of the current picture and the number of the last decoded picture are
displayed, as shown in the following illustration. Here is a typical sequence of
steps in which you may use the video viewer:

1. Open the video stream you want to analyze.
2. Start the video viewer.

3. Monitor the displayed picture for quality problems.

GOP And Pictwre | Slice And MB Ve Vayer |

Playing... Sym2 trp (]
youon o =

B
. o/ ’?" T |
TSAE (ot mmﬂhﬂﬁiﬁ

4. Pause the player whenever you notice a problem in a picture, such as a
degradation in quality. The player is intentionally made to play at a speed
slower than the regular play speed to allow you to stop at specific frames.
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Switch to the analysis tabs to view details of the currently displayed picture
down to the macroblock level.

Step forward or backward in decode order in the Slice And MB tab, or switch
back to the video viewer and resume play.

ES Analyzer synchronizes the picture being currently displayed by the video
viewer with the picture/data that is displayed on the other tabs: GOP And Picture
and Slice And MB. This means that:

The GOP And Picture and Slice And MB tabs always display data for the
same picture.

When you switch from the video viewer to either the GOP And Picture
or the Slice And MB tab, you are presented the data for the picture being
displayed on the Picture Player tab.

When you switch from the GOP And Picture or the Slice And MB tab to the
Picture Player tab, the video viewer presents the picture for the data being
displayed on the GOP And Picture or the Slice And MB tab.

If you select a macroblock and switch to the picture-quality analysis tabs
(such as MB Size Display, Q-Scale Code Display or Slice Display), you will
find that the same macroblock remains selected for easy identification.

The video viewer, however, has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scalable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

= Main Profile @ High Level MP@HL)
= Main Profile @ Main Level (MP@ML)
= 4:2:2 Profile @ Main Level (4:2:2P@ML)
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Picture player remote = The Remote Control is displayed whenever the Picture Player tab is selected.

control Playing... Sym2 trp (=]

[ || bldbpuﬂﬂﬁ :l

Play Video

Plays the video stream from where it last stopped.

Stop

Stops the video stream and allows the other analysis tabs to
be selected.

H

Next Picture

Steps forward one frame.

[

Play from GOP Start

Plays the pictures from the start of the current GOP.

o

Zoom/Restore Display

Enlarges and restores the area in which the picture appears.

Fit Best in Display

Fits picture in display area or displays picture at original size.

I:L Area/Display Picture at
True Size
ﬂ ﬂ Left/Right Scroll Scrolls the displayed picture left and right.
| Up/Down Scroll Scrolls the displayed picture up and down.

B B

Show/Hide information

Shows or hides the information panel for the displayed picture.
The following information is displayed:

GOP Number - in which the frame is present. Coded Number
- refers to the picture number within the GOP. Display Time -
in hh:mm:ss:cc; where cc is the display number in the whole
file. Display Number - refers to the display number of a picture
within the GOP.

292
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ES Analyzer — Working with audio streams

ES Analyzer analyzes both MPEG (-1 and -2) Audio streams and Dolby Digital
(AC-3) Audio streams.

Understanding MPEG audio streams

An MPEG audio stream consists of a sequence of audio frames. Audio data
may be received for multiple channels. Each channel is divided into sub-bands
for which data is transmitted.

ES Analyzer verifies audio streams according to the MPEG audio
recommendations. Support for both MPEG Layer I and Layer II audio is available.
MPEG-2 extensions for Layer I and II (surround and center channels, and low
frequency channels) are also interpreted and analyzed. Multi-lingual extensions in
MPEG-2 are currently not analyzed. ES Analyzer is also unable to analyze the
MPEG-2 Audio stream if the extension bit stream is present.

For a detailed discussion on the MPEG audio syntax, refer to ISO 11172-3 and
ISO 13818-3.

With ES Analyzer, you can:

B Navigate to any audio frame; see details in the Navigating through Streams
section in the Getting Started chapter in this manual.

m  View frame details, including frame header, and plots of the frame data, as
shown in the following illustration.

B Interpret and display audio descriptors received in higher level streams and
validate them against the stream.

B Play an audio stream.

For each audio frame, data may be received for at most two channels, as shown
in the next illustration; additional channels may also be received in the MPEG-2
extension.
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Audio Player
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The Audio Player is available on MPEG-1, MPEG-2 and Dolby AC-3 streams
(and AAC as an option). With a suitable sound card installed in the host PC,
audio streams can be played.

NOTE. The speed and quality of playout, is not high fidelity, but is sufficient to
allow an audio stream to be monitored for analysis.

WARNING. While an audio stream is playing, you cannot access any other
analyzer functions. In particular, do not close the Audio Player while an audio
stream is playing (especially in loop mode), because you will be unable to reopen
the player (and control the stream) until it has finished playing.

If more than one audio device is installed, a selection can be made from the
Device dropdown list.

Channel Select
Audio Play

Devicel Crystal Sudio Systern F'Iayl:uau:lll (}]F‘*l ll

Play Chanmelz ILeft,Hight Charinel LI

The channels to be played can be selected from the Play Channels dropdown list.

=T S .
<H—| To open Audio Player, select the player start button, which is available
on the audio stream header pages.

The Audio Player control panel is displayed:

I [H-20-50 fish2 mpg52] - k| x|

The player controls follow the same convention as the Video Player controls:

Icon Description
Play
b
Stop
ll
[ 3 Fast forward
LT Fast rewind

(To use Fast Forward and Fast Rewind, press the required button and then
stop the action with the Stop button.)
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The Audio Player display shows the following:
B Play time

B Stream Name and Audio PID number

m  Player status (Stop/Play)

The following controls are available in addition to those described in the
preceding list.

EI Toggles continuous (or looped) playout.

T Toggles a real time waveform display.

NOTE. Currently two channels are output to the sound card. These can be
assigned as required (as mono or stereo) from any of up to five channels in a
Stream.
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Explaining MPEG-1 audio  ES Analyzer displays data for each channel separately.

streams —

WP | (lealoe |

— Frame Header
D |1 Layer Il-a-"'e’:2 Protection Bit »
Bitrate I334kbps Sampling Frequency I‘lB-DkHZ Padding Bit b 4
Private Bt b 4 Mads IStB"30 Made Extension ID
Copuright x Emphasis INone Original or Copy x
CRC Check. |3[|33‘| Bound |2? SBlimit Izr

s ool i

i | SCFSI | Goowping | Scalefactor |  Charel Selest

Left Charinel Audio Play

DeviGEI Crystal Audio System F'Iaybaclj qr-r l|
Play Channels ILe[t_Hight Channel 'l

=
=]
)

=239

Bits/ Codeword{shi—

sh—

For the selected audio frame, ES Analyzer displays the following:
B The frame header.
B A plot of bits per code word against the sub-bands for each channel.

m  SCFSI (Scale Factor Selection Information) plotted against sub-band for each
channel.

B Grouping information plotted against sub-bands for each channel.
®  The scale factor plotted against the sub-band.

B Channel selection and playout controls.

296 MTSA-HW and MTSA-PC Analyzer Applications User Manual



ES Analyzer — Working with audio streams

Explaining MPEG-2 audio For MPEG-2 Audio streams, ES Analyzer analyzes the following channels if the
streams  data is present: Left, Right, Left Surround, Right Surround, Center and LFE.
Currently, ES Analyzer analyzes 5.1 Audio streams. When ES Analyzer detects
an MPEG-2 Audio stream, the information displayed is similar to what is shown
in the following illustration.

Mty | Choulor | MC Header | MC Composite Status |

— Frame Header
D |1_ Layer ILayerE Protection Bit x
Bitrate Im Sampling Frequency I‘M-1 kHz Padding Bit \/
Prriveate Bit b4 Mode IStE'ED bode Extengion ID—
Copyright b 4 Emphasis W Original or Copy v

CRLC Check. |421 53 Ecound IBD SBlimit |3[|

s ol SCFSI Groupi Scalefacio
e | I TOUpInE € ! | — Channel Select
Center Channel Audio Flay

:!: DeviGEI Crystal Audio System F'Iaybaclj qr-r l|
3 Play Channels | LefRight Channel | =

)

:

§

3 L K
= o

pryr L5f] . EE

ES Analyzer displays information on the following tabs: MPEG-1 Header,
MC Header (Multi-channel header), and MC Composite Status (Multi-channel
composite status).

MPEG-2 Audio streams are backward compatible with MPEG-1 streams.
Therefore, the MPEG-1 header for each frame is the same as that for an
MPEG-2 Audio stream.
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The MC Header tab displays information about the additional data present for the
multi-channel extensions, over the two stereo channels. It gives you the number
of channels that are present, the presence of the LFE channel, additional CRCs,
and other relevant fields in the MC Header, as shown.

MPE 1 Header W el l MC Composite Status |
Multichannel Header Infermation —{ M ullizharrel Header | nfamations |
Mo, of Channels |3— Dematnx Procedure ’2— CRC wWord ’W
Audio Mit for Small Boom Coppright 1D Bit 3¢ Copyright 1D Start MC Mode ’r
Charnel | nfamnation I ultilingual Channel Infiormations E xtenzion Bitstream [nformation
Centar \/ Lfe X Multilingual Layer x Extenziom Bitztrzam Flag x
Sunaund v Mo. of Channels ,D— Mo of Bits in

; " M
Mo, of Channels |2 5 ampling Frequency ’D— Ancillany Data Field

The MC Composite Status tab provides the sub-band information of the channels;
and their relationship with the transmission channels, as shown.

MPEG 1 Header ] MC Header WL Cocapnsive Biains |
TC Allocation ¥ alid for all Subband Groups 4 MC Prediction ON X Dynamic Crosstalk Used %
Dynamic Crosstalk LR @

TC Allacabion 0 0 0 0 2 2 a 2 q 0 z 2
Dynamic: Crozs hode KA || AR | WAS | N | NAA | NAR | NS | AR | A || NAR | MRS || MR
Dyanarnic Crasstalk for | NAA | NAR | NAA || NAR | MAS (| NAS | MAR || WAR | HAS || /A | HAA || AR
Second Steren Program

1 2 3 4 5 53 7 8 1 10 11 12

Subband group

The lower part of the dialog box displays information specific to the channels.
You can select the channel for which you want to see the details by clicking the
appropriate graphic at right. The channel-specific data for the selected channel is
displayed at left as for MPEG-1.

ARV O | i
I SCFSI l Grouping I Sealefactor ] Channel Select
Audio Flay

Device | Cryztal Audia Spatemn F'Ia_l,lbaclj @ =T

Play Channels | Left Right Channel =

Center Chanmel

Bits' Codeword{shi=

&
=
=]
]

sh—
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Explaining the Status bar ~ The status bar for Audio streams displays the following:

display B Frame number, which is the number of the current frame in the stream.
B Layer number, which is the number of the audio stream.
m  Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.
|For Help. press F —— |Frame# |S{F: 48.0kHz |2Bbkbitsfs  [Layerz | |off gy

Understanding Dolby Digital (AC-3) audio streams

ES Analyzer also analyzes Dolby Digital's audio streams, which could be an
independent, standalone audio stream, or a multiplexed stream that is embedded
inside an MPEG-2 System stream (ATSC transport or program stream). The
Dolby Digital stream is analyzed by ES Analyzer for syntactic compliance with
Dolby Digital specifications.

For a detailed discussion on the Dolby Digital audio syntax, refer to the document
A/52 from Advance Television Systems Committee (ATSC).

ES Analyzer analyzes Dolby Digital stream frame by frame and also performs
CRC checks for each audio frame. When analyzing a Dolby Digital stream, you
may navigate to any frame and also view data specific to an audio block within it.

Automatically detecting the data format used in the Dolby Digital stream, ES
Analyzer analyzes both the little endian and the big endian formats. For ease of
debugging, ES Analyzer displays information for all the fields of any block for
any audio frame.

When errors are encountered in a stream, ES Analyzer reports the errors and
synchronizes to the next audio frame to continue the analysis.
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ES Analyzer displays the header and audio block information on specific tabs, as
shown. The Header And BSI tab displays the Dolby Digital synchronization and
bit stream information.

sty | | CACI [ | caca ez

Mair &udio Service: Complete Main 3/2 :Channels->L.CR.SLSR

0.707(-3.00B) 5.
:
0

A
A .

Crystal tsudio System Playbacl ¥ 'l'l =IT
Left Channel =]
Right Charinel =

The audio controls are only available on the Header and BSI tab.
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Depending on the selection, the Audio Block tab displays information for the
corresponding audio block within the frame.

Header And BST Fadin Hlock |
[l ) : : . ‘ ;
Awudio Black Number o 1 2 3 4 5
Dwnamic R ange P b Coupling Strategy Information
Gain Range "ord Exist x Gain Range “Word Exist far Channel2 0 Coupling Strateqgy Exists \/ Phase Flag in Use s
Gain Range 'Ward ID Gain Fange ‘Ward for Channel2 IN A Coupling in Use \/ Rematrixing Strategy @
— Bit Allocation Parametric Information - Delta Bit Allocation 3¢
—Bit Allocation Information ————— ~ SHR Offset \/ _ Coupling Delta Bit Allacation Exists M.A.
Bit Allocation Info Exists J Coarze SHR Offset 21 Coupling Delta Bit Allocation Seaments M.A.
Coupling Fine SMR Offset 12 =
Slow Decay Code > ) . Laow Frequency Effect \/
Fast Decay Code 1 Caupling Fast Gain Code Channel Expanent Strateqy 015
Slow Gain Code 1 - Coupling Leak Initiization o ————— Channel Fine SNA Offset 12
S+ Ga - | Channel Fast Gain Code 4
103 (e Bk Gt Gt | Faszt Leak Initilzation 0
Masking Floor Code |5 Slow Leak Irtifzation 0
‘ Gkip Length Exists 3¢ Skip Length IN.A. ‘
— Channel Select ———————————— . . 5
Caong iy Tt | Channel Fields |
Left Channel
e R r—Band Structure
=] E
@ I I I I “ m I
Vo e

| I !
48 72 ©DE 120 144 1€E 132 Z1E 240

L5 B Y

The lower part of the previous illustration displays the channel-specific
information for the selected audio block, as shown in the following illustration.

o lies Tinthy | Channel Fields I
Left Channel

(=] E
L T e L e e O N

48 2 26 120 144 6@ 1292 =216 240

$b—

— Band Structure
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Coupling Info Chevivie L e bl
i~ Block Switch and Dither Fage — Exponent Strategy
. Caupling E t Strat Reuse
Block Swatch Flag b4 OUPING ERponEnt Sttatedy
: Channel Exponent Shrategy FReuss
Dither Flag v Channel Banduith Code N
—Edponent——————————————— — BitAllacation Infarmnation
Gain Range Cods IF Channel Fine SMA Offzet MLA.
Channel Fast Gain Code WA
—Coupinga———  ~ DeltaBit Allazation
Coupling Co-ord Exists x Dielta Bit dillocation Ewvists WA
Master Coupling Co-ord I H.A Delta Bit Allocation seaments M4,

The Coupling information tab distinguishes between the stand-alone and coupled
data for the selected channel. The green band denotes the standalone information,
and the blue region denotes the coupled information. The blue region may be
further divided into bands; these appear as solid lines as opposed to the dotted
lines that denote sub-bands.

Explaining the Status bar  The status bar for Dolby Digital Audio streams displays the following:

display ®  Frame number, which is the number of the current frame in the stream.
®  Bit rate of the Dolby Digital audio stream.
B Sampling rate.
B Frame size information.
B Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.
||F|:|IHEI|3, press Fl ————— |FrameHi |BitRate 192 kbps |F#5 48 KHz |FSCOD:20 | | Offzet: 0 4|

302 MTSA-HW and MTSA-PC Analyzer Applications User Manual



ES Analyzer — Working with Program streams

ES Analyzer — Working with Program streams

Program streams are quite similar to MPEG1 System streams in structure. A
Program stream consists of a sequence of packs. Each pack has a header, an
optional system header, and any number of packets. If a system header is not
received in a pack, then the last received header is applicable for the pack. The
system header is sent periodically in the stream to facilitate random access. Each
pack contains any number of packets. Each packet belongs to a particular stream
and has a PID associated with it. If packets of a given PID are concatenated,
you get the embedded PES stream with this PID. The PES stream in turn has

an elementary stream embedded in it.

For more details on Program streams, refer to the ISO/IEC 13818-1 document.

—Pack
SCR Base |1 Child Stream 1D |224 hﬂ;t:-:ﬁ?le 4000000
itzds
SCR Exstension |24E| Child Stream Type IPESWES]
— System Headara
Header Length |12 Videa Bound |1 CSPS Flag 4
Fixed Flag 4 Audio Baund |1 System Yideo Lock Flag &
Rate Bound |4uuunuu bitz/s System Audio Lock Flag <
STREAM ID I STREAM TYPE I STD BUFFER SIZE
45 19 Audia Stream 4096 Bytes
! 224 YWideo Stream 235520 Bytes
4| | ¥

ES Analyzer performs conformance and semantic checks at the program stream
packet level as per the ISO/IEC 13818-1 recommendations. An embedded stream
is checked when you navigate through one; for details, see the Navigating through
Streams section in the Getting Started chapter.
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For Program streams, you can:
B View pack and system headers, as shown in the previous illustration.

B View the program stream map; see the Viewing the program stream map
section for details.

B View an embedded stream at the PES or the elementary stream level; see
the Understanding Packetized Elementary Streams section for details in this
manual.

®  Perform buffer analysis of the embedded audio/video stream using the STD
model; see the Analyzing Streams chapter for details in this manual.

B Perform PCR/PTS frequency analysis model; see the Analyzing Streams
chapter for details in this manual.

Viewing pack and system headers

When navigating through a stream, the current pack is displayed in the header
display area, as shown in the preceding illustration. The pack and system header
fields are displayed for the current packet of the Program stream. The currently
applicable system header is displayed for the packet. The receipt of a system
header in the current pack is indicated by a check mark in the system header group
box. A cross mark indicates that the system header was received earlier.

The list of streams declared in the header is displayed in the elementary stream
list box. It is possible that the stream may contain some PES streams that are not
declared in the System Header. Such streams are added in the tree view when

a packet of the same is encountered.
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Viewing the program stream map

j=l| The program stream map can be viewed by clicking the stream map icon
(PSMAP) in the tree view window. This pops up the stream map showing the
descriptors for the Program stream and the contained elementary streams. The

descriptors associated with each elementary stream in a program can be viewed in
one of two ways:

B By double-clicking the corresponding icon for the stream in the display

| By clicking the more details icon shown for the corresponding stream in
the elementary stream listbox

— Pragram Map Table

Version Kumber IU Current Nexst Indicator e EI
CRC |382|3531 459 M ap Mumber |2

— Elementam Streams

Pl D e rmmermns et manmrn s nm o L

| STREAM TPE

F 197 MPEG1 Audio (003

The form is extended (if not already extended) to add the descriptors display, as
shown in the following illustrations. All descriptors that are received for the
corresponding stream are displayed on tabbed folders. If a descriptor is not
received, its tab will not appear in the descriptor display. The illustrations below
show descriptors for the respective video and audio tabs.

[Descriptars for Stream I0:224

videa |
Multiple Frame Fiate Flag b 4 Frame Fiate ISD
Constrained Parameters Flag % Still Picture Flag x
MFEGZ

Escape Bit b 4 Profile IMain
= IMain Chrama Format IW

Frarme Rate Extension Flag x
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|Descriptars for Stream 10:192

Audio |

x

Free Farmat Flag

S

D

Layer I 2

Explaining the Status bar ~ The status bar for Program streams displays the following:

display B Pack number, which is the number of the displayed packet.

m  Packet number, which is the number of the current packet in the entire stream.

B Packet number of SID, which is the number of the current packet taking into
account only packets of the same stream ID (SID).

m At GOP level, the location of GOP header/start at PES level and Pack level is
displayed by PES packet number & Pack number respectively.

B At AES & AC3 level, the location of frame header/start at PES level and Pack
level is displayed by PES packet number and Pack number respectively.

B Byte offset in the file, which is the first byte of the Pack header being currently
viewed in both the hexadecimal and decimal formats.

“or Help, press F1 — |.+ [PESPKi 1 |Pack#t13 7 T182kbits£s |Layerz |Framet;1 V |Off 0x12815(75797] = |
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ES Analyzer — Working with teletext

Teletext can be incorporated into DVB streams. ES Analyzer allows the associated
data to be analyzed and viewed.

TERT

To view the teletext data, navigate to the teletext icon in the Tree view
window.

Initially, the Page Header data will be displayed:

i@ Tektronix MPEG-2 ES Analyser - [AC3 on DVB.mpg] o]
& Fla Edi View Window Node Selings Help EIE]]
= - k2 k2
|=|e | = JEl= «lollalsE =alaa) e
=gy TPT ]
- @R PROGRAM 833 Teletext Data Block Ini
PES(PID=255), MPEG 2/ Dataldevtiier  [16 DataUnitln |2 Detalnit Lengtt  [#4
- () PES[FID=255) MPEG 14 -
& Fest ! Line Off st 325 Field Parity Second Field Framing Code 228
(=] PES(AID=257), PES Packs
& 28 FEsiFD-32) S cortar Magazine Number [5 Packet Numper [0 Designation Code [N-4
et T eletest 193]
(&F PROGRAM 239 Pige Heads |
@F PROGRAM 837
@F PROGRAM 300 PageH — TE—— —
- PROGRAM 40 ubcods Valu ational Option Character Set Bits
Magzzine Number  [6 51 [o s2 o
I I I ciz [0 o130 c1a 1
Page Number [100 53 o g4 [0
Conlral Bit Flag
Update Indicator - 96 Interupted Sequence 9 Supress Header 36 Newsflash 9
Inbitit Display € M agazine Serial s ErasePage ¥ Sublitle x
< ] Necated 1 Hapley | Decoding Parameters |

Stieam Propet Value Py
e, SN G GANDVE TeletextMl11. 1. BRI 122 : §5
 TwpeoiVideo:  Mpeg2

o Typeoldudio:  Mpegl
« User Dats Streams: 1 .
o ToldProgiams:  §

« Sewvice Type:  DVB

< D 4

LOCATION I MESSAGE

TPT-»PESIPID=32]. PES containing Telete. Incomect Data Unit Length coded. Allowed value is Dx2c
TPT-»PES[PID=32]. PES containing Telete. . Incomect Data Unit Length coded. Allowed value is Dx2c
TPT->PES[PID=32]. PES containing Telete. . Incomect Data Unit Length coded. dllowed value is 0x2c

-l

< |
For Help, press F1 [ — ] [TPTPKHED | Off 01 5 B{8598)
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Using the Next button, details of the page can be viewed in the Data Packet tab.

i@ Tektronix MPEG-2 ES Analyser - [AC3 on DVE.mpgl Lo
%) Fle Edt View Window Node Selings Help _151x|
= - P
|= o= O |8 =2+|0||edi=q|5aE ¢
.
E & i Mext Telstext Frame —
= G? PROGRAM 838 Teletext Data Block InfG
FES[PID=255], MPEG 2%/ Dataldentiier  [16 Dataliitin 2 Data Unit Length  [44
PESIPID=256). MPEG 1 A,
GR PESIFID-256) Line Dffset 15 FeldPaiy [t Fieid FiamingCade 228
() PESIFID=257). FES Packi
1 25 PESIPID-32), FES cortar| | MagezneNumter [5 Packst Mumber [10 Dessigriation Code [N A

&P PROGRAM 893
- PROGRAM 837
&P PROGRAM 900 Diata Packet Info

E- & PROGRH 0 Side Parel Informations———| | Character Informations
Prage Type Basic Level 1

LeftSide Panel X Right Side Panel X Second GO Character sat [ra
Page Codin 7plus 1 Odd parity
1 s
Number of Columns insids Pansl N2 Second Nations! O ption Selection N5

Page Header | Color Map Table | THETE

Black Eackground Substiuion 6

Devaded Display | Decoding Parameters |

TKRuwerbefinanz. fiService; B2 40P

N — |

Stream Propet Value -

« AudoTracks: 5 —
« TypeofViden:  Mpes2

 Typeoféudic:  Mpegl J

® Llzer Data Streams: 1

« Tolsl Progiams: 5 - -
4| D 4| | »

|Ne#t Packet , GOF or Frame T |Frame#33 |PIDT023 packet [ [ 0if 0435372121 9634)

Other tab pages (Color Map Table, Decoded Display, Decoding Parameters)
provide detailed teletext encoding data. These tabs will only appear as progress is
made through the stream using the Next button and the analyzer detects them.

VBI (enhanced teletext support)

308

Enhanced teletext support is available (reference: ETSI EN 301-775). The
supported extensions include the following:

B VPS (Video Program System)
B WSS (Wide Screen Signaling)
®  Monochrome Data

Note that the associated information screens will only be available for display
where data of the specific type is available in the stream.

Examples of the screens are shown in the following illustrations.
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VPS (V|deo Program 8" Tokranix MPEG-2 E5 Analyser | ‘
System) Jsg@m A |

=g TPT
E]- @2 PROGR&M 1
PESIPID=33), MPEG 2 ¥ic
- frg PESIFID=47) PES contai
~() USERIPID=43)
=48], PES contai

=36), MPEG 1 A
-3 PESIPID=37), MPEG 1 &

« SheamType:  Transpart
- Video Tracks: 1

« fudio Tracks: 2

- Typeofiideo:  Mpeg2
« Typeoféudio:  Mpegl
« User Data Streams: 1

WSS (Wide Screen
Signaling)

S(PID=37), MPEG 1 Au

Full Format

Subtitles out of active area

« Audo Tiacks . 2
* Typeofviden:  Mpeg2
- Typeofbudio:  Mpegl
o User Dt Streams: 1

« Total Programs: 1

- SewiceType:  DYB

{12151 TPT>PES(PID=45), PES cortaining VBl .. Initializing VEI stream
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Monochrome data
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ES Analyzer — Advanced audio compression

Elementary Stream Analyzer (ES Analyzer) performs offline stored stream
analysis for MPEG1 Audio, MPEG2 Audio, and Dolby Digital Audio streams, as
well as MPEG1 and MPEG2 video streams. The streams can embedded inside
DVB, ATSC or MPEGI System streams.

Advanced Audio Compression (AAC) is one of the audio compression

formats defined by the MPEG-2 standard. AAC used to be called NBC
(Non-Backward-Compatible), because it is not compatible with the MPEG-1
audio formats. AAC offers a better compression ratio than MP3 (MPEG-1 Layer
3) and is the state-of-the-art in audio compression technology. It can include up
to 48 audio channels, 15 low frequency enhancement channels, 15 embedded
data streams and has multi-language capability. MPEG formal listening tests
have demonstrated that it can provide slightly better audio quality at 96 kb/s than
layer-3 at 128 kb/s or layer-2 at 192 kb/s.

Due to its high coding efficiency, AAC is a prime candidate for any digital
broadcasting system. Japanese authorities were the first to decide to use AAC
within practically all-digital audio broadcasting schemes. Because their first
services will start in the year 2000, this decision has already triggered the
development of dedicated AAC decoder chips at a number of manufacturers. Due
to its superior performance, AAC will also play a major role for the delivery of
high-quality music via the Internet. Furthermore, AAC (with some modifications)
is the only high-quality audio-coding scheme used within the MPEG-4 standard.

The AAC bit stream is encoded in either of two formats:
®  Audio Data Interchange Format (ADIF)
®  Audio Data Transport Stream Frame (ADTS)
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The corresponding forms are displayed according to the format of the input bit
stream These forms display the information contained in the fields of the Header
and the Raw Data.

Hierarchy window ——

Summary window ——

Analysis window
Packell 1235, Prgiand 170 Resing PHT .
) Packelb TG Fleadig PAT,
Error log window Packeth 13611 Pograns® 170 Roadng PMT...

Packetl 15447 Readig PAT..
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ADIF stream forms

The analyzed information regarding the input ADIF stream is displayed by means
of a property sheet containing three tabs.

The ADIF Header tab of the following figure displays the fields of the header.

SCE0,SCE1,5CE 2, SCE 3,5CE 4, 5CE 6, SCE B, CPE 0.CPE 1, CPE 2,
CPE 4, CPE 5. CPE &, CPE 7. CPE 8, CPE 3, CPE 10, CPE 11, CPE 12,

—
s
CPE 13,CPE 14, CPE 15, 5CE 7,SCE 8,SCE 9, SCE 10, SCE 11, SCE12,
A ]
M A
o
EN

Figure 75: ADIF header Information
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Element color coding in

the Raw Data tab

Color coding of Raw Data

314

tabs

The Raw Data tab of the following figure displays the fields in each raw data
block. A slider control helps to navigate through the various raw data blocks. The
information regarding each raw data block is displayed by means of another child
property sheet containing seven tabs (for more information the fields in each tab
(See Figure 77.) to (See Figure 83.)

Figure 76: ADIF raw data Information

The Element Type (below the slider bar) is color-coded; the key is given on the
right side of the display in the Element Types box. The number displayed in the
Element Type color spot indicates the EIT (element instance tag) of that syntactic
element.

The text in the Raw Data tabs is color-coded as follows:

Light Blue Indicates the syntactic element is present and activated in the
raw data.

Dark Blue Indicates that the syntactic element is present, but currently
inactive in the raw data.

Dark Gray Indicates that the syntactic element is not present in the raw
data.
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Figure 77: Single channel element Information

LOMG_STAR
0
50

Figure 78: Coupling pair element information
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ONLY_LONG

Figure 80: Low frequency element channel information
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7747784141

Figure 81: Data stream element information

Figure 82: Program configuration element information
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SCE | CPE | €CE | LFE | DSE | PCE ]

Fill Element

Count |0 Increment Count |255

Extension Payload

Extension Type |Bilslream filler

Figure 83: Fill element information

The ‘Channels' tab of the following figure displays the configuration of the coded
channels. The physical location of the speakers corresponding to the channels
coded in the stream for standard and non-standard configurations can be displayed.

ADIF Header | RawData ]

i Channels

PCE Mo. |0 'I
+ Audio Play
Device Crystal SoundFusion(tm)] = \E P=IT

Left Speaker IFronl Left 1 'I
Right Speaker IFronl Right 1 - I
Implicit S peaker Mapping INUI’]'S tandard

— Speaker-Channel Mapping
Gremrarens Front Left - - Front Right - >

[7 J——

€-—— ~—or oo -
“-—— ~F¥0-D 8O- ———

------ Back Left ——> ¢~ Back Right ~——

Figure 84: ADIF channels (non-standard) information
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The syntactic element type corresponding to each speaker in the Speaker-Channel
Mapping is denoted by a color-code scheme, the legend for which is given in the

Ch.Element Types box. The number appearing in the color spots denotes the EIT
(element instance tag) of that syntactic element.

Gy S omont) ] 0N
|
g Swrownd

Figure 85: ADIF channels (standard) information
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ADTS stream forms

The analyzed information regarding the input ADTS stream is displayed by means
of a property sheet containing three tabs.

The ADTS Header tab of the following figure displays the fields of the header,
while the Raw Data tab displays the fields in each raw data block and the
Channels tab displays the configuration of the coded channels. The content of the
Raw Data and Channels tabs are identical to that in the ADIF stream.

Figure 86: ADTS header information
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ES Analyzer - Closed caption analysis

Closed captions are captions that are hidden in the video signal, invisible without
a special decoder. The place they are hidden is called line 21 of the vertical
blanking interval (VBI).

ES Analyzer allows closed caption data to be analyzed and inspected.
The two options are:

B CCA Standalone (Player + CC-EIA608 + CC-EI708 analysis)

®  Full Elementary Stream Analyzer + CC-EIA608 + CC-EI708 analysis

NOTE. No special installation process is required. The options are dongle
protected/enabled.

The Stand-Alone option has full Closed Caption functionality, but other ES
Analyzer functions are disabled.

XDS analysis is currently disabled. Extended Data Services is a supplementary
data stream existing in Line 21, Field 2. It is used to provide additional data
(primarily content advisory information) on the program being aired (Reference:
EIA-744).

Enabling closed caption analysis

1. Open a stream containing Closed Captions.
2. Expand the navigation tree and open either a VES or a GOP node.

3. Enable Closed Caption Analysis in the Settings menu. A check mark next
to the option indicates that Closed Caption Analysis is enabled.

NOTE. By default, Closed Caption Analysis is enabled. It is recommended that
it be only enabled when required; disabling it will improve the speed of picture
analysis processing.

However, disabling and enabling the Closed Caption Analysis feature should only
be done when a stream is first opened, not during analysis. Opening the feature
during analysis may result in improper analysis.

When Closed Caption Analysis is enabled, the Closed Caption Display tab
will be visible in the Slice and MB GOP tab.

4. Ensure that the Picture Display Settings (Settings > Picture Display...) are
as shown in the following screenshot:

MTSA-HW and MTSA-PC Analyzer Applications User Manual 321



ES Analyzer — Closed caption analysis

Picture Dizplay Settings I

— Dizplay Order af Pictures
() Presentation Order 2} Decoding Order

— Motion Yector Owverlap Colour Selection
& White O Vector Dependent
{J Black O Background Dependent

EE Cancel

= Display Order of Pictures > Presentation Order

= Motion Vector Overlay Color Selection > White

Selecting closed caption analysis standard

Two primary forms of Closed Caption Analysis are offered: CC-EIA608 and
CC-EIA708. CC-EIA746 support is also supported in the EIA608 mode.

The selection of CC-EIA608 or CC-EIA708 is made from the Closed Caption
Display tab available in the Slice and MB GOP tab.

NOTE. Whichever standard is selected, no closed caption content will be
displayed until the file has been at least partially analyzed. To start analyzing the
stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

2 > &

CC-EIA608 support

Celect CC
¥ E|ARD3

i EIAT03
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The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA608 Closed Caption Analysis is enabled:

Caption Services Test Services E sterded D ata Services
F,‘:chof‘cca ’VO(‘HO(‘TS @ ¢ EDE

@ 2 @O0 (O 2@ C 4

| — Current Frame

Active Mode IF’op On

Background Color -
Row 14: IN A WILDERNESS v

Row 15:  TEEMING WITH LIFE. Background Opague

[EENERS ETTIEY | Roll Up | Pop On | Paint On

Clozed Caption Data in Current Mode

—El&-746 Data

LURL Ihttp:h"www.dtvacu "l Go |
Marne INCAM Expires INA.
Base Row 13 Type Is Script IN.A.

Pen Attribute:

’7Llnderline K Coor ] Flash K ltalics K

Cursar Position

At the top of the display, the LED icons indicate that closed caption data has
been received in the Field and Services sections; green indicates that data has
been received.

If data has been received for the current GOP it should be displayed in the Display
Memory tab and on the picture display:

IN A WI
TEEMING

The remaining tabs (Roll Up, Pop On and Paint On) display various parameters
defining the manner in which the captions will be displayed.

CC-EIA746 support ~ Associated with CC-EIA608 is CC-EIA746 which supports the transmission of
URLSs (Uniform Resource Locators) within the closed caption data.

The URLSs transmitted in the T2 closed caption service are parsed, decoded and
displayed in the EIA-746 Data view.

Ela- 746 D ata
URL | http :thwminwr. fo0.C ¥ ] El

Mame |M.A | Expirez IN..-'-"-..
Type LA, Scripk IN..-'-"-..

B The attributes shown apply to the URL selected from the dropdown list.

B The selected URL is fetched and displayed on the default Web browser
installed on the system.
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CC-EIA708 support

Select CC
" El&E03

* Ela708

The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA708 Closed Caption Analysis is enabled:

~— Caption Service I Samvica 1 - I
—wt— —Window Text

serveeType  [stancad W | [RowD: N AWILDERNESS
- Packet Infa Row 1: TEEMING WITH LIFE.

Sequence No. I 3 .

Packet Size |5

—%Window D efinition Parameter

Byestet [0 window 1D [1 Window Stle 1D [2
- Wi

Block |.”f° . —window Style Parameter

BlockSize |2 Justy  [LEFT Piirt Ditection  [LEFT_T0_RIGHT

e ID —Pen Style Parameter

ctive Window [1 PenSize  |STANDARD | Font Style [Defaut

Details of the fields in the Closed Caption Analysis window are as follows:

Caption service
list.

Packet info

The service whose details are to be displayed can be selected from the dropdown

Sequence No. The sequence number of the packet from which the current service

block has been extracted (for example, Service 1, Service 2, etc).

Packet Size The packet size that has been coded in the packet header.

Block info

324

Bytes Left The number of bytes still to be received.

Block size The size of the service block.

Bytes Left The number of bytes still to be received.

Active Window The Window ID which is currently the active window.
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Window identity e

w
w1

W# The buttons in red in the W# column indicated the defined windows in the
received service. The parameters to the right of this column depend on the
selection made here.

Window text The text shown in the current window.

Window definition By placing the cursor over the more...field all the parameters related to the
parameters window definition can be viewed.

WINDOW DEﬁNITIOH PARAMETERS
PARAMETER NAME PARAMETER VALUE

1 Anchor Hovzontal 0
Anchor Fomnt 0
Anchar Vertical 60
Column Count 32
Column Lock NO
Fen Style 10 1
Friority 0
Relaiive FPostioning NO
Row Count 3
Row Lack NO

32 Visibe NO
Window fD 1
Window Shyie [0 2

Windowe D efinition Pararneter —

“window (D |1 ‘window Style [D IZ w
—Window Style Parametsr

Justify JLEFT Print Direction ILEFT_T -

— Pen Style Parameter

Pen Size [STANDAR | Font Ste [Defaul -
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Window style parameters

By placing the cursor over the more...field all the parameters related to the

window styles can be viewed.

WINDOW STYLE PARAMETERS
*  PARAMETER NAME PARAMETER VALUE
1 Bovdar Codor <0,0,0>
Bardas Typne NONE
| Display Effect SNAP
| Effact Direchion N.A.
Effect Speed N.A.
3 Filf Codar =176,6,74>
| Fill Opaciy TRANSPARENT
Justife LEFT
| Print Direction LEFT_TO_RIGHT
l Soroll Ditection BOTTOM_TO_TOP
Moo Wran NO
I —Window D efinition Parameters
Windew 1D [T Window StielD [Z -J

— Window Style Parameters

‘ Jushify  JLEFT Pritat Dlirection ILEFT q

"F'en Style Parameters

F'enSle!ISTAND.ﬁ.FI Font Styple |Default -

_—

By placing the cursor over the more...field all the parameters related to the pen
styles can be viewed.

Pen style parameters

PEN STYLE PARAMETERS
1 PARAMETER NAME PARAMETER VALUE
| Ecge Type NONE
. Font Styis Default
| italics NO
i Cffsat NORMAL
Pen Size STANDARD
Teud Tag Dialog
- Underine NO 3 unllQTnnl

~"window Definition Parameters———

Windaw 10 I Windaw Stpls (D |2 -J

— Window Styls Parameter
Justify ILEFT Print Direction ILEFT_T -

— Pen Syl Parameters

0 Pen Sizz [STANDAR | Font Stle [Defaul q
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Dumping closed caption statistics

Closed Caption Analysis statistics can be written to file for each standard (EIA608
and EIA708).

NOTE. Regardless of which standard is selected, no closed caption statistics can
be dumped until the file has been at least partially analyzed. To start analyzing
the stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

2 > &

The sequence of actions required for a dump of statistics to be successful is as
follows:

1. The Dump CC Statistics option in the Settings menu will only become
available when analysis (or partial analysis) has established that Closed
Caption data is carried in the stream.

2. A standard must be selected from the Dump CC Statistics option sub-menu,
for example, EIA608.

3. A destination file must be specified for the statistics dump.
4. Further analysis must be carried out to provide data for the statistics dump.

The following paragraphs describe the setup required for each standard; however,
the previous steps must be adhered to for the dump to be successful.
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EIA608 closed caption 1. Select the EIA608 option from the Dump CC Statistics sub-menu.

[lucent16.mpg]

statistics dump

Settings Wal=

Video Analysis.

Picture Dizplay..

O | 8= i

DCT Display

te And BB

¥ Closed Caption Analysis ON/OFF

Dump CC Stahistic:

tdcor

l — Picture U

2. Enable Dump Statistics.

Closed Caption EIAG08 Statistics

~ ¥ Dump Statistic:

Statistics File:
|CATEMPACCT7 dat |
— Caption Services
¥ CC1 " ccz
v CC2 [T ccd
— Dlisplay Mode
 RallUp " PopOn
% Display Mem ' Pairt On

Ela708 ‘

|

Cancel |
YWiew Repart |

3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (reports that you set up) can be viewed by selecting View Report.
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EIA708 closed caption 1. Select the EIA708 option from the Dump CC Statistics submenu.

statistics dump

Settings Wl
I *
Video dmalysis. D | | Gx
| Picture Dizplay..
e And MB
DCT Dusplay

L4 GOF (S

|¥  Closed Caption &nalysis ONAOFF

Dump CC 8 3 Elag0S
l — Pictune SRR ——

2. Enable Dump Statistics.

Closed Caption EIATDS Statistics E2 I
~ ¥ Dump Statistic
0K
Skatistics File: _I
IE:\TEMF’\EE?DBW.dal _l Cancel |
- Service(s) Yiew Report I
Bwallable Dump
Semice 1
Service 2 ; T
<« |
— Window(z]
¥ window D v window 4
7 Window 1 v window 5
I ‘window 2 ¥ window &
¥ ‘windows 3 ¥ wWindaw 7

3. Identify a destination file in the Statistics File: field.
4. Enable the parameters to be dumped.
5. Select OK.

Existing reports (that is, reports previously set up) can be viewed by selecting
View Report.
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ES Analyzer — DVB subtitle stream analysis

DVB Subtitling provides a means of conveying region-based bit-mapped graphics
as MPEG-2 packetized elementary streams (PES). The bit-mapped pixel images
are run-length encoded and transmitted with color look-up tables (CLUT) to

a decoder where the stream is decoded and the subtitle image rendered with the
on-screen display.

When a DVB Subtitle node is revealed and highlighted, the screen shown below
is displayed:

=gl TPT

S @f PROGRAM 8258

- &7 PROGRAM 8325

S @F PROGRAM 8384

=] (B8] PESIPID=2023) MPEG 2Video

=48 vEsa)

| I GOP

@B PES(PID=2224]. MPEG 2 Audio

(B PESIPID=2826), MPEG 2 Audio

=} f PES[PID=2625). DVE Subtitle
BB \E Subtitie{PagelD=2]

F- &f PROGRAM 8448

- @f PROGRAM 8575

- @7 PROGRAM 8640

NOTE. Some streams may show subtitle nodes from which the Page view
(described below) cannot display any subtitles.

This is not an error, it is because the stream is too short to carry the requisite data.
If possible, record a longer section of the stream and retry the analysis.
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i#'Tektronix MPEG-2 ES Analyser - [chandmar2. mpg]
&} Fie Edt Yiew Window MNode Setings Help

|& = aF A _a=«clo|als

w Q| BH | 2

Bl TPT
& PROGRAM 8258
@F PROGRAM 8325

DVB Sublitls Data | Page view |

7 ~Pags Compasition Seamen
- @f PROGRAM 5384 |
PESIPID=2823), MPEG 2 Video SegmentLength 14 Version Mo E el
) Page State [Acquisition Paint Tirs(@ 50 ~ | Region Hor. Address [72
= & VES(Z3)
GOP Flegion Ver, Address [450
=2824). MPEG 2 Audio -
28], MPEG 2 Audio - Region Compositor| 1 B
Segmentlength ][5 Fil Flag v Level of 45il
- el E— Width 612 2B FirelCode |0
g g zzggim :;;2 — Height % 4BRPReiCoe [0
5 CLUT ID ’
Depth 48il 2BitPielCode [0
H- @ PROGRAM 8540
B &f PROGRAM 8706 Object 1D 20 Jid |
[ &P PROGRAM 8768 Type g Horzontal Postion [0 Foraground Pixel Coda [N |
Provider Flag x Vertical Posion |0 Backgiound Pixel .4
LT Defition D [T =]
CLUT Enty I[g =
Steam Property | Value SegmentLength |38 B BitvEnty Flag g Full Range Flag W
e e s | S
- SteamType:  Transport 4 Bit/Enty Flago” Crivaue  [128
* VideoTiscks: 8 oo [ Ch¥alue [123
+ AudoTracks: 10 Default CLUT Table ...
« TypeofVideo:  Mpeg2 2 Bit/Entiy Flag 3¢ TVaue [0
= Typeofdudo:  Mpegl Default Color New Color [N
« User Dats Strears 6
+ TotalPograms: 8
~ObjectData D [20 -
Segment Length | 3843 Top Field Data Block Length [1511 Mumber of Codes 14
Version No. [ BolemFedDataBlock  [1524
Coding Method |0 Mon-Modifying Colar » Show Object

LOCATION [ MESSAGE

1000 TPT->PESIFID=2827), MPEG 2 Video>V... Initializing ¥ES stream
1005 TPT-»PESIPID=2827) MPEG 2 Video>V.. This is an MPEG-2 Yiden Elementary Stream

1173 TPT5PESIPID=2827), MPEG 2 VideoV... Noimages fom previous GOP are available. Playing GOP# 1 may show hazy results
1240 TPT-3PES(PID=2827), MPEG 2Videos... In the picture play mode macroblock level enars are not flagged

I1UUU TPT->PESIPID=2823]. MPEG 2 Video->¥... Initislizing YES strearn
4

3

For Help, press F1 M  [DisploySetl [TPTPRiHGSS2

[PESPRH# |PTS:00:05:07:13914838 AncPage#l | DFf Dx148446(1344504)

The working area contains two tabs: DVB
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DVB Subtitle Data tab

The DVB Subtitle Data tab displays the fields associated with the current display.
Access to two areas of detail is provided by pressing the Default CLUT Table...
and the Show Object... buttons.

Acquisition Paoint

1]

I
Il
i

2
—
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Object view  The Object view displays a decoded bitmap of the selected object rendered on
a blank screen (that is, with no underlying picture). The fields at the top of the
dialog box, provide the user with the options of changing the decoder type (2-bit,
4-bit or 8-bit), the background color, and the CLUT identity. As described in the
standard, the CLUT is attached to the region, not the object; therefore, the user
can see the bitmap using all of the available CLUTs.

The Object view is displayed by selecting the Show Object... button on the DVB
Subtitle Data tab.

D¥EB Subtitle : Object

— Setting
Decoder Tupe |d-Bit Decoder j Clut 1Ty |2 ﬂ

Backaround Colc |Black i

The Cowardly Lion from The Wizard of
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CLUT view  The Object view is displayed by selecting the Default CLUT table...button on the
DVB Subtitle Data tab.

DVYE Subtitle Default CLUT I
—Default CLUT
2 Bits CLUT 8 Bits CLUT
Y
4 Bits CLUT
-
cot [ 5 - N
s | e |
o | | oo —
| — .1 IS

NOTE. Subtitles in the UK are colored in a limited set, (ved, cyan, green,
yellow, white), one for each of four speakers/actors and white for additional
speakers/actors.
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Page view tab

On the Page view tab, the regions listed in the Page Composition Segment area
of the DVB Subtitle Data tab are rendered on a blank screen (size 720(H) x
576(W) pixels). The regions and objects are rendered at their actual locations on
the blank screen. The user can select the Decoder Type and Background Color
from the dropdown lists.

DVE Sublite Data Page View |

Setting

Decoder Type 4-Bit Decoder | ™ B ackaground Cole M -

| wouldn't put my foot through a
Picasso painting. And I'm not going
to put my leg through...

NOTE. Background color is not carried in the broadcast. The user can select
a suitable color.

MTSA-HW and MTSA-PC Analyzer Applications User Manual 335



ES Analyzer — DVB subtitle stream analysis

336 MTSA-HW and MTSA-PC Analyzer Applications User Manual



Index

B M PIDs view, 60
bit rates, 103 menu preferences, 126
pie chart, 106 context, 34 font, 1.27
program view, 35
C N S
Configuration navigation
preferences, 126 overview, 3 stream, 122
context menus, 34 packets view, 65
PIDs view, 60 T
E program view, 3 S tables (SI/PSI) view, 55
error tables _(SI/PSI) view, 55 task examples, 133
next, 36 tests view, 48 tests view, 48

event log, 99

P X

F packets view, 65 XML export, 59
parameters
F3 key, 36 edit, 97

edit all, 123

MTSA-HW and MTSA-PC Analyzer Applications User Manual 337



	toc
	Important safety information
	General safety summary
	Service safety summary
	Terms in this manual
	Symbols and terms on the product
	Preface
	Product documentation


	TSCA - Getting started
	TSCA features
	File Analysis and Real Time modes
	Technical background
	User interface
	CaptureVu feature
	Triggered recording
	Starting the TSCA software
	Interface card overview
	Setting up the IP interface
	Starting analysis
	Setting the stream content font
	TSCA – Understanding the TSCA window
	TSCA top level displays
	TSCA window components
	Error status LEDs
	Context menus

	TSCA – Using the Program view
	Program navigation - transport stream node
	Program navigation - program nodes
	Program navigation - elementary stream node

	TSCA – Using the Tests view
	Tests navigation - all tests
	Test navigation - test nodes
	Test navigation - PID nodes

	TSCA – Using the Tables view
	Table summary pane
	Tables detail view - Section view
	Tables detail view - SI repetition graphs
	Export SI/PSI as XML

	TSCA – Using the PID view
	PID view - all PIDs
	PID view - detail view (All PID and PID Group)
	PID view - detail view (PIDs)

	TSCA – Using the Packets view
	Packet navigation bar
	Packet navigation - filter nodes
	Packet Detail view

	TSCA – Using the Interface view
	Detail view tabs
	Readings and controls
	SDR RF interface views

	TSCA – Common user interface concepts
	Windows management
	Icons
	Graph management
	Timing graphs
	Bit rate graphs
	PIT graph
	RTP Loss distribution graph
	Thumbnail views
	Parameter edit
	Event log
	Bit rates
	EPG view
	MPE views
	CaptureVu feature
	Triggered recording
	Menu bar and options
	Configuration
	Script files

	TSCA – Task examples
	Which tests have failed in an analyzed stream
	How many PIDs are there in a stream? How many PIDs are reference
	What tests have been applied to a program PID?
	Establish the stream type of a PID
	How many programs are there in the Stream?
	What are the contents of the Programs? And what Pids are they on
	What is the bit rate of each PID in a program?
	What is the latest version number of the Program Association Tab
	Examine a transport packet

	TSCA – SI/PSI nodes

	PES Analyzer – Getting started
	Starting the program
	Options
	Opening a file
	PES Analyzer – Menus and controls
	Toolbar
	Status bar
	Slider bar
	Menus and options

	PES Analyzer – Packet Hex view
	Packet header

	PES Analyzer – Event log
	Packet selection

	PES Analyzer – Packet header interpretation
	PES Analyzer – Program structure
	The diagram
	Selecting a packet type

	PES Analyzer – PTS/DTS timing analysis
	Access unit selection
	Scrolling the view
	Video streams
	Audio streams
	AC-3€audio streams
	AAC audio streams
	E-AC3 audio streams


	T-STD Buffer Analyzer – Getting started
	Suitable streams
	Table handling
	Starting the program
	Settings
	Opening an MPEG file
	Opening a BMR file
	Window layout
	Initial processing of MPEG files
	Initial processing of BMR files
	T-STD Buffer Analyzer – Menus and controls
	Toolbar
	Status bar
	Menu options

	T-STD Buffer Analyzer – Stream list
	Selecting streams
	Processing streams

	T-STD Buffer Analyzer – Event and message logs
	Global event log
	PID event log
	Trace

	T-STD Buffer Analyzer – Results graphs
	Common features
	Elementary Buffer graph
	Multiplex or Main Buffer graph
	Transport Buffer graph


	ES Analyzer – Getting started
	Starting the ES Analyzer
	Opening an MPEG stream
	Understanding the main window and icons
	Tree view and navigation
	Header, extension and hex displays
	ES Analyzer – Error testing methods and outputs
	Run Through Stream test mode
	Error filtering
	Status bar
	Regression testing and error log files
	Reports and field selection
	Demultiplexing transport streams to PES or elementary output fil

	ES Analyzer – Working with transport and PES streams
	Using Packet view
	Understanding PES

	ES Analyzer – Working with video streams
	Viewing the sequence header
	Viewing the GOP and picture header
	Displaying the slice and macroblock
	Analyzing picture quality
	Using the video viewer for picture analysis

	ES Analyzer – Working with audio streams
	Understanding MPEG audio streams
	Audio Player
	Understanding Dolby Digital (AC-3) audio streams

	ES Analyzer – Working with Program streams
	Viewing pack and system headers
	Viewing the program stream map

	ES Analyzer – Working with teletext
	VBI (enhanced teletext support)

	ES Analyzer – Advanced audio compression
	ADIF stream forms
	ADTS stream forms

	ES Analyzer – Closed caption analysis
	Enabling closed caption analysis
	Selecting closed caption analysis standard
	CC-EIA608€support
	CC-EIA708€support
	Dumping closed caption statistics

	ES Analyzer – DVB subtitle stream analysis
	DVB Subtitle Data tab
	Page view tab






